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Preface

LogicSource for ManageWise reveals the logic behind the software to as
you in designing, implementing, and troubleshooting your ManageWise 
system.

LogicSource offers an explanation about how ManageWise works. When
understand how the product works, you are better prepared to maintain 
effective network management system for your environment.

Purpose of This Document

This document presents an overview of the ManageWise product, a 
description of its processes, a list and description of the error messages
provides, and information about how to troubleshoot and optimize 
ManageWise. This document also presents information about how 
ManageWise works with third-party and other Novell products.

Use this information to gain a better understanding of the ManageWise 
processes you use and to maintain an effective manageWise implement

Expected Knowledge Level

This document is primarily for system administrators who have either a 
Novell CNE or working experience with ManageWise.

You should also be familiar with network management concepts and term

However, the information in this document is comprehensive enough to h
you gain an understanding of ManageWise from the ground up as long as
Preface �
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are familiar with the basic principles of network management and 
administration.
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� Understanding ManageWise

ManageWise® is software that lets you manage your multi-vendor networ
a cohesive system. Using ManageWise, you can perform these tasks: 

� Analyze your networks from a single management station.

� Monitor and manage servers, routers, and hub cards, and receive 
notification of potential problems on your network via real-time alarm

� Manage, control, and view information about devices on your netwo
with the help of graphical network maps.

� Control and monitor, from your desktop, the DOS* and Windows* 
workstations that are attached to your NetWare network.

� Communicate directly with workstations on your network using a two
way, split-screen dialog box.

� Access and control your network from a remote location.

� Receive regular updates on the status of network devices and 
connections.

� Access hardware and software information about the nodes on your
network.

� Manage your network print queues.

� Request continuous or on-demand scanning for viruses on servers a
workstations.
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� Collect and store hardware and software information about Macintos
platforms connected to a ManageWise Server using Inventory Mana

ManageWise software components can be divided into the following four
categories:

The ManageWise Console software provides a graphical user interface an
remote control service. You can monitor and manage your network from 
workstation on which the console software resides. For further informatio
see Table 1 on page 13.

The ManageWise Server software components gather and store informatio
about your network and communicate it to the ManageWise Console. Fo
further information, see Table 2 on page 14.

The ManageWise Agents perform specific tasks that enhance ManageWis
You can install them on one or more servers in your network. Agents incl
the NetWare Management Agent (NMA), which lets you manage every se
on which the NMA is installed. For further information, see “ManageWise 
Agents” on page 16.

The ManageWise Client is a set of files and programs that execute when y
log in from a managed workstation as part of the ManageWise group. It m
be installed on every managed workstation on your network. For further 
information, see Table 5 on page 22.

See the ManageWise CD-ROM for more information about using 
ManageWise features.

ManageWise Console

The ManageWise Console is a Windows application that helps you mana
your NetWare® networks by providing an integrated graphical interface, a
database of network information, and an alarm management system. 

All the ManageWise Console components must be installed on one or m
Windows 95*, Windows 98*, or Windows NT* 4.x workstations from whic
you want to manage the network. This workstation is also referred to as 
ManageWise Console.

From the ManageWise Console, you can do the following tasks:
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� View a map of the network segments on your network (an internetwo
map).

� View detailed maps of each network segment (a segment map).

� View trend data.

� Receive alarms.

� Set thresholds.

� Manage networking resources, NetWare servers, hubs, and routers.

� Control workstations remotely.

� Monitor printing queues.

NOTE: Be sure to exclude the ManageWise Console workstation when 
you define your ManageWise group.

The following table lists the ManageWise Console components and their
functions.

Table 1 ManageWise Console Software Components

Component Functions

ManageWise Console Provides user interface, Alarm Manager, Database Administration Tool, 
Segment Consolidation Tool, and online Help system.

Alarm Monitor Receives and displays real-time alarms from the Alarm Manager.

SNMP Data Server Manages devices using SNMP over IP and IPX protocols.

NetExplorer Manager Sends requests to NETXPLOR.NLM on the ManageWise Server to 
retrieve the discovered information. Obtains discovered network data 
and topology devices, and stores this information in the ManageWise 
database.

Segment Consolidation Tool Lets you manually combine multiple segments in ManageWise maps 
into a single segment.

Database Administration Tool Lets you back up, reset, and purge alarms and restore your database.

Online Help System Provides information about how to use ManageWise features.
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ManageWise Server

The ManageWise Server is a set of NetWare Loadable Modules (NLMs) 
provide updated server data to the ManageWise Console and an interfac
configuring and monitoring the NetExplorer discovery system.

The term "ManageWise Server" also refers to the physical server on you
network on which you have installed NetExplorer, LANalyzer®, Desktop 
Manager, NetWare Management Agent, inventory components, and viru
protection modules. You need only one server on your network to functio
the ManageWise Server.

At a minimum, you must install the NetWare Management Agent and 
MWISE.NLM on every server on your network that you want to manage fr
the ManageWise Console.

NOTE: NetWare 3.x servers support only the NetWare Management 
Agent and MWISE.NLM. You cannot use a NetWare 3.x server as your 
ManageWise Server.

The following NetWare Loadable Modules (NLMs) ship with ManageWis
and perform these functions:

Table 2 ManageWise Server Software Components

Component Functions Where Installed

NXPCON.NLM Provides interface for configuring and monitoring 
the NetExplorer discovery system on your 
ManageWise Server.

NetWare 4.1x or NetWare 5 
server

NETXPLOR.NLM Communicates with other NetExplorer 
components to collect network discovery data. 
Downloads discovered data to your ManageWise 
Console when requested.

NetWare 4.1x or NetWare 5 
server

NXPIPX.NLM Discovers IPX network devices, segments to 
which they are connected, and other information, 
such as services on systems.

NetWare 4.1x or NetWare 5 
server

NXPIP.NLM Discovers IP routers, segments to which they are 
connected, IP addresses, and all devices on 
segments where NetWare LANalyzer® Agent 
software is installed.

NetWare 4.1x or NetWare 5 
server
�� LogicSource for ManageWise
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NXPLANZ.NLM Discovers all devices on segments where 
NetWare LANalyzer Agent software is installed.

NetWare 4.1x or NetWare 5 
server

SERVINST.NLM Implements the NetWare Server Management 
Information Base (MIB).

On every ManageWise Server 
(including NetWare 3.x servers 
on which NetWare 
Management Agent is 
installed)

NTREND.NLM Implements the Threshold and Trend MIB. On every ManageWise Server 
(including NetWare 3.x servers 
on which NetWare 
Management Agent is 
installed)

NWTRAP.NLM Generates alarms when user-configured 
parameters are exceeded.

On every ManageWise Server 
(including NetWare 3.x servers 
on which NetWare 
Management Agent is 
installed)

HOSTMIB.NLM Implements the standard Host Resources MIB 
(RFC 1514) and Novell’s extensions to the Host 
Resources MIB.

On every ManageWise Server

FINDNMS.NLM Discovers workstations running the ManageWise 
Console.

On every ManageWise Server

NDSTRAP.NLM Implements the NetWare Directory Services® 
(NDS)Trap Management Information Base (MIB).

On every NetWare 5 
ManageWise Server

LDINV.NLM Coordinates access to and maintenance of the 
inventory database and supplemental log files.

On the ManageWise Server 
running Inventory Manager

SCAN.INI Keeps distributed LDAPPL.INI files current with 
the LDAPPL.INI file in the core server’s network 
directory.

Servers

USER.NLM Enables Desktop Manager to take control of a 
workstation and obtain diagnostic information.

On any server

LDISCAN.NLM Scans file servers to discover all hardware and 
software installed on the server.

On any server
Understanding ManageWise ��
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ManageWise Agents

ManageWise agents are software components that enhance ManageWis
functionality by performing specific tasks, such as keeping watch over a 
NetWare server (NetWare Management Agent) or overseeing a network 
segment (NetWare LANalyzer Agent).

In most cases you can install the agents on one, several, or all of the ser
on your network. (The exception is the NetExplorer Manager, which shou
be installed on only one ManageWise Server.) You can install ManageW
Agents in any order.

ManageWise Agents perform these tasks:

� Gather useful information from servers and clients in real time, and m
it available to the ManageWise Console.

� Alert you through alarms to the ManageWise Console when problem
conditions occur on your network.

� Carry out commands issued by the ManageWise Console.

� Log performance and trend information.

ManageWise Agents include the NetWare LANalyzer Agent, the NetWar
Hub Services Agent, and the NetWare Management Agent.

The NetWare LANalyzer Agent

The NetWare LANalyzer Agent enhances the discovery process by lettin
NetExplorer monitor network traffic on the segments that the server is 
attached to. The NetWare LANalyzer Agent can monitor Ethernet and to
ring segments. 

You can use the NetWare LANalyzer Agent to obtain information about n
IPX stations and IP addresses for stations that use TCP/IP. Used as a ro
one NetWare server running the NetWare LANalyzer Agent can monitor 
several network segments simultaneously.

The NetWare LANalyzer Agent gathers the following information for you:
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� Segment traffic performance statistics and trends

� Segment traffic trend histories

� Segment stations’ detailed statistics, including busiest stations and i
station conversation statistics

� Error reports, which are sent immediately to the ManageWise Conso

The NetWare LANalyzer Agent also performs these functions:

� Detects network overload, excessive errors, and stations using dupli
IP addresses

� Monitors segment inactive nodes

� Captures packets

Because the NetWare LANalyzer Agent captures packets, it enables you
perform the following tasks:

� Specify packet-capture filtering criteria.

� Decode and view captured packets at the ManageWise Console.

� Analyze your network operations.

� Identify network problem sources.

NetWare Hub Services Agent

The NetWare Hub Services Agent supports Ethernet and token ring hubs
enables you to perform the following management tasks:

� Locally and remotely manage server hubs that comply with the Nove® 
Hub Management InterfaceTM  (HMITM) specification.

� Monitor hub performance.

� Monitor stations attached to a hub.
Understanding ManageWise ��

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

age 
MA 
out 

t-data 

ch 

ters.

sily 
s the 

tion 
gent 
our 
� Enable and disable network access to stations connected to a hub.

The NetWare Management Agent

The NetWare Management Agent (NMA) software lets you remotely man
any device attached to the server on which the software is installed. The N
provides dynamic (real-time) server performance data and information ab
server alarms to the ManageWise Console. It also receives managemen
requests from the ManageWise Console.

The NMA provides you with the following server usage information for ea
managed server:

� NLMs that are running

� Disk and volume usage

� Key-server statistical trends

� Memory usage and availability

� Printing status

� Bindery information

� Interface data

You can also set and monitor alarm thresholds for critical server parame

About SNMP-Based Management

The ManageWise Console and third-party management consoles can ea
manage the NetWare Management Agent because the agent implement
Simple Network Management Protocol® (SNMP). 

You can use management consoles that comply with the SNMP specifica
and ManageWise together on one network. The NetWare Management A
includes Management Information Bases (MIBs) that let you compile at y
console using any standard MIB compiler.
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Figure 1 illustrates an internetwork using NetWare Management Agent, 
ManageWise, and a console based on UNIX* software.

Figure 1 NetWare Management Agent Configuration

Gathering Local Trend Information at the Server

Collecting trend data about devices creates a large amount of traffic on t
network, because the ManageWise Console must query the device contin
to develop data. This can be especially expensive and burdensome whe
are monitoring remote devices.

NetWare Management Agent provides a solution to this problem. It lets y
collect trend data at the server. Because the trend data is stored at the s
the ManageWise Console does not have to poll the server constantly to 
maintain an internal trend data file.

The ManageWise Console can save on network traffic by collecting the tr
data only as needed. Figure 2 illustrates this process using NetWare 
Management Agent.
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Figure 2 Server-Based Trend Data Collection

Support for Secure SNMP Transactions

You can limit the access of management consoles performing GET and 
requests using SNMP over a NetWare Core Protocol Connection or by se
security for SNMP management. 

The NetWare Management Agent provides traditional SNMP Agent secu
and also provides improved security by requiring NetWare SUPERVISOR
OPERATOR login before granting access to SNMP functions.

For details about these security features and instructions about their 
configurations, see the ManageWise CD-ROM, mwmna.pdf, Chapter 3, 
"Setting Up Secure SNMP Transactions."

About NetWare Management Agent NLM Files

The NetWare Management Agent software consists of the following NetW
Loadable Module (NLM) files that are installed on a NetWare server:

Table 3 NLMs on a NetWare Server

NLM name Description

SERVINST.NLM. Implements the Threshold and Trend MIB (NWTREND.MIB). When loaded, 
NTREND.NLM sets up trends and thresholds for each monitored attribute 
according to the server’s configuration. The NTREND.INI file contains 
configuration parameters for NTREND.NLM.

HOSTMIB.NLM Implements the standard Host Resources MIB (RFC 1514) and Novell 
extensions to that MIB (NWHOSTX.MIB).
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Table 4 provides brief descriptions of the MIBs associated with NetWare 
Management Agent.

Table 4 MIBs Provided with NetWare Management Agent

NTREND.NLM Implements the Threshold and Trend MIB (NWTREND.MIB). When loaded, 
NTREND.NLM sets up trends and thresholds for each monitored attribute 
according to the server’s configuration. The NTREND.INI file contains 
configuration parameters for NTREND.NLM.

NWTRAP.NLM Implements the NetWare Server Trap MIB (NWALARM.MIB). The 
NWTRAP.CFG file contains configuration parameters for NWTRAP.NLM.

FINDNMS.NLM On NetWare servers running NetWare Management Agent, listens for 
ManageWise Consoles advertising themselves using the Service Advertising 
Protocol (SAP) number 0x026a. FINDNMS.NLM adds the Internetwork Packet 
Exchange (IPX) address of discovered ManageWise Consoles to the list of 
stations that receive traps.

NDSTRAP.NLM Implements the NDSTRAP.MIB to capture and forward NDS events to SNMP 
management consoles.

MEMMGR.NLM A general-purpose memory manager that all NetExplorer NLM files call.

MIB Name Description

NDSTRAP.MIB A Novell proprietary MIB designed to capture NDS events and forward them to 
SNMP management consoles as SNMP TRAPs. The MIB currently supports at 
least 130 traps, and new ones are being added as the need arises.

NWALARM.MIB A Novell proprietary MIB that handles all the NetWare Core OS alerts and 
forwards them as SNMP TRAPs. It currently supports over 375 traps. New ones 
are being added as the need arises.

NWHOSTX.MIB A Novell extension to RFC1514 (the Host Resources MIB). It adds devices and 
components that are specific to NetWare that were not directly included in 
RFC1514.

NWSERVER.MIB A Novell proprietary MIB that forms the basis for NetWare Core OS 
management. Over 300 objects are identified in this MIB. It defines access to the 
parameters that consoles can set for GET and SET. The MIB includes groups 
and tables for users, file system, volumes, queues, ODI, and SET parameters.

NLM name Description
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ManageWise Client

The ManageWise Client is a set of files and programs that you install on e
workstation you wish to manage. The ManageWise Client enables 
ManageWise components to run on each workstation on which it is insta

ManageWise Client components include initialization files, configuration 
files, data files, and executable files—for example, the terminate-and-sta
resident programs (TSRs) that enable Desktop Manager’s real-time featu
such as Chat and File Transfer.

Each time you log in from a workstation on which the ManageWise Clien
installed, the ManageWise Client scans the workstation contents for inven
information and activates agents that allow ManageWise to interact with 
workstation.

The ManageWise Client includes the following files and programs:

Table 5 ManageWise Client Workstation Software Components

Component Functions Where Installed

CLNTCFG.EXE Prepares each workstation for access by Desktop 
Manager.

Windows 3.x, Windows 95, 
Windows 98 workstations

DOSCFG.EXE A configuration program that installs DOS User 
agents on the target workstations.

DOS workstations

Inventory MacScan An inventory scanner for the target workstations. Macintosh workstations

LDAPPL.INI A file that records software descriptions and that 
the scan program uses to identify the software on 
workstations.

Server, workstations

LDISCAN.CFG A configuration file that stores the DeviceIDs that 
the Inventory Server assigns to each workstation.

All scanned workstations

LDISCAN.EXE A program that scans workstations for inventory 
information.

DOS workstations

LDISCAN2.EXE An inventory scanner for the target workstations. OS/2 workstations

LDISCNNT.EXE An inventory scanner for target workstations. Windows NT workstations
�� LogicSource for ManageWise
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NTSTACFG.EXE A configuration program that installs the User 
agents on the target workstations.

Windows NT workstations

OS2SETUP.EXE A configuration program that loads the User 
agents on the target workstations.

OS/2 workstations

POPUPTSR.EXE A TSR required for Chat, File Transfer, Run 
Program, and permission-required features.

DOS workstations

TYPES.DAT, 
VALUES.DAT, 
MACHINES.DAT, 
FILES.DAT

Data files that make up the inventory database. Servers

USEROS2.EXE The service loaded on the target workstation that 
enables the various Desktop Manager features.

OS/2 workstations

USERTSR.EXE A TSR loaded on the target workstation that 
enables the real-time features of Desktop 
Manager.

DOS workstations

WLDISCAN.EXE An inventory scanner for target workstations. Windows 3.x, Windows 95, 
Windows 98 workstations

WUSER.EXE Enables Desktop Manager to take control of and 
obtain diagnostic information from client 
workstations.

Windows 3.x, Windows 95, 
Windows 98 workstations

WUSER32.EXE The service loaded on the target workstation that 
enables the various Desktop Manager features.

Windows NT workstations

Component Functions Where Installed
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This chapter describes ManageWise® functions, as well as basic concepts an
information to familiarize you with ManageWise and its components. You c
use this information to make better decisions about configuring, 
administering, and troubleshooting a ManageWise system.

This chapter is divided into the following sections:

“ManageWise Product Architecture” on page 25
“ManageWise Console” on page 28
“NetExplorer” on page 56
“NetWare Management Agent” on page 203
“NetWare LANalyzer Agent” on page 204

ManageWise Product Architecture

The table and figure that follow explain and illustrate the components of 
ManageWise.

Table 6 explains what the ManageWise components do.

Table 6 ManageWise Components: What They Do

Component What It Does

ManageWise Console Provides the software and user interface that let you monitor and interact with 
managed servers and devices on your network

ManageWise Server Provides the software the ManageWise Console needs to communicate with the 
server on which it is installed
Processes/Features ��
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Table 7 on page 26 shows where the various ManageWise components can
installed on a network.

Table 7 ManageWise Components: Where They Are Installed

Graphical User 
Interface

Displays maps, data, and alarms

Lets you view and change settings, monitor performance, and troubleshoot 
problems

Alarm System Responds to and displays alarms

NetExplorerTM  
Manager

Brings discovery data from the ManageWise server to the ManageWise 
database

Database Contains all ManageWise data

NetExplorer Gathers discovery data from NetWare Loadable ModuleTM  (NLM) components 
and sends it to the ManageWise Console

NXPIPX.NLM Discovers IPXTM  nodes

NXPIP.NLM Discovers IPTM  routers

NXPLANZ.NLM Gathers node and segment data from NetWare LANalyzer® Agent software

NXPCON.NLM Allows configuration and monitoring of NetExplorer discovery processes

MEMMGR.NLM General-purpose memory manager NLM that all NetExplorer NLM files call

NetWare 
Management AgentTM

Provides dynamic data about NetWare services

NetWare Hub 
Services Software

Provides dynamic data about HMITM  Other Agents hubs, cards, and ports

NetWare LANalyzer 
Agent

Monitors and analyzes network segments and provides dynamic data about 
them; finds devices on segments, captures packets

Other Agents Provides dynamic data about specific types of nodes

Component Where It Is Installed

ManageWise Console On one or more MS Windows* workstations anywhere on the network

Component What It Does
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NOTE:  Figure 3 provides a functional view of ManageWise, emphasizing 
how the related components provide discovery data or dynamic 
performance data about a certain type of node.

Figure 3 ManageWise Console and NetExplorer Server Overview

ManageWise Client On DOS*, OS/2*, Macintosh*, Windows 3.1, Windows 95*, Windows 98*, and 
Windows NT* workstations

NetExplorer NLM 
(NetWare Loadable 
Module)

On the ManageWise Server 

NetWare 
Management Agent

On every NetWare server

NetWare LANalyzer 
Agent

On every Ethernet or token ring segment; installed on one NetWare server per 
segment

NetWare Hub 
Services Agent

On any server with an HMI-compliant hub

Component Where It Is Installed
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ManageWise Console

The ManageWise Console software is an MS Windows application that h
you manage your NetWare networks by providing an integrated graphica
interface, a database of network information, and an alarm-managemen
system. It is installed on a Windows 95, Windows 98, or Windows NT 4.x
workstation.

ManageWise provides management tools for network functions such as 
NetWare servers, network clients, network segments, hubs, routers, and 
SNMP*-manageable nodes. 

ManageWise includes the following: 

� Network discovery and graphical interface

The NetExplorer Manager module retrieves discovery information fro
the ManageWise database, and the ManageWise Console presents 
discovered network in graphical maps. The ManageWise alarm syste
alerts you to problems and other conditions on the network.

When you first install ManageWise, it has no information about your 
network. Before ManageWise can manage your network effectively, 
must discover your network. However, the ManageWise Console 
displays a list of NetWare servers, and allows you to manage those se
with NetWare Management Agent, prior to discovery.

� SNMP server

An SNMP server provides access to SNMP functions and receipt of tr
over both IP and IPX protocol stacks. ManageWise includes an SNM
MIB browser to manage remote SNMP devices.

For more information, see “SNMP Basics” on page 36 and “Using the 
MIB Browser” on page 48.

� ManageWise database

ManageWise stores information about your network in the ManageW
database. This database contains a logical model of your network, 
configuration information about devices on your network, custom ma
data, a log of alarms, and ManageWise configuration information.
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The ManageWise database uses the Btrieve* record management sy
The database consists of many Btrieve files (indicated by the file 
extension .BTV) stored in the \ManageWise\ManageWiseDB directo

The following ManageWise features are discussed in this section:

� “Desktop Management” on page 29

� “Inventory” on page 31

� “Configuration Information” on page 32

� “Remote Control” on page 34

� “File Transfer” on page 34

� “Chat” on page 35

� “SNMP Device Management” on page 45

� “Management Information Bases” on page 45

Desktop Management

Managing Remote Workstations. ManageWise Desktop Manager lets you
perform these tasks for remote workstations:

� Control workstations and servers, including moving files, launching 
programs, and performing remote system operations across a netwo
from a single ManageWise Console.

� Modify workstation and server configurations across the network from
the ManageWise Console.

� View active network information, including information about network
devices, DOS versions, and available memory status.

� View data collected from an inventory scan. 

� Control stations at remote sites that do not have network lines to you
office. 
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� Control network print queues. 

Queue Monitor monitors print queues and print jobs, manages netwo
print queues, and manipulates queued print jobs.

ManageWise Anti-Virus Software prevents viruses from being introduced
into NetWare and Windows NT servers and clients. Each time you log in
the ManageWise group, the virus protection files are added to the worksta
from which you log in. The anti-virus software has continuous and on-dem
scanning on both the server and local workstation drives. It also has patt
based and rules-based scanning. Refer to anti-virus guides for informatio
how anti-virus software works.

Desktops Available. To be able to manage a workstation from the 
ManageWise Console, you must install the platform-specific ManageWis
Client software on the workstation. The platforms available are these: 

DOS Desktops

DOSCFG.EXE installs DOS User agents on a DOS workstation.

POPUPTSR.EXE terminate-and-stay-resident (TSR) enables Chat, File 
Transfer, Run Program, and permission-required features.

USERTSR.EXE is a TSR loaded on DOS workstations that enables Cha
Transfer, and Run Program for Desktop Manager.

Windows Desktops

Your workstations must be Windows 3.1, 95, 98, or NT.

On each Windows workstation, CLNTCFG.EXE must be installed to allow
Desktop Manager access.

WUSER.EXE lets Desktop Manager obtain diagnostic information from 
Windows workstations.

OS/2 Desktops

OS2SETUP.EXE loads User agents on a workstation.

USEROS2.EXE enables the various Desktop Manager features.
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Inventory

The inventory scanner collects information about software names, versio
numbers, and configuration statistics for servers and workstations. You c
include Power Macintosh workstations, laptops, and other portable 
workstations in your inventory scans.

Table 8 Inventory Scanning Software and Workstation Types

ManageWise Inventory software consists of files distributed among serv
workstations, and a database.

Table 9 Inventory Software Files and Functions

TYPES.DAT, VALUES.DAT, MACHINES.DAT, and FILES.DAT are data 
files that make up the inventory database.

Executable Workstations

LDISCAN.EXE DOS

WLDISCAN.EXE Windows 3.1, 95, and 98

LDISCNNT.EXE Windows NT

LDISCAN2.EXE OS/2

Inventory MacScan Macintosh

Filename Function

LDAPPL.INI Contains software descriptions that let the scan program calculate the identity of 
the software on workstations

LDISCAN.CFG A configuration file that stores DeviceIDs that the Inventory Server assigns to 
each workstation

TYPES.DAT Stores information about types in the inventory database

VALUES.DAT Stores information about values in the inventory database

MACHINES.DAT Stores information about machines in the inventory database

FILES.DAT Stores information about files in the inventory database
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Configuration Information

Disk and Volume Usage

From the ManageWise Console, you can view the following detailed 
information about disk and volume usage.

The Server Configuration window graphically shows you server name, serve
uptime, NetWare operating system version, and number of each configura
node.

For interface adapters, the Detailed Display shows you LAN type and spee
MAC address, driver description, frame type, protocols, and logical boar
name and number.

For adapters, the Detailed Display shows you adapter type and descriptio
driver description and version number, number of nodes attached to an 
adapter, I/O ports, memory address, interrupt numbers, and DMA chann

For bound protocols, the Detailed Display shows you protocol name, addre
and description; number of packets in and out; and logical board name a
number.

For users, the Detailed Display shows you the following information:

� For user accounts on the server: login name and real name, accoun
password status, disk usage, number of bad login attempts, and addr
bad login attempts.

� For users currently logged in: login name, connection number, privile
status, client address, login time, open and locked files, amount of re
and written data, and number of NCP requests.

For connections, the Detailed Display shows you connection number, logi
name, status, client address, connected time, open and locked files, amo
read and written data, and number of NCP requests.

For open files, the Detailed Display shows you connection number, user, 
volume, and filenames.

For installed software, the Detailed Display shows you product, version, an
description of product.
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For CPU, the Detailed Display shows you percentage of CPU utilization a
CPU type and speed.

For print queues, the Detailed Display shows you queue name, type of que
number of jobs, number of servers, volume, job state, and attach state. F
each job in the queue, it shows you job number, position, size, descriptio
user, entry time, control flags, target time, target server, and actual server
each server attached to the queue, it shows you status and name.

For each disk, the Detailed Display shows you disk system number, drive
name, status, and read/write information, drive type, number of cylinders
number of sectors/track, capacity, block size, number of heads, driver na
and SCSI information. For each physical partition on the disk, it shows y
partition type, size, redirect area, logical partition ID, fault tolerance, and
physical partition ID.

For each volume, the Detailed Display shows you volume name and moun
state, size, percentage used; used space, free space, and directory slots
space that can and cannot be purged; name spaces; compression; sub-
allocation; data migration flags; and number of disks the volume spans.

For each segment of the volume, the Detailed Display shows you logical 
partition ID, disk drive on which the segment resides, drive, physical partit
ID, segment size, and whether the volume segment is mirrored or duplex
For each user of the volume, it shows you amount of space used, total am
of space on the volume the user can use, and username.

Node Configuration Information

Each node and segment in the database can also contain details about tha
or segment. For example, configuration information can include the type
operating system, the number and size of disk drives, and the amount of R

Alarm System Configuration Information

Each type of alarm has a severity, state, and disposition that is stored in 
database. The severity, state, and disposition are set to default settings 
you first install the ManageWise Console. Changes you make are stored i
database. For more information, see “ManageWise Btrieve Database” on pag
109.
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The types of alarms (SNMP traps) that ManageWise can interpret are 
determined by the Management Information Bases (MIBs) that ManageW
has compiled. See “MIB Module” on page 48 for more information.

Custom Map Information

When you create a custom map, the data used to redraw the map is stor
the database.

ManageWise does not automatically discover and add custom map and 
configuration information to the database; you must enter it manually. 

You can add and maintain this information on a node-by-node basis, as 
needed. If you remove a node that you added manually from your netwo
you also need to delete it manually from the database. 

If you delete a node that was autodiscovered, NetExplorer deletes it from
database seven days after removal from the network.

NOTE: This information is not preserved if you reset the entire database 
and start over. Resetting the entire database deletes all data entered since 
you installed ManageWise or reset the database. Novell recommends that 
you do not reset the database without carefully considering other 
alternatives.

Remote Control

Desktop Remote controls a client or host workstation. A client workstation
a computer dialing in to a network over a modem line. A host workstation
a network node that is remotely controlled by the client workstation. Seve
configuration options are available for configuring the client and host 
workstations.

File Transfer

File transfer allows transmission of files, which is useful in case of missing
corrupt files on a workstation managed by ManageWise. Users can also 
files that contain information about a network problem occurring on a 
workstation.
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Captured NetWare LANalyzer Agent packets can be saved to a file for la
viewing at your ManageWise Console, transfer to another machine, or 
viewing in LANalyzer for Windows.

Chat

Chat lets you support network users directly using message boxes. Rese
shows that when software users experience a problem, they prefer to as
people for help instead of relying on documentation. 

From the ManageWise Console, you can open a Chat window containin
message box for you and another message box for a user logged in to a
machine on which the ManageWise Client software is installed.

The screen shot below shows the ManageWise Chat window:

The screen shot below shows the ManageWise Chat window including 
example text:
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SNMP Basics

The Simple Network Management Protocol (SNMP) is the application 
protocol that offers network management services within the Internet suit
protocols. Most leading network products support SNMP, allowing vendo
independent management of Internet devices and applications.

SNMP is a datagram (connectionless) protocol that can run via transport
protocols including the NetWare Core Protocol (NCP), IPX, and TCP/IP. T
chapter provides a brief overview of SNMP to help you use ManageWise
software to manage SNMP-manageable devices on your network.

This chapter describes how SNMP management works in general. For spe
information about using SNMP to manage a NetWare server, see the cha
on managing servers in ManageWise Software: Management Guide. For 
information about managing other SNMP devices, see the chapter on 
managing SNMP devices in ManageWise Software: Management Guide. 
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Figure 4 SNMP Model

SNMP Model. The SNMP model defines the following two components, a
shown in Figure 4.

� An SNMP Manager, which resides on the ManageWise Console.

An SNMP Manager is any entity that can query agents using SNMP 
operations. It provides an interface that allows users to request data o
alarms resulting from traps. It can also archive data to permit historic
analysis. ManageWise is an SNMP manager.

� An SNMP Agent, which resides in each manageable device on the 
network.

An SNMP Agent is a program that provides access to management 
about a particular network device and responds to SNMP Manager 
requests for the data. The NetWare Management Agent 2.x software
later is an example of an SNMP Agent that resides on a NetWare se

SNMP Operations. Devices on the network are managed through 
transactions between the SNMP Manager and the SNMP Agent residing i
device to be managed. SNMP provides two kinds of management 
transactions:

� Manager-request and agent-response transactions

In a manager-request and agent-response transaction, the SNMP Mana
sends a request packet, sometimes called a Protocol Data Unit (PDU), t
SNMP Agent in some device. The SNMP Agent complies with the reque
and returns a response PDU to the manager. There are three types of re
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� GET allows the manager to ask the agent for the current value of on
more objects in the managed device. The agent gathers the requeste
and sends it to the manager.

� GETNEXT is essentially the same as a GET, except that it allows a 
manager to retrieve data from a table.

� SET allows the manager to ask the agent to change the value of one
more objects to specified values. The agent performs the SET and s
a confirmation to the manager. If the manager requests multiple objec
be set in the same PDU, the agent must either set all the objects or se
of them.

For each request PDU, there is one response PDU. In the case of a GET
GETNEXT request, the response PDU contains either the requested data
error code. For a SET request, the response PDU returns with an error s
if the SET failed. If the SET did not fail, the response is identical to the requ
and all variables are updated.

In an unsolicited notification, or trap, the SNMP Agent sends a TRAP PDU
to the SNMP Manager to inform it that some event has occurred. The ag
can include the names and values of pertinent objects. The manager doe
confirm that it received the trap.

SNMP Design Philosophy. It is worth noting some of the philosophy behin
the design of SNMP:

� An SNMP Agent should be small, simple, and have minimal impact o
the device it is managing. For example, a router’s task is to route pack
while the tasks of the network management station is to manage. 
Therefore, the manager, and not the agent, should handle any compl

� You need network management most when the network is having trou
Under these conditions, a datagram protocol probably performs bett
than a connection-oriented protocol, which could spend most of its ti
rebuilding dropped connections rather than moving data. A conseque
of using datagrams, however, is that delivery is unreliable. Packets c
get lost, duplicated, or reordered.

SNMP is a polling protocol. The manager periodically polls the agents to
determine whether anything needs attention. If the request (or response)
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lost, the manager is in control. It has the resources and the global knowl
to deal with the situation. 

The manager can use trap-directed polling, whereby it can use receipt of a
as a hint to focus its attention on the device sending the trap. However, be
traps are unconfirmed and delivery is unreliable, the manager cannot rel
receiving traps to indicate that something is abnormal. 

SNMP Security. SNMP has a primitive security mechanism whereby eac
PDU contains a string called the community string. 

The community string acts like a combination of the username and passw
When you configure an SNMP-manageable device, you can often specify
community string that provides read-write access to objects within the dev
and another that limits access to read-only. 

If the community string in the request PDU from the manager matches e
of these strings, the request is granted. Otherwise, it is refused. 

If the community string in the request PDU from the manager does not m
either strings, the SNMP Agent does not respond to the SNMP request. 

Many devices default to the single community string public, which allows a
access. For NetWare servers, you can specify a null community string, w
allows any access.

SNMP Object Names. Each managed device on the network has one or m
SNMP objects associated with it. 

SNMP objects are practical, specific items that are essential for fault or 
configuration analysis. Each SNMP-manageable object within a device m
have a unique name so that it can be referred to in SNMP operations. 

Because a device can contain objects defined independently by several 
different vendors, the naming scheme must ensure that different vendors
not choose the same name for different objects.

SNMP uses the hierarchical naming scheme developed by the Internatio
Organization for Standardization (ISO). In the ISO scheme, the name sp
(set of all available names) is a tree. The tree consists of a root connecte
number of labeled nodes. Each node can, in turn, have subnodes of its o
(termed subordinates), which are labeled.
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A label is a pairing of a brief textual description and an integer. An exam
of a label is iso(l). The name of a node, termed an OBJECT IDENTIFIER,
the sequence of integers labeling each node on the path from the root to
node in question. The textual description part of a node's label is for use
convenience only. It never appears on the wire in a PDU.

The root node itself is unlabeled, but has at least three subnodes directly u
it:

�  iso(l), which is administered by ISO

� ccift(O), which is administered by the International Telegraph and 
Telephone Consultative Committee (CCITT)

� joint-iso-ccitt(2), which is jointly administered by ISO and CCITT

The administrative authority for each node is free to assign further subordi
nodes and to delegate authority to others to name objects under those n
In this way, name dashes are avoided because every vendor allocates n
out of its own subtree.

The SNMP naming convention is very similar to a DOS or NDSTM  fully 
qualified path name. The following is an example of part of a naming tree.
objects of interest to SNMP are in the iso part of the tree and are placed u
the Internet node.
SNMP Naming Tree

iso (1)
   org (3)
      dod (6)
         internet (1)
            directory (1)
            mgmt (2)
               mib-2 (1)
                  system (1)
                  interfaces (2)
                  at (3)
                  ip (4)
                  icmp (5)
                  tcp (6)
                     tcpRtoAlgorithm (1)
                     tcpConnTable (13)
                        tcpConnEntry (1)
                           tcpConnState (1)
                           tcpConnLocalAddress (2)
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                           tcpConnLocalPort (3)
                           tcpConnRemAddress (4)
                           tcpConnRemPort (5)
                  udp (7)
                  egp (8)
                  transmission (10)
                  snmp (11)
                  rmon (16)
            experimental (3)
            private (4)
               enterprises (1)
                   novell (23)

In this example, tcpRtoAlgorithm is the convenient name for the manage
object that indicates the tcp retransmission timeout algorithm in use on t
managed device. Its OBJECT IDENTIFIER is 1.3.6.1.2.1.6.1.

Novell has been assigned node 1.3.6.1.4.1.23, and can assign names und
node without conflicting with names generated elsewhere.

SNMP-Manageable Objects. You can manipulate scalars and tables using 
SNMP operations.

While table objects can contain complex, structured values, scalar object
contain only simple, unstructured values. Table 10 on page 41 lists and 
explains scalar values.

Table 10 Scalar Object Values

Value Explanation

INTEGER Signed whole number. Although the SNMP specification imposes no size limit, 
most implementations restrict an INTEGER to 32 bits.

Counter Non-negative integer that increases monotonically until it reaches a maximum 
value (2^32-1), at which time it wraps and starts increasing again from zero. 

Counters are typically used to count interesting or atypical events in the system. 
The absolute value of a Counter is often less interesting than its delta value since 
the last sample. The delta value is used to derive rate information.
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Tables. SNMP allows data to be structured into tables. A table is made up
rows and columns, like a table of information in a document. 

A table is a list of records where each record corresponds to a row in the t
and each field in the record corresponds to a column within the row. Tab
cannot be nested.

Table 11 shows a fragment of tcpConnTable for a host. The table is used in
addressing examples that follow.

Table 11 SNMP Table Example

Gauge Non-negative integer that can increase or decrease, but cannot exceed a 
maximum value. 

The value of a Gauge is at maximum whenever the information being modeled 
is greater than or equal to the maximum. 

If the information being modeled subsequently decreases below the maximum 
value, the Gauge also decreases. The absolute maximum value a Gauge can 
take is 2^32-1.

TimeTicks Non-negative integer that represents the time (module 2-32) in hundredths of a 
second since some epoch. For example, an object of type TimeTicks can be used 
to model how long a system has been up and running since it was started.

IpAddress 32-bit Internet address.

OCTET STRING Sequence of octets (bytes). An OCTET STRING can be used to represent the 
following:

� A string of printable characters, such as the name of a system.

� Any arbitrary binary data, such as a MAC layer address.

OBJECT IDENTIFIER Representation of the name of a manageable object.

Other Types SNMP allows three Other Types: NULL, Opaque, and NetworkAddress. 
However, these are never used and can be ignored.

 tcpConnState topConnLocalAddress tcpConnLocal Port tcpconnReniAddres
s

tcpConnRemPort

 2 0.0.0.0 9 0.0.0.0 0

Value Explanation
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SNMP operations apply only to individual scalar objects. Specifically, SNM
does not allow operations on tables as a whole, or on rows within tables
does, however, allow operations on individual table entries.

SNMP addresses a table entry by concatenating "instance" information t
end of the OBJECT IDENTIFIER of the field you want to access. Thus, t
first part of the resultant OBJECT IDENTIFIER identifies the column, and t
latter part identifies the row.

Tables in SNMP must have an index that uniquely identifies each row. T
index can be either a single value or an ordered set of values. 

The table designer defines the index, which is usually made up of the va
of fields within the table. For example, in tcpConnTable, the index require
uniquely identify a row is formed from the ordered set of values—
tcpConnLocalAddress, tcpConnLocal Port, tcpConnRemAddress, and 
tcpConnRemPort.

The OBJECT IDENTIFIER instance to access tcpconnstate in the last ro
the table shown in Table 11 on page 42 is as follows:

1.3.6.1.2.1.6.13.1.1.130.57.4.252.1028.130.57.10.123.6000, in which

 2 0.0.0.0 19 0.0.0.0 0

 2 0.0.0.0 23 0.0.0.0 0

 2 0.0.0.0 ill 0.0.0.0 0

 6 130.57.4.252 1028 130.57.10.123 6000

1.3.6.1.2.1.6.13.1.1 Represents the OBJECT IDENTIFIER of 
tcpConnState.

130.57.4.252 Specifies the local address of interest.

1028 Specifies the local port of interest.

130.57.10.123 Specifies the remote address of interest.

6000 Specifies the remote port of interest.

 tcpConnState topConnLocalAddress tcpConnLocal Port tcpconnReniAddres
s

tcpConnRemPort
Processes/Features ��

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

 
he 

is 
es.
You can access table entries using the following methodologies:

� Randomly, by specifying the complete instance and using the GET 
operation.

� Sequentially, using the GETNEXT operator. When you supply a 
(possibly partial) OBJECT IDENTIFIER instance with the GETNEXT
operator, it returns the value and OBJECT IDENTIFIER instance of t
next object in lexicographic order. 

If you subsequently do a GETNEXT on the returned OBJECT 
IDENTIFIER instance, the next instance is returned, and so on. In th
way, you can "walk" a table without any prior knowledge of the index

NOTE: SNMP imposes an order on objects based on their names within 
the global naming tree. For any two distinct SNMP objects A and B, the 
IDENTIFIER of object A is either greater than or less than the IDENTIFIER 
of object B. This system of lexicographic ordering determines object order 
for GETNEXT requests.

For example, using Table 11 on page 42,

GETNEXT 1.3.6.1.2.1.6.13.1.1 returns

value-2
instance-1.3.6.1.2.1.6.13.1.1.0.0.0.0.9.0.0.0.0.0

GETNEXT 1.3.6.1.2.1.6.13.1.1.0.0.0.0.9.0.0.0.0.0 returns

value-2
instance-1.3.6.1.2.1.6.13.1.1.0.0.0.0.19.0.0.0.0.0

GETNEXT 1.3.6.1.2.1.6.13-1.1-0.0-0.0-19.0.0.0-0.0 returns

value-2
instance-1.3.6.1.2.1.6.13.1.1.0.0.0.0.23.0.0.0.0.0

GETNEXT 1.3.6.1.2.1.6.13-1.1.0.0.0.0.23.0.0.0.0.0 returns

value-2
instance-1.3.6.1.2.1.6.13.1.1.0.0.0.0.111.0.0.0.0.0
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GETNEXT 1.3.6.1.2.1.6.13.1.1-0-0.0-0-111.0-0.0-0.0 returns

value-6
instance-1.3.6.1.2.1.6.13.1.1.130.57.4.252.1028.130.57.10.123.6000

To add a new row to a table, a management station usually sends a SET
referring to a nonexistent object instance. The agent then creates the com
row containing that object instance. 

If the SET PDU does not contain a value for each field in the row, the ag
usually provides a default value for that field. Some tables, notably those
the RMON IM (RFC 1271), have a more complex row creation protocol, 
which is described in the appropriate Request for Comment (RFC).

SNMP Device Management

An SNMP server provides access to SNMP functions and receipt of traps 
IP and IPX protocol stacks. ManageWise includes an SNMP MIB browse
help you manage the following remote SNMP devices:

� Routers

� Bridges

� Switches

� Hubs

Management Information Bases

A Management Information Base (MIB) describes a set of manageable 
objects. A manageable device can implement one or more MIBs, depend
on its function. An SNMP MIB is similar to a database schema in that it 
describes both the structure and format of a set of data.

When a vendor develops an SNMP-manageable device, the vendor typi
designs a MIB that models the data that is important to managing that typ
device. This type of MIB is termed a "proprietary MIB" because it is owne
by the vendor. However, most vendors make their proprietary MIBs publi
available because they want their devices to be manageable.
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When a MIB is made physically available, the vendor usually publishes i
a document called a Request for Comment (RFC).

Proprietary MIBs are usually placed under the vendor's assigned node J
internet(l) private(4) enterprises(l) I in the branch of the naming tree. For
instance, all Novell proprietary MIBs are under f-internet(l) private(4) 
enterprises(l) novell(23) 1. See “SNMP Global Naming Tree” on page 46 for 
more information.

The textual representation of a MIB is a named module, written in a subs
the ASNA language, which groups together related definitions. One or m
MIB modules can be stored in a regular ASCII text file. 

This section describes the MIB module in enough detail for you to read a
understand a MIB, and to use it in conjunction with the SNMP MIB Brows
tool.

SNMP Global Naming Tree

All SNMP objects are named in the global naming tree. In the example in
Figure 5, at the root, which is not named, the tree is divided into three 
branches. Each branch is subdivided down to the Internet branch, where 
managed objects are registered. Within certain branches of the tree, the
naming of objects is delegated to different authorities.

Figure 5 Global Naming Tree

Each object is uniquely named with a series of non-negative integer valu
that describe its location in the tree. These names are given using dotted
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notation beginning from the unnamed root. For example, the Novell node
the tree, novell (23), is described as 1.3.6.1.4.1.23. Thus, it is the 23rd le
within the enterprises branch within the private branch, and so on up to th
branch.

The SNMP global naming tree is also known as the SNMP MIB because
MIB that defines an SNMP object also describes that object's place in the
Thus, you can view the tree as a collection of management data that con
of numerous objects.

The tree names several branches within the Internet branch to group obje
a logical way. These branches include the management, experimental, a
private branches.

Management Branch

Most leading industry devices support the management (mgmt) branch, 
allowing vendor-independent management of Internet devices. The mgm
branch of the MIB includes objects that have been standardized for SNM
management. This standard set of objects includes MIB-II.

Experimental Branch 

The experimental branch includes MIBs that are currently being defined.
Pending successful implementations, satisfactory results, and user intere
they are candidates to be moved to the mgmt branch.

Private Branch

The private branch allows individual companies to supply MIBs for their o
devices, where the management data relevant to a particular device is n
covered by a standard MIB.

Compiling the MIBs

The MIB Compiler compiles all the MIB files in the CURRENT directory int
a single binary file, ManageWise\BIN\SNMPMIBS.BIN, for use by the MI
Browser and the SNMP protocol decoder. 

The compiler also adds or updates trap definitions in the database for us
the ManageWise alarm system.
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Using the MIB Browser

The SNMP MIB Browser tool lets you talk to any SNMP-manageable nod
over either TCP/IP or IPX.

The MIB Browser lets you select, from the compiled MIBs, the set of obje
you want to display and save this set as a named profile. (An object can
anything defined in the MIB; for example, a specific statistic.) Subsequen
you can select this profile from a list. 

When you run the profile, the MIB Browser sends SNMP queries to the n
to obtain the data objects that you requested. For writable objects, you c
enter new values, and the MIB Browser writes these to the node.

You can add, delete, and edit profiles. When creating a profile, you can h
the MIB Browser periodically poll the node or you can have it perform a 
"single shot" update on demand. You can also select whether you want to
the data in a table or in a graph (available for polled mode only).

MIB Browser profiles are stored as ASCII text files with a ".PRF" extensi
in the ManageWise\SNMPMIBS\PROFILES directory.

For more information about the ManageWise MIB Browser, see the chap
on managing SNMP devices in ManageWise Software: Management Guide.

MIB Module

The following list summarizes the format conventions used in the text of 
MIB module:

A comment is anything between a double hyphen and the end of the line
more rarely, another double hyphen). For example,

- This is a comment
- This is a comment - This is not part of the comment
A name is an arbitrary number (one or more) of letters, digits, and hyphen

hyphen cannot be the last character of the name, and it cannot be 
immediately followed by another hyphen.

An object name must start with a lowercase letter.
Type names and module names must start with an uppercase letter.
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White space (spaces, tabs, and new lines) is not significant except that na
keywords, and symbols such as "::=" must not be interrupted by white
space or comments.

The following example shows the basic format of a MIB module.
Sample MIB Module

RFC1213-MIB DEFINITIONS                BEGINIMPORTS    mgmt, 
NetworkAddress, IpAddress, Counter, Gauge, TimeTicks

                     FROM RFC1155-SMI          OBJECT-TYPE                     
FROM RFC-1212;– DefinitionsEND

The MIB module shown above is explained as follows:

� RFC1213-MIB is the name of the MIB module.

� DvIMPORTS lists a collection of objects, types, and macros that are
referenced in this module but are defined in the module named after
keyword FROM (RFC1155-SMI).

� Definitions contains the text of the actual object definitions. Four kind
of definitions can be used: 

� Value assignments

� Type assignments and textual conventions

� Manageable object definitions

� Trap definitions

These definitions are explained below.

Value Assignments

Value assignments are usually used to define OBJECT IDENTIFIERS fo
interior (nor-deaf) nodes in the naming tree. These are examples of valu
assignments:
mib-2 OBJECT IDENTIFIER::= mgmt 1

mgmt was imported from module RFC1155-SML, where it is defined to ha
the value 1.3.6.1.2. Therefore, identifier mib-2 of type OBJECT IDENTIFIE
is assigned the value 1.3.6.1.2.1.
tcp OBJECT IDENTIFIER:: =I mib-2 6 1
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mib-2 was previously defined to have the value 1.3.6.1.2.1. Therefore, 
identifier tcp of type OBJECT IDENTIFIER is assigned the value 
1.3.6.1.2.1.6.

Type Assignments and Textual Conventions

Type assignments give a name to a new type. 

SNMP MIBs use this feature to create textual conventions. In textual 
conventions, a descriptive name is defined as an alias for an existing type
additional semantics are defined in accompanying comments. This new 
descriptive type name is then used throughout the rest of the MIB to impr
readability and clarity.

Note that a type assignment does not actually define a new OBJECT 
IDENTIFIER type; it merely documents the conventions used to interpre
value of this type.

The following is an example of textual conventions:
    DisplayString ::= OCTET STRING This data type is used to 

model textual information taken from the NVT ASCII 
character set. By convention, objects with this syntax are 
declared as having SIZE (0-255)

   PhysAddress ::= OCTET STRING This data type is used to model 
media addresses. For many types of media, this will be in 
a binary representation. For example, an Ethernet address 
would be represented as a string of 6 octets.

Object Definitions

Object definitions can be scalar, or they can be presented in tables. Both 
are explained below.

All Objects. All SNMP-manageable objects are defined using the OBJEC
TYPE macro, which performs a value assignment to define the OBJECT
IDENTIFIER for the object and also captures the semantics of the object

The following is an example of a typical object definition:
tcpRtoAlgorithm         OBJECT-TYPE

SYNTAX                      INTEGER {

other(l),none of the following

 constant(2),a constant rto

 rsre(3),MIL-STD-1778, Appendix B
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        ACCESS        read-only

        STATUS       mandatory

DESCRIPTION

"The algorithm used to determine the time-out value used for
retransmitting unacknowledged octets."

tcp 1)

This example defines a new manageable object:

� tcpRtoAlgorithm is the convenient "user friendly" name for the object. 
OBJECT IDENTIFIER (or "on the wire" name) is I tcp I ) or 
1.3.6.1.2.1.6.1 (because tcp was defined, in Table 11 on page 42, to have 
the value 1.3.6.1.2.1.6).

� SYNTAX specifies the type of the object (in this case, INTEGER). It 
an enumerated INTEGER, the value of which is restricted to an explic
listed value (in this case, 1, 2, 3, or 4). The name associated with ea
value is only for the user’s convenience. On the wire, the value is 
indistinguishable from any other INTEGER value.

The SYNTAX clause can specify any legal SNMP type. You might also s
"subtypes" of these types. A subtype  further restricts the set of values a
can take.

For INTEGER types, a subtype takes the form of an inclusive range of val
In the following example, the integer is restricted to values in the range 0
65535, inclusive:

INTEGER(O ... 65535)

For OCTET STRING types, a subtype can be defined that has either a fi
length or a range of possible lengths. For example,

OCTET STRING (SIZE (6))
OCTET STRING (SIZE (0 ... 255))
DisplayString (SIZE (0...127))

ACCESS specifies the maximum access for the object. Your access righ
might be less depending on the community string used and the  
implementation of the MIB. The following are possible access values:
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read-only
read-write
write-only
not-accessible

These are  self-explanatory, except for not-accessible. Tables and table 
cannot be accessed directly using SNMP; only individual table entries ar
accessible. Therefore, table and row level definitions are flagged as not-
accessible. 

Objects that are defined to be used only as parameters of traps are also
defined as not-accessible because you cannot access them directly.

STATUS provides information about the state of the MIB object. Possible
values are these:

� mandatory

Indicates the object must be implemented.

� optional

Is never used. If any objects within a group are implemented, all obje
within the group must be implemented.

� obsolete

Indicates the object is no longer supported.

� deprecated

Indicates the object is being phased out. It will become obsolete.

� DESCRIPTION provides a textual description of the semantics of the
object.

� REFERENCE (not shown in this example) has the same form as the
DESCRIPTION clause. It is sometimes used to provide a textual 
reference to a definition in some other document, such as an IEEE or
standard.

Tables. In SNMP MIBs, table definitions usually include four parts:
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� The table object itself is defined with the SYNTAX SEQUENCE OF 
<TableEntry>.

� The row object is defined under the table node with the SYNTAX 
<TableEntry>.

� The type assignment for <TableEntry> defines the fields within the ta

� The object definitions for each field are placed under the entry node.

The following is a sample definition of tcpconnTable:
tcpConnTable OBJECT-TYPE

SYNTAXSEQUENCE OF TcpConnEntry

ACCESSnot-accessible

STATUSmandatory

DESCRIPTION

 "A table containing TCP connection-specific information"

 ( tcp 13 )

tcpConnEntry OBJECT-TYPE

SYNTAXTCPConnEntry

ACCESSnot-accessible

STATUSmandatory

DESCRIPTION

 "Information about a particular current TCPconnection. An 
object of this type is transient, in that it ceases to exist 
when (or soon after) the connection makes the transition to 
the CLOSED state."

INDEX ( tcpConnLocalAddress,

 tcpConnLocalPort,

 tcpConnRemAddress,

 tcpConnRemPort

tcpConnTable 1 )

TcpConnEntry ::= SEQUENCE

tcpConnStateINTEGER,

tcpConnLocalAddressIpAddress,

tcpConnLocalPortINTEGER (0..65535),

tcpConnRemAddressIpAddress,

tcpConnRemPortINTEGER (0..65535)

tcpConnStateOBJECT-TYPE

SYNTAX INTEGER

tcpCormEntry 1

 tcpConnLocalAddress OBJECT-TYPE SYNTAX IpAddress

tcpConnEntry 2

 tcpConnLocalPort OBJECT-TYPE SYNTAX INTEGER (0..65535)
Processes/Features ��

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

s 

 an 

ow 

CT-

 can 
t an 
 

e 
s a 

 

tcpConnEntry 3 1

 tcpConnRerrAddress OBJECT-TYPE SYNTAX IpAddress

tcpConnEntry 4 1

 tcpConnRemPort OBJECT-TYPE SYNTAX INTEGER (0..65535)

tcpConnEntry 5 1

Most of the clauses in this example are explained in the section “Object 
Definitions” on page 50. The  INDEX and DEFVAL clauses are explained a
follows:

INDEX, which appears in the table entry definition, defines how to name
instance of an object within the table.

For example, in tcpConnTable, the index required to uniquely identify a r
is formed from the ordered set of values:

tcpConnLocalAddress,tcpConnLocalPort, tcpConnReraAddress, 
tcpConnRemPort.

DEFVAL (not shown in this example) is sometimes used within the OBJE
TYPE macro, defining objects that are part of a table. 

This clause defines an acceptable default value for the object. This value
be used by the agent when a new row is created by ManageWise withou
explicit value for that object having been supplied. Examples of DEFVAL
clauses are shown below:

Trap Definitions

When you compile a MIB containing SNMP traps, information about thos
traps is added to the ManageWise database. When ManageWise receive
trap, it uses the information in the database to determine the alarm type,
generate the summary string, and so forth.

DEFVAL(0) INTEGER

DEFVAL('00000000'h) hexadecimal string

DEFVALI 10 011- NULL OBJECT IDENTIFIER 0.0
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You can add annotations to the trap definitions in a MIB file to improve th
presentation of alarm information, as described in the chapter on manag
SNMP devices in the ManageWise Software: Management Guide.

Trap definitions are similar to object definitions, except that they use the 
TRAP-TYPE macro.

The following is a sample trap definition:
linkDown TRAP-TYPE

ENTERPRISEsrimp

VARIABLES ifIndex

DESCRIPTION

 "A linkDown trap signifies that the sending protocol entity 
recognizes a failure in one of the co=unication links 
represented in the agent's configuration."

The clauses in the trap definition are explained as follows:

� ENTERPRISE contains the OBJECT IDENTIFIER of a node in the 
vendor's tree, which, along with the trap number, uniquely identifies 
trap.

� VARIABLES defines an ordered sequence of NM objects that are pas
as parameters of the trap when it is generated.

� DESCRIPTION provides a textual description of the semantics of the
trap.

Obtaining MIBs

Standard MIBs, which are published as RFCs, can be obtained by anonym
FTP to host ftp.nisc.sri.com (192.33.33.22). The \rfc directory contains al
published RFCs. The Internet-drafts directory contains the latest working
documents that have not yet reached standards status.

Vendor-proprietary MIBs are often posted on host venera.isi.edu (128.9.0
and can be obtained through anonymous FTP.

The ManageWise directory... \ManageWise\SNMPNHBS\ALLIVMS 
contains some of the more widely encountered ManageWise MIBs.
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Extended Functionality Through Snap-In Applications

Snap-in applications can use and extend the capabilities of  the Manage
Console. Novell develops applications that work with ManageWise, som
which are included in the ManageWise product. 

Third-party developers can integrate their applications using ManageWis
Console interfaces so that multiple applications can inter-operate in the 
ManageWise environment. See “Third-Party Tools” on page 367 for more 
information.

NetExplorer

NetExplorer discovers a network when it finds devices such as servers, 
workstations, and printers that are attached to the network. The general 
for a device, machine, or service attached to a network is node. 

The discovery process collects node information that ManageWise need
help you manage your network. Because of the information that NetExplo
discovers, you can see a map of your network, view nodes by name and
properties, and specify a network node to manage.

Because large networks can support various protocols such as IP and IP
NetExplorer includes NLMs to discover nodes on both kinds of networks

NetExplorer System Components

The NetExplorer system consists of components described in the followi
table:

Table 12 NetExplorer Components 

NetExplorer Manager On the ManageWise 
Console

Updates the ManageWise database with data collected 
on the ManageWise Server.

NETXPLOR.NLM On the ManageWise 
Server 

Communicates with NetExplorer Manager and with the 
discovery NLM files (NXPIPX.NLM, NXPIP.NLM,  
NXPLANZ.NLM) that are actively discovering network 
objects; stores data in the sequential NETXPLOR.DAT 
file.
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Figure 6 illustrates the architecture of the NetExplorer discovery system a
shows the roles of the various components, network nodes, and agent 
software.

NXPIPX.NLM On the ManageWise 
Server

Discovers various NetWare nodes on IPX networks and 
NetWare/EP® networks; sends information about nodes 
to NetExplorer.

NXPIP.NLM On the ManageWise 
Server

Discovers IP routers on EP networks; sends information 
about routers to NetExplorer.

NXPLANZ.NLM On the ManageWise 
Server

Communicates with NetWare LANalyzer Agent software 
to gather information about all nodes communicating on 
monitored segments; sends information about nodes to 
NetExplorer.

NXPCON.NLM On the ManageWise 
Server

Used to configure the discovery system and display 
discovery status information.

MEMMGR.NLM On the NetWare 
Server

General-purpose memory manager, which all 
NetExplorer NLM files call.
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Figure 6 NetExplorer Discovery System Architecture

NetExplorer uses NetWare Management Agent and NetWare LANalyzer
Agent software to discover network topological and statistical information
Using these agents throughout your network enhances the accuracy and
of logical maps displayed by the ManageWise Console; however, they a
optional.

ManageWise Server

The ManageWise Server is a set of NetWare Loadable Modules (NLMs) 
provide updated server data to the ManageWise Console and an interfac
configuring and monitoring the NetExplorer discovery system.

The term "ManageWise Server" also refers to the physical server on you
network on which you have installed NetExplorer, LANalyzer, Desktop 
Manager, NetWare Management Agent, inventory components, and viru
�� LogicSource for ManageWise
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protection modules. You need only one server on your network to functio
the ManageWise Server.

At a minimum, you must install the NetWare Management Agent and 
MWISE.NLM on every server on your network that you want to manage fr
the ManageWise Console.

NOTE: NetWare 3.x servers support only the NetWare Management 
Agent and MWISE.NLM. You cannot use a NetWare 3.x server as your 
ManageWise Server.

For more information, see “Understanding ManageWise” on page 11.

Configuring the Discovery System with NXPCON.NLM

NXPCON.NLM is used to configure the discovery system and view discov
status information.

NetExplorer Modules

NetExplorer collects information from specialized modules. The modules
NLMs that collect topological information from your network according to
the protocol  your network uses (such as IP and IPX). NetExplorer also 
collects current statistical information:

� NXPIP.NLM collects information from IP networks.

� NXPIPX.NLM collects information from IPX networks.

� NXPLANZ.NLM collects statistical information.

� NXPLOR.NLM gathers information from the other NLMs.

Discovery Scope

You define the scope of NXPIP discovery. By default, the IP scope is the
network of any networks to which the ManageWise Server is connected,
defined by the class of the network. 

For example, if the ManageWise Server’s IP address is 130.59.6.22, the
discovery NLM discovers the entire 130.59.0.0 network and its subnetwo
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You can restrict or expand the scope by specifying scoping information u
NXPCON.

By default, NXPIPX attempts to discover your entire IPX internetwork. Yo
can restrict the scope of discovery by specifying a list of IPX network numb
using NXPCON.

Discovery Schedule

Scheduled Discovery. Scheduled discovery works similarly to continuous 
discovery except that the discovery processes are allowed to run only du
certain time periods each week. You can set the schedule using NXPCO

Schedule intervals are specified by a start time and a duration. It is impo
that you set your schedule time to be greater than or equal to one cycle 
in order to attain complete discovery. 

When the end of the scheduled interval is reached, discovery operations
suspended. Discovery resumes at the start of the next scheduled interva
addition, if discovery is limited to one pass during an interval, each discov
process is suspended if it reaches the end of a pass before the interval h
expired.

You can also use scheduled discovery that is not limited to one pass.

Starting with its own IP addresses, NXPIP uses the EP Routing Table to o
the addresses of what might be other IP routers. It gets these addresses
the Next Map IP Address field in the IP Routing Table.

Table 13 Discovery Cycle Timing Sequence in Scheduled Discovery Mode

The first sequence in the NetExplorer discovery cycle involves the discov
of IP routers. NXPIP locates its local router using TCP/IP configuration 

Scheduled Discovery Process

1st Pass 2nd Pass 3rd Pass NXPIP

1st Pass 2nd Pass 3rd Pass NXPIPX

1st  2nd 3rd NXPLANZ

Initial Discovery Cycle
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information and queries it for the identity of other routers on the network
then queries the MIBs on the routers using SNMP. The following informat
is then collected: IP addresses, interface types, and MAC addresses.

Autodiscovery. Autodiscovery begins with a RIPTM  broadcast to the local IP
network. The addresses of all responses to the RIP broadcast are collecte
saved as possible IP routers. Then each IP device that responded is "pin
with an SNMP Get Request for its required System Descripter. 

If the IP device responds positively, then additional SNMP requests are m
to determine whether this IP device is a router. If it is a router, its interfac
table, routing table, and address tables are scanned for connection inform
and addresses of other routers. 

The connection information and other configuration data is then packaged
IPC transmit packets and sent to NETXPLOR.NLM. The new IP address
discovered are added to the list of IP router candidates for later processi

When all this activity is complete, the next address of an IP device in the
of IP router candidates is processed identically. The processing loop, as
described above, continues repeatedly until all the IP addresses of route
candidates have been tested.

When the list of addresses of IP router candidates has been exhausted, 
message indicating that autodiscovery is complete message is transmitt
NETXPLOR.NLM. NXPIP.NLM then waits for any new IPC commands; fo
example, another autodiscovery start command.

To customize autodiscovery using five command line input parameters, 
complete these steps:

�� Use the "/log" input option to enable the trace logging option. 

The option instructs NXPIP.NLM to create an ASCII file (NXPIP.TXT
in the \etc subdirectory that describes each IP router discovered and
associated MIB data.

�� Use the "/mode" command to instruct NXPIP.NLM to perform only a 
single autodiscovery pass.

The default condition is for continuous monitoring of the network, alwa
looking for new IP routers. 
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�� Use the "/community  cccccccc" command option to change the defa
SNMP community string from "public" to a user-defined string that is
input after the "/community".

�� Use the "/delay ddddd" command option to enforce a user-defined d
between all SNMP requests.

The delay value ddddd is a decimal value for the number of milliseco
NXPIP.NLM should delay between SNMP requests. This option is use
in small networks or on NetWare servers containing many executing
NLMs when you want to reduce the CPU utilization of NXPIP.NLM an
allow other NLMs a greater opportunity to execute.

�� Use the "/router ddd" command option to set a limit on the number o
routers that can be discovered by NXPIP.NLM. 

The default is 100 routers.

Manual Discovery 

On source-route bridged token rings, the way ManageWise maps display
source-route bridged token rings depends on whether you have NetWare
LANalyzer Agent installed on each ring:

� If you do not have NetWare LANalyzer Agent installed on each sourc
route bridged ring in your network, ManageWise discovers the netwo
but consolidates all source-route bridged token rings that share the s
IPX network number or EP subnet into a single segment. 

� If you do have NetWare LANalyzer Agent installed on each source-rou
bridged ring, each NetWare LANalyzer Agent discovers its own ring 
(segment) and every node on it. ManageWise displays the ring as an
unconnected segment in the Internet map. 

� If you have a NetWare LANalyzer Agent installed on a source-route 
bridged ring connected to a router, the ManageWise Internet map sh
the correct connections. 

However, if two networks each have several rings and only one ring 
each network is connected to a router, the ManageWise Internet ma
shows the correct connections only of the rings that are directly connected 
to the router. The other source-route bridged rings in each network a
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LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

 node 
rface 

ch 
d on 
 by 

that 

gs 
 
odes 
displayed as disconnected segments on the Internet map. Figure Figure 7 
illustrates this second case.

Figure 7 Source-Route Bridge, as Shown on the ManageWise Internetwork Map

In all cases, bridge information is not discovered. As a consequence, 
NetExplorer treats each interface of a source-route bridge as a separate
on the network. One icon appears on the ManageWise maps for each inte
of the source-route bridge.

When you have NetWare LANalyzer Agent installed on one server on ea
ring of an IPX source-route bridged network, the segment names displaye
the ManageWise Internet map consist of the IPX network number followed
the MAC address of that server’s interface to the ring. 

If NetWare LANalyzer Agent is monitoring more than one interface, the 
address shown for a ring is the MAC address of the interface monitoring 
ring.

You can correct all these problems manually by creating bridges and rin
using the Edit function of the ManageWise Console. Once you create the
source-route bridges and token ring segments and move the token ring n
to the correct segments, NetExplorer does not undo your changes.
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Transparent Bridges. NetExplorer cannot fully discover transparent bridge
ManageWise consolidates groups of transparently bridged segments run
the same network number into a single segment in the maps. 

You can correct this problem by using ManageWise Edit > Add to create
segments and bridges that are not discovered, and then move discovered
to the correct segment.

Configuration Changes. NetExplorer detects most changes in the network
topology, such as the addition, reconfiguration, or deletion of interfaces, 
resulting in changes being made to the Internet maps. However, if you rem
the system from the network, it is not detected unless you move it to ano
location in the network.

ManageWise does not automatically discover and add custom map and 
configuration information to the database; you must enter it manually. You
add and maintain this information on a node-by-node basis, as needed. 

If you remove a node that you added manually from your network, you a
need to delete it manually from the database. NetExplorer deletes an 
autodiscovered node from the database seven days after its removal from
network.

ManageWise contains other services that can be added manually to a sy
or detected by the introduction of third-party applications. Once the discov
NLM software obtains information about these nodes, it saves that 
information in a local file (NETXPLOR.DAT) and forwards this information
to NetExplorer Manager on the ManageWise Console.

Continuous Discovery. NetWare LANalyzer Agent monitors every packet o
the network segment it is installed on, creating a list in local memory of all
physical (MAC) addresses and IP addresses of all the nodes communica
on the segment. 

After NXPIPX completes Phase 1, NXPLANZ uses SNMP to query all 
NetWare LANalyzer Agent servers for the list of workstations they have 
observed communicating on the network. NXPLANZ obtains a list of 
NetWare LANalyzer Agent servers from NXPIPX. 
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IP Discovery

The primary function of NXPIP.NLM is the automatic discovery of  IP route
that provide SNMP access.  The autodiscovery process is methodical in
the nearest IP routers are discovered first and the most distant IP router

IPX Discovery

NXPIPX.NLM (NXPIPX) provides some of the functionality that lets 
NetExplorer discover your network. NXPIPX collects information about IP
network topology and network node configuration.  Nodes discovered incl
the following:

� NetWare servers

� NetWare workstations

� Non-NetWare routers

� IPX networks

NXPLANZ Discovery

NXPLANZ is installed on the ManageWise Server. It queries NetWare 
LANalyzer Agent software for information about all the nodes that exist o
the network segment on which the LANalyzer Agent is installed, regardles
protocol.

You should always enable NXPLANZ.NLM if you have NetWare LANalyze
Agent software on your system. For your network to be discovered corre
NetWare LANalyzer Agent software must be running on every token ring
your system.

NXPLANZ gathers node and segment data from NetWare LANalyzer Ag
software.

NXPLANZ communicates with NetWare LANalyzer Agent software to 
gather information about all nodes communicating on the segments it 
monitors and sends information about nodes to NetExplorer.
Processes/Features ��

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

nt it 
ses 

l 

s 

ings, 
n 
 are 

r by 

es as 

 and 
NetWare LANalyzer Agent monitors every packet on the network segme
is installed on, creating a list in local memory of the physical (MAC) addres
and IP addresses of the nodes communicating on the segment. 

After NXPIPX completes its Phase 1, NXPLANZ uses SNMP to query al
NetWare LANalyzer Agent servers for the list of workstations they have 
observed communicating on the network. NXPLANZ obtains a list of 
NetWare LANalyzer Agent servers from NXPIPX.

NXPIP.NLM

NXPIP.NLM is a software module developed for NetWare 3.11. The 
software's primary function is to collect MIB-I and MIB-II data from router
that support SNMP. 

The SNMP routers are discovered through positive responses to SNMP p
which are followed up with SNMP inquiries that provide detailed informatio
about the routers’ configuration. SNMP routers and their associated data
transmitted to NETXPLOR.NLM through an IPC channel. 

The SNMP router data is subsequently forwarded to NetExplorer Manage
NETXPLOR.NLM. The SNMP router data is stored in the NetWare 
Management Map (NMM) database and utilized by various NMM 
applications.

NetExplorer Subsystem

NetExplorer is a distributed network management subsystem that execut
a background task under Windows. NetExplorer Manager is a set of 
autodiscovery NLMs that can execute on any NetWare server version 4.x
above.

The current product contains three NLMs: 

� NXPIPX.NLM collects information about NetWare servers, IPX 
workstations, and IPX routers.  

� NXPIP.NLM collects information about SNMP-instrumented routers. 

� NETXPLOR.NLM receives the collected autodiscovery data from 
NXPIPX.NLM and NXPIP.NLM via an Interprocess Communication 
channel (IPC). 
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The IPC interface executes over SPX, allowing the autodiscovery NLMs
execute on the same or separate NetWare servers. NETXPLOR.NLM sav
data packets from the autodiscovery NLMs in a sequential file, SLV.DAT.

The sequential file is read by NETXPLOR.NLM each time a  new connect
is established by the NLM and a request for autodiscovery data is made b
Windows 3.1 resident NetExplorer Manager (NEM) software.

NEM collects data packets from NETXPLOR.NLM via the Remote 
Procedure Call (RPC) interface. The RPC layer utilizes SPX for transpor
services. 

NEM also has direct access to the NMM database in which NEM stores 
autodiscovery data. The autodiscovery data allows NEM to define netwo
relationships from which a topological map of the network can be construc

The autodiscovery NLMs execute on selected NetWare file servers in the
managed network. 

Autodiscovery NLMs execute quietly in the background periodically. 
NetWare provides the scheduling and timing resources necessary for 
autodiscovery NLM execution. 

Each autodiscovery NLM utilizes the resident protocol stacks of NetWare
query and collect  network management data. Current autodiscovery NL
utilize  SPX/IPX, TCP/IP, and SNMP stacks. Future releases will utilize t
AppleTalk* protocol stack as well.

The actual autodiscovery NLMs, NXPIPX.NLM and NXPIP.NLM, execute
independently of NEM. The NEM interacts with the autodiscovery NLMs
indirectly through an RPC control and data channel linked to 
NETXPLOR.NLM. 

Currently NEM is limited to requesting an autodiscovery data flow from 
NETXPLOR.NLM. NEM; however, it can specify a variable starting 
autodiscovery record from within the SLV.DAT sequential file.

During initialization, the two autodiscovery NLMs, NXPIPX and NXPIP, 
open IPC channels to NETXPLOR.NLM. Further operation of the 
autodiscovery NLMs is suspended until a start command is generated by
NETXPLOR.NLM. 
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This feature allows NETXPLOR.NLM to control autodiscovery in multi-
protocol environments. In particular, NETXPLOR.NLM allows NXPIP to 
begin and complete autodiscovery before NXPIPX is allowed to run. 

Because NXPIP autodiscovery data is more exact than NXPIPX data, a m
accurate picture of the network is revealed in the NMM Map application.

After autodiscovery is activated, each autodiscovery NLM makes protoco
specific requests to network elements. The responses received contain 
information that the autodiscovery NLMs can use to identify various netw
elements. 

As each network element is discovered, a data packet is sent from the 
autodiscovery NLM to NETXPLOR.NLM. NETXPLOR.NLM receives the 
autodiscovery packet and adds an RPC header to the packet before writin
packet to SLV.DAT.

Concurrently, NETXPLOR.NLM is constantly listening for RPC connectio
requests from remote NEM applications. If a connection request is receiv
NETXPLOR.NLM validates the software version for compatibility. 

Connection requests for invalid versions are refused. Valid connection 
requests are accepted and a processing thread is created to support the
NEM connection. 

The process thread opens SLV.DAT in a shared mode and searches for 
starting autodiscovery record requested by NEM. Once the appropriate re
has been found, the processing thread gathers the record and transmits
NEM via RPC calls.

The process is repeated until all the sequential autodiscovery records ha
been read and transmitted to NEM. Processing threads sleep periodicall
allowing other autodiscovery or NetWare 3.11 NLMs to execute.

NXPIP.NLM Features

The primary function of NXPIP.NLM is the automatic discovery of  IP route
that provide SNMP access. 

The autodiscovery process is methodical in that the nearest IP routers a
discovered first and the most distant IP routers last. The autodiscovery pro
can be customized through five command line input parameters: 
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The "/log" input option instructs NXPIP.NLM to create an ASCII file 
(NXPIP.TXT) in the \etc subdirectory that describes each IP router discove
and its associated MIB data, thus enabling trace logging.  

The "/mode" command instructs NXPIP.NLM to perform only a single 
autodiscovery pass.  

The default condition is for continuous monitoring of the network to look f
new IP routers.   

The "/community  cccccccc" command option changes the default SNMP
community string from "public" to a user-defined string  that is input 
immediately after the "/community". 

The "/delay ddddd" command option enforces a user-defined delay betw
all SNMP requests.  

The delay value ddddd is a decimal value for the number of milliseconds
NXPIP.NLM should delay between SNMP requests. 

This option is useful in small networks or  on NetWare servers containing
many executing NLMs when the user wants to reduce the CPU utilizatio
NXPIP.NLM and allow other NLMs a greater opportunity to execute.  

The "/router ddd" option limits the number of IP routers that can be discove
by NXPIP.NLM. The default is 100 routers.

NXPIP.NLM also looks for two configuration files during startup that resid
in  the \etc subdirectory: 

The file IP_NETS.DAT can be edited to limit the scope of autodiscovery.

This file is a  list of ASCII IP addresses in dotted notation; for example, 
130.57.00.00.  

IP network addresses in this file are inclusive, meaning NXPIP.NLM 
discovers only IP networks specified in this file. If this file is not found, 
NXPIP.NLM discovers the entire Internet without limitations.  

The file COMMUNIT.IP is an ASCII file that contains alternate SNMP 
community strings.  
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This allows IP router autodiscovery to take place in those networks that 
more than one community string throughout the Internet.

NXPIP.NLM Overview

The first operation NXPIP.NLM performs during startup is an analysis of 
user's command line. 

If no command line options are specified, then NXPIP.NLM sets all 
processing options to their respective default values. Otherwise, the use
command line options are processed.  

NXPIP.NLM next displays the values of all the user options on the Conso
screen.  

NXPIP.NLM then initializes its internal variables and tables.  

Next NXPIP.NLM looks for the two startup files in /ETC, IP_NETS.TXT an
COMMUNIT.IP, for additional processing options.  

UDP sockets are then opened  for RIP and SNMP network I/O, and an IP
connection request is made to NETXPLOR.NLM.  

If all these operations are accomplished without error, then process 
IpcFromSlv is created to begin looking for IPC commands from 
NETXPLOR.NLM.  

At this point the main thread exits. IpcFromSlv waits on the IPC channel u
a command is received. Currently, only an autodiscovery start command
valid. 

When this command is received, a start response message is transmitted
to NETXPLOR.NLM to confirm IP Router autodiscovery initiation. After  th
Start command response is transmitted, autodiscovery is initiated.

Autodiscovery begins with a RIP broadcast to the local IP network. 

The addresses of all responses to the RIP broadcast are collected and sa
possible IP routers. Then each IP device that responded is "pinged" with
SNMP Get Request for its required System Descripter.  
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If the IP device responds positively, additional SNMP requests are made
determine whether this IP device is a router. If it is a router, then its interf
table, routing table, and address tables are scanned for connection inform
and addresses of other routers.  

The connection information and other configuration data is then packaged
IPC transmit packets and sent to NETXPLOR.NLM. The new IP address
discovered are added to the list of IP router candidates for later processi

When all this activity is complete, the next address of an IP device in the
of IP router candidates is processed identically. The processing loop, as
described above, continues until all the IP addresses of router candidates
been tested.  

When the list of addresses of IP router candidates has been exhausted, 
autodiscovery complete message is transmitted to NETXPLOR.NLM.  
NXPIP.NLM then waits for any new IPC commands.

NXPIP.NLM Components

This section identifies and describes the important software components
NXPIP.NLM.

Table 14 Major Tables

Title Description

SNMP_RESPONSE

SNMP_REQUEST

These tables contain decoded SNMP PDUs for SNMP responses and 
requests, respectively. The data in these tables is in machine-readable 
binary prior to ASN.1 decoding/encoding.

RESPONSE_TABLE_VAR
S

REQUEST_TABLE_VARS

These tables contain  decoded SNMP variable lists for SNMP responses 
and requests, respectively. The data in these tables is in machine-readable 
binary prior to ASN.1 decoding/encoding.

SNMP_CONFIGURATION Contains setup information about the SNMP socket used for network I/O. It 
includes information about timeouts, retry counts, and community strings.

SNMP_ROUTER_TABLE Contains all the MIB-I and MIB-II data discovered about a particular IP 
router. It is  a mirror of all the data that is transmitted to NETXPLOR.NLM 
and then forwarded to NetExplorer Manager.
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IPCPACKET The buffer transmitted to NETXPLOR.NLM, which contains general 
information about the recently discovered IP router. This packet is 
transmitted once per IP router and is always transmitted first before any 
router interface packets are sent.

IPCPACKETIF The buffer transmitted to NETXPLOR.NLM, which contains an IP router's 
interface information. This packet is transmitted once per interface.

ROUTER_LIST Maintains a list of all IP network devices discovered during autodiscovery. 
NXPIP.NLM attempts to communicate with each network device address in 
this table to determine if the network device could be an IP router. This is a 
candidate list of IP addresses that may belong to an IP router.

SAVED_ROUTER_LIST Maintains a list of all IP addresses owned by discovered routers. This list is 
matched against any new router that is discovered to determine whether the 
router has been previously discovered.

BOUNDARY_LIST Contains a list of all valid IP network addresses. If a router is discovered and 
the network address of the router is contained in this list, then the data 
describing this router is transmitted to NETXPLOR.NLM. Otherwise, the 
data collected is discarded. The IP network addresses for this table are read 
in from a file ip_net in subdirectory \etc.

Title Description
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Table 15 Subroutines

Subroutine Action

Void Main NXPIP.NLM execution entry point. 

The first operation NXPIP.NLM performs during startup is an analysis of 
the user's command line.

If no command line options are specified, NXPIP.NLM sets all processing 
options to their respective default values.  Otherwise, the user command 
line options are processed.  

NXPIP.NLM displays the values of all the user options on the Console 
screen. 

The main routine initializes the saved_router_list table to zero. 

Next GETHOSTID is called to determine the IP address of this NetWare 
server. 

Main registers a termination routine with NetWare using system call 
atexit. 

Main calls build_boundary to create a list of valid IP network addresses 
that will limit the scope of IP router discovery.  

If the user has specified /log, then start_debug is called to open an ASCII 
file to receive the output of IP router autodiscovery. 

Open_udp_port is called to create a UDP socket for network I/O.

Initialize_snmp_io is called to set the SNMP operational parameters.

GetFileServerName is called to get an ASCII string name identifying this 
NetWare server.  

The main function calls open_ipc from the IPC library to create an IPC 
channel between NXPIP.NLM and NETXPLOR.NLM. 

If the call fails, a warning message is displayed on the NetWare console 
informing the user that NETXPLOR.NLM is not loaded. Main  sleeps for 
10 seconds and then tries to open an IPC connection again.  

The process of trying to open an IPC connection and then sleeping 
repeats endlessly or until an IPC connection is made.  

Once the IPC connection has been established then process 
IPCFromSlv is created to begin autodiscovery.  The main function then 
executes an ExitThread to terminate its execution.
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GET_IT Get_it is a subroutine that scans the table (router_list) that contains IP 
addresses of potential IP routers.

Each IP address is input into check_internetwork_list to determine 
whether the IP address is within the autodiscovery range of addresses. 

If the range test fails, a new IP address is taken from router_list and 
execution begins again. 

If the IP address of the IP device is within that autodiscovery range, the 
IP address is sequentially "pinged" with an SNMP Get Request for its 
required System Descripter. 

If the IP device responds positively, additional SNMP requests are made 
to determine whether this IP device is a router. If it is a router, its interface 
table, routing table, and address table are scanned for connection 
information and addresses of other routers. 

The connection information is stored in the router data table, the_table, 
for later processing. New IP addresses that are discovered are added to 
router_list for later investigation.  

If it is discerned that the IP device under investigation is not an IP router, 
all processing on that device is terminated and the next IP address is 
taken from router_list and execution begins anew.

After all the information has been obtained from the IP device and it is 
determined that the IP device is an IP router, SendSnlmDiscoverData is 
called to transmit the IP router information to NETXPLOR.NLM via IPC.

The subroutines called to collect IP router data are as follows: 
build_sysDescr_packet, build_ipForwarding_packet, 
build_ifNumber_packet, build_ifTable_packet, 
build_ipRoutingTable_packet, build_ipAddrTable_packet, and 
build_sysName_packet.

dump_record Dump_record writes all the MIB data collected from a router to an ASCII 
file called NXPIP.TXT in subdirectory tc.  

This function can be enabled only as a command line option during 
NXPIP.NLM loading by specifying the "/log" option.

Subroutine Action
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build_boundary This subroutine is called immediately during initialization. It attempts to 
open the file IP_NETS.TXT in the \etc subdirectory.  

If the file does not exist, the subroutine just returns.  Otherwise, the ASCII 
file is parsed for IP network addresses in ASCII dotted notation. 

Each valid IP network address read is stored in table boundary_list. This 
table is used by several subroutines to ensure that the IP autodiscovery 
process does not discover IP routers that are outside the discovery 
boundaries set up by the user.

Once the file has been completely read, it is closed and the subroutine 
returns to the caller.

start_debug A short subroutine that creates and opens an ASCII log file in the \etc 
subdirectory.  

If the subroutine fails, FAILURE is returned. Otherwise, SUCCESS is 
returned.

ip_snooper_cleanup This is the function call registered with atexit during initialization. It is 
called by NetWare 3.11 when the program is unloaded from the System 
Console by the user or when NXPIP.NLM executes an exit library call. 

The subroutine first checks to determine whether logging is active. If it is, 
then the log file is closed. 

The subroutine calls close_udp_port and close_snmp_port to disable 
these two socket ports. 

The subroutine tests whether the IPC channel between 
NETXPLOR.NLM and NXPIP.NLM is open. If it is, then close_ipc is called 
to terminate the connection.  

The subroutine exits.

open_udp_port Open_udp_port creates an I/O socket for RIP broadcasts. It is called 
during initialization. 

Socket is called to create a UDP socket. 

Ioctl is  called to set the new socket up in non-blocking mode.

If any of these function calls fail,  FAILURE is returned. Otherwise, the 
socket identifier is returned to the caller.

Subroutine Action
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close_udp_port Close_udp_port is called during exit processing. The subroutine closes 
the socket identified by the socket identifier, which is an input parameter 
of the call.  

The program always returns SUCCESS to eliminate any recursive error 
processing during shutdown.

send_request This subroutine is called to transmit a UDP packet. 

The caller inputs a socket identifier, a pointer to a BYTE buffer, and the 
size of the output buffer in bytes. 

The subroutine calls sendto to transmit the UDP packet.  

If the transmit buffer is busy, the program sleeps briefly before retrying the 
transmission.  

SUCCESS is returned upon completion of a  transmission.

If the transmitted UDP packet was truncated by the transport layer, then 
UDP_SEND_TRUNCATED is returned.  

All other errors cause FAILURE to be returned.

get_response Get_response is called to receive UDP packets from a particular UDP 
port identified by socket identifier.  

Get_response initializes the socket by making calls to FD_ZERO. 

FD_SET is called to set up the select call by linking the input socket 
identifier with the select call. 

Select is called. 

If select times out, then UDP_TIMEOUT is returned. Otherwise, recvfrom 
is called to get the UDP packet from the transport layer. 

If an error occurs, UDP_RECV_FAILURE is returned.  Otherwise, 
SUCCESS is returned.

Subroutine Action
�� LogicSource for ManageWise
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set_random_seed Set_random_seed is a short subroutine that creates a seed number for 
generating a sequence of pseudo-random numbers. 

The subroutine gets the current system time in seconds by calling time. 

The value of system time is passed into srand as the seed number 
necessary for generating a sequence of random numbers.  

This ensures that a new sequence of random numbers is generated each 
time NXPIP.NLM is loaded.

get_random_assoc_id This is a short subroutine that is called whenever an SNMP PDU is being 
created for transmission.  

The subroutine calls rand to get a random integer. 

The random integer is returned to the caller for use as an SNMP 
association identifier.

discover_snmp_router Discover_snmp_router is called each time an IP address of a potential IP 
router is discovered. 

If the address is unknown to the program, the IP address is added to the 
search list table, router_list. 

If the input IP address is a member of router_list or if the number of 
routers in router_list exceeds the maximum entries,  the subroutine 
returns to the caller.

check_internetwork_list This subroutine takes an input IP address and compares the network 
portion of the IP address against a list of IP network addresses that define 
the scope of the IP autodiscovery process. 

The subroutine checks for the existence of file IP_NETS.TXT. If the file 
does not exist, no further checking is done, because the default is to 
discover the entire internetwork.  

In this circumstance TRUE is always returned. 

If the file exists, the input IP address is compared against the addresses 
contained in IP_NETS.TXT, which are stored in the array boundary_list. 

If the input IP address matches any of the IP addresses in boundary_list,  
TRUE is returned. Otherwise, FALSE is returned.

Subroutine Action
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check_saved_router_list This subroutine takes an input IP address and checks table 
saved_router_list to determine whether the input IP address was 
previously known as an IP address of a router.

If the router IP address was previously discovered, FALSE is returned. If 
the IP address is a new address, the input IP address is added to 
saved_router_list and TRUE is returned to the caller.

open_snmp_port Open_snmp_port creates an I/O socket for SNMP requests and 
responses. It is called during initialization. 

The subroutine  calls set_random_seed, which determines the seed 
number for a sequence of pseudo-random numbers. Random numbers 
are used in SNMP PDUs to match SNMP responses with SNMP 
requests.

Socket is called to create a UDP socket. 

Ioctl is called to set the new socket up in non-blocking mode. 

If any of these function calls fail, FAILURE is returned. Otherwise, the 
socket identifier  is returned to the caller.

close_snmp_port Close_snmp_port is called during exit processing. 

The subroutine checks if the SNMP socket is open.  

If it is, then the subroutine closes the socket. 

The program always returns SUCCESS to eliminate any recursive error 
processing during shutdown.

Subroutine Action
�� LogicSource for ManageWise
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send_snmp_request This subroutine is called to transmit an SNMP PDU. 

The program delays itself by the default value assigned by the user 
during startup; that is, the value set by parameter "/delay". 

SnmpRequestBuild is called to create an ASN.1 encoded packet. 

If the Request PDU is created successfully, sendto is called to transmit 
the SNMP PDU. 

If the ASN.1 encoding process fails, SNMP_BUILD_FAILURE is 
returned. 

If the outbound PDU packet is truncated,  SNMP_SEND_TRUNCATED 
is returned. 

All other processing errors return SNMP_FAILURE.

If the SNMP PDU request is successfully transmitted, SNMP_SUCCESS 
is returned.

get_snmp_response Get_snmp_response is called to receive SNMP PDU response packets 
from SNMP devices. 

Get_snmp_response initializes the socket by making calls to FD_ZERO. 

FD_SET is called to set up the select call by linking the input socket 
identifier with the select call. 

Select is called. 

If select times out, SNMP_TIMEOUT is returned. Otherwise, recvfrom is 
called to get the SNMP packet from the transport layer. 

If an error occurs, SNMP_RECV_FAILURE is returned.  Otherwise, 
SnmpResponsePars is called to decode the ASN.1 encoded PDU. 

If the ASN.1 decoding fails,  SNMP_PARSE_FAILURE is returned.  
Otherwise, SNMP_SUCCESS is returned.

SnmpRequestBuild This subroutine takes a binary representation of an SNMP request 
packet and calls various SNMP library routines to encode the SNMP 
request packet into an ASN.1 SNMP PDU.  

The SNMP PDU is built backwards; that is, the bottom of the packet (MIB 
variables) are built first, while the SNMP header is built last.  

BUILD_ERRORS are returned if the packet encoding procedure fails at 
any point. Otherwise, SNMP_SUCCESS is returned.

Subroutine Action
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SnmpResponseParse This subroutine decodes an ASN.1 SNMP response PDU.  

The subroutine calls various parsing subroutines from the SNMP library 
to decode the PDU.  

Unlike SnmpRequestBuild, the packet is decoded from top to bottom; 
that is, the header is decoded first and any SNMP variables associated 
with the SNMP response packet are decoded last.  

Any parsing errors return PARSE_ERROR. Otherwise, the subroutine 
returns SNMP_ERR_NOERROR.

setup_socket Setup_socket is a short subroutine that prepares a UDP socket for 
transmission.  

The subroutine sets the socket to the correct destination IP address and  
destination UDP socket.

initialize_snmp_io This subroutine is called during NXPIP.NLM initialization.  

The program sets the retry rate, the timeout value, the polling rate, and 
the default snmp community string.  

The subroutine calls open_snmp_port to create a Berkeley socket for 
SNMP network I/O.  

If the SNMP socket creation fails, FAILURE is returned. Otherwise, 
SUCCESS is returned.

Subroutine Action
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build_sysName_packet Build_sysName_packet creates and transmits an SNMP PDU to gather 
the sysName of an SNMP device.  

The subroutine calls setup_socket to set the destination IP address and 
UDP port of the SNMP device.  

The Get_request PDU is built with the object ID of the sysName variable.   

The Get_request is  ASN.1 encoded and transmitted through a call to 
send_snmp_request. 

If the transmit is successful, get_snmp_response is called to get the 
SNMP response PDU from the target SNMP device.  

Get_snmp_response is called repeatedly until the correct PDU response 
packet is discerned, as determined by the SNMP request ID.  

If the matching SNMP response is valid, the returned sysName Octet 
string is stored in the IP router table, the_table. 

If  no response is received within the timeout and retry limits, 
SNMP_RECV_TIMEOUT is returned.  

SNMP_FAILURE is returned for all other errors.

build_sysDescr_packet Build_sysDescr_packet creates and transmits an SNMP PDU to gather 
the sysDescr of an SNMP device.  

The subroutine calls setup_socket to set the destination IP address and 
UDP port of the SNMP device.  

The Get_request PDU is built with the object ID of the sysDescr variable. 

The Get_request is  ASN.1 encoded and transmitted through a call to 
send_snmp_request. 

If the transmit is successful, get_snmp_response is called to get the 
SNMP response PDU from the target SNMP device.  

Get_snmp_response is called repeatedly until the correct PDU response 
packet is discerned, as determined by the SNMP request ID. 

If the matching SNMP response is valid, the returned sysDescr Octet 
string is stored in the IP router table, the_table.  

If  no response is received within the timeout and retry limits, 
SNMP_RECV_TIMEOUT is returned. 

SNMP_FAILURE is returned for all other errors.

Subroutine Action
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build_ipForwarding_packet Build_ipForwarding_packet creates and transmits an SNMP PDU to 
gather the ipForwarding of an SNMP device.  

The subroutine calls setup_socket to set the destination IP address and 
UDP port of the SNMP device.  

The Get_request PDU is built with the object ID of the ipForwarding 
variable.   

The Get_request is ASN.1 encoded and transmitted through a call to 
send_snmp_request.  

If the transmit is successful, get_snmp_response is called to get the 
SNMP response PDU from the target SNMP device.  

Get_snmp_response is called repeatedly until the correct PDU response 
packet is discerned, as determined by the SNMP request ID.  

If the matching SNMP response is valid, the returned ipForwarding value 
is stored in the IP router table, the_table.  

If no response is received within the timeout and retry limits, 
SNMP_RECV_TIMEOUT is returned.  

SNMP_FAILURE is returned for all other errors.

Subroutine Action
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build_ifNumber_packet Build_ifNumber_packet creates and transmits an SNMP PDU to gather 
the ifNumber of an SNMP device.  

The subroutine calls setup_socket to set the destination IP address and 
UDP port of the SNMP device.  

The Get_request PDU is built with the object ID of the ifNumber variable.   

The Get_request is  ASN.1 encoded and transmitted through a call to 
send_snmp_request.  

If the transmit is successful, get_snmp_response is called to get the 
SNMP response PDU from the target SNMP device. 

Get_snmp_response is called repeatedly until the correct PDU response 
packet is discerned, as determined by the SNMP request ID.  

If the matching SNMP response is valid, the returned ifNumber value is 
compared against the maximum interface array entries 
(MAX_IF_ARRAY_SIZE) supported in the IP router table, the_table. 

If the value of ifNumber is greater than the maximum allowable array 
entries, ifNumber is truncated to equal the maximum entries.  

The value of ifNumber is then stored in the_table. 

If no response is received within the timeout and retry limits, 
SNMP_RECV_TIMEOUT is returned.  

SNMP_FAILURE is returned for all other errors.

Subroutine Action
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build_ipRoutingTable_packet Build_ipRoutingTable_packet creates and transmits an SNMP PDU to 
gather the values of certain selected fields in the ipRoutingTable. 

In particular, the values of fields ipRouteDest, ipRouteifIndex, and 
ipRouteNextHop of ipRoutingTable are all requested from an SNMP 
device.  

The subroutine calls setup_socket to set the destination IP address and 
UDP port of the SNMP device.  

A GetNext_request PDU is built with the object IDs of the ipRoutingTable 
variable fields requested.  

The GetNext_request is ASN.1 encoded and transmitted through a call 
to send_snmp_request.  

If the transmit is successful, get_snmp_response is called to get the 
SNMP response PDU from the target SNMP device.  

Get_snmp_response is called repeatedly until the correct PDU response 
packet is discerned, as determined by the SNMP request ID.  

If the matching SNMP response is valid,  the returned values of the 
ipRoutingTable fields are stored in the IP router table, the_table. 

The GetNext_request is  built and transmitted again to access the next 
entry in the ipRoutingTable and the processing described above is 
repeated.  

Additional GetNext_requests are built and transmitted repeatedly until all 
the entries in the ipRoutingTable have been examined. 

If no response is received from any of the GetNext_requests within the 
timeout and retry limits, SNMP_RECV_TIMEOUT is returned.  

SNMP_FAILURE is returned for all other errors.

Subroutine Action
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build_ifTable_packet Build_ifTable_packet creates and transmits an SNMP PDU to gather the 
values of certain selected fields in the ifTable. 

In particular, the values of fields ifIndex, ifDescr, ifType, ifPhysAddress 
and ifOperStatus of ifTable are requested from an SNMP device.  

The subroutine calls setup_socket to set the destination IP address and 
UDP port of the SNMP device.  

A GetNext_request PDU is built with the object IDs of the ifTable variable 
fields requested.  

The GetNext_request is ASN.1 encoded and transmitted through a call 
to send_snmp_request.  

If the transmit is successful, then get_snmp_response is called to get the 
SNMP response PDU from the target SNMP device.  

Get_snmp_response is called repeatedly until the correct PDU response 
packet is discerned, as determined by the SNMP request ID.  

If the matching SNMP response is valid, the returned values of the ifTable 
fields are stored in the IP router table, the_table.  

The GetNext_request is built and transmitted again to access the next 
entry in the ifTable and the processing described above is repeated.  

Additional GetNext_requests are built and transmitted repeatedly until all 
the entries in the ifTable have been examined. 

If no response is received from any of the GetNext_requests within the 
timeout and retry limits, SNMP_RECV_TIMEOUT is returned.  

SNMP_FAILURE is returned for all other errors.

Subroutine Action
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build_ipAddrTable_packet Build_ipAddrTable_packet creates and transmits an SNMP PDU to 
gather the values of certain selected fields in the ipAddrTable. 

In particular, the values of fields ipEntAddr, ipAdEntIfIndex, and 
ipAdEntNetMask of ipAddrTable are requested from an SNMP device.  

The subroutine calls setup_socket to set the destination IP address and 
UDP port of the SNMP device.  

A GetNext_request PDU is built with the object IDs of the ipAddrTable 
variable fields requested. 

The GetNext_request is ASN.1 encoded and transmitted through a call 
to send_snmp_request. 

If the transmit is successful, get_snmp_response is called to get the 
SNMP response PDU from the target SNMP device.  

Get_snmp_response is called repeatedly  until the correct PDU response 
packet is discerned, as determined by the SNMP request ID.  

If the matching SNMP response is valid, the returned values of the 
ipAddrTable fields are stored in the IP router table, the_table.  

The GetNext_request is built and transmitted again to access the next 
entry in the ipAddrTable, and the processing described above is 
repeated.  

Additional GetNext_requests are built and transmitted repeatedly until all 
the entries in the ipAddrTable have been examined. 

If no response is received from any of the GetNext_requests within the 
timeout and retry limits, SNMP_RECV_TIMEOUT is returned.  

SNMP_FAILURE is returned for all other errors.
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search_this_network_for_rout
ers

This subroutine is called each time a new IP discovery cycle is initiated.  

The program increments the discovery pass counter variable, 
pass_counter.  

The IP router table, the_table, is re-initialized to zero.  

A RIP broadcast packet is constructed.  

The RIP packet is broadcast through a call to send_request.  

Get_response is called repeatedly to collect all the responses to the RIP 
broadcast.  

The IP address of each responder is  added to the list of IP router 
candidates, through repeated calls to discover_snmp_router.  

The subroutine calls buildCommunityNameTable to read the 
COMMUNIT.IP file in the \etc subdirectory. 

BuildCommunityNameTable inputs all SNMP community strings to be 
used during autodiscovery.  

Get_it is called to begin autodiscovery.  When get_it returns, a complete 
cycle of autodiscovery has been completed.  

Search_this_network_for_routers builds an autodiscovery_complete IPC 
message and calls write_ipc to send the message to NETXPLOR.NLM.  

Upon verifying the autodiscovery_complete message, the subroutine 
exits.  

If any errors are discerned with the IPC channel, the subroutine 
continuously tries to re-establish communication with NETXPLOR.NLM 
through repeated calls to open_ipc.  

When the IPC connection is re-established, then the 
autodiscovery_complete message is sent and the subroutine exits.

Subroutine Action
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IpcFromSlv IpcFromSlv is a thread generated by the main program that continuously 
looks for IPC messages from NETXPLOR.NLM.  

Upon receiving a command, a new autodiscovery thread is initiated to 
process the request.  

If any breaks in IPC communication are discerned, IpcFromSlv 
continually tries to re-establish the IPC channel via repeated calls to 
open_ipc. 

If the user has put NXPIP.NLM into a single discovery pass mode, ("/
mode"),  IpcFromSlv terminates NXPIP.NLM after one discovery cycle.

DiscoverInitiation DiscoverInitiation is a short subroutine that acknowledges a 
start_discovery IPC command from NETXPLOR.NLM with an 
SNLM_DISCOVERY_INIT response packet.  

The subroutine calls search_this_network_for_routers to begin IP router 
autodiscovery.

Subroutine Action
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SendSnlmDiscoverData SendSnlmDiscoverData is the subroutine called to transmit IP router data 
after it has been completely discovered.  

Before sending the IP router data, the subroutine performs four data 
validation tests. 

First, check_internetwork_list is called to make sure the IP address of the 
router is within the current discovery range.

Second, check_saved_router_list is called next to ensure that 
NXPIP.NLM has not previously discovered this router.  

Third, the subroutine ensures that MIB variable ipForwarding is set to 
TRUE, thus showing that this router is performing the function of 
forwarding IP packets.  

Fourth, the subroutine ensures that the maximum number of discovered 
routers has not been exceeded.  

If any test is unsuccessful, the subroutine returns to the caller and no 
packets are sent to NETXPLOR.NLM.  

If  all four tests are passed, SendSnlmDiscoverData builds an 
SNLM_IP_ROUTER_DATA and sends the packet to NETXPLOR.NLM 
via write_ipc.  

SendSnlmDiscoverData builds individual SNLM_IP_ROUTER_IF_DATA 
packets, one for each physical interface, and transmits these packets to 
NETXPLOR.NLM via write_ipc.  

If logging has been enabled, ("/log" command line option), then 
dump_record is called to write an ASCII description of the discovered 
router to a disk file.  

The count of discovered routers, known_routers_count, is  incremented.  

The subroutine  sleeps for 1 second to let other NLMs execute before 
returning to the caller.

Subroutine Action
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NXPIPX.NLM

NXPIPX.NLM (NXPIPX) provides some of the functionality that lets 
NetExplorer discover your network. It collects information about IPX 
network topology and network node configuration.  

Nodes discovered include these:

� NetWare servers

� NetWare workstations

� Non-NetWare routers

� IPX networks

To discover network nodes, NXPIPX uses the following:

� SNMP

� NCP

� RIP

� IXP Diagnostics

� SPX Diagnostics

buildCommunityNameTable This subroutine is called immediately before autodiscovery is initiated.  

The subroutine attempts to open the file communit.ip in the \etc 
subdirectory.  

If the file does not exist, the subroutine returns. Otherwise, the ASCII file 
is parsed for community strings that will be used during autodiscovery.  

Each valid community string read is stored in table communityName. This 
table is accessed by the SNMP transmit routines during autodiscovery.  

Once the file has been completely read, it is closed and the subroutine 
returns to the caller.

Subroutine Action
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NXPIPX uses SAP instead of NDS information to obtain seeds.

NXPIPX includes the following subsystems:

� Request Processor

� Discovery Processor

� Data Management

NXPIPX includes the following services:

� Communication

� Resource management

� Request management

� Debugging and logging

NXPIPX imports the following services:

� IPC

� SNMP encoding and decoding

� SNMP community name access

� NXP configuration

� Memory management

Request-Process Subsystem Flow of Operation

NXPIPX transmits network management information to NetExplorer via a
Interprocess Communication (IPC) channel. NXPIPX and NetExplorer ca
run on separate servers because the IPC interface executes over SPX. 
However, ManageWise 2.x installs NetExplorer services on only one ser

During its initialization, NXPIPX uses a main thread to open and monitor
IPC channel to NetExplorer for exchanging discovery requests and disco
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packets. NXPIPX also uses an internal thread to open and monitor an IP
channel to itself for processing internal discovery requests.

To initiate global NXPIPX discovery, NetExplorer generates a start command.

To discover specific types of nodes such as NetWare servers and worksta
NXPIPX generates a series of internal discovery commands via the internal-
thread IPC channel.

NetExplorer can suspend and resume discovery.

During operation, NXPIPX does the following:

1. Anticipates discovery requests via the main- and internal-thread IPC
channels.

2. Receives discovery requests.

3. Validates discovery requests.

4. Drops invalid and duplicate discovery requests.

5. Creates a discovery thread to process a valid discovery request.

6. Creates an active discovery thread that requests discovery informat
including identity and components from a node according to its node
type, such as NetWare server or workstation.

7. Receives requested information from nodes.

8. Sends a discovery data packet via the main-thread IPC channel for e
discovered node.

Packet Types 

NXPIPX classifies discovery data packets according to the types describe
the following table.
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Table 16 Packet Types and Descriptions

Discovery Process Subsystem

The collection of discovery data consists of the following requests:

� Global discovery

� Server detail discovery

� Workstation detail discovery

Global discovery is the basic functionality of NXPIPX that discovers the IP
network topology and the basic configuration of  network nodes. Server de
discovery and workstation detail discovery gather more specific configura
information.

Type Description

Registration Contains information about NXPIPX discovery availability. A registration packet 
is transmitted once and during initialization via main-thread IPC channel. 
Discovery includes no packet to end registration; registration ends when the 
main-thread IPC channel disconnects.

Request Contains information that specifies a global discovery type and time. NetExplorer 
uses request packets to initiate, suspend, and resume global discoveries via the 
main-thread IPC channel.

Data Contains information about

� IPX network topology.

� Network topology that is derived from third-party routers.

� The configuration of discovered nodes such as NetWare servers and 
workstations.

� The service that a node provides.

NXPIPX transmits data packets to NetExplorer via the main-thread IPC channel.

Status Contains information confirming NetExplorer receipt of a discovery request or 
completion notice.

NXPIPX transmits status packets to NetExplorer via the main-thread IPC 
channel.
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Methodologies for Accessing Network Information

NXPIPX uses specific programs to discover IPX network topology and ga
the basic configuration of IPX network nodes from various information 
sources. The following table contains information types, the sources from
which the information is derived, and the programs used to derive the 
information.

Table 17 IPX Network Information Collection

Algorithm for Global Discovery

After NXPIPX receives a request to start the global discovery process, it
spawns thread groups for the following node types:

� Server

Information Type Source Program

Server information (name, 10-
byte address, and services)

Bindery CLIB or SPX Diagnostics

LAN information (MAC, IPX 
bindings)

Diagnostics IPX Diagnostics

LAN information (ifType) NM-II SNMP/IPX

WAN information (MAC, IPX 
bindings, ifType)

MIB-II, ADAPTER MIB, IPXMIB SNMP/IPX

NWIP information (NWIP ID, and 
MAC, IP mask)

Diagnostics IPX Diagnostics and SPX 
Diagnostics

SFT information (MS Engine, 
Primary I/0 Engine, Secondary I/0 
Engine)

Diagnostics, NWSERVER MIB IPX Diagnostics and SNMP/IPX

Link information (MAC, IPX 
binding, hop count)

Diagnostics SPX Diagnostics

Workstation information (MAC) Connection Table, NWSERVER 
MIB, NXPPLUS MIB

CLIB or NCP and SNMP

Workstation information (user 
name)

Connection Table, NWSERVER 
MIB, NXPPLUS MIB

CLIB or SNMP
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� Router

� Workstation

Each thread group discovers a specified type of node on the network. Th
server thread group is the main data stream. The router thread group is 
suspended until the completion of the server thread group. The router an
workstation thread groups build upon the information that the server thre
group establishes.

Server Thread Group

The server thread group involves three phases: 

Phase 1 discovers IPX network topology and the basic configuration of no
via NetWare routers. 

Phase 2 discovers added router and workstation information. 

Phase 3 detects changed node configuration.

The following sections discuss discovery in more detail.

Phase 1. To lower network traffic, NXPIPX divides Phase 1 discoveries. T
first iteration of Phase 1 uses the following CLIB APIs to read a discover
server's bindery:

ScanBinderyObject   returns the server name and its service.
ScanProperty   reads the server network address.
ReadPropertyValue   returns the server network address.

The station list of the network node table identifies NetWare routers. After
first Phase 1 iteration, subsequent iterations read NetWare router binder
using the following SPX Diagnostics Service calls:

Get All Known Servers   retrieves a list of routers including their name
and services.

Get Specific Server Information   returns the network address o
a specified router.

Phase I is complete when the last NetWare router is discovered.
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Phase 2. Each Phase 2 iteration reads the bindery of a non-NetWare rout
server identified in the station list of the network node table. The first iterat
of Phase 2 tries to discover servers on non-NetWare networks that might 
been missed in Phase 1.

After each Phase 1 and Phase 2 iteration, NXPIPX reports new and upd
servers to NetExplorer via IPC. NXPIPX also identifies NetWare routers fr
the station list of the network node table and stores them in the NetWare ro
table.

Phase 2 is completed when the last non-NetWare router network is proce

Phase 3. NXPIPX can start as many as five server threads simultaneousl
until every server in the station list of the network node table is processed
make sure that NetExplorer is up to date, each server thread verifies ser
configurations.

For every server in the station list of the network node, table NXPIPX does
following:

1. Uses IPX Diagnostics Service calls and SNMP queries to obtain a se
component list.

2. Compares the latest information with the network node table informa

3. Resets the report status of servers for which information has change

4. Reports updated server information to NetExplorer via IPC after 
processing every server in the station list of the network node table.

Server Identification. NXPIPX identifies every server, including its name,
network address, and service in each iteration, and then verifies whethe
server exists in the station list of the network node table according to a ke
the server 10-byte network address.

The following table contains the server varieties discovered, the informa
gathered, and the program used to extract information:
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Table 18 Server Information

When the station list of the network node table already contains a discov
server, NXPIPX can update the server name or leave it unchanged acco
to a preconfigured preference. NXPIPX also adds newly discovered serv
to server information and, in this case, does not check for changed 
information.

When the station list of the network node table does not contain a discov
server, NXPIPX uses an IPX Diagnostics Service call to obtain the serve
component list and then add the server and its components to the station 
the network node table.

Data Packet Generation to NetExplorer. After every iteration, network 
server discovery reiterates, while NXPIPX starts a maximum of five serv
threads to report server configurations to NetExplorer.

Each server thread does the following:

1. Assembles server information.

2. Formats a data packet containing server information.

3. Delivers the packet.

4. Ends.

Status Update to NetExplorer. When the router, workstation, and server 
thread groups are complete, NXPIPX

1. Revives the router thread group to start the router discovery.

Variety Information Program

Server with WAN link if                
Type adMAC

WAN IPX bindings SNMP query

SFT server The primary and secondary I/O 
engines

SNMP query or IPX Diagnostics 
broadcast to the MS virtual 
network

NWIP server The IP mask and AC from a body 
of LAN driver information

SPX Diagnostics Service call
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2. Sets a server completion flag to indicate the end of the server thread g
for the router and workstation thread groups.

3. Sends a discovery completion packet to NetExplorer.

Exceptions to Discovery Cycles. To accelerate router discovery and enabl
NXPLANZ to start collection from NetWare LANalyzer Agents (NLAs) in it
first cycle, NXPIPX performs only the first iteration of Phase 1 and of Phas

To accelerate server discovery in its second cycle, NXPIPX performs ev
phase but the first iteration of Phase 1.

Router Thread Group

Router discovery includes three phases:

Phase 1 identifies NetWare routers from the Station list of the Network N
table. 

Phase 2 invents non-NetWare routers on the network. 

Phase 3 (which is disabled) consolidates non-NetWare routers.

The following sections describe the basic router discovery sequence.

Phase 1. Phase 1 processes all servers in the Station list of the Network N
table to discover servers that are NetWare routers. Phase 1 does not cau
network traffic.

NXPIPX assumes that servers contain logical or physical LAN/WAN boar
The IPX Diagnostics response and SNMP query during the server thread
group indicate the number of physical and logical LAN/WAN boards that 
server contains. NXPIPX assumes that a multiple-board server is a NetW
router.

NXPIPX queries the NetWare Router table using a router’s 10-byte netw
address.

When the NetWare Router table already contains a router, NXPIPX upda
changed router name or address in the NetWare Router table, and appen
updates route paths.
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NXPIPX adds newly discovered routers and their route paths to the NetW
Router table.

Phase 1 is complete when the last server is processed that is listed as a
NetWare router on the Station list of the Network Node table.

Phase 2. Phase 2 discovers non-NetWare routers. Non-NetWare routers do
respond to IPX/SPX Diagnostics Service calls and rarely support IPX 
instrumentation query via SNMP from the server thread group. NXPIPX u
SPX Diagnostics service calls via NetWare routers to discover non-NetW
routers and their configurations.

NXPIPX uses the following commands to gather discovery information:

Get Local Routing Table   returns the NetWare router LAN board 
used in specific routing.

Get Specific Network Information   returns the route path and hop
count between a NetWare router and a specified network.

Phase 2 is complete when the last router on the NetWare Router table is
processed.

Example. In the following sequence, SERVER1 indicates that M1 is the MA
at the forwarding route address, and Board 2 is the interface in SERVER1
uses the route. NXPIPX uses the first SPX Diagnostics Service call to qu
SERVER1to determine which board Board 2 refers to. From the respons
NXPIPX discovers that Board 2 refers to M8, which is bound to N2. From
these two queries, NXPIPX discovers that M1 is bound to N2 and routes
N3.

1. The network uses SERVER1 as a router between N1 and N2.

2. Using the second SPX Diagnostics Service call, NXPIPX queries 
SERVER1 for the route path used between N2 to N3.

3. In preparation for locating non-NetWare routers, NXPIPX discovers 
logical LAN board of the servers in the Station list of the Network No
table.

4. NXPIPX starts as many as five router threads and continues until all
servers and routers in the Station list of the Network Node table are 
processed. Each router thread uses the first SPX Diagnostics Servic
Processes/Features ��
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to identify the logical LAN board of a specific router and then add the
identity information to the Network Node table.

5. Using the Network list of the Network Node table to construct a netwo
router list, NXPIPX finds the network that includes the link that is mo
referred to and the network that includes the link that is least referred
NXPIPX uses the most- and least-referred link networks in the secon
SPX Diagnostics Service call as the target network. 

For example, N2 is the network referred to most and N7 is the netwo
referred to least.

6. NXPIPX starts as many as five router threads at a time and continues
all servers and routers in the Station list of the Network Node table a
processed. 

Each router thread uses the second SPX Diagnostics service call to 
route paths to each of the two networks in the Network-Router list fro
a specified router. NXPIPX stores each route path associated with a
specific network in the Network-Router list.

7. NXPIPX queries every server in the Station list of the Network Node
table that does not include a server or router. 

In the example above, only SERVER4 on N4, SERVER5 on N5, and
SERVER8 on N7 are queried in this phase.

8. NXPIPX uses the Network-Router list to construct a list of router-
networks. The router-network list includes NetWare and non-NetWar
routers.

9. NXPIPX adds every NetWare router that includes its route paths tha
register a hop count of 1 to the NetWare Router and Network Node tab

NXPIPX adds every non-NetWare router including at least one route p
to the Non-NetWare Router table. The route path consists of the netw
the router is on and the MAC address of the router. 

NXPIPX uses the route path network and a false MAC address of 0 
specify other route paths to which the router can directly route.

Data Packet Generation to NETXPLOR. After Phase 2, NXPIPX reports  
non-NetWare routers discovered in this cycle one at a time.
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Each data packet does not reflect any update to the non-NetWare router. I
represents a snapshot of the router information that could be discovered
NXPIPX.

Status Update to NETXPLOR. At the completion of Phase 2, NXPIPX 
destroys the NetWare Router and Non-NetWare Router tables. The next g
discovery cycle reconstructs them. NXPIPX also sets the Router Comple
flag to indicate the end of the Router thread group. The Workstation thre
group uses the flag to identify the global-discovery state.

NXPIPX sends a discovery completion packet to NETXPLOR when the 
workstation thread group is complete before the router thread group star

Workstation Thread Group

The Workstation Thread Group discovers NetWare workstations logged i
attached to NetWare servers.

To identify workstations, NXPIPX uses the fact that workstations attache
a server run NetWare Client software. NXPIPX stores connection informa
in the Connection Table on the server to which a workstation is attached. E
workstation Component list specifies a shell and shell driver.

The following illustrates the basic workstation discovery sequence.

Phase 1. NXPIPX starts as many three workstation threads at a time and
continues to process until it has discovered every workstation in the Stat
list of the Network Node table. 

If the server or router thread group has not completed yet, NXPIPX querie
servers again for workstation information. Each workstation thread works
a specific server to retrieve the list of workstations that are associated with
server.

To query the server Connection Table for workstation-connection 
information, NXPIPX uses the following CLIB APIs via the Workstation 
thread:

GetServerInformation   retrieves the information on how many 
connections of the discovery server are in use.

GetInternetAddress   gets the network address of a specific connecti
to the discovery server.
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GetConnectionInformation   gets the user name associated with th
specific connection.

Using the following calls, the other workstation threads collect informatio
from the Connection Table of other servers:

Create Connection (NCP)   creates a connection with the specific 
server that lets NXPIPX access the server Connection Table.

Get Server Information (NCP)   returns the number of active serve
connections.

Get Internet Address (NCP)   returns the network address of a 
specific server connection.

Close Connection (NCP)   closes the connection to the server.
Get Connection Table (SNMP)   returns the specific connection and

its user name from the server from NWSERVER MIB or NXPPLUS MI

NXPIPX distinguishes the OS version of the target server to correctly inter
the Get Server Information  maximum connection count:

� For NW 3.x, NXPIPX uses the maximum connection count as the upper
limit in constructing the Temporary Workstation table.

� For NW 4.x, NXPIPX uses the connection count as the upper limit in 
constructing the Temporary Workstation table.

Workstation Identification.  Each workstation thread stores information 
about connections and their network addresses in a Temporary Worksta
table.

With each network address, NXPIPX uses an IPX Diagnostics Service ca
retrieve the connection Component list. NXPIPX uses the Component lis
find connections that originate from workstations and to drop non-worksta
entries.

NXPIPX uses an SPX Diagnostics Service call to retrieve the IP mask an
MAC from the shell driver information for NWIP workstations.

NXPIPX uses CLIB APIs or SNMP queries to return a workstation-user 
name. Considering the configuration preference specified for the discove
workstation, NXPIPX can update a changed workstation-user name.
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NXPIPX adds newly discovered workstation information to the Workstati
list.

NXPIPX ignores unchanged information and updates changed information
workstations that the Workstation list already contains.

Status Update to NETXPLOR. NXPIPX reports new and updated 
workstations to NETXPLOR via IPC. After the thread assembles informat
discovered from a workstation, the thread constructs and delivers a data
packet, and then continues workstation discovery.

When the Workstation thread group is done, NXPIPX sets the workstatio
completion flag. The router and server thread groups use the workstation
completion flag to ascertain the global discovery state.

Data Packet Generation to NETXPLOR. If the router and server thread 
groups are completed when the workstation thread group is to be compl
NXPIPX sends a discovery completion packet to NETXPLOR to indicate 
completion of the global discovery process.

NXPLANZ.NLM

NXPLANZ.NLM communicates with NetWare LANalyzer Agent software t
gather information about nodes communicating on the segments that the 
software monitors. It also sends information about nodes to NetExplorer.

NETXPLOR.NLM

On the ManageWise Server, NETXPLOR.NLM communicates with 
NetExplorer Manager and with the discovery NLM files that are actively 
discovering network objects: NXPIPX.NLM, NXPIP.NLM, and 
NXPLANZ.NLM. 

NETXPLOR.NLM stores data in the sequential NETXPLOR.DAT file, whic
is stored on the ManageWise Server.

WANs

NetExplorer discovers the following network segments:

� Source-route bridged token rings
Processes/Features ���
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� LAN and WAN segment types

NetExplorer discovers the following LAN and WAN segment types:

� ATM 

� LAN: ARCNET*  

� LAN: FDDI 

� LAN: Ethernet 

� LAN: LocalTalk*

� LAN: Token Ring

� SMDS

� WAN: X25

� WAN: ISDN

� WAN: SDLC

� WAN: Serial

� WAN: PPP

� WAN: Frame-Relay

� WAN: TI

� WAN: T3

These values are discovered correctly if a system connected to the segm
responds with an interface type from MIB # RFC 1573.

Dial-Up

You can use NetExplorer over a dial-up connection to discover informatio
from any location on your network. Once the connection is made, it will 
��� LogicSource for ManageWise
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remain open as long as NetExplorer is running. To control costs, you ma
want to schedule discovery for night time or weekends when rates are lo

Adding Segments and Nodes

When NetExplorer is unable to completely discover your network, you ca
manually add segments and nodes to your network map. This is useful w
your network includes devices other than IP routers and IPX nodes, or w
you have a device that has been placed on the network but not yet disco
by NetExplorer.  

Adding the device manually lets you manage the new device immediatel
instead of waiting until NetExplorer discovers it.

Names of Discovered Nodes 

ManageWise displays the names of discovered nodes in maps, tables, a
dialog boxes.

Naming is a complex process. As discovery cycles proceed and more 
information arrives, the names displayed in ManageWise maps and othe
windows can change. Also, ManageWise gives different priorities to nam
depending on the source of the name information.

Name Source Priority. This section provides information about the priority
of name sources and some general statements about names displayed in
tables, and dialog boxes. Information applies to the final name displayed 
discovery is complete. 

The sources of name information and their priorities are shown in Table 19.

Table 19 Name Source Priorities

Source Priority Comments

User 1 Names you enter in the database take precedence over discovered 
names. NetExplorer Manager never changes a name you enter.
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General Information About Naming. The following are not rules, but 
general statements that might help you understand the names that 
ManageWise displays:

� NetExplorer never changes names of nodes you enter.

� Names shown in ManageWise maps and other windows are sensitiv
discovery order.

� The name of a workstation logged in to multiple servers under differe
usernames can alternate ("flip-flop") between the different username
you restart NETXPLOR.NLM.

The Location Unknown Segment. Most nodes that ManageWise discover
are immediately placed on the correct segment. However, if too little 
information arrives to identify a node, it appears in a special segment ca
LOCATION UNKNOWN. This segment contains certain partially defined 
nodes.

In some cases, ManageWise places nodes in the LOCATION UNKNOW
segment during the early discovery processes of the initial discovery cycle
relocates them to their correct segment when a later process provides 
additional information. 

Bindery 2 IPX server names are located in the server AUTOEXEC.NCF file; 
ManageWise obtains them through IPX diagnostic queries.

Logged-in or attached usernames are retrieved from NetWare 
Management Agent.

Service names are located in the bindery. Nodes send them in SAP 
packets.

MIB-II 2 If you do not configure the name in the MIB, NXPIP assigns a name 
of NONAME or IPRouter#n (where n is a unique integer).

NetWare 
Management

2 Discovered via the NXPIPX Agent.

ManageWise-created 
names

3 If NetExplorer cannot find a name, it creates a name using the MAC 
address of the system.

Source Priority Comments
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For example, when a router is configured to filter IPX diagnostic packets, 
IPX node on the other side of the router is placed in the LOCATION 
UNKNOWN segment.

ManageWise moves the following nodes from the LOCATION UNKNOW
segment to the correct segment if an IP or IPX address is discovered:

� NetWare for UNIX* servers 

� Portable NetWare servers

� Access servers

� Modem servers

� Print servers

You can move these nodes to the correct segment by configuring them w
the appropriate network address information.

Meaningful Map Names. If you configure router information (such as the 
system name and location) in the router’s SNMP MIB, ManageWise reco
it in the database, letting maps display meaningful IP router names. 

You can configure this information in the router’s MIB using any SNMP 
configuration tool, including the ManageWise SNMP MIB Browser.

NetExplorer Manager

NetExplorer Manager resides on each ManageWise Console machine. 
NetExplorer Manager updates the ManageWise Console database using
collected by the NetExplorer components, such as NXPIP.NLM on the 
ManageWise Server.

NetExplorer Manager performs the following tasks:

� Communicates with NETXPLOR.NLM to retrieve records from the 
NETXPLOR.DAT file. 

� Interprets these records. 

� Checks to see whether the node has already been discovered.
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� Uses a set of rules to determine any additional attributes of the discov
node.

� Generates NetExplorer alarms.

� Generates informational alarms during network discovery.

� Writes discovery information to the ManageWise database.

Figure 8 shows the operation of NetExplorer Manager. 

Figure 8 NetExplorer Manager

NetExplorer  Manager begins by establishing a connection to the Manage
Server. It then starts reading records from the NETXPLOR.DAT file, 
remembering the record number of the last record processed from the 
NETXPLOR.DAT file. 

If this reading process is interrupted because of scheduling or a broken 
connection, NetExplorer Manager begins reading records from the point 
where it left off when it reconnects to the ManageWise Server. However, if
NLM processes are restarted, the NETXPLOR.DAT file is recreated and 
NetExplorer Manager starts reading from the first record in the new file. 

When NetExplorer Manager retrieves a record from the ManageWise Se
it searches the database to determine whether the node referred to by th
record is in the database. If the node is not in the database, NetExplorer
Manager inserts it. 
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When NetExplorer Manager updates the database, it notifies Alarm Man
of the change. Alarm Manager records the change in the Alarm Log, and
marks maps as "Changed" in their window titles.  

NetExplorer Manager then looks for a rule in its rules table to help classify
node. If the node in the record matches one of the rules, NetExplorer Man
updates the database according to the rule. The rules help NetExplorer 
Manager make decisions, such as which icon should be used to display 
node on the maps.

NetExplorer Manager first applies rules that are permanently built in to 
ManageWise, and then applies rules that have been added by application
snap in to ManageWise, such as third-party applications.

Third-party rules are added to the NetExplorer Rules table by third-party
ManageWise applications to enhance NetExplorer discovery. The 
ManageWise Software Development Kit (SDK) provides a tool for editing
rules.

MAC-address rules define additional attributes for network objects within
MAC address range. For example, a built-in MAC-address rule specifies 
a MAC address with a prefix of 00-00-1B is a Novell network adapter. 
ManageWise predefines a large number of MAC-address rules.

Nodes for which few or no rules apply have the Unknown Node icon. If y
install third-party applications that update the rules after NetExplorer 
Manager has run, these new rules do not affect the database unless you 
the NetExplorer NLM processes. This causes NetExplorer Manager to 
reprocess records for all nodes on the network. 

ManageWise Btrieve Database

The ManageWise database stores information about all discovered devic
each segment of your network. The database also stores information ab
alarms that occur on the network.

The ManageWise database uses the Btrieve record management system
database consists of many Btrieve files (indicated by the file extension .B
stored in the \ManageWise\ManageWiseDB directory. These files contain
logged alarms; information ManageWise discovers about your internetwo
its segments, servers, routers, workstations, and other network objects; 
configuration information you enter about your network objects.
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ManageWise records incoming data in files in the 
\ManageWise\ManageWiseDB directory. 

The ManageWise software also comes with a \ManageWise\ENff-TYDB 
directory that contains "empty" files with the same names and definitions
the active data files in the \ManageWise\ManageWiseDB directory. Thes
files are not completely empty; that is, their length is not (and should not
zero bytes.

NOTE: Do not copy or delete database files manually. Use the Database 
Administration Tool, discussed in the next section, to maintain your 
database.

Database Structure 

The ManageWise database is based on a model of the network. The dat
structure reflects this model by describing the objects that make up the 
network and their relationships to each other. 

In addition to these objects, the database records information about alarms. 
Alarms are notifications about events that occur on a network.

The ManageWise database is created and maintained by ManageWise 
components. The files are in Btrieve record manager file format. You can
any application compatible with Btrieve to read the database tables.

Although you can read the ManageWise database with any Btrieve-
compatible application, you should never write to the ManageWise database
with any tool other than a ManageWise application or the ManageWise 
database application programming interface (API). (The database API is
defined in NetWare Management System Database Schema and Applica
Programming Interface in the NetWare Management System Software 
Development Kit.)

Writing to the database with tools other than ManageWise applications or
database API can cause the database to become inconsistent, damagin
usefulness of your network management data. 

Database Objects 

The ManageWise database is object-centered. This means it is organized 
around objects and their characteristics. The core concepts of an object-
centered database are objects, classes, and relationships.
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An object is an item in the database that represents something that exists 
real world. The database records information about this item. For example
ManageWise database records information about networks and the obje
that form the networks, such as PCs, cabling segments, and network ca

Each object has a unique identifier (ID) that the ManageWise database uses
identify the object in tables. The ManageWise database also uses uniqu
to identify alarms.

Objects and alarms are represented differently in the ManageWise datab
The ID numbers for objects and alarms are assigned sequentially when 
object or alarm instance is created. Thus, each object ID is unique amon
object IDs, and each alarm ID is unique among all alarm IDs. An alarm is
usually associated with a particular object in the database.

The characteristics of objects are called attributes. For example, network 
address is an attribute of a network, while cable type is an attribute of a 
segment.

Table 20 shows an example of a database object.

Table 20 Segment Object Example

Attribute Name Value

Dbflags 0

ID 12

Lockout FALSE

Name # C9901729 1.1.1.0 
159.30.80.59

flags 0

resourceDLL NULL

resourceID 0

manageable 0

discoveryTime 0

discoveryCycle 0
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Object Classes. A class is an abstract data type that represents a group o
objects that share certain characteristics. Each object in the database is
member of a class.

For example, the ManageWise database defines a class called Box. A Box is 
any discrete piece of hardware attached to a network, such as a PC works
or a network server. 

As a class, Boxes share certain characteristics, such as the way they are
attached to the network. However, each individual Box object within the B
class can differ from any other Box in certain ways, such as the type of 
hardware it is or the type of functions it provides on the network. Each 
instance of an object class also generally has a name that distinguishes it
other objects in the same class.

Some common ManageWise database classes are shown in Table 21.

Table 21 ManageWise Database Classes

datalinkType 2

protocols 16

cableType 0

user ID 0

comment

Class Explanation

User Individual person who should be contacted when a particular object needs 
maintenance.

Box Hardware box; for example, a workstation or server.

Functions Hardware and software capabilities provided by Box objects, such as hub 
functions, router functions, or server functions.

Segment Portion of a network that includes a physical cable and might include repeaters 
and hubs.

Attribute Name Value
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In the ManageWise database, each class is described in a separate table
classes are described in several tables; for example, the database contai
table for hub functions, one for NetWare server functions, and one for ro
functions. The database also contains a Generic table for functions or cla
of objects that are not predefined.

Depending on the applications you use with ManageWise, your copy of t
database might not contain all the classes described in this reference. In
addition, your copy of the database might contain classes not described in
reference.

Object Relationships. A relationship is a connection between two or more
object instances. Certain classes of object typically participate in certain t
of relationships with each other, and the ManageWise database stores 
information about these relationships. For example, on the network, box
contain devices such as network cards. These devices are connected to
network segments, which, in turn, make up the network.

The database reflects this. In the database, Boxes contain Devices and D
are connected to Segments, which are contained by Networks. Containm
or Ownership, and Connection are two of the relationships the ManageW
database records.

To define a relationship, the database associates the unique object IDs o
related objects, recording each object ID in a field in the appropriate tabl

For example, the Connect table defines Connect relationships. A Conne
goes from a Device object to a Segment object. So, the Connect table sh
the object ID of the Device in the fromID field, and the object ID of the 
Segment in the toID field.

Device Network interface object, such as an adapter card. Each Device is contained in 
(owned by) a Box object and is used to connect that Box to a Segment object.

Network Group of segments that use a single protocol, such as the Internetwork Packet 
Exchange (IPX) protocol. Segments within the same network are interconnected 
by bridges. Networks are logically interconnected by routers.

World Internetwork, such as an enterprise or a site network.

Class Explanation
Processes/Features ���

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

te 
ion 

ts 
d 
the 
the 

ap.

t for 
ny 

 
ain a 
e 

wo 
to 
from 
 the 
ct 

 
the 
the 
Relationships in the Database. Three relationships are recorded in separa
relationship tables within the database: the Connect relationship, the Locat
Owner relationship, and the Owner relationship.

� The Connect relationship defines connections between Device objec
(such as adapter cards) and Segments. Device objects are containe
within Boxes, while Segments are contained within Networks. Thus, 
Connect relationship ultimately shows how each Box object fits into 
network.

� The  Location Owner relationship defines the ManageWise custom m

When you create a custom map, the database creates a Page objec
each page in the map. Each Page becomes the Location Owner of a
objects you place on that Page. 

The custom map also uses Goto objects, which can point to either a
Segment, a Box, or another Custom Map Page. Each page can cont
symbol object that can contain a page. Pages and symbols define th
hierarchical structure of the custom map.

� The Owner relationship defines containment. 

In Figure 9 on page 115, the relationship (Connect) is named between the t
objects that are related (Segment and Device). On the line from Device 
Connect, the figure names the two fields in the database that record the 
part of the Connect relationship: the fromID field in the Connect table and
ID field in the Device table. Both of these fields contain the Device’s obje
ID.

Similarly, on the line from Connect to Segment, the figure names the two
fields that record the to part of the Connect relationship: the toID field in 
Connect table and the ID field in the Segment table, which both contain 
Segment’s object ID.
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Figure 9 How Figures Show the Connect Relationship

Not all relationships are defined in separate tables like the Connect table
Some other relationships that exist in the database are the relationship be
a NetWare server and the services it advertises (SAP objects); the relatio
between a Device, such as a network adapter card, and the frame types 
(Frame objects); and the relationship between objects and the users who
maintain them. These relationships are recorded directly in the relevant ta

For example, many object tables contain a user ID field to record the obj
ID of the user who should be contacted if the object needs maintenance
user’s object ID leads to a record in the User table that contains the user
name and contact information.

In the figures in this reference, relationships that are not recorded in sep
tables appear as in Figure 10, which shows the contact relationship between
Box and a User.

Figure 10 How Figures Show Direct Relationships

Owner Relationship. One object can be contained by another, like a piece
paper in a file folder. When one object contains another, the containing ob
is referred to as an owner or parent object, and the contained object is referre
to as a child. The relationship is referred to as the Owner relationship. 

The Owner relationship is key to the structure of the ManageWise datab
The ManageWise database views the network as a hierarchy, and every o
except the topmost object is owned by another object in the hierarchy. 
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For example, Boxes own Functions, which describe services available thr
a Box. Thus, a PC (a Box) that acts as a network router owns a Router 
Function in the database. The topmost object, which has no owner, is kn
as the Universe.

Although the ManageWise database can contain multiple instances of m
objects, it can contain only one Universe. The hierarchical Owner structu
allows the ManageWise database to describe complete groups of enterp
internetworks. The database defines each enterprise or company as a W
and records information about various Network objects within the World.

The Owner table records Owner relationships by associating the object ID
the parent and child objects. Because Owner relationships are so commo
figures in this reference use a shorthand to define them.

Figure 11 shows this shorthand. On the left, instead of showing the Owne
table between the two related objects and showing the parent and child f
on the connecting lines (as on the right), this figure uses a dotted line, lab
Owner, to connect the parent and child objects. The arrow on the line po
toward the child object.

Figure 11 How Figures Show the Owner Relationship

The Location Owner relationship is also a parent-child relationship, in wh
an object on the custom map, such as a Page, can own another object t
appears in that location on the map, such as a Box. The Location Owner
relationship is identical to the Owner relationship shown in Figure 11 on page 
116.

Data Types and Constants. Table 22 describes the data types used in the 
ManageWise database.
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Table 22 ManageWise Database Data Types

Type Name Type Size Description

BOOL short 2 MS Windows data type.

HARDWARE-TYPE short 2 Can have any of the following values:
100 NULL
101 OTHER

102 MACINTOSH
103 MAINFRAME
104 MINI

105 PC

BTRV_DATATYPE BYTE 1 Can have any of the following values:
0 STRING
1 INTEGER

2 FLOAT
3 DATE
4 TIME

5 DECIMAL
6 MONEY
7 LOGICAL

8 NUMERIC
9 BFLOAT
10 I-STRING 11 ZSTRING

14 UNSBINARY
15 AUTOINCREMENT

BYTE unsigned 1 char 

CABLE_TYPE short 2 Can have any of the following values:
0 OTHER

1 COAX
2 TWISTED PAIR
3 UNSHIELDED PAIR

4 FIBER OPTICS
5 THIN COAX
6 UNKNOWN

CHAR unsigned 1 char
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DATA-LINK-TYPE short 2 Can have any of the following values:
0 UNKNOWN DATA LINK
1 OTHER NETTYPE

2 ETHERNET 802.3
3 TOKENRING 802.5
4 FDDI

5 ARCNET
6 SERIAL
7 X25

8 PPP
9 ATM
10 ISDN

11 FRAME RELAY
12 DIALUP
13 56KB SERIAL

14 MDLC
15 SDLC
16 SMDA

17 SNA
18 T1
19 T3

20 LOCATION UNKNOWN
21 LOCAL TALK

DBCLASS short 2 Database class identifier.

DB-VERSION unsigned 4 Value indicating the version of the schema long 
implemented in this collection of tables; used in 
the Universe table.

DLLNAME char 14 Buffer for the name of the resource module (the 
length of the buffer is RES-DLL-NAME-LEN).

DWORD unsigned 4 MS Windows data type.

long

Type Name Type Size Description
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EQUIPMENT-TYPE short 2 Can have any of the following values:
0 UNKNOWN
1 BOX

2 DEVICE
3 DISK
4 DISK CONTROLLER

5 DISPLAY
6 DISPLAY ADAPTER
7 HUB

8 HUB FUNCTION
9 HUB GROUP
10 WSERVER

11 PRINT SERVER
12 PRINTER
13 ROUTER

EVENT-FAMILY short 2 Can have any of the following values:

0 NONE
1 SNMP
2 SNOOPER

EV-GDS LONG 4 Used to hold the alarm handler disposition code, 
as follows:

1 BEEP

2 LOG
3 EXECUTE
4 TICKER TAPE

EVENT-OBJID unsigned 4 Sequential number assigned to each alarm 
instance as long as it is created in the database.

EV-SEVERITY short 2 Can have any of the following values:
0 UNKNOWN

1 CRITICAL
2 MAJOR
3 MINOR

4 WARNING

Type Name Type Size Description
Processes/Features ���

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99
EVENT-STATE short 2 Can have any of the following values:
0 UNKNOWN
1 INOPERATIVE

2 DEGRADED
3 OPERATIONAL

EVENT-TYPE WORD 2 Enumeration used to distinguish events within an 
event family; it differs for each event family.

FRAME_TYPE DWORD 4 Can have any of the following values:
0 UNKNOWN
1 VIRTUAL LAN

2 LOCALTALK
3 ETHERNETII
4 ETHERNET 802.2

5 IBM TOKEN RING
6 ETHERNET 802.3
7 802.4

8 NOVELL PCN2
9 GNET
10 PRONET10

11 ETHERNET SNAP
12 IBM TOKEN RING SNAP
13 LANPAC 11

14 ISDN
15 NOVELL RX NET
16 IBM PCN2 802.2

17 IBM PCN2 SNAP
18 OMNINET 4
19 3270 COAXA

20 IP
27 SLIP
28 PPP

29 NETWARE IP
30 FDDI 802.2
31 FDDISNAP

32 OTHER

ERROR

Type Name Type Size Description
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ID unsigned 4 Sequential number assigned to each object 
instance that is created in the database.

LAN_TYPE short 2 Can have any of the following values:

0 OTHER
1 ETHERNET 802.3
2 TOKEN RING 802.5 4MB

3 TOKEN RING 802.5 16MB
4 ARCNET
5 FDDI

MAC-ADDR BYTE[6] 6 Array for MAC address.

NET-TYPE short 2 Can have any of the following values:

0 UNKNOWN
1 IP
2 IPX NET

3 IPX ADDR
4 INTERNAL NET NUMBER
5 APPLE TALK

6 OSI
7 DECNET
8 TOKENRING

9 IPX UNNUMBERED

NETWORK-ADDR struct General network address structure.

DWORD protocol

WORD length

NET-TYPE tag

BYTE address [24]

PREFERENCES DWORD 4 User preferences.

Type Name Type Size Description
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SYMBOL.TYPE short 2 Can have any of the following values:
0 NULL
1 COUNTRY

2 REGION
3 STATE
4 CITY

5 CAMPUS
6 BUILDING
7 FLOOR

8 OFFICE

Type Name Type Size Description
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TABLE short 2 Can have any of the following values:
-1 NULL-T
0 ATTACHED-T

1 BOX-T
2 CLASS-T
3 CONNECT-T

4 DEVICE-T
5 EQUIPMENT-T
6 EVENT COMMENT-T

7 EVENT SEVERITY-T
8 EVENT-T
9 EXTENDED ATTRIBUTE-T

10 FRAME-T
11 GENERIC-T
12 GOTO-T

13 HUB FUNCTION-T
14 HUB GROUP-T
15 HUB PORT T

16 HUBff
17 LEGCON-T
18 LOCATION OWNER-T

19 NETWORK-T
20 NWPRINT SERVER-T
21 NWSERVER-T

22 OBJECT RES-T
23 RESERVEl-T
24 OWNER-T

25 RMON-T
26 ROUTER-T
27 SAP-T

28 SEGMENT-T
29 SYMBOL-T
30 TEXT-T

31 TRAPJ
32 RESERVE2-T
33 USER-T

34 WALLPAPER-T
35 WORLD-T

Type Name Type Size Description
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TIMESTAMP DWORD 4 32-bit unsigned value representing the number of 
seconds elapsed since 00:00:00 GMT, January 1, 
1970.

TIMEZONE short 2 16-bit signed value representing the difference in 
minutes between GMT and local standard time. 
For  example, for the United States Pacific 
Standard Time  zone (PST), the value is 480 
(8*60).

WALLPAPER-
FORMAT

short 2 Can have any of the following values:
0 UNKNOWN
1 BITMAP

2 WFM
3 DRW
4 TIFF

5 EPS

Type Name Type Size Description
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TABLE short 2 Can have any of the following values: 
-1 NULL-T
0 ATTACHED-T

1 BOX-T
2 CLASS-T
3 CONNECT-T

4 DEVICE-T
5 EQUIPMENT-T
6 EVENT COMMENT-T

7 EVENT SEVERITY-T
8 EVENT-T
9 EXTENDED ATTRIBUTE-T

10 FRAME-T
11 GENERIC-T
12 GOTO-T 

13 HUB FUNCTION-T
14 HUB GROUP-T
15 HUB PORT-T

16 HUBff
17 LEGCON-T
18 LOCATION OWNER-T

19 NETWORK-T
20 NWPRINT SERVER-T
21 NWSERVER-T

22 OBJECT RES_T
23 RESERVEl-T
24 OWNER-T

25 RMON-T
26 ROUTER-T
27 SAP-T

28 SEGMENT-T
29 SYMBOL-T
30 TEXT-T

31 TRAPJ
32 RESERVE2-T 
33 USER-T

34 WALLPAPER-T
35 WORLD-T

Type Name Type Size Description
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Constants. Table 23 describes the constants used in the ManageWise 
database.

Table 23 Database Constants

Name Value Description

EV-GDS-BEEP 0X0001 Flag that causes an audible beep when an alarm 
occurs.

EV_GDS_LOG 0X0002 Flag that causes the alarms to be logged in the 
database.

EV-GDS-EXECUTE 0X0004 Flag that causes a program to be executed when an 
alarm occurs.

EV-GDS-TICKER-TAPE 0X0008 Flag that causes the alarm to be displayed in the 
status bar of the console.

FILENAME-STR 143 Drive, path, and filename, not to exceed 127 
characters.

GROUP_OBJID-LEN 64 Length of the group object.

INT-NET-NUMBER-LIEN 10 Length of an internal net number.

LOGIN-NAME-STR 48 Length of the login name.

MAC-ADDR-LEN 6 Length of a MAC address.

MAX-STR 255 Maximum string size, 255 characters maximum.

MED_STR 40 Medium string size, 40 characters maximum.

MODULE-NAME.LEN 8 Module name length.

NAME-STR 64 Name string size, 64 characters maximum, used for 
the name of a person or object instance.

NET–NUMBER_LEN 12 Length of a net number.

NET-PROTOCOL-UNKNOWN 0X0001 Unknown network protocol.

NET-PROTOCOL.IP 0X0002 IP protocol.

NET-PROTOCOL-ISO 0X0004 ISO protocol.

NET-PROTOCOLDEC 0X0008 DECnetTM  protocol.
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Network Model. The ManageWise database contains a number of predefi
classes and describes the relationships among these classes. The most
important classes in the model are UNIVERSE, WORLD, NETWORK, 
SEGMENT, BOX, and DEVICE. Also important are functions, which 
represent hardware and software capabilities.

NET-PROTOCOLJPX 0X0010 IPX protocol.

NET-PROTOCOLAPPLETALK 0X0020 AppleTalk protocol.

NET-PROTOCOLXNS 0X0040 XNSTM  protocol.

NET-PROTOCOLSNA 0X0080 SNA protocol.

NET-PROTOCOL-BANYAN 0X0100 BanyanTM  VinesTM  protocol.

NET-PROTOCOL_VINES 0X0100 Vines protocol.

NET-PROTOCOL.NET-BEUI 0X0200 NetBeui protocol.

NET_PROTOCOL_SMB 0X0400 SMB protocol.

NET-PROTOCOL-OTHER 0X0800 Other protocols.

OBJECT-ID-LEN 110 Maximum length of an object ID.

PF_BOLTED 1 Flags objects that cannot be repositioned on the 
custom map.

PHONE-STR 31 Phone number string size, 31 characters maximum.

REG_STR 80 Regular string size, 80 characters maximum.

RES_DLL.NAME-LEN 14 Length of the resource module name.

RESOURCE-IS_BITMAP 0XFFFF Flag indicating that a resource is a bitmap.

RESOURCEiS_ICON 0XFFFE Flag indicating that a resource is an icon.

SML_STR 20 Small string size, 20 characters maximum.

SUMMARY-LEN 169 Length of summary field.

TEXT-STR 255 Text string size, 255 characters maximum.

CLASS-NAME-STR 30 Length of the class name.

Name Value Description
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Each World object represents a local WORLD within the UNIVERSE. A 
World object can represent, for example, an enterprise, company, or othe
organization. The name of the World is set to the company name given w
you install ManageWise.

Each Network object represents a collection of segments. Each Network
object refers to a single protocol; for example, the IPX protocol. Network
using the same protocol can be logically interconnected by routers, while
segments within a network are interconnected by bridges.

A Segment object represents a portion of a network that includes a phys
cable and can include repeaters and hubs. A Segment object can be own
more than one Network object.

Connected to each Segment object are Device objects (also called netw
adapters or interfaces). Each Device object is contained in (owned by) a
object. Box objects represent any hardware item that is connected to a 
Segment object by some Device object.

In the ManageWise network model, the Box object is the central piece of
network. Thus, before discussing a diagram of the entire network, it is 
appropriate to discuss the Box model and how the network grows from it

Box Model. In the physical world, a network is made up of interconnected
hardware boxes. The ManageWise network model reflects this. 
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Figure 12 Network Hierarchy Above the Box Object

Below the Box object in the network hierarchy, each Box object can own
Functions that represent the software or hardware capabilities contained 
real-world box. For example, a Box that acts as a NetWare server owns 
NetWare Server Function, while a Box that acts as a hub owns a Hub Fun

Some of the Function classes Novell has defined are these: 

NetWare File Server

NetWare: Print Server 

Router: AppleTalk 

Hub: HML Router: IP

Router: IPX

NetWare: LANalyzer Agent, Bridge, and Terminal Server

Third-party ManageWise applications might define additional Function 
classes. Functions are represented as objects that are owned by a Box o
This duplication of information simplifies network navigation.

Figure 13 shows a Box that owns multiple functions.
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Figure 13 Network Hierarchy Below the Box Object

Entire Network Model.  To represent a complete network model, Figure 14 
combines the network hierarchy above the Box object with the hierarchy
below the Box object.
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Figure 14 Entire Network Model

This model of the network provides for multiple World objects contained 
within the single Universe object. Ownership rules are as follows: 

Each World object contains one or more Network objects. 

Each Network object is owned exclusively by one World object. 

Each Network object contains one or more Segment objects.

A Segment object can be owned by more than one Network object.

A Segment object owns one or more Box objects.

Each Box object must own at least one Device object that is connected t
Segment object that owns the Box object.
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A Box object can be owned by more than one Segment object. 

In this case, for each Segment object, the Box object must own at least o
Device object connected to that Segment object. 

For example, the Box shown in Figure 15 is owned by and connected to two
different Segment objects.

Figure 15 Entire Network Model

Table Description Conventions

Field Names. Each table contains a set of fields that describes the class, 
object, or relationship. Throughout the database, the following naming 
conventions are used for field names:

� In a field name that consists of multiple words, the words are run toge
and the second and subsequent words begin with uppercase letters,
boxType or protocolName.
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� Abbreviations such as ID, SAP, MIB, and DLL that are typically all 
uppercase are also uppercase in field names,  as in ID, linkID, or 
resource.DLL.

� Words are spelled out, except for the abbreviations listed in Table 24 on 
page 133 and the prefixes of the subfields of a network address. 

For a network address, the full name is abbreviated and the abbrevia
is used as a prefix to the subfields.  

� When a field refers to a field in another table, the name of the referri
field contains the name of the field referred to. 

For example, because the Frame table describes a frame associated
a particular device, two fields in the Frame table refer to fields in oth
tables. 

The deviceID field refers to the ID field in the Devicetable. Similarly, th
deviceclassID field, which describes the Class of the device, refers to
ID field in the Class table.

Table 24 Abbreviations Used in Field Names

Abbreviation Meaning

ID identifier

num number

equip equipment

info information

ack acknowledgment

attr attribute

TZ time zone

disp disposition

trans translator

comty community

rel relationship
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Subsequent sections in this chapter discuss the tables in more detail. In 
discussions, the following conventions apply:

� The database name of each table is given in parentheses in the head
the section that discusses the table. For example, in the section "Bo
Table (BOX-T)", BOX-T is the identifier of the Box table.  

� The fields in each table are described using three columns, as follow

� The Field Name column gives the name of the field in the data 
definition (.DDF) file. 

� The Field Type column gives the data type of the field. 

� The Description column gives further information about each fiel
In some fields, constants are used.

In the list of fields, a field name in boldface indicates that the field is an ind

A note in the Description column indicates whether the index is unique.

In each Object table, the object ID (ID field) is a unique index.

Database Tables 

The ManageWise database uses tables to record information about clas
objects, and relationships. These tables are structured to contain the 
information pertinent to the model of the network described in the OBJEC
DEVICE ID section “Database Structure” on page 110. The database consists
of the following types of tables.

Object tables. The Object tables contain data about the objects defined in
database.

The database contains a number of Object tables, each of which records
information about a particular object class. For each object, there is exac
one object instance in exactly one Object table. 

The object class M determines which of the Object tables contains the 
information about the object. For example, information about an object o
class BOX is recorded in the Box table. Thus, to find the attributes for a 
particular object, you must retrieve the record of that object from the 
appropriate Object table.
��� LogicSource for ManageWise

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

g 

 
hips 

l 
n 
, the 
 table 

rm 

tion 
s. One 

 class 

jects. 
.

ss. 
tes 

. 
 table 
e 
n 

lts 
which 
Relationship tables. The Relationship tables describe relationships amon
objects. To do this, a table records the object ID of each object in the 
relationship. For example, the Owner table contains the object IDs of the
parent and the child objects in an owner relationship. The Legal Relations
table describes what classes of objects can participate in specific entity 
relationships.

Extended Attribute tables. The Extended Attribute tables contain additiona
data for object instances. The Extended Attribute tables are used when a
attribute can have multiple values for a single object instance (for example
Frame and SAP tables) or when there is a need to add attributes to a given
(the Extended Attribute table).

Alarm tables. The Alarm tables record information about alarms. Most 
alarms are associated with an object in the database. The Alarm and Ala
Comment tables describe alarms.

Class tables. The Class tables represent relationships between or informa
about classes of objects. These tables describe how the database operate
such table is the Class table, which gives the mapping between an object
and the Object table that holds the attributes of that object.

The Connect table records relationships between Device and Segment ob
The Owner, Connect, and Location Owner tables are Relationship tables

Object Tables. Each Object table describes the objects in a particular cla
The tables give each object ID, name, and description, as well as attribu
specific to the object class.

Common Fields in the ManageWise Database. Each Object table begins 
with a group of common fields, which are summarized in the table below
These fields are in every Object table in the ManageWise database. Each
also contains a unique set of fields, following the common fields, that giv
attributes specific to the class of objects the table describes. The commo
fields are listed in Table 25 on page 136.

Null values in the resourceDLL and resourceID fields indicate that defau
are used. The defaults are determined by the object class and subclass (
is specific to the class).
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Table 25 Fields Common to All Database Object Tables

The ManageWise database contains the Object tables shown in Table 26.

Table 26 List of Object Tables

Field Name Field Type Description

dbflags WORD Used internally by the database API.

ID ID Object ID of the object instance; unique index for 
all object tables.

lockout BOOL Lock out automatic update (set by user).

name CHAR[NAME_STR+1] Name of this instance of the object, constrained to 
be NAME-STR characters long.

flags DWORD In the Goto, Symbol, Text, and Wallpaper tables: 
flags used by applications to determine whether 
an object can be moved on the custom map:

 * 0 indicates the object is mobile

 * 1 (BOLDED) indicates the object cannot be 
moved

resourceDLL DLLNAME Resource filename. If the resourceDLL is the 
filename of an icon file, the resourceID value must 
be -2. If the resourceDLL is the filename of a 
bitmap file, the resourceID value must be -1.

resourceID WORD Resource ID of the resource.

manageable DWORD Manageable bit field. Still in table, but not used 
(obsolete).

discoveryTime DWORD Most recent update time.

discoveryCycle DWORD Discovery tag.

Table Description

Box Describes attributes of hardware that is connected to a Segment; for example, a 
workstation or server.

Device Describes characteristics of network interface objects, such as adapter cards.
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Other Object tables might exist in your database, depending on your 
ManageWise configuration.

Box Table (BOX-T). The Box Table describes attributes of nodes such as 
workstations and servers.

This table lists the unique fields in the Box table. Common fields, which 
appear before the unique fields, are described in Table 25 on page 136.

Equipment Describes attributes of a type of equipment, either hardware or software.

Generic Used for objects that do not fit in the other classes. For example, a ManageWise-
compatible application, whether developed by Novell or by another vendor, might 
use the Generic table to add information to the ManageWise database.

GoTo Contains a Goto object, which is used in custom maps for navigation purposes. 
It points to a Segment, a World, or a Custom Page.

Hub Function Records hub functions that exist within Box objects.

Network Records network types and network numbers.

NetWare Server Describes NetWare server functions that exist within Box objects.

NetWare Print Server Describes print server functions that exist within Box objects.

Router Describes various router functions that exist within Box objects.

Segment Records the attributes of each network segment.

Symbol Records the attributes of Bitmap, Icon, or Page objects.

Text Describes strings that can be placed on a page within the custom map.

User Gives information about contact persons.

Wallpaper Records information about user-supplied files that contain bitmaps.

World Records the name of the world. The name is set to the company name you give 
when you install ManageWise.

Other Object tables might exist in your database, depending on your ManageWise 
configuration.

Table Description
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Table 27 Box Table (BOX-T)

Field Name Field Type Description

boxType BOX-TYPE Subclass that identifies the kind of Box. This field 
is calculated from the primaryFunction and 
hardwareType.

boxState DWORD Current state of the box; values defined by 
application using this field.

functionFlags DWORD Flags indicate the presence of a function. Still in 
the table, but will be made obsolete.

Internal NetworkNumber NETWORK-ADDR Network number; a network address structure 
made up of multiple fields, as shown. The index is 
defined on the combination of the !Tag and 10 
through 111 fields.

iProtocol DWORD

Length WORD

iTag NET_TYPE

iO BYTE

ill BYTE

i23 BYTE

equipID ID Object ID from the Equipment table, which 
contains information about the manufacturer and 
model of the Box object.

userID ID Object ID of primary person (user) to contact 
about this Box; must be null or an object ID listed 
in the User table. Secondary contacts can be 
stored in the Extended Attribute Table.

comment CHAR[TEXT-STR+1] User-defined comment. Made up of multiple 
fields, as shown.

comment0 CHAR[128]

commentl CHAR[128]

busType CHAR[SML-STR+1] User-defined field.
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Figure 16 on page 140 shows how the Box table and other database tables
interrelate.

NetExpResDLL DLLNAME Name that the NetExplorer finds for the icon.

NetExpResID WORD ID that NetExplorer finds for the icon.

primaryFunction WORD Class ID of the primary function owned by the 
Box.

hardwareType WORD Hardware type of the Box.

extFunctionF DWORD[3] Flag that indicates presence of a function. 
Augments functionFlags above. This field will be 
made obsolete. Made up of multiple fields, as 
shown.

extFunctionF0 DWORD

extFunctionFl DWORD

extFunctionF2 DWORD

Field Name Field Type Description
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Figure 16 Box Relationship Tree

Device Table (DEVICE-T). The Device table describes characteristics of 
network interface objects such as adapter cards. Each Device object is o
by a Box object and connected to a Segment object.

Table 28 lists the unique fields in the Device table.

Table 28 Device Table (DEVICE-T)

Field Names Field type Description

machineAddress MAC-ADDR Machine address of this device; a non-unique index 
made up of 6 bytes, as shown.

mo BYTE
��� LogicSource for ManageWise

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

s 

utes 

ot 
 the 
Equipment Table (EQUIPMENT-T). The Equipment table describes attribute
of a type of equipment, either hardware or software. 

For example, the equipID field in the Box table refers to an entry in the 
Equipment table. The Equipment entry then describes the hardware attrib
of the Box object.

Table 29 lists the unique fields in the Equipment table.

Table 29 Equipment Table (EQUIPMENT-T)

Generic Table (GENERIC-T). The Generic table is used for objects that do n
fit in the other classes. An application can tailor the size and structure of
data field for its own use. 

Table 30 lists the unique fields in the Generic table.

ms BYTE

control WORD Reserved for future use.

lineSpeed CHAR[MED_ATR+1] User-defined text describing the device line speed.

protocols DWORD Bits indicating the presence of a protocol.

equipID ID Equipment manufacturer and model object ID; must be 
null or an object ID listed in the Equipment table.

reserved CHAR(30) Reserved for future use.

Field Name Field Type Description

equipType WORD Identifies the type of equipment; an administered value; 
a non-unique index.

manufacturer CHAR[NAME.ATR+1] Manufacturer of the hardware or software.

model CHAR[SML-STR+1] Model number of the hardware or software.

reserved CHAR[31] Reserved for future use.

Field Names Field type Description
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Table 30 Generic Table (GENERIC-T)

Goto Table (GOTO-T). The Goto table points to a Page, Segment, or Worl
object to move to when navigating within the custom map. 

Table 31 lists the unique fields in the Goto table.

Table 31 Goto Table (GOTO-T)

Hub Function Table (HUB-FUNCTION-T). The Hub Function table records 
hub functions that exist within Box objects. Hub functions are updated on
by ManageWise hub-management services. 

Table 32 lists the unique fields in the Hub Function table.

Table 32 Hub Function Table (HUB-FUNCTION-T)

Field name Field Type Description

ClassID DBCLASS Class of the object; a non-unique index.

Reserved CHAR[21] Reserved for future use.

datal-en WORD Length of the data field.

Data CHAR[TEXT STR+1] Unspecified data dependent upon classID. Made up of 
multiple fields, as shown.

DataO CHAR[128]

Datal CHAR[l 28] Note: This field can be bigger than 256 bytes.

Field Name Field Type Description

gotoID ID Object ID of object to go to; a non-unique index.

gotoClassID DBCLASS Class of object to go to.

reserved CHAR[21] Reserved for future use.

Field Name Field Type Description

SAPNumber WORD SAP number that corresponds to the type of hub 
providing the hub function.
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Network Table (NETWORK-T). The Network table records network types an
network numbers. 

Table 33 lists the unique fields in the Network table.

Table 33 Network Table (NETWORK-T)

status DWORD Whatever bits the application uses for status.

maxHubs WORD Maximum number of hubs allowed for this cluster.

supportedMIBs DWORD MIB groups supported by this cluster.

version CHAR[SML_STR+1] Version of the function.

controlComty CHAR[SML-STR+1] Supervisor access string for SNMP.

trapComty CHAR[SML_STR+1] Public access string for SNMP.

monitorComty CHAR[SML.STR+1] Monitor access string for SNMP.

equipID ID Object ID for equipment manufacturer and model of the 
main box. Must be null or an object ID listed in the 
Equipment table.

userID ID Object ID of person to contact about this hub; must be 
null or an object ID listed in the User table.

reserved CHAR[31] Reserved for future use.

Field Name Field Type Description

networkNumber NETWORK-ADDR Network number; a network address structure made up 
of multiple fields, as shown. The index is defined on the 
combination of the nnTag and nn0 through nnll fields.

nnProtocol DWORD

nnLength WORD

nnTag NET - TYPE

nn0 BYTE

nnll BYTE
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NetWare Server Table (NWSERVER-T). The NetWare Server table describes
NetWare Server Functions. A NetWare Server Function is contained in a 
object; this relationship must be listed in the Owner table. This table lists
unique fields in the NetWare Server table.

Table 34 NetWare Server Table (NWSERVER-T)

nn23 BYTE

netMask NETWORK_ADDR Network mask; a network address structure made up of 
multiple fields, as shown.

maskProtocol DWORD

maskLength WORD

maskTag NET-TYPE

mask0 BYTE

mask23 BYTE

reserved CHAR[23] Reserved for future use.

Field Name Field Type Description

equipID ID Object ID for manufacturer and model number of 
software that provides this function. Must be null or an 
object ID listed in the Equipment table.

version CHAR[SML-STR+1] Version of the function.

userID ID Object ID of person to contact about this NetWare 
server; must be null or an object ID listed in the User 
table.

data CHAR[256] Unspecified data. Made up of multiple fields, as shown.

dataO CHAR[128]

datal CHAR[128]

reserved CHAR[26] Reserved for future use.

Field Name Field Type Description
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Figure 17 NetWare Server Function Relationship Tree

NetWare Print Server Table (NWPRINT-SERVER-T). The NetWare Print 
Server table describes Print Server Functions. A Print Server Function is
contained in a Box object; this relationship must be listed in the Owner ta

Table 35 lists the unique fields in the NetWare Print Server table.

Table 35 NetWare Print Server Table (NWPRINT-SERVER-T)

Field Name Field Type Description

EquipID ID Object ID for manufacturer and model number of 
software that provides this function. Must be null or an 
objectID listed in the Equipment table.

Version CHAR[SML.STR+1] Version of the function.

UserID ID Object ID of person to contact about this print server; 
must be null or an object ID listed in the User table.

Data CHAR[TEXT-STR+1] Unspecified data. Made up of multiple fields, as shown.

Data0 CHAR[128]

Data1 CHAR[l 28]
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Router Table (ROUTER-T.) The Router table describes various Router 
Functions.

Table 36 lists the unique fields in the Router table.

Table 36 Router Table (ROUTER-T)

Router Functions are owned by Box objects, as shown in Figure 18.

Comment CHAR[256] User-defined comment. Made up of multiple fields, as 
shown.

Comment0 CHAR[128]

Comment1 CHAR[128]

Reserved CHAR[26] Reserved for future use.

Field Name Field Type Description

routerClassID DBCLASS Type of router.

protocols DWORD Reserved for future use.

equipID ID Object ID for manufacturer and model number of 
software that provides this function. Must be null or an 
object ID listed in the Equipment table.

userID ID Object ID of person to contact about this router; must be 
null or an object ID listed in the User table.

reserved CHAR[25] Reserved for future use.

Field Name Field Type Description
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Figure 18 Router Function Relationship Tree

Segment Table (SEGMENT-T). The Segment table records the attributes of
each network segment. Each Segment object is owned by a Network ob

Table 37 lists the unique fields in the Segment table.

Table 37 Segment Table (SEGMENT-T)

Field Name Field Type Description

datalinkType DATA-LINK-TYPE Type of network.

protocols DWORD Reserved for future use.

cableType CABLE-TYPE Type of cable used on the segment.

userID ID Object ID of person to contact about this network 
segment; must be null or an object ID listed in the User 
table.

comment CHAR(TEXT-STR+1] User-defined comment. Made up of multiple fields, as 
shown.

commento CHAR[128]

commentl CHAR[128]

reserved CHAR[27] Reserved for future use.
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Symbol Table (SYMBOL-T). The Symbol table records the attributes of Icon
and Page objects in the custom map. An Icon object is an object of class
SYMBOL with a symbol type that is not null. A Page object has a null sym
type.

Table 38 lists the unique fields in the Symbol table.

Table 38 Symbol Table (SYMBOL-T)

Text Table (TEXT-T). The Text table describes strings that can be placed o
Page within the custom map. 

Table 39 lists the unique fields in the Text table.

Table 39 Text Table (TEXT-T)

User Table (USER-T). The User table gives information about contact 
persons. 

Field Name Field Type Description

size POINT Object size. Made up of multiple fields, as shown.

sizeX INT Horizontal.

sizeY INT Vertical.

symbolClassID DBCLASS Class of symbol: Symbol or Page; a non-unique index.

symbolType SYMBOL-TYPE Type of symbol. One of the defined symbol type 
constants (SYMBOL-TYPE).

reserved CHAR[31] Reserved for future use.

Field Name Field Type Description

text CHAR[TEXT-STR+1] Text displayed on custom map. Made up of multiple 
fields, as shown.

text0 CHAR[128]

textl CHAR[l 28]

reserved CHAR[23] Reserved for future use.
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Table 40 lists the unique fields in the User table.

Table 40 User Table (USER-T)

Wallpaper Table (WALLPAPER-T). The Wallpaper table records information
about user-supplied files that contain bitmaps or other graphical objects 
are displayed in ManageWise maps. 

Table 41 lists the unique fields in the Wallpaper table.

Table 41 Wallpaper Table (WALLPAPER-T)

Field Name Field Type Description

phone CHAR[MEO-STR+1] Telephone number of user.

location CHAR[REG-STR+1] Location of user.

title CHAR[MED-STR+1] Job title of user.

comment CHAR[TEXT-STR+1] User-defined comment. Made up of multiple fields, as 
shown.

comment 0 CHAR[128]

commentl CHAR[128]

reserved CHAR[20] Reserved for future use.

Field Name Field Type Description

size POINT Object size. Made up of multiple fields, as shown.

sizeX INT Horizontal.

sizeY INT Vertical.

format WALLPAPER-
FORMAT

Format of the wallpaper file: BMP, WMF, DRW, TIFF, 
and so on.

file CHAR[FILENAME-
STR+1]

Name of file containing wallpaper.

reserved CHAR[17] Reserved for future use.
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World Table (WORLD-T). The World table records information about World
within the Universe.

Table 42 lists the unique fields in the World table.

Table 42 World Table (WORLD-T)

Relationship Tables. The Relationship tables describe relationships among
objects. The database contains the Relationship tables described in Tab

Table 43 Relationship Tables

Owner Table (OWNER-T). The Owner table is the most important table in th
database. It defines most of the relationships between database objects

Field Name Field Type Description

slaveAddress NETWORK_ADDR Slave address associated with the World object; a 
network address structure made up of multiple fields, as 
shown.

saProtocol DWORD

sal-ength WORD

saTag NET-TYPE

saO BYTE

sa23 BYTE

serverl-landle WORD Indicates an execution instance of the NetExplorer NLM 
application.

reserved CHAR(23) Reserved for future use.

Table Description

Owner Defines the parent-child relationship between object instances.

Connect Defines links between Segments and Devices.

Location Owner A parallel table to the Owner table. It records the relationships defined by the 
custom map.
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An application can be guaranteed of the following structure: all object 
instances, except for the single instance of a Universe class, participate 
child of at least one object in either the Owner relationship or the Locatio
Owner relationship. Pairings in the Owner table must be permitted by en
in the Legal Relationships table.

Table 44 shows Owner relationships in the network model: the Universe 
object owns the World object, the World object owns the Network object, 
Network object owns the Segment object, and so on.

Table 44 Owner Table (OWNER-T)

Connect Table (CONNECT-T). The Connect table defines links between 
Segment and Device objects. A Device object can be connected to only 
Segment object. 

Field Name Field Type Description

dbFIags WORD Used internally by the database API.

parentID ID Object ID of the containing object; a non-unique index.

parentClassID DBCLASS Object class of the containing object.

childID ID Object ID of the contained object; a non-unique index.

childClassID DBCLASS Object class of the contained object.

position POINT Position. Still in table, but unused (obsolete).

PosX INT Horizontal.

PosY INT Vertical.

promote BOOL Reserved for future use.

hide BOOL Reserved for future use.

X coord DWORD Horizontal position.

Y coord DWORD Vertical position.

reserved CHAR[l 8] Reserved for future use.
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For Box objects that own multiple Device objects, the Connect table defi
which Device object is physically connected to which Segment object.

A Connect relationship is a directional relationship, in which data moves fr
one object to another in one direction only. The fromID and toID fields in 
Connect table define the starting and ending points, and thus define the 
direction of the Connect relationship.

The linkID and linkClassID fields can be used to provide additional 
information about the type of connection. These fields are currently unus

Table 45 shows Connect relationships in a Router Function Relationship T

Table 45 Connect Table (CONNECT-T)

Location Owner Table (LOCATION-OWNER-T). Like the Owner table, the 
Location Owner table defines a distinct parent-child relation between obj
instances. The Location Owner table records the relationships defined b
custom map.

Table 46 Location Owner Table (LOCATION-OWNER-T)

Field Name Field Type Description

dbFlags WORD Used internally by the database API.

linkID ID Object ID of the link object; a non-unique index.

linkClassID DBCLASS Object class of the link object.

fromID ID Object ID of the from object; a non-unique index.

from0lassID DBCLASS Object class of the from object.

toID ID Object ID of the to object; a non-unique index.

toClassID DBCLASS Object class of the to object.

resrved CHAR[28] Reserved for future use.

Field Name Field Type Description

dbFIags WORD Used internally by the database API.
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Figure 19 shows Locational Owner relationships in a Custom Map 
Relationship Tree.

parentID ID Object ID of the containing object; a non-unique index.

parentClassID DBCLASS Object class of the containing object.

childID ID Object ID of the contained object.

childClassID DBCLASS Object class of the contained object.

position POINT Position. Still in table, but not used (obsolete).

PosX INT Horizontal.

PosY INT Vertical.

flags DWORD Flags used by application.

X coord DWORD Horizontal position.

Y coord DWORD Vertical position.

reserved CHAR[l 8] Reserved for future use.

Field Name Field Type Description
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Figure 19 Custom Map Relationship Tree

Extended Attribute Tables. The Extended Attribute tables contain additiona
data for object instances. The database includes the Extended Attribute t
described in Table 47.

Table 47 Extended Attribute Tables

Table Description

Extended Attribute Associates an attribute with an object. This table is extensible.

Frame Contains Frame records, which are extended attributes for Device objects.

Information in the table includes the frame type and protocol address of the 
device.

SAP Lists the SAP numbers (representing services) that a server has advertised.

The Extended Attribute tables are used when an attribute can have multiple 
values for a single object instance (for example, the Frame and SAP tables) or 
when there is a need to add attributes to a given table (the Extended Attribute 
table).
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Extended Attribute Table (EXTENDED-ATTRIBUTE-T). Table 48 shows the 
Extended Attribute table, which associates an attribute with an object. Th
attribute is identified by name. 

The mapping between attrName and the dataType and dataLength occu
each extended attribute record. These values are assumed to be consis
within the database. That is, all the extended attribute records with a giv
attrName have the same dataType and dataLength.

Table 48 Extended Attribute Table (EXTENDED-ATTRIBUTE-T)

Extended attributes are currently used by the Configuration subsystem t
contain additional Box attributes. These attributes are as follows:

RAM specifies the amount of memory installed on a network node. 

OPERATING SYSTEM specifies the operating system used on the node

OPERATING SYSTEM VERSION specifies the version of the operating 
system. 

Field Name Field Type Description

dbF1ags WORD Used internally by the database API.

relatedID ID Object with which this attribute is associated; a non-
unique index.

relatedClassID DBCLASS Object class of the associated object; a non-unique 
index.

attrName CHAR[SML-STR+1] Attribute name.

dataType BTRV-DATATYPE Btrieve data type of the value field.

data-length WORD Length of the value field.

value CHAR[TEXT_STR+1] Attribute value. Made up of multiple fields, as shown.

valueO CHAR[128]

valuel CHAR[128]

reserved CHAR[32] Reserved for future use.
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DISK CAPACITY specifies the total disk capacity of a node.

In addition, multiple secondary contacts for Segment objects are stored in
Extended Attribute table.

The Extended Attribute table is extensible, allowing it to be used for 
additional attributes as the need arises.

Table 48 on page 155 lists the currently used extended attribute names. It do
not show the dbFiags, relatedID, dataLength, value, and reserved fields.

Table 49 Extended Attribute Names and Data Types

Frame Table (FRAME-T). Frame records are extended attribute records fo
Device objects. Each Frame record specifically contains the frame type an
address. Because a Device object can have an unspecified number of 
addresses, the Frame record permits an unlimited number of addresses 
each Device object.

relatedClassID attrName dataType

BOX CPU BTRV-DT-ZSTRING

BOX Contact BTRV-DT_ZSTRING

BOX Disk BTRV-DT_ZSTRING

BOX Display BTRV-DT-ZSTRING

BOX Last Serviced BTRV-DT-ZSTRING

BOX OS BTRV-DT_ZSTRING

BOX RAM BTRV-DT_ZSTRING

BOX NetWare Component BTRV-DT-ZSTRING

DEVICE Other Address BTRV-DT-ZSTRING

SEGMENT Contact BTRV_DT_ZSTRING
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Table 50 Frame Table (FRAME-T)

Table 51 NIMS Database

Field Name Field Type Description

dbFlags WORD Used internally by the database API.

deviceID ID Object ID of the associated Device object; a non-unique 
index.

deviceClassID DBCLASS Object class of the source object.

frame CHAR[REG-STR+1] Describes the type of hardware used to pass data to the 
network; entered by the user who configures the Device 
object.

frameType FRAME-TYPE Specifies how the data is framed before it is placed on 
the network; a non-unique index.

networkAddress NETWORK_ADDR Network address; a network address structure made up 
of multiple fields, as shown. The index is on the 
combined fields naTag and naO through nall.

naProtocol DWORD

naLength WORD

naTag NET-TYPE

naO BYTE

nall BYTE

na23 BYTE

protocolID BYTE[6] Reserved for future use.

protocolIDO BYTE

protocolID5 BYTE

Field Name Field Type Description

protocolName CHAR[REG-STR+1] Reserved for future use.

protocolInfo CHAR[REG-STR+1] Reserved for future use.
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SAP Table (SAP-T). The SAP table lists the SAP numbers that servers hav
advertised. Each SAP number represents a service that a server offers. 
Multiple SAP records can have the same server object ID, which indicates
each of the SAP numbers has been discovered on that server.

Table 52 SAP Table (SAP-T)

Alarm Tables. The Alarm tables record information about alarms. Each ala
is associated with an object in the database. The alarm tables in the curr
schema are described in Table 53.

Table 53 Alarm Tables

Alarm Table (EVENT-T). The Alarm table contains one record for each logg
alarm. A unique identifier, ID, is assigned to each alarm when it is written
the Alarm table. Each Alarm record consists of the unique identifier num
and the attributes associated with the alarm.

reserved CHAR[27] Reserved for future use.

Field Name Field Type Description

dbFlags WORD Used internally by the database API.

boxID ID Associated Server object; a non-unique index.

boxClassID DBCLASS Object class of the Server object.

SAPNumber WORD Associated SAP number; a non-unique index.

numinstances WORD Number of instances of this SAP.

reserved CHAR[20] Reserved for future use.

Table Description

Alarm Lists every alarm that has been logged in the system. Each alarm is identified 
with a unique alarm ID, which is used throughout the system to refer to the alarm.

Alarm Comment Adjunct to the Alarm table. Contains comments users have entered about 
alarms.

Field Name Field Type Description
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Table 54 Alarm Table (EVENT-T)

Field Name Field Type Description

dbFlags WORD Used internally by the database API.

ID EVENT-OBJID Alarm ID of alarm; unique index.

alarmFlags WORD Flags used by Alarm Manager.

ackTime TIMESTAMP Time when user acknowledged alarm.

ackTZ WORD Reserved for future use.

ack1Flag BYTE 1 if the alarm has been acknowledged, 0 
otherwise; unique index.

family EVENT FAMILY Family of this alarm type.

alarmType EVENT-TYPE Unique value describing the type of the alarm.

affectedID ID Object ID of the affected object; unique index.

affectedClassID DBCLASS Class of the affected object.

affectedType WORD Type of the affected object.

transModule CHAR[MODULE_NAME
-LEN]

Name of the alarm translator module.

state EV-STATE State of the affected object.

globalDisp EV_GDS Global disposition.

severity EV-SEVERITY Severity of the alarm.

agentAddress NETWORK-ADDR Address of object that generated the alarm; a 
network address structure made up of multiple 
fields, as shown.

aaProtocol DWORD

aaLength WORD

aaTag NETffYPE

aaO BYTE

aa23 BYTE
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NOTE: This field might be bigger than 128 bytes.

Alarm Comment Table (EVENT-COMMENT-T). The Alarm Comment Table 
contains optional user comments associated with particular alarms. Beca
the comment field is optional, it is stored in a separate table to conserve s

agentTime TIMESTAMP Time when the agent reported the alarm.

agentTZ WORD Reserved for future use.

transAddress NETWORK-ADDR Address of the alarm translator for the alarm; a 
network address structure made up of multiple 
fields, as shown.

transProtocol DWORD

transLength WORD

transTag NET-TYPE

transO BYTE

trans23 BYTE

transTime TIMESTAMP Time when the alarm was received by the alarm 
translator.

transTZ WORD Reserved for future use.

summary CHAR[SUMMARY-LEN] String describing the event; must be null 
terminated; typically includes a description of the 
event and the name of the affected object.

short

detail-length WORD Length of the detail variable-length data field.

detail CHAR[128] Variable data, which gives information about the 
event in a format specific to the event family.

Field Name Field Type Description
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Table 55 Alarm Comment Table (EVENT-COMMENT-T)

Class Tables. The Class tables define relationships between classes of ob
and alarms. These tables are read-only under typical operating conditions
are written to only when a new application is integrated into ManageWise a
needs to create a new Class.

The database includes the Class tables described in Table 56:

Table 56 Class Tables

Class Table (CLASS-T). Each object in the database must belong to exactl
one object class. 

The attributes of an object are described in an Object table. (See Table 26 on 
page 136 for a list of Object tables.) The Object table that contains the 
attributes for a particular object class is determined by looking up the clas
the Class table.

The Class table is also responsible for keeping track of legal class values.
class must have an entry in the Fields table. The Class table is small and
cached by the database subsystem. 

Field Name Field Type Description

dbFlags WORD Used internally by the database API.

alarmID EVENT-OBJID Alarm ID of alarm; unique index.

comment CHAR[255] User comments.

Table Description

Class Table of cross-references. Each cross-reference defines the table that contains 
the attributes for an object class.

Object Resource Table of cross-references. Each cross-reference defines the resource required to 
display a class and type. This table is mostly used for a BOX and BOX-TYPE 
pair, but has been generalized for use in other classes. This table is also cached 
by the database subsystem. The database API provides access to this table.

Legal Relationships Defines the object classes that are permitted to participate in each type of 
relationship.
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In the table, a notation of 1 indicates that no instances of these classes a
written to the database. 

Table 57 Class Table (CLASS-T)

Table 58 shows the Class table for the schema described in this reference.
table shows only the name, display name, and attrTable fields.

Table 58 Class Table Example

Field Name Field Type Description

dbFlags WORD Used internally by the database API.

ID DBCLASS Object class; unique index.

name CHAR[CLASS_NAME-
STR+1]

Name of class; consistent internal name.

displayName CHAR[CLASS-NAME-
STR+1]

Display name of class.

attrTable TABLE Associated attribute table.

boxType BOX-TYPE Box type associated with class.

bitNum WORD Function bit number associated with the class.

Name Display Name Object Table (attrTable)

Adapter Adapter GENERIC-T

Router: AppleTalk Router: AppleTalk ROUTER-T

Box Box BOX-T

Bridge Bridge ROUTER-T

CPU CPU 1 GENERIC-T

Device Device DEVICE-T

Disk Disk 1 GENERIC-T

Equipment Equipment EQUIPMENT-T
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File Service File Service GENERIC-T

File System File System GENERIC-T

Go To Symbol GoTo Symbol GOTO-T

Hub Equipment Hub Equipment HUB-T

Hub: HMI Hub: HMI HUB_FUNCTIONJ

Hub Group Hub Group HUB_GROUPff

Hub Port Hub Port HUB-PORT T

Router: IP Router: IP ROUTERJ

Router: IPX Router: IPX ROUTERJ

Link Link 1 GENERIC-T

Network Network NETWORK-T

Network Hub Network Hub GENERIC-T

Print Server NetWare: Print Server NWPRINT-SERVER-T

NetWare Server NetWare: File Server NWSERVER-T

NetWare Users NetWare Users GENERIC-T

OS Number OS Number GENERIC-T

Page Class Page Class SYMBOIJ

Print Queue Print Queue GENERIC-T

Ram RAM GENERIC-T

NetWare LANalyzer Agent NetWare: LANalyzer Agent GENERIC-T

Segment Segment SEGMENT-T

Symbol Symbol SYMBOL-T

Terminal Server Terminal Server GENERIC-T

Text Text TEXT-T

Name Display Name Object Table (attrTable)
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Object Resource Table (OBJECT-RES-T). The Object Resource table maps 
class or subclass to a resource filename and resource ID. This allows th
display of objects on the screen to be more flexible. The database API 
provides access to information in the Object Resource table.

Table 59 Object Resource Table (OBJECT-RES-T)

Universe Universe UNIVERSE-T

User User USER-T

Volume Volume GENERIC-T

Wallpaper Wallpaper WALLPAPER-T

World World WORLD-T

Router: Other Router Other ROUTER-T

Hub: Other Hub: Other GENERIC-T

Logged-in User Logged-in User GENERIC-T

Connection Connection 1 GENERIC-T

Installed Software Installed Software GENERIC-T

Open File Open File GENERIC-T

MSL MSL 1 GENERIC-T

Bound Protocol Bound Protocol GENERIC-T

Network Interfaces Network Interfaces GENERIC-7

NLM NLM 1 GENERIC-T

NetWare System NetWare System GENERIC-T

NetWare Volume NetWare Volume GENERIC-T

Field Name Field Type Description

dbFlags WORD Used internally by the database API.

Name Display Name Object Table (attrTable)
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Legal Relationships Table (LEGCON-T). The Legal Relationships table 
defines which classes of objects can participate in legal relationships.

Table 60 Legal Relationships Table (LEGCON-T)

class ID DBCLASS Object class; the index is the combination of two fields: 
this field and subClass.

subClass WORD Undefined subClasstype; the meaning of this field 
depends on the class.

resourceDLL DLLNAME Resource filename.

resourceID WORD Resource ID of the resource.

reserved CHAR[26] Reserved for future use.

Field Name Field Type Description

dbFlags WORD Used internally by the database API.

refTable TABLE Table number of the entity relationship table.

numElements WORD Number of elements in the relationship (for example, 2 
for a binary relationship, 3 for a ternary relationship, and 
so on).

Elements Allowed class of each element of the relationship (up to 
4); each element is indexed.

ele0 DBCLASS

elel DBCLASS

ele2 DBCLASS

ele3 DBCLASS

preset BOOL To permit extensibility, this flag prevents the preset legal 
relationships from being deleted by the user.

reserved CHAR[32] Reserved for future use.

Field Name Field Type Description
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Table 61 shows some of the current Legal Relationships for the database
structure described in this reference. The table does not show the dbFla
relTable, or preset fields, and the name of the numElements field is 
abbreviated as num. Table 61 also omits the ele3 field because it is not use
for any relationships in the current database structure.

Table 61 Legal Relationships Table Example

Table num ele0 ele1 ele2

CONNECT-T 3 Hub Port Device Segment

CONNECT-T 3 Hub: HMI Device Segment

CONNECT-T 3 Link Device Segment

LOCATION-OWNER-T 2 Page Class Box

LOCATION-OWNER-T 2 Page Class Go To Symbol

LOCATION-OWNER-T 2 Page Class Segment

LOCATION-OWNER-T 2 Page Class Symbol

LOCATION-OWNER-T 2 Page Class Text

LOCATION-OWNER-T 2 Page Class Wallpaper

LOCATION-OWNER-T 2 Symbol Page Class

OWNERJ 2 Universe World

OWNER-T 2 World Network

OWNER-T 2 Network Segment

OWNER-T 2 Segment Box

OWNER-T 2 Box Device

OWNER-T 2 Box Print Server

OWNER-T 2 Box NetWare Server

OWNER-T 2 Box Bridge

OWNER-3 2 Box NetWare LANalyzer 
Agent
��� LogicSource for ManageWise

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

lains 
 box 
How ManageWise Configuration Affects the Database

The Edit > Database Object command from the ManageWise menu bar 
launches two different icon-accessed dialog books: 

� The Box dialog book, if you select a networked node on the map.

� The Segment dialog book, if you select a segment on the map. 

This section explains the relationship between the fields in the Box, the 
Segment dialog book pages, and the ManageWise database. It also exp
the processes that are initiated from database relationships for the dialog
buttons within the Box and Segment dialog books.

This section discusses the following topics:

� Database configuration overview

OWNER-T 2 Box Hub: HMI

OWNER-T 2 Box Router: AppleTalk

OWNER-T 2 Box Router: IP

OWNER-T 2 Box Router: lPX

OWNER-T 2 NetWare Server CPU

OWNER-T 2 NetWare Server Disk

OWNER-T 2 NetWare Server File Service

OWNER-T 2 NetWare Server File System

OWNER-T 2 NetWare Server Network Hub

OWNER-T 2 NetWare Server NetWare Users

OWNER-T 2 NetWare Server OS Number

OWNER-T 2 NetWare Server RAM

OWNER-T 2 NetWare Server Volume

Table num ele0 ele1 ele2
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Contains a relationship tree that illustrates the database fields used 
the Box and Segment dialog books.

� Box dialog book

Shows each page of the Box dialog book, and shows how each field
determined from the database.

� Segment dialog book

Shows each page of the Segment dialog book, and shows how each
is determined from the database.

Throughout this section, the following notation is used to name fields in a
record:recName. fieldName, where recName is the name of the database tabl
and fieldName is the name of the field in the table. For example, box.nam
refers to the name field in the Box table, and device.equipID refers to the
equipID field in the Device table.

In some cases, a field from a dialog page or dialog box causes several fi
in the database to be filled in. In this case, the affected fields are listed in
table, with the field names in the first column and the data placed in them
the second column. In such a table, an ellipsis ( ... ) indicates that there a
intervening fields in the table that are not affected by the dialog field.

In the example given in Table 62, the Make and Model field on a dialog page
affects three fields in the Equipment table. The Make and Model informat
itself is stored in equipment.name, the object ID of the Equipment record
the same as the value of box.equipID in the associated Box record, and 
constant EQUIP_BOX is stored in the equipment.equipType field.

Table 62 Configuration Description Example

Database Configuration Overview. The relationship tree shown in Figure 20 
illustrates each table used for the Box and Segment dialog books. 

Field Name Value

ID box.equipID

name Make and Model

equipType EQUIP-BOX
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The relationships between these tables and the dialog book fields are 
described in detail in the following sections. Table 44 on page 151 describes 
the Owner relationship, which is indicated by a dashed line in Figure 20. See 
Table 25 on page 136 for a description of the fields each table contains.

Figure 20 Box Relationship Tree

Box Dialog Book. The Box dialog book consists of the following pages:

�  Configuration Summary page

�  System Information page

�  Adapter Information page

�  Services page

�  Disk Information page

�  Contact Information page
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�  Location Information page

�  Miscellaneous Information page

This section describes these pages and their associated dialog boxes. Fo
field within the pages shown in the screen shots, this section provides a 
that identifies the location in the ManageWise database where ManageW
stores the field variables.

Configuration Summary Dialog Page. You can access the Configuration 
Summary page, shown in Figure 21, by selecting Edit > Database Object fo
a box, and clicking the Configuration Summary icon.

Figure 21 Box Configuration Summary Dialog Page

The Configuration Summary page provides a read-only overview of 
information about the selected box. You can modify the fields on this pag
only from one of the other dialog pages, as follows:
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System Information Dialog Page. You can access the System Information 
page, shown in Figure 22 on page 171, by clicking the System Information 
icon.

Figure 22 System Information Dialog Page

The items on this page correspond to fields in the ManageWise databas
follows:

Section Modify In

System Summary System Information page

Adapter Summary Adapter Information page

Contact Summary Contact Information page

Internal Network Number System Information page
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System Name is stored in boxname.

Operating System is stored in extended-attribute.value, where the rest o
record is as follows:

Last Serviced is stored in extended-attribute.value, where the rest of the re
is as follows:

CPU Type is stored in extended-attribute.value, where the rest of the reco
as follows:

Field Name Value

relatedID box.ID

relatedClassID BOX

attrName OSI

dataType BTRV-DT-ZSTRING

dataLength 256

Field Name Value

relatedID box.ID

relatedClassID BOX

attrName 'Last Serviced'

dataType BTRV-DT-ZSTRING

dataLength 256

Field Name Value

relatedID boxID

relatedClassID BOX

attrName CPU

dataType BTRV-DT-ZSTRING
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where the rest of the record is as follows:

where the rest of the record is as follows:

IPX Internal Network Number is stored in box.InternalNetworkNumber 
(appears only if the box is a NetWare File Server).

Make and Model is stored in equipmentname, as follows:

dataLength 256 RAM Size-Stored in 
extended_attribute.value

Field Name Value

relatedID boxID

relatedClassID BOX

attrName RAM

dataType BTRV_DT_ZSTRING

dataLength 256 Display Model-Stored in 
extended_attribute.value 

Field Name Value

relatedID box.ID

relatedClassID BOX

attrName Display

dataType BTRV-DT-ZSTRING

dataLength 256

Field Name Value

ID box.equipID

Field Name Value
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Image is stored in equipment.resourceDLL, as follows:

Device Type is stored in box.hardwareType.

Icon is determined by the Box table. The icon is obtained from 
objectResource.resDLL when box.resourceDLL = NULL. Otherwise, the
icon is obtained from box.resourceDLL.

The file box.resourceDLL is a dco file and box.resourceID = 0XFFFE. Th
icon displayed is from the ManageWise\ICONS subdirectory.

Add System Make and Model Dialog Box. You can access the Add System 
Make and Model dialog box by clicking the Add button under the Availab
Make and Model section on the System Information page. This dialog bo
enters make and model information into an Equipment record. (This sam
dialog box is also used for Edit System Make and Model.)

name ’Make and Model'

equipType EQUIP-BOX

Field Name Value

ID box.equipID

resourceDLL Image filename in the Pictures 
subdirectory

resourceID *FFFF Use constant RESOURCE_IS-
BITMAP)

equipType EQUIP-BOX

Field Name Value
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Figure 23 Add System Make and Model Dialog Box

The items in this box correspond to fields in the ManageWise database, 
follows:

Make and Model is stored in equipment.name, where box.equipID refers t
Equipment record. See Table 29 on page 141 for further details.

Picture is stored in equipment.resourceDLL, as follows:

Adapter Information Dialog Page. You can access the Adapter Information
page by clicking the Adapter Information icon. This dialog page shows fie
related to a single device record.

Field Name Value

ID box.equipID

ResourceDLL

Picture filename

Field Name Value

resourceID *FFFF Use constant RESOURCE-IS-
BITMAP)

equipType EQUIP-BOX
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Figure 24 Adaptor Information Dialog Page

The items on this page correspond to fields in the ManageWise databas
follows:

In the Adapter Information field, each item in the list box corresponds to 
device in the box. For each device, ManageWise displays the MAC Addr
field and the Segment Connected To field.

The three fields Segment Connected To, Segment Type, and Cable Type
located in the segment record for the segment to which the adapter is 
connected. This is modeled in the database by the Connect table. The re
a Connect record as follows:

Field Name Value

fromID device.ID

fromClassID
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The record indicates that the adapter is connected to the segment. The d
the Segment Type and the Cable Type (and the Segment name in the Ad
list box) comes from the Segment record. The segment record fields tha
relevant to the dialog box are as follows:

Segment Connected To is stored in segmentname.
Segment Type is stored in segment.datalinkType.
Cable Type is stored in segment.cableType.
MAC Address is stored in device.machineAddress.
Make and Model is stored in equipmentname, as follows:

For Binding Information, each network binding in the table is in the Fram
record as follows:

NOTE: Use data types defined in FRAME_TYPE. See Table 50 on page 
157.

DEVICE

toID segment.ID

toClassID SEGMENT

Field Name Value

ID device.equipID

name Make and Model

equipType EQUIP-DEVICE

Field Name Value

deviceID device.ID

frameType 0 33

Field Name Value
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NOTE: Use constants named NET_PROTOCOL_x, defined in Table 23 on 
page 126.

I/O Port is stored in a private table in the database.
Interrupt is stored in a private table in the database.
Memory Address is stored in a private table in the database.
DMA Use is stored in a private table in the database.

Add One Network Interface Dialog Box. This dialog box, shown in Figure 25 
on page 179, enters network adapter information into a device record.

networkAddress network address

networkAddress.naProtocol 20-212
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Figure 25 Add One Network Interface Dialog Box

The items in this dialog box correspond to fields in the ManageWise data

The segment connected to an adapter is located in the segment record f
segment to which the adapter is connected. This is modeled in the databa
the Connect table. The result is a Connect record as follows:

Field Name Value

fromID device.ID

fromClassID DEVICE

toID segment.ID
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The record indicates that the adapter is connected to the segment. The v
of this field comes from the Segment table as follows:

Segment Connected To is stored in segmentname.

The value of the rest of the fields are as follows:

Make and Model is stored in equipment.name, where the rest of the reco
as follows:

MAC Address is stored in device.machineAddress.

For Binding Information, each network binding in the table is in the Fram
record as follows:

NOTE: Use data types defined in FRAME_TYPE. See  Table 50 on page 
157.

toClassID SEGMENT

Field Name Value

ID device.equipID

name Make and Model

equipType EQUIP_DEVICE

Field Name Value

deviceID deviceID

frameType 0 33

Field Name Value

networkAddress network address

networkAddress.naProtocol 20 212

Field Name Value
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NOTE: Use constants named NET-PROTOCOL.x., defined in Table 23 on 
page 126.

Services Dialog Page. You can access the Services dialog page, shown in
Figure 26 on page 181, by clicking the Services icon.

Figure 26 Services Dialog Page

The items on this page correspond to fields in the ManageWise databas
follows:

IPX Internal Network Number.  Stored in box.IntemalNetworkNumber.

Selected Services. ManageWise computes the list of services contained in
box from all the services that participate in an owner relationship with the
given box. The Owner table models this in the database. 

For example, the following Owner record indicates that the Box owns a 
NetWare Server service:
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Disk Information Dialog Page. You can access the Disk Information page, 
shown in Figure 27, by clicking the Disk Information icon.

Figure 27 Disk Information Dialog Page

The Make and Model and Type of Disk fields shown on this page are from
Equipment record. The ID of the Equipment record is in an Extended Attrib
record as follows: 

Field Name Value

parentID box.ID

parentClassID BOX

childID nwserver.ID

child-class NWSERVER
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Extended-attribute.value is an array of 64 IDs. 

Each ID is an ID of an object in the Equipment table. 

The value displayed in the Make and Model field of the dialog page is 
equipmentname. 

The value displayed in the Type of Disk field of the dialog page is 
equipmentmodel. 

If an ID does not correspond to an Equipment record, it should be ignore

The first zero ID indicates that there are no more IDs in the Extended Attrib
record.

Add Disk Make and Model Dialog Box. The Add Disk Make and Model dialog
box, shown in Figure 28 on page 183, enters make and model information into
an Equipment record.

Figure 28 Add Disk Make and Model Dialog Box

The items in this dialog box correspond to fields in the ManageWise datab
as follows:

Make and Model is stored in equipment.name, as follows:

Field Name Value

ID equip.ID

name Make and Model

equipType EQUIP-DISK
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Type of Disk is stored in equipment.model, as follows:

Contact Information Dialog Page. You can access the Contact Information 
page, shown in Figure 29, by clicking the Contact Information icon.

Figure 29 Contact Information Dialog Page

The items on this page correspond to fields in the ManageWise databas
follows:

Field Name Value

ID equip.ID

model Type of Disk

equipType EQUIP-DISK
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For Contact Information the ID of the primary contact is in the userID field
the Box record. All contacts (including the primary contact) are in 
extended_attribute.value, where the rest of the record is as follows:

The * extended_attribute.value is an array of 64 IDs. Each ID is an ID of
object in the user table. The value displayed in the Contact Information f
is user.name. If an ID does not correspond to a user record, it should be
ignored. The first zero ID indicates there are no more IDs in the Extende
Attribute record.

The primary user is also stored as an ID in the box.userID field. Other va
are stored in the following fields:

Name is stored in username.
Title is stored in usertitle.
Phone is stored in userphone.
Location is stored in userlocation.
Picture is stored in userresourceDLL.

NOTE: The primary contact is in two places: the box.userID field and an 
Extended Attribute record of the format just described.

Add Contact Dialog Box. The Add Contact dialog box, shown in Figure 30 on 
page 186, enters user information into a user record.

Field Name Value

relatedID boxID

relatedClassID BOX

attrName Contact

dataType BTRV-DT-ZSTRING

dataLength 256

value *ID array
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Figure 30 Add Contact Dialog Box

The items in this box correspond to fields in the ManageWise database a
follows:

Name is stored in username.
Title is stored in usertitle.
Phone is stored in userphone.
Location is stored in userlocation.
Picture is stored in userresourceDLL.

Location Information Dialog Page. You can access the Location Informatio
page, shown in Figure 31, by clicking the Location Information icon.
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Figure 31 Location Information Dialog Page

The items on this page correspond to fields in the ManageWise databas
Office, Floor, Building, Campus, City, Region, State, and Country are in o
Extended Attribute record in the extended attribute.value field, where the
of the record is as follows:

Because data length is 256 bytes, each field is 32 bytes, including the nu
byte.

Field Name Value

relatedID box.ID

relatedClassID BOX

attrName Location

dataType BTRV-DT-ZSTRING

dataLength 256
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Miscellaneous Information Dialog Page. You can access the Miscellaneous
Information page, shown in Figure 32, by clicking the Miscellaneous 
Information icon.

Figure 32 Miscellaneous Information Dialog Page

The Miscellaneous Information field in this page corresponds to a field in 
box.comment, as follows:

Segment Dialog Book. The Segment dialog book consists of the following
pages:

� Configuration Summary page

Field Name Value

ID box.ID

comment Miscellaneous Information
��� LogicSource for ManageWise

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

 that 
tores 

t 

icon.

ly 
� Segment Information page

� Contact Information page

� Miscellaneous Information page

This section displays each  page and a table for each field within the page
identifies the location in the ManageWise database where ManageWise s
the field variables.

Segment Configuration Summary Dialog Page. You can access the Segmen
Configuration Summary page, shown in Figure 33, by selecting Edit > 
Database Object for a segment, and clicking the Configuration Summary 

Figure 33 Segment Configuration Summary Dialog Page

The Configuration Summary page provides a read-only overview of 
information about the segment. You can modify the fields on this page on
from one of the other segment dialog pages, as follows:
Processes/Features ���

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

n 

e, as 
Segment Information Dialog Page. You can access the Segment Informatio
page, shown in Figure 34, by clicking the Segment Information icon.

Figure 34 Segment Information Dialog Page

The items on this page correspond to fields in the ManageWise databas
follows:

Segment Name is stored in segment.name.
Cable Type is stored in segment.cableType.
Segment Type is stored in segment.datalinkType.

Section Page

Segment Summary Segment Information page

Contact Summary Contact Information page
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Each entry in the Network Information table is from a Network record whi
owns the segment, as follows:

The relevant fields in the network record are as follows:

� Protocol is stored in network.Protocol.

� Network Address is stored in network.networkNumbernn0 through 
network.networkNumbernn23.

� Network Mask is stored in network.nebnask.mask0 through 
network.netmask.mask23.

Add Network Dialog Box. The Add Network dialog box, shown in Figure 35, 
enters network address and protocol information into a Network record.

Figure 35 Add Network Dialog Box

The items in this box correspond to fields in the ManageWise database, 
follows:

Field Name Value

parentID networkID

parentClassID NETWORK

childID segment.ID

childClassID SEGMENT
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Protocol is stored in network.nnProtocol.
Network Address is stored in network.networkNumbernn0 through 

network.networkNumber.nn23.
Network Mask (displayed only for TCP/IP protocols) is stored in 

network.netmask.mask0 through network.netmaskmask23.

Contact Information Dialog Page. You can access the Contact Information 
page, shown in Figure 36, by clicking the Contact Information icon.

Figure 36 Contact Information Dialog Page

The items on this page correspond to fields in the ManageWise databas
follows:

For Contact Information, the ID of the primary contact is in the 
segment.userID record. 

All contacts (including the primary contact) are in extended-attribute.valu
where the rest of the record is as follows:
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The * extended-attribute.value is an array of 64 IDs. Each ID is an ID of 
object in the user table. The value displayed in the Contact Information f
is username. If an ID does not correspond to a user record, it should be 
ignored. The first zero ID indicates there are no more IDs in the Extende
Attribute record.

The primary user is also stored as an ID in the box.userID field. Other va
are stored in the following fields:

Name is stored in username.
Title is stored in usertitle.
Phone is stored in userphone.
Location is stored in userlocation.
Picture is stored in userresourceDLL.

NOTE: The primary contact is in two places: the segment.userID record 
and an Extended Attribute record in the format just described.

The Add Contact Dialog Box. The Add Contact dialog box is identical to the
Box configuration shown in Figure 30 on page 186.

Figure 37 on page 194 shows a Segment Configuration Relationship Tree. A
shown, each Segment has a primary contact. This contact must be listed 
User table. In addition, multiple secondary contacts for a Segment can b
stored in the Extended Attribute table.

Field Name Value

relatedID segment.ID

relatedClassID SEGMENT

attrName Contact

dataType BTRV-DT-ZSTRING

dataLength 256

value ID array
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Figure 37 Segment Configuration Relationship Tree

Miscellaneous Information Dialog Page. You can access the Miscellaneous
Information page, shown in Figure 38, by clicking the Miscellaneous 
Information icon.

Figure 38 Miscellaneous Information Dialog Page

The following field corresponds to a location in the ManageWise databas

Miscellaneous Information corresponds to the comment field in the Segm
table, as follows:
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Database Maintenance

NOTE: You should always back up your database before performing 
maintenance operations.

ManageWise provides tools that let you maintain the data on the Manage
Console. 

The Database Administration Tool lets you control the function of the ala
database, back up and restore the ManageWise database, and perform 
tasks to help you maintain your ManageWise data. The maintenance 
requirements for each type of database information are discussed in the
sections that follow.

Maintaining ManageWise affects the ManageWise Server also. For exam
when you back up the ManageWise Server and other servers running 
ManageWise agents, you must take care to exclude open ManageWise 

Topology Information

NetExplorer discovers most topology information automatically. You can 
supplement the NetExplorer data by editing the database manually from
ManageWise Console. Certain network configuration changes might not
accurately reflected in the logical maps.

Custom Map and Configuration Information . ManageWise does not 
automatically discover and add custom map and configuration informatio
the database; you must enter it manually. 

You can add and maintain this information on a node-by-node basis, as 
needed. If you remove a node that you added manually from your netwo
you also need to delete it manually from the database. 

In the case of a node that was autodiscovered, NetExplorer deletes it from
database seven days after it is removed from the network.

Field Name Value

ID segmentID

comment Miscellaneous Information
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NOTE: This information is not preserved if you reset the entire database 
and start over again. Resetting the entire database deletes all data you 
entered since installing ManageWise or resetting the database. Novell 
recommends that you do not reset the database without carefully 
considering other alternatives.

Alarms 

Alarm Details. You can look at the alarms in more detail using the Alarm
Report or the Alarm Monitor.

The Alarm Report. This displays alarms that have been logged in the 
database. It can display all logged alarms or only alarms that apply to a ce
state or segment. 

The Alarm Report also lets you delete, acknowledge, or add comments t
alarms, and view online Help for alarms. 

If you acknowledge or delete all the alarms logged against a workstation
segment, the alarm graphic above the node or segment icon disappears

Alarm System Configuration Information.  Each type of alarm has a 
severity, state, and disposition that is stored in the database. The severity,
and disposition are set to default settings when you first install the 
ManageWise Console. Changes you make are stored in the database.

The types of alarms (SNW traps) that ManageWise can interpret are 
determined by the MIBs that ManageWise has compiled. See “Compiling the 
MIBs” on page 47 for more information.

Logged Alarm Information.  ManageWise stores each logged alarm in the
database when it is received. ManageWise also stores notes you attach 
alarms in the database.

Network Node and Segment Class Information

The database  includes information about itself and the types of objects 
knows about. Third-party products can add new types of objects. When t
do this, they add to the class information. Objects in a new class act just
ManageWise objects.
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NetWare 5 and SNMP Management

NetWare 5 includes more SNMP functionality than previous releases of 
NetWare. This section reviews SNMP principles and describes the netwo
management functionality newly included in NetWare 5.

SNMP Agent

An SNMP agent is a piece of software that runs on any managed device i
network. It continuously monitors the device, collecting data on a regular
basis and responding to data requests from the SNMP-based console. 

An administrator at the console can request management information  b
clicking on the appropriate object. In turn, the console sends a request to
agent via SNMP, typically using UDP, a low-overhead transport protocol t
is a part of the TCP/IP protocol suite. 

An IPX implementation of SNMP is also available in ManageWise. Upon
receiving the request, the SNMP agent sends the requested information 
console using SNMP. 

This standard mechanism allows any SNMP console to request informat
from any SNMP agent. 

An SNMP console can be any console from any of the major vendors in 
network management arena, including HP OpenView*, Tivoli TEMS*, CA
Unicenter*/TNG* and of course Novell ManageWise.

NetWare Management Agent Functional Overview

Used either as a component of ManageWise or as a standalone product
NetWare Management Agent runs on NetWare 5, intraNetWare, NetWare
and NetWare 3.x, providing the right set of NLMs for each network operat
system. 

In addition to server monitoring and management, as a ManageWise 
component or a standalone product, the NetWare Management Agent pro
functionality that is not available in the SNMP modules delivered by NetW
5: namely, alarms and trends. 
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Server Monitoring

Server monitoring provides instant information about various monitored 
elements of the NetWare server such as CPU utilization, memory size, c
buffers, connected users, volumes, disks, disk space usage per user, loa
NLMs, network adapters, print queues, and print jobs. These statistics pro
the essential framework for a server management solution.

Server Management

The NetWare Management Agent enables you to actively manage NetW
servers. There are 187 SET parameters on the NetWare server which ca
used to tune the server's performance. 

NMA lets you view and change all parameters remotely from any SNMP
console—a fundamental aspect of the single-point-of-administration conc

Alarms

Over 580 different types of alarms (SNMP traps) can be sent from any 
NetWare server to the ManageWise Console or to any other SNMP-base
console.

The alarms inform you about events that have occurred or thresholds that
been crossed. They play a key role in your management system, becaus
notify you about symptoms of a potential problem before the problem actu
occurs.

Trends

Trends provide historical data about various server objects and can be 
displayed in a diagram on the SNMP console. 

Trends are stored at the server side, which eliminates the need for polling
can be accessed via SNMP by any SNMP-based console. 

The diagrams are essential for planning and making projections because
historic data provides clues about the long-term viability of various netwo
components.
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SNMP Functionality in NetWare 5

The Server Monitoring and Server Management components of the NetW
Management Agent are included in NetWare 5. Server Monitoring provid
information about the server, which can be divided into the following 
categories:

From your ManageWise Console, you can retrieve the information about
server by double-clicking on a managed server in the server list, or by do
clicking on the server icon in the map. 

The server monitoring information described above is available for any 
NetWare 5 server without any additional NetWare Management Agent.

Category Description

System Summary Server-related data including address, name, up-time, NDS context, etc.

CPUs List of CPUs with their current utilization.

NLMs List of NLMs with memory usage, version number, and other details.

Memory Overview of server memory, including the number of cache buffers.

Network Interfaces Utilization of each logical network interface.

Adapters Utilization of each physical network adapter.

Bound Protocols Statistics on protocols.

Disks Hard disk details.

Users User information, including data about whether users are connected and how 
much space they utilize on the server volumes.

Connections List of current connections.

Volumes Statistics about volumes.

Print Queues List of print queues with their print jobs, which can be manipulated (delete, move, 
hold, etc.).

Installed Software Server software installed via PINSTALL.
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In addition, the SNMP instrumentation in NetWare 5 includes the Server 
Management functions of the NetWare Management Agent, which allow 
to manage servers via  SNMP. 

You can do this by entering the SET commands used to tune up the NetW
server. These commands can be entered through any console that uses
SNMP standard and is equipped with MIB browsing capabilities. 

Using the ManageWise GUI for server management, you can read and w
SET parameter settings with a mouse click.

Security and SNMP

Every network administrator must be concerned about file server security
unauthorized person tampering with SET parameters can seriously brea
security, affecting the server's performance and possibly its stability. 

However, security is also one of the weaknesses of SNMP. The current ve
of SNMP uses passwords, called Community Strings, for read (GET) an
write (SET) operations. Unfortunately, those passwords are currently 
transmitted without any encryption.

To solve this security problem, the NetWare Management Agent can be 
configured to use additional authentication by running SNMP over the 
NetWare Core Protocol (NCP).

In this configuration, only a console logged in with administrator rights ca
retrieve data or change the server settings. This authentication mechani
available in ManageWise, in the standalone NetWare Management Agent
in the SNMP modules included in NetWare 5. It is enabled by default and m
be disabled if you want to use the SNMP agents with an SNMP console 
does not support SNMP over NCP.

Initiatives are underway to provide a higher level of security in SNMPv2 a
SNMPv3. Novell is participating in those efforts and will be ready to 
implement new security measures as soon as they are adopted as stand
However, until this happens, Novell recommends using the advanced 
authentication provided by ManageWise.
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NMA Alarms

Over 450  types of alarms are available for the NetWare operating syste
Also, ManageWise has introduced the NDS alarms for NetWare 5—addi
yet another 130 types of alarms that monitor the  events in Novell Direct
Services.

An alarm is a standardized message that can be sent automatically from
SNMP agent to any SNMP console. An alarm is typically sent when an e
occurs (for example, a user has logged in, a communication failure takes
place) or a predefined threshold has been exceeded. The latter can be 
something as simple as  the CPU utilization reaching 90 percent.

Alarm thresholds and sampling intervals can be set for each alarm type 
depending on your particular needs.

Many important alarms such as CPU utilization allow you to set two differ
thresholds and sampling intervals—typically one for short-term monitorin
and the other for long-term trending. 

The ManageWise console further lets you configure the behavior of each
alarm type at the console screen (severity level, ticker tape, beep, affect
node status in the map, database log, etc.). 

Additionally, each alarm can be used to launch an external application su
software that forwards the alarm to a pager, e-mail, cellular phone mess
service, or GSM SMS (Global System for Mobile Communications Short
Message Service). A list of such applications is available at www.novell.c
managewise/partners.

Alarm Targets

The FINDNMS.NLM automatically builds the list of ManageWise Consol
to which the NetWare Management Agent sends every alarm. If you unlo
this NLM, the NetWare Management Agent does not recognize any cons
targets.

This is useful when you want to send the alarms from a particular server 
to selected consoles in the network. That also applies for non-ManageW
consoles. In this scenario, you must enter the IP or IPX address of each
console in the TRAPTARGET.CFG file on the server.
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NetWare Management Agent Trends

NetWare Management Agent provides the capability to collect historic da
or trends. Many of the objects monitored by the agent change over time,
keeping track of those changes is important. 

A long-term trend tells you a lot about your network and allows you to 
distinguish between what is normal and what is not. It can also be used t
project future network behavior and can help you optimize and balance t
network's performance.

The NetWare Management Agent trends are similar to those provided by
LANalyzer Agent. They are collected and stored on the server, which 
eliminates any need for polling. As a result, the impact on the network 
performance is minimal. 

Trend data can be retrieved using SNMP, and is accessible by any SNM
based console. The ManageWise console can present the data in differe
graphs for the last hour, day, week, month, or year. The agent stores up t
years of historic data.

SNMP alarms and trends are not available in NetWare 5. If you are intere
in this functionality, you must purchase the standalone NetWare Managem
Agent for each of your servers or ManageWise to manage your entire netw

MIB Compilation

MIB is a text file that enables access to SNMP agent information from an
SNMP console. It describes the structure of the agent's information using
standard ASN.1 (Abstract Syntax Notation). Compiled MIBs create an SN
template database for interpreting SNMP packets.

ManageWise compiles MIBs automatically after installation. After any 
changes, such as introduction of a new MIB, all MIBs can be recompiled u
the MIB Compiler tool. 

MIB compilation is very easy. To manually compile MIBs, you place your
new MIB in the directory \MW\NMS\SNMPMIBS\CURRENT and run the 
MIB Compiler.

For non-SNMP consoles, you must compile the NetWare Management A
MIBs before you can use their information. This applies to the NetWare 
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Management Agent in ManageWise, the standalone NetWare Managem
Agent, and  the SNMP modules included in NetWare 5. 

Refer to your console manual for details about MIB compilation at your 
specific console.

NetWare Management Agent

The NetWare Management Agent (NMA) uses SNMP to provide current 
NetWare server performance and alarm information where they can be u
to you using the ManageWise Console.

Figure 39 NetWare Management Agent Configuration

The NMA software also lets you remotely manage any device attached to
server on which the software is installed.

The NMA provides you with the following server usage information for ea
managed server:

� NLMs that are running

� Disk and volume usage

� Key-server statistical trends
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� Memory usage and availability

� Printing status

� Bindery information

� Interface data

A copy of NMA resides on every managed server.

You can use an NT 4.x server as your ManageWise Console ONLY IF yo
install the NT Agent.

The NT Agent supports the SNMP standard for network management, 
providing information that can be accessed by SNMP-based manageme
consoles such as ManageWise. The NT Agent’s functionality is similar to 
of the NetWare Management Agent, enabling remote control, server 
monitoring, alarms, and trending on NT Servers.

NetWare LANalyzer Agent

You should install the NetWare LANalyzer Agent (NLA) software on one 
server per physical NetWare segment to get the most complete informat
possible about your network.

NetWare LANalyzer Agent. NLA performs these tasks:

� Tracking network activity such as passing data packets from node to
node.

� Sending alarms to ManageWise Console when your network encoun
conditions such as heavy traffic.

� Detecting problems at the lower layers of the OSI 7 layer model.

� Detecting remote devices that have stopped sending and receiving 
packets.

� Capturing and analyzing packets situated remotely on your network.
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In most instances, information gathered by NXPIP and NXPIPX is suffici
to place nodes on the network maps correctly. However, when NXPIP an
NXPIPX do not gather enough information, NXPLANZ retrieves MAC 
addresses collected by the NetWare LANalyzer Agent software. 

When NXPIP and NXPIPX discover new nodes using the MAC addresses
new nodes are added to the database. All nodes are discovered on segm
monitored by NetWare LANalyzer Agent.

Nodes Not Equipped with the IPX Diagnostic Responder. NXPIPX 
discovers the following nodes, but does not necessarily place them corre
on the ManageWise maps:

� NetWare for UNIX® servers 

� Portable NetWare servers  

� Access servers  

� Modem servers  

� Print servers

Because these nodes do not respond to IPX diagnostics, they cannot an
queries from NXPIPX.NLM. Consequently, the LAN information required 
place them on the maps might not be available. 

In this situation, NetExplorer places these nodes in the LOCATION 
UNKNOWN segment map. In most cases, the presence of NetWare 
LANalyzer Agent on each segment that these nodes appear on enables 
NetExplorer to obtain the missing information and correctly locate the no
in the maps. 

You can move nodes in LOCATION UNKNOWN manually to the correct 
segment by using Edit > Database Object from the ManageWise Consol

Source-Route Bridged Token Rings 

The way ManageWise maps display source-route bridged token rings dep
on whether you have NetWare LANalyzer Agent installed on each ring:  
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LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

g 
 all 
ber 

 
ise 

d to 
s. 

in 
 

re 

 node 
rface 

ch 
d on 
 by 

that 

s 
 
odes 
� When you do not have NLA installed on each source-route bridged rin
in your network, ManageWise discovers the network but consolidates
source-route bridged token rings that share the same IPX network num
or EP subnet into a single segment.

� If you do have NLA installed on each source-route bridged ring, each
NLA discovers its own ring (segment) and every node on it. ManageW
displays the ring as an unconnected segment in the Internetmap. 

� If you have an NLA installed on a source-route bridged ring connecte
a router, the ManageWise Internetmap shows the correct connection

However, if two networks each have several rings and only one ring 
each network is connected to a router, the ManageWise Internetmap
shows the correct connections only of the rings that are directly connected 
to the router. The other source-route bridged rings in each network a
displayed as disconnected segments on the Internetmap.

In all cases, bridge information is not discovered. As a consequence, 
NetExplorer treats each interface of a source-route bridge as a separate
on the network. One icon appears on the ManageWise maps for each inte
of the source-route bridge.

When you have NetWare LANalyzer Agent installed on one server on ea
ring of an IPX source-route bridged network, the segment names displaye
the ManageWise Internetmap consist of the IPX network number followed
the MAC address of that server’s interface to the ring. 

If NetWare LANalyzer Agent is monitoring more than one interface, the 
address shown for a ring is the MAC address of the interface monitoring 
ring.

You can correct all these problems manually by creating bridges and ring
using the Edit function of the ManageWise Console. Once you create the
source-route bridges and token ring segments and move the token ring n
to the correct segments, NetExplorer does not undo your changes.

RMON

NetWare LANalyzer Agent (NLA) implements technology also known as 
Remote Monitoring (RMON).
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NLA displays information by groups on logical maps in the ManageWise
Console. The following list includes the groups of information:

� Statistic Group

� History Group

� Alarm Group

� Host Group

� Host Top N Group

� Matrix Group

� Filter Group

� Packet Capture Group

� Event Group

� Token Ring Stats Group

� Token Ring History Group

� Ring Station Group

� Ring Station Order Group

� Ring Station Config Group

� Source Routing Group

Data Management

Data Flow

Data flows from NetWare LANalyzer Agent software installed on NetWar
segments to network monitors.
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Data Gathering and Storage

Data is gathered and then stored as .GT files in the GTREND.NLM direct
on every server where NetWare LANalyzer Agent is installed.

Files in the GTREND.NLM directory contain trend data that shows how yo
network resources are being used currently and over time, based on sta
such as available file cache and disk space, length of time that jobs rema
print queues, and CPU utilization levels. 

This data is useful for troubleshooting and for planning for future network
requirements.

Alarms

The ManageWise alarm system alerts you to problems and other condition
the network. Alarms come from any node that sends SNMP traps to the 
ManageWise Console. For example, NetWare Management Agent instal
on a server can generate an SNMP trap when an alarm threshold is exce
or an error condition occurs.

Programs running on the ManageWise Console can also generate alarm
example, NetExplorer Manager generates informational alarms during th
course of discovery. Alarms can also be generated if a connectivity test i
progress and an error is detected.

Alarm Severity, State, and Disposition

ManageWise assigns all alarms a default severity, state, and disposition
you can change the default settings. Severity settings indicate the seriou
of the alarm; state settings represent the operational status of the affecte
workstation; disposition settings indicate actions that are to occur when a
alarm of a certain type arrives.

Visual Presentation

When an alarm occurs, a bell-shaped icon within a rectangle appears abo
affected segment or node in maps. The bell icon indicates that one or mo
alarms (with a severity of major, minor, or critical) are logged against the
segment or node.
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If an alarm is reported for an object, ManageWise displays the alarm on 
maps that include the object and percolates it upward if maps are linked
together.

The color and placement of the bell above the object represents the sever
the alarm. The color of workstation icons changes dynamically according
the operational status of the workstation, as indicated by alarms received
the ManageWise Console. A nonoperational workstation appears with a 
grayed icon. See your ManageWise documentation for more information

Alarm Tables

You can look at the alarms in more detail using the Alarm Report or the Al
Monitor.

The Alarm Report. Displays alarms that have been logged in the databas
can display all logged alarms or only alarms that apply to a certain state 
segment.

The Alarm Report also lets you delete, acknowledge, or add comments t
alarms, and view NetWare ExpertTM  help, which displays help for alarms. If 
you acknowledge or delete all the alarms logged against a workstation o
segment, the alarm graphic above the node or segment icon disappears

The Alarm Monitor.  Starts when you start the ManageWise Console. It 
displays a table of the most current 400 alarms received since the Consol
started, even if they are not logged in the database. For more detailed 
information about the ManageWise alarm system, see “Alarm System 
Configuration Information” on page 33. 

Communication of Alarms

LANalyzer Agent running on a server can generate alarms when networ
traffic on a segment exceeds preset thresholds for conditions such as 
utilization, packet rates, broadcast rates, and error rates. The segment a
are included in the MIB. You can modify the reporting characteristic of th
alarms.

Thresholds

Thresholds are events and conditions that NLA detects in order to create
alarms. You can change threshold values to ensure that you are notified
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events you want to know about; for example, when utilization exceeds a
certain percentage of your available disk space.

Baselines

Baselines define the conditions for alarm thresholds by recording your 
network’s "typical" bandwidth utilization, packets per second, error rates,
kilobytes per second, and server activity levels. 

You should take care to establish your baseline when performance is at 
acceptable-to-excellent levels on your network. Once you know what is 
normal for your network, you can identify, monitor, and address problems
decreased performance or increased utilization.

Alarm Notices

As soon as an alarm is generated, NLA sends an alarm notice to the Ala
Manager on the ManageWise Console. The ManageWise Console notifies
immediately with an icon, a sound, or both. 

You can also configure ManageWise to dial a pager to notify you of alarm
that occur when you are away from the ManageWise Console.

Connectivity Testing

ManageWise software provides a test facility that lets you verify that you h
a good communication path from the ManageWise Console to devices in 
internetwork. 

You can test connectivity to a network device with which you suspect a 
problem, or continuously monitor one or more critical network devices su
as servers or routers. The test consists of pinging the target device to ver
the device is on the network and communicating effectively.

One-Time Pinging

If you suspect a problem with a network device such as a server or router
can ping the device one time to determine whether it is actually 
communicating, and which protocols are bound to the device. ManageW
generates an alarm if the target fails to respond.
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Continuous Pinging

You can monitor critical network devices continuously by defining targets a
setting ManageWise to perform periodic echo tests using the Ping utility.
Using this facility, you can proactively monitor critical network devices an
receive alarms when they are not responsive.

NOTE: You must keep the Connectivity Test window open the entire time 
you are monitoring.

Configuring ManageWise Components to Use IP Protocol

This section describes procedures for configuring ManageWise compone
to use the Internet Protocol (IP) for communication. 

NOTE: ManageWise does not function in an IP-only environment. 
However it does function with IP/Compatibility Mode (IP/CMD) or IPX/SPX 
and IP protocols.

Overview. Implementing IP on your network has many benefits, and a 
growing number of companies are supporting IP implementations. Becau
NetWare 5 supports IP-only networks, NetWare users can take advantag
the network performance and connectivity features available through IP.

ManageWise was designed to use IPX/SPXTM  protocols to take advantage of
the Service Advertising ProtocolTM  (SAP) to detect services hosted on devic
and to communicate with ManageWise system components, as well as D
OS/2* and Macintosh* agents. It was also designed to support communica
with networked devices through IP. 

The SNMP-based functions in ManageWise use IPX or IP, depending on
which protocol is available for communicating with the managed device.

By default the NetWare Management Agent and the LANalyzer Agent ar
configured to communicate over IPX and advertise services hosted on th
server using an assigned SAP ID. You must configure these agents to us
This task is covered in the following section.

The workstation utilities that can be configured to use IP are the Invento
Scanner and Remote Control Agent.
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NOTE: Only the Windows-based desktop management utilities can be 
configured to use IP.

The following table lists the components that can be configured to use IP

Table 63 Configuring NetWare LANalyzer Agent

A ManageWise Console uses SAP to identify itself. By default, NetWare
LANalyzer Agent sends SNMP traps to all ManageWise Consoles that u
SAP. 

You can prevent NetWare LANalyzer from sending SNMP traps to the 
ManageWise Console by turning off the "auto-trap" function in the 
LANZ.NCF file on the server, and then configuring the trap destination lis
manually so that it lists only the destinations you want to receive traps.

Configuring the LANZ.NCF File.  To manually configure the LANZ.NCF 
file on the server running NetWare LANalyzer Agent, complete these ste

�� Open the LANZ.NCF file, which is located in SYS:\SYSTEM\.

Component Type Component Name IP Support

SNMP Agents NetWare LANalyzer Agent Set the alarm (trap) target IP address in the 
TRAPTARG.CFG file. Set agent for segment 
monitoring in ManageWise Console.

NetWare Management 
Agent

Set the alarm (trap) target IP address in the 
TRAPTARG.CFG file.

Inventory Scanners Windows NT Inventory 
Scanner (LDISCNNT.EXE)

Scan Windows NT workstations and servers for 
inventory information over IP.

Windows Inventory Scanner 
(WLDISCAN.EXE)

Scan Windows 3.x, Windows 95, and Windows 98 
workstations for inventory information over IP.

Remote Control User 
Agents

Remote Control Agent 
(WUSER.EXE)

Remote Control Agent host for Windows 3.x, 
Windows 95, and Windows 98 workstations over 
IP.

Remote Control Agent NT 
(WUSER32.EXE)

Remote Control Agent host for Windows NT 
workstations and servers over IP.

Remote Control Agent 
NetWare (USER.NLM)

Remote Control Agent host for NetWare servers 
over IP.
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�� Change LOAD LANZCTL trapreg = 1 to LOAD LANZCTL trapreg = 0

The "auto-trap" function is now turned off. (The value 1 means On ,a
0 means Off.)

�� Open the TRAPTARG.CFG file, which is located in SYS:\ETC\.

You need to unload the SNMP.NLM to modify this file.

�� Look through the file to find the sections designated for IP addresse

�� Add the IP addresses of the destinations to which you want NetWare
LANalyzer Agent to send traps.

NOTE: You must reboot the server for the changes to take effect.

Configuring NetWare Management Agent. A ManageWise Console uses 
SAP to identify itself. By default, NetWare Management Agent sends SN
traps to all ManageWise Consoles that use SAP. 

You can prevent NetWare Management Agent from sending SNMP traps
the ManageWise Console by unloading the FINDNMS.NLM file on the 
server, and then configuring the trap destination list manually so that it lis
only the destinations you want to receive traps.

To manually configure the NetWare Management Agent, complete these
steps:

�� Open the TRAPTARG.CFG file, which is located in SYS:\ETC\.

�� Add consoles’ (trap recipients’) IP addresses to the TRAPTARG.CFG
file.

You need to unload the SNMP.NLM to modify this file.

�� Look through the file to find the sections designated for IP addresse

�� Unload the FINDNMS.NLM file on managed servers hosting the 
NetWare Management Agent software.

NOTE: Changes do not take effect until you reload the NWTRAP.NLM file.
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Configuring Inventory Scanners to Run on IP. Desktop Manager uses the
platform-dependent scan programs to determine the hardware and softw
configurations of workstations. 

You can use the /PROTOCOL parameter to switch from IPX (default) netw
protocol to IP. 

NetWare servers cannot send data over IP. The scanners on the Window
platform have been enhanced to send IP address of the workstation that
enables the administrator to remotely control agents over IP.

To scan Windows 3.x, Windows 95, and Windows 98 workstations connec
to IP, complete these steps:

�� Locate the WLDISCAN.EXE file.

WLDISCAN.EXE is located in the ManageWise Server's 
SYS:\\MW\LDT\ folder.

�� Read down through the file and find the line where you specify the IP
over which you want the scan program to send data to the Inventory
Gatherer.

�� Specify /p parameter. 

To scan Windows NT workstations connected to IP, complete these step

�� Locate the LDISCNNT.EXE file.

LDISCNNT.EXE is located in the ManageWise Server's 
SYS:\\MW\LDT\ folder.

�� Specify the /NTT parameter as IP for communication with the remote
inventory server.

The parameter values specify the dotted decimal IP address of the re
inventory server.

Configuring User Agents to Run on IP. By default, user agents are set to ru
on IPX. You can configure workstations and servers to run over IP.
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To configure Windows NT workstations to run on IP, run NTSTACFG.EX
with the IP/TCPIP option so that you can install the remote control agent o
IP.

To configure Windows 3.x, Windows 95, and Windows 98 agents to run on
complete these steps:

�� Open WUSER.INI from the \WINDOWS directory.

Alternatively, you can create WUSER.INI in the \WINDOWS director

�� Type a MISC section in the WUSER.INI file.

�� Type an entry in the MISC section that specifies the protocol you want
agent to run on.

WUSER.INI should read as follows:
[MISC]

PROTOCOL=IP

The agent can also be loaded manually to run on IP by specifying the pro
as IP in the WUSER command line parameter as follows:
WUSER /P=IP

Command line parameters override protocol entries specified in WUSER

To manually configure NetWare 3.x, 4.x, or 5.0 servers to run on IP, comp
these steps:

�� Locate the MW_AUTO.NCF file. 

The MW_AUTO.NCF file is located in the SYS: volume of the NetWa
server.

�� At the end of the LOAD=USER line, type the following:

P=IP

The line should look like this:
LOAD USER P=IP

Sample MW_LOGIN.DAT Script: IP Implementation.  Networked and 
remote workstations can run the scan program from a login script. By def
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the MW_LOGIN.DAT file is included in your system or container login scri
when you install ManageWise. 

A sample MW_LOGIN.DAT file that is configured to use IP follows:

REM === ManageWise Desktop Management Include file for System Login ===
IF <OS> = "WINDOWS_NT" THEN
#\\<servername>\SYS\MW\LDT\LDISCNNT /NTT<ip address of server> 
/S="<servername>" /V /i=\\<servername>\SYS\MW\LDT\ldappl.ini
#\\<servername>\SYS\MW\LDT\NTSTACFG /IP/TCP 
/L=\\<servername>\SYS\MW\LDT\SELTEMP /NOUI
ELSE 
IF "%<WINBOOTDIR>" = "" THEN
#L:\MW\LDT\ISDOSBOX
write ERROR_LEVEL
IF ERROR_LEVEL = "1" THEN
#L:\MW\LDT\CLNTCFG
#L:\MW\LDT\WLDISCAN /P=IP /S=<inventory servername>
ELSE
#L:\MW\LDT\DOSCFG /L=\\<servername>\SYS\MW\LDT\SELTEMP 
/S=\\<servername>\SYS\MW\LDT
#L:\MW\LDT\LDISCAN /S=<inventory servername> 
END
ELSE
#L:\MW\LDT\CLNTCFG
#L:\MW\LDT\WLDISCAN /P=IP /S=<inventory servername>
END
END
REM === End Include File ===\

For more information on configuring ManageWise components to use IP
communication, refer to the user guides and online help delivered with y
product. You can also go to http://www.novell.com/documentation to acc
the product guides.

NetWare LANalyzer Agent Database

LANalyzer stores collected network information in a Btrieve database. Se
“ManageWise Btrieve Database” on page 109 for more information about the 
database.
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� Error Messages

This chapter gives you the information you need to understand and respo
error messages you might receive while using ManageWise®. 

The messages are arranged in alphabetical order, with numbers precedi
letters. Each message is followed by an explanation that includes the so
of the message, an explanation and/or possible causes of the error, and a
you can take to remedy the problem.

4.11-748 read from non present page process pserver 12 module netware.nlm threads 
package code offset [hex code].

Source: ManageWise Server

Possible Cause: An NLMTM  program may have tried to write to non-existent memory, or fro
memory that does not belong to that NLM.This causes a page fault in mem
The server may be using an outdated NLM program, the server memory c
be corrupted, or a programming error may exist in the software.

Action: Replace the NLM with an updated version. If you cannot replace the NLM
use the SET server utility to set the "Write Fault Emulation" parameter to O
This allows the old NLM to continue running.

WARNING: Altering these SET parameters is likely to cause memory 
corruption. The most effective resolution is to remove the NLM that is 
causing the corruption.

Adapter [MAC address] is not monitored because it is not a supported media type.

Source: LANalyzer®
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Explanation: NetWare® LANalyzer Agent supports Ethernet, token ring, and FDDI, 
although 100BaseT and 100VG-AnyLAN are considered Ethernet media
types. Other adapter media types are not supported.

Action: Use an Ethernet, token ring, or FDDI adapter for NetWare LANalyzer Ag
operations.

Adapter [MAC address] is not monitored because NetWare LANalyzer Agent cannot 
allocate memory.

Source: LANalyzer

Explanation: NetWare LANalyzer Agent does not have adequate RAM available to it 
build the internal data structures required to monitor the adapter.

Action: Unload any unnecessary NLM files or add additional memory to your se

Adapter [MAC address] is not monitored because the driver’s promiscuous mode 
cannot be turned on.

Source: LANalyzer

Possible Cause: The driver is corrupted or the adapter is damaged.

Action: Replace the adapter. If the problem persists, call your Novell Authorized
ResellerSM group.

Agent Not Monitoring

Source: NetWare LANalyzer Agent

Explanation: The NetWare LANalyzer Agent is not monitoring one or more network bo
drivers.

Possible Cause: The NetWare LANalyzer Agent NLM files (in LANZ.NCF) may have 
stopped running.

Action: Make sure the NetWare LANalyzer Agent NLM files (in LANZ.NCF) are 
running, by completing these steps:

�� On the NetWare LANalyzer Agent server, load NWSNMP.

�� Load LANZCONF.

�� Select the network board driver that the message indicates is not be
monitored, and then press Enter.
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�� Select Network Interface Items from the menu.

�� Verify the following information:

� The Item column contains an entry labeled Statistics and the 
corresponding Status column indicates valid.

� The Owner column indicates monitor.

� The Network column indicates the name of the adapter.

�� If all the information is correct, that interface should be monitored by
NetWare LANalyzer Agent; skip to Step 12.

If you have changed the network board in this server since the first t
you installed NetWare LANalyzer Agent, it might take some time for 
NetExplorer software to record the new board in the database.

If you do not want to wait for NetExplorer Manager to update the 
database, you can update the MAC address of the network board 
manually by doing the following:

�� In the ManageWise Console, click the server in a map.

�� Select Edit > Database Object. 

�� Click the Adapter Information icon.

���� Select the adapter that has changed.

���� Click Edit.

� Change the MAC Address field to reflect the new node address 
the server. (Type config at the server console and press Enter to
obtain this address.)

� Enter a dummy value in the Make and Model field.

� Click OK.

���� If you have not changed the network board in this server since the fi
time you installed NetWare LANalyzer Agent, sometimes completing 
following steps corrects the problem:
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� At the server console command prompt, type ULANZ and press
Enter.

This unloads the NetWare LANalyzer Agent NLM files. 

� Delete the SYS:\LANZ\LANZ.CFG file.

� At the server console command prompt, enter LANZ.

This reloads the NLM files.

Btrieve* 91 Error

Btrieve MACHINES.DAT, TYPES.DAT, FILES.DAT, and VALUES.DAT errors

Source: Btrieve database

Possible Cause: Files may be loading at the wrong location.

Action: Verify that BREQUEST.EXE loads at the administrator workstation. 

Possible Cause: You may be using the wrong version of Btrieve, or using two different 
versions at the same time.

Action: Verify that you are using the correct version of Btrieve. Novell® recommends 
Btrieve 6.10e. Also check to make sure that you are using the same versi
Btrieve on both the ManageWise Console and the ManageWise Server.

Possible Cause: The MACHINES.DAT, TYPES.DAT, FILES.DAT, or VALUES.DAT files 
may have become corrupted (for example, by a power outage).

Action: Rebuild the inventory database and restore these .DAT files.

Btrieve 1002 or 2001 errors

Source: Btrieve database

Explanation: These errors indicate insufficient memory.

Possible Cause: You may be running too many applications at the same time, or you m
storing unnecessary files.

Action: Close some of your open applications and unload any unnecessary TSR
example, e-mail or alarm notification programs. It may also help to minim
your Windows program groups.

BTRIEVE STATUS=95

Source: ManageWise Console
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Explanation: This error is usually caused by a timeout in the WAN/LAN.

Action: Increase the SPXTM  timeouts to twice their default values. By default, they w
most likely be as follows:
SPX VERIFY TIMEOUT=54

SPX LISTEN TIMEOUT=108

SPX ABORT TIMEOUT=540 

IMPORTANT: Note that these parameters have values in a 1:2:10 ratio. 
Novell recommends that you maintain the same ratio when making 
changes.

Btrieve status=<#>

Source: Btrieve database

Explanation: These numbered errors occur for a variety of reasons, and are usually re
by rebuilding the Inventory Database.

IMPORTANT: When you rebuild the database, the old database is 
overwritten by the new one. Before you begin, you may want to back up 
your *.DAT files.

Action: To rebuild the Inventory Database, complete these steps:

�� At the ManageWise Server console, enter UNLOAD LDINV and 
UNLOAD LDISCAN.

�� Enter LOAD LDINV REMOVE.

�� Enter BSTOP.

This unloads BSPXCOM.NLM and BTRIEVE.NLM.

NOTE: If TCPIP.NLM is loaded or bound, BTRIEVE.NLM will not 
unload. You may need to unload other applications that are using 
TCPIP before BTRIEVE.NLM can be unloaded. It may be easiest to 
down the server, restart it with the -NA switch (server -na), and then 
use Netbasic to access the volume to delete the necessary files. You 
can also run Vrepair to purge the volume before you restart the server.

�� At a workstation, delete MACHINES.DAT, TYPES.DAT, FILES.DAT 
and VALUES.DAT files in the administrator's network files directory 
(default SYS:MW\LDT).
Error Messages ���

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

he 

YS: 

ry 

6.

F 
ack 
 
d.
�� Also delete or rename LDINV.ERR and any MACHINES.PRE, 
TYPES.PRE, and VALUES.PRE files.

�� In SYS:SYSTEM, delete or rename BTRIEVE.TRN (if the folder and t
file exist).

�� To eradicate the deleted .DAT and .PRE files, go to the root of the S
volume and enter PURGE /A:

�� At the ManageWise Server console, enter the following commands:
     BSTART

NOTE: The BSTART command loads BTRIEVE.NLM and calls the 
correct memory allocations.
LOAD LDINV FILE=SYS:\MW\LDT

LOAD LDISCAN INV_SERV=servernamename FILE=SYS:\MW\LDT

 Substitute your path name as necessary. 

�� At a workstation, run LDISCAN /V /S=servername.

Alternatively, log in to the network. If you accepted the default Invento
Manager lines, LDISCAN.EXE runs in the System login script.

���� Restart the ManageWise Console workstation and BREQUEST /R:2

NOTE: If the console machine is a Windows 3.1x machine, you need 
to execute BREQUEST /R:26, before launching Windows. Windows 
95 consoles do not need to run BREQUEST. BREQUEST.EXE can be 
loaded into high memory, or a WINSTART.BAT file can be used to 
save conventional memory.

Some Windows workstations might freeze when BREQUEST.EXE is 
loaded using a WINSTART.BAT file.

���� Load Inventory Manager from the ManageWise Control Panel in 
Windows.

On NetWare 5® servers,  it may be necessary to edit the AUTOEXEC.NC
file and REM the ManageWise lines; then down the server and bring it b
up, before you can delete the *.DAT files. Many NLMs are dependent on
Btrieve. You cannot unload Btrieve until all dependent NLMs are unloade

Cannot retrieve path from nwinst.tmp

Source: SETUP.EXE
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Explanation: When installing ManageWise, you must map a drive to the root from wh
the files are installed. Installation may not be able to complete if you hav
copied the contents of the ManageWise CD to your network under a progr
directory and attempted to run the setup from that subdirectory.

Action: Map a drive to the root on which SETUP.EXE is located, and run setup f
the Start menu.

Communication with server failed (Error 251)

Source: NetWare Management AgentTM

Explanation: NetWare Management Agent cannot communicate with the server.

Possible Cause: This error usually means that the NETMAN user account on the serve
running NetWare Management Agent is corrupt.

Action: Use SYSCON or NWADMIN to delete the account, re-create another use
with the name NETMAN, and assign that user a password. (When using
NWADMIN, make sure the context in which you create the NETMAN user
the same context as the ManageWise Server.) 

If you give the user a different password, remember to register that new 
password on the ManageWise Console.

Could not connect to host. Please check DNS entry for host

Source: ManageWise Console

Possible Cause: This error occurs while executing IDISCNNT.EXE on an NT machine t
does not have a DNS Entry defined.

Action: To prevent the message from appearing and to permit the Windows NT 
Scanner to scan Inventory, complete these steps:

�� Determine the DNS Entry to be defined.

�� Use the Network > Control Panel option to configure the DNS for the
workstation.

You can also resolve the problem by creating a hosts file that points to th
NetWare server on the NT server or workstation.

Could not map ID of the user on the agent to a name.

Source: NetWare Management Agent
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Explanation: This error occurs if the client workstations (Windows 98, Windows 95, 
Windows 3.x) are not logged in to NDSTM .

Action: On the client workstations, log in to the ManageWise server.

Critical Error In Setup

Setup cannot copy AUTOEXEC.BAT file.

Source: SETUP.EXE

Possible Cause: Your AUTOEXEC.BAT file may be set to READ-ONLY.

Action: Remove the read-only file attribute.

Error LANS001: Invalid temporary path <\\ 
servername\SYS\LOGIN\MW\LDT\SELTEMP\>

Source: ManageWise Server

Explanation: This error can occur during login.

Possible Cause: The desktop management TSR files are probably being loaded by a us
does not have the correct access rights to the 
SYS:\LOGIN\MW\LDT\SELTEMP directory on the ManageWise Server.

Action: Make sure that the user has Create, Read, Write, Erase, Modify, and File
rights on that directory. 

If the user is a member of the MANAGEWISEGROUP user group, verify th
the MANAGEWISEGROUP user group has those rights on that directory

Ethernet adapter [MAC address] is not monitored because it is a pipelined adapter.

Source: LANalyzer

Possible Cause: A pipelined adapter is one that begins to send received data to the drive
the entire packet has been received. NetWare LANalyzer Agent cannot 
support this method of data reception because it must tally all the informa
in a packet before the information is sent to its destination.

Action: If the adapter allows you to switch from pipelined mode to nonpipelined 
mode, do so. 

If the adapter cannot switch modes, use a nonpipelined adapter for NetW
LANalyzer Agent transactions. Check the interNetWireSM bulletin board for 
information regarding availability of the recommended adapters. You mig
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have to contact your adapter vendor for the appropriate adapter.

Ethernet/Token Ring adapter [MAC address] is not monitored because the driver does 
not support promiscuous mode. 

Source: LANalyzer

Explanation: A promiscuous mode driver receives all the packets and errors on the ne
it is attached to. NetWare LANalyzer Agent requires promiscuous mode 
function properly, so the agent does not support nonpromiscuous mode 
Ethernet or token ring adapters.

Action: Install a promiscuous mode driver on the server. Check the NetWire bull
board for information regarding availability of the latest promiscuous mod
drivers. You might have to contact your adapter vendor for the appropria
driver.

Evaluation Period has ended. Contact your nearest Novell Authorized Reseller for a 
licensed copy.

Source: SETUP.EXE

Explanation: This error occurs if you are trying to use an expired evaluation copy of t
ManageWise software. It may also occur with a licensed copy if the 
ManageWise license files are corrupt or missing.

Action: Obtain a licensed copy of ManageWise. If the copy you are using is licen
complete these steps:

�� At the server console prompt type the following: 
UNNMA2.NCF

UNLOAD MWISE.NLM

�� Delete the files MWISE.MLS and NMA2.MLS from the server's 
SYS:ETC directory.

These are hidden files.

�� Delete SYS:SYSTEM\SERVINST.NLM and MWISE.NLM.

�� Run the MW 2.5 SETUP.EXE routine and follow the options to instal
MW.

On the license screen, the license count should be 0.
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�� Insert the MW 2.5 license diskette into drive A: and click on Add Licen

Note that the MW license count increases to the proper count.

�� Select Custom Install.

�� Install ONLY the NetWare Management Agent (NMA).

This option should be grayed out and selected, indicating that it is a 
required option. 

�� Unselect all other options.

�� Continue and install NMA.

���� After NMA has been installed and the MW 2.5 SETUP routine has 
finished, go to the server’s prompt and type NMA2.NCF.

Failed to get response from server. Ensure that server is operational.

Source: ManageWise Console

Action: Go to the Database Object Editor for that server and change the IPX inte
address to the new one. Alternatively, you can reset the discovery at the s
and reset the database at the console.

Illegal attribute.

Source: ManageWise Console

Possible Cause: An attempt was made to add a property that is illegal to an object. The
schema determines what properties can be inherited by an object class. (
to the NDS  Schema documentation if available.)

Action: You cannot add the specified property to the specified object. Complete t
steps to identify the damaged object:

�� Set DStrace=on, Set DStrace=+s, Set DStrace=*h.

NOTE: For more information about NDS, point your browser to 
support.novell.com.

�� Watch the dstrace (directory services screen) for any 608 errors.

The object directly above the 608 error is the problem object.
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�� If the object is not a server, volume, or OU object, delete the object.

IMPORTANT: If it is a server, volume or OU object that seems to be 
damaged, contact a Novell Directory Support Technician.

In the following example, User6 is the problem object to be deleted.

DStrace screen:

324BE558:350     valueTime=32484A4D,1,1 type=1, flags=0, oldCTS=3241A830,1,1
324BE558:353     valueTime=32484A4D,1,2 type=6, flags=0, oldCTS=3241A830,1,1
324BE558:356     valueTime=32484A4D,1,3 type=6, flags=0, oldCTS=3241A830,1,1
324BE558:360     valueTime=32484A4D,1,4 type=6, flags=0, oldCTS=3241A830,1,1
324BE558:363     valueTime=32484A4D,1,5 type=6, flags=0, oldCTS=3241A830,1,1
324BE558:382    SYNC:[620000EC][(13:54:48),1,1] FS1_V1.OU.OU.O (Volume)
324BE558:401    SYNC:[1E0000D5][(13:55:23),1,1] FS2_CDROM.OU.OU.O (Volume)
324BE558:487    SYNC:[F600043C][(14:00:18),1,1] User1.OU.OU.O (User)
324BE558:630    SYNC:[080004B9][(14:02:15),1,1] User2.OU.OU.O (User)
324BE558:768    SYNC:[040004BB][(14:02:34),1,1] User3.OU.OU.O  (User)
324BE558:912    SYNC:[070004BC][(14:02:56),1,1] User4.OU.OU.O (User)
324BE559:054    SYNC:[040004BD][(14:03:17),1,1] User5.OU.OU.O (User)
324BE559:141    SYNC:[040004BE][(14:03:52),1,1] Group1.OU.OU.O(Group)
324BE559:193    SYNC:[090003BB][(15:06:39),1,1] FS2.OU.O (NCP Server)
324BE559:249    SYNC:[30000165][(15:06:49),1,1] FS2_SYS.OU.O (Volume)
324BE559:275    SYNC:[A20003AC][(15:06:53),1,1] FS2_V1.OU.O (Volume)
324BE559:336    SYNC:[110003EF][(14:00:21),1,3] User6.O (User)324BE559:448  
SYNC: Objects: 25, total changes: 629, sent to server <CN=FS2>
324BE559:450   SYNC: error sending updates to <CN=FS2> ERROR: -608
324BE559:459  SYNC: Start outbound sync with (2) [BF000145]<FS3.OU.O>
324BE559:460 SYNC: End sync of partition <[Root]> All processed = NO.

�� Force another sync; then check see if the error has been resolved.

If it has been resolved, you should receive the message "All 
processed=YES."

If there are no damaged objects, the error might be the result of a Schem
problem. To isolate the problem, complete these steps:

�� Perform a set DSTrace=*. from both the target and source servers.

 This reloads DS and the schema information.

�� Perform a Global Schema update from DSrepair:  load dsrepair > 
advanced options > Global schema operations > reset local schema
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�� Make sure that the server on which you are running the ManageWis
Console software does not have the master of the [root] partition.

�� Run DSrepair > advanced options > repair local DS database; then t
on the option for Rebuild Operational Schema.

�� Restart the server that contains the problem master replica.

NOTE: If this message occurs with a "DSACommonRequest error" it is not 
an error; it is a valid informational message stating that during an addition 
or removal of an object one server’s database is different from another. If 
this is the case, use set dstrace=no debug set dstramin= +min. This resets 
dstrace back to defaults, without loading and unloading DS.

Instrumented OS Emulator unable to Register Object class: 100.3.1

Source: NetWare Management Agent.

Possible Cause: This message usually means a queue (such as a print queue) is corru

Action: Try deleting the jobs in the queue. If this does not solve the problem, comp
the following steps:

�� Delete the queue from the SYS:\SYSTEM directory.

�� Run BINDFIX.

�� Re-create the queue.

IS20SET, an error has occurred in program.

Source: SETUP.EXE

Explanation: When installing ManageWise, you must map a drive to the root of the so
from which the files are installed. Installation may not be able to complet
you have copied the contents of the ManageWise CD to your network und
programs directory and attempted to run the setup from that subdirectory

Action: Map a drive to the root where SETUP.EXE is located, and run setup from
Start menu.

ManageWise client Setup was unable to properly set the path for the Novell WUser 
Agent service. ManageWise client setup cannot complete successfully.

Source: SETUP.EXE
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Possible Cause: This message can occur on a Windows NT workstation or server if you
account does not have administrator or administrator equivalent privilege
The Windows NT station configuration utility tries to add the Novell WUs
Agent service, which is possible only if the user account has administrat
privileges.

Action: When NTSTACFG.EXE is executed for the first time, make sure that the u
who logs in has appropriate administrator or administrator-equivalent 
permissions on the Windows NT machine.

Module NETXPLOR.NLM not loaded retrying...

Source: ManageWise Server

Possible Cause: This message is sometimes displayed on the console of the ManageW
Server when the NetExplorer NLM files are loading. This is not a serious
error; after the NLM files are loaded, the message disappears and the sof
operates normally.

Action: None

No resources on probe

Source: NetWare LANalyzer Agent

Explanation: The NetWare LANalyzer Agent cannot find the resources it is looking fo

Possible Cause: This error can occur if any of the following conditions exist:

� SNMP is loaded with the incorrect parameters.

� Another NLM is automatically loading SNMP without the parameters

� The upper limit on memory dynamically allocated by NetWare 
LANalyzer Agent was exceeded.

Action: Complete the following steps:

�� Make sure SNMP is loaded with the following parameters: 

LOAD SNMP VERBOSE CONTROL= TRAP=

�� If you have this statement in your AUTOEXEC.NCF file, make sure th
another NLM is not automatically loading SNMP without the paramete
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�� To make sure that these parameters are being used, load CONLOG.N
(point your browser at http://support.novell.com/search/ff_index.htm 
get the Novell File Finder utility and input the filename CONLOG.EXE
to review the loading of the NLM files.

When SNMP loads, it should return the following message: 

SNMP: ControlCommunity now accepts any community name

�� If it seems that the upper limit on memory that can be allocated 
dynamically by NetWare LANalyzer Agent has been exceeded, refer
the bound= parameter in the SYS:\SYSTEM\LANZ.NCF file for an 
explanation about increasing or decreasing the memory used by NetW
LANalyzer Agent.

No Response

Source: NetWare LANalyzer Agent

Possible Cause: The network segment may be pointing to an inactive remote monitor.

Action: Complete the following steps:

�� In a ManageWise Console window, select the segment reporting no 
response. 

You can select a segment from the View > All > Network Segments 
window or the Internetwork map.

�� Select Edit > Database Object.

�� Scroll down to the NetWare LANalyzer Server icon and select it.

�� Select an active LANalyzer server.

�� Click Save.

�� Select Fault > Test Connectivity to verify that the ManageWise Cons
can communicate with the server running NetWare LANalyzer Agent

Out of Top N resources

Source: NetWare LANalyzer Agent
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Possible Cause: Another NLM may be loading SNMP without parameters, or with incor
parameters.

Action: Make sure SNMP is loaded with the following parameters:

LOAD SNMP VERBOSE CONTROL= TRAP=

If you have this statement in your AUTOEXEC.NCF file, make sure that 
another NLM is not automatically loading SNMP without the parameters.

To make sure that these parameters are being used, load CONLOG.NLM
(point your browser to http://support.novell.com/search/ff_index.htm to g
the Novell File Finder Web utility and input the filename CONLOG.EXE) 
review the loading of the NLM files.

When SNMP loads, it should return the following message: 

SNMP: ControlCommunity now accepts any community name

If the error message is still reported, take one of the following actions:

�� In the ManageWise Console, close any Network Dashboard window
Top 20 Station Table window that you are not using.

�� On the NetWare LANalyzer Agent Server, increase the Top N resour
value in the SYS:\SYSTEM\LANZ.NCF file.

This file contains a detailed description of the Top N resources variable.

You can also use the LANZCONF utility on the NetWare LANalyzer Age
Server to see how many Top N tables have been opened. To do so, com
the following steps:

�� Load NWSNUT.

�� Load LANZCONF.

�� Select the network board driver that is being monitored.

�� Select Network Interface Items from the menu.

�� Count how many Host Top N entries are in use.

Each entry shows which console and service (Network Dashboard or Sta
Table) owns it.
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Segment not monitored

Source: LANalyzer

Explanation: The segment you have selected and polled is not responding.

Action: Complete these steps:

�� Check the AUTOEXEC.NCF of the NetWare Lanalyzer Agent (NLA)
server and make sure the # sign has been removed from the lines th
default read as follows: 
#SEARCH ADD sys:lanz  

#lanz.ncf

�� Type MODULES at the server console prompt, and do the following:

��DD Note any NLA modules that do not load.

��EE Check for possible file corruption by comparing with installation 
copies.

��FF Verify that the card is capable of promiscuous mode and that the
driver is the most current. 

�� On the NLA server, verify the following:

��DD SNMP is loaded in the AUTOEXEC.NCF with the following synta
LOAD SNMP Verbose Control= Trap=

��EE This line is above any other line that may auto-load SNMP, such
the following:
LOAD TCPIP 

or 
LOAD INITSYS.CFG

�� LOAD LANZCON at the NLA server, choose STATISTICS, and verify
that the packet counts are incrementing.

�� On the NetExplorer server, verify that SNMP is loaded in the 
AUTOEXEC.NCF with the following syntax:

LOAD SNMP Verbose Control= Trap=

�� LOAD IPXCON, choose SERVICES, and verify that the NLA server 
sending out SAP of type 023A.
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�� Toggle through the screens on the NetExplorer server to the NetExpl
Console Utility 1.00, choose SNMP settings, and verify the following

��DD The community types discovered are correct (remember that 
community names are case-sensitive).

��EE The Discovery Community Names includes the one used by the N
server.

��FF The NXPLANZ cycle has completed at least one cycle.

�� At the ManageWise Console, select the NLA server, Choose Edit > 
Database Object > Services > Edit, and add NetWare LANalyzer Ag
to the list of current services.

�� Click on the Adapters or Interfaces icon to make sure that any old 
adapters that have been replaced are no longer listed.

���� Click on the Segment icon in the Internetwork map, Choose Edit > 
Database Object > click on LANalyzer server, and verify the followin

����DDThe correct server is monitoring the segment.

����EEThe correct segment type is being used.

���� If necessary, do the following:

����DDDisable load balancing, if it is enabled.

����EECheck sys:etc\traptarg.cfg to make sure the MW console's addre
present for sending traps to.

���� Unload NLA by typing ULANZ at the server, delete sys:lanz\lanz.cfg
and restart NLA by typing LANZ.

���� Reset the database at the ManageWise Console and reboot.

Station connection_number attempted to use an unencrypted password call.SERVER

Source: ManageWise Server

Explanation: The indicated station could not log in.

Possible Cause: An application or utility tried to log in, verify a password, or change a 
password without first encrypting the password. The server is configured
accept only encrypted passwords.
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Action: Try one or more of the following:

�� Replace the application or utility with one that encrypts passwords w
making calls to log in, verify, or change passwords. If the utility is a 
NetWare 2.x utility, replace it with a NetWare 3.x or 4.0 utility.

�� Use the SET parameter "Allow Unencrypted Passwords" to configure
server to accept unencrypted passwords.

The ManageWise serial number <#> is already in use.

Source: SETUP.EXE

Explanation: A license diskette cannot be used on a single server more than once.

Possible Cause: This error occurs when you try to re-use a Master License Agreement (
license diskette to increase your license count in a server. MLA licenses 
stackable, as long as a different ManageWise-MLA license diskette is use
each subsequent license.

Action: Insert an unused license diskette to continue the installation.

Time is way out of sync.

Source: ManageWise Console

Explanation: There is a discrepancy between the time settings on the ManageWise C
and the managed servers on your network.

Possible Cause: The GTREND.NLM that comes with MW2.6 fails to create SYS:GTRE
and therefore fails to write historical data to the server.

Action: Complete these steps:

�� Set the time zone settings on the ManageWise Console and the man
servers to the correct time zones.

�� Manually create SYS:GTREND; then run LANZ.NCF on the server.

When GTREND.NLM loads it will use this directory to start writing historica
data to the server.

Token Ring adapter [MAC address] is not monitored because it is a pipelined adapter.

Source: LANalyzer
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Explanation: A pipelined adapter is one that begins to send received data to the driver 
the entire packet has been received. NetWare LANalyzer Agent cannot 
support this method of data reception because it must tally all the informa
in a packet before the information is sent to its destination.

Action: If the adapter allows you to switch from pipelined mode to nonpipelined 
mode, do so. 

If the adapter cannot switch modes, use a nonpipelined adapter for NetW
LANalyzer Agent transactions. Check the NetWire bulletin board for 
information regarding availability of the recommended adapters. You mig
have to contact your adapter vendor for the appropriate adapter.

Token Ring adapter [MAC address] is not monitored because the driver does not 
support raw send.

Source: LANalyzer

Explanation: NetWare LANalyzer Agent requires an adapter driver that supports the 
send feature. An adapter driver that supports raw send allows applicatio
build both the header and data components of a frame. The driver then 
receives the packet and sends it to its destination.

Action: Install an adapter driver on the server that supports raw send. Check the
NetWire bulletin board for information regarding availability of the 
recommended drivers. You might have to contact your adapter vendor fo
appropriate driver.

Unable to access security information.

Source: Desktop Management

Explanation: The user is unable to access security information or connect to his or he
Novell Directory Services tree. The ManageWise Console is unable to con
to the server from which the client (user agent) workstation derived its secu
template. The Console is not able to access the security template inform
for the user agent.

Possible Cause: The ManageWise Console may be logged in incorrectly or attached to
wrong server.

Action: On the ManageWise Console, attach or log in to the server to which the c
workstation is connected. 
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Unable to connect to user’s Novell Directory Services tree.

Source: Desktop Management

Explanation: The user is unable to access security information or connect to his or he
Novell Directory Services tree. The ManageWise Console is unable to con
to the server from which the client (user agent) workstation derived its secu
template. The Console is not able to access the security template inform
for the user agent.

Possible Cause: The ManageWise Console may be logged in incorrectly or attached to
wrong server.

Action: On the ManageWise Console, attach or log in to the server to which the c
workstation is connected. 

Unable to copy <filename>

Source: SETUP.EXE

Explanation: When installing ManageWise, you must map a drive to the root from wh
the files are installed. Installation may not be able to complete if you hav
copied the contents of the ManageWise CD to your network under a progr
directory and attempted to run the setup from that subdirectory.

Action: Map a drive to the root on which SETUP.EXE is located, and run setup fr
the Start menu.

Unable to validate context

Source: SETUP.EXE

Possible Cause: This error can occur while installing ManageWise Agents on a worksta
that already has the Console installed.

Action: Complete these steps:

�� Restart the target server where you want to install the ManageWise 
Agent.

�� Right-click on Network neighborhood; then choose NetWare 
Connections.

�� Make sure you are attached to the proper tree and server.

�� Do a UNC32.EXE of the client and then re-install.
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Unknown SNMP alert from [ip address]

Source: ManageWise Console

Possible Cause: The MW Console does not have the necessary MIBs to interpret the 
information from the SAA server.

Action: Obtain the files CE.MIB and SNA.MIB from the NetWare for SAA CD.

User Agent connected to the DS <Server Name>. Connect to the <Server Name> to 
get the security information.

Source: Desktop Management

Explanation: The user is unable to access security information or connect to his or he
Novell Directory Services tree. The ManageWise Console is unable to con
to the server from which the client (user agent) workstation derived its secu
template. The Console is not able to access the security template inform
for the user agent.

Possible Cause: The ManageWise Console may be logged in incorrectly or attached to
wrong server.

Action: On the ManageWise Console, attach or log in to the server to which the c
workstation is connected. 

Wrong version of DLL CTL3D.DLL

Source: ManageWise Console

Possible Cause: This message is usually the result of low memory but can also occur if y
using an incorrect version of the CTL3D.DLL file.

Action: Free more conventional memory. You may also need to install the correc
version of the CTL3D.DLL file. To do so, complete these steps:

�� Change directories to your Windows SYSTEM directory.

�� Back up CTL3D.DLL.

�� Copy SYS:\LOGIN\MW\LDT\CTL3D.DLL to \WINDOWS\SYSTEM.

You have no console privileges on this server

Source: Desktop Management
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Possible Cause: This message can mean that you are attempting to perform a task direc
server to which you are not currently attached. 

It can also mean that you do not have sufficient rights to perform the task
Console privileges are available to users who are SUPERVISOR-equiva
or who were granted console operator rights. 

Action: Ensure that you are attached to the target server and that you have appro
console privileges to perform the task. If necessary, you can use SYSCO
NWADMIN to verify or modify the user rights.
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� Troubleshooting

This chapter provides information to help you troubleshoot ManageWise
software. It is divided into the following sections:

� “Questions to Ask” on page 239

� “Troubleshooting Specific Problems” on page 249

� “Technical Support and Update Information” on page 306

Questions to Ask

This section provides a list of questions to help you identify the source o
problems with ManageWise Network Management Products.

What Are the Symptoms?

How do you know there’s a problem: an error message, an option that w
work, data or results that don’t make sense, etc.?

What Software Are You Using?

What is the version of your NetWare® servers?

What version of ManageWise are you running?

What version of workstation operating systems are you using?
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Is this a new installation or an existing installation that has stopped work

What, if any, are the previously installed MW components: MW 2.0, MW 2
Beta versions, Evaluation copies?

Do you have the latest patches (if you are not sure, please refer to the 
minimum patch list on the Support Connection Web site: http://
support.novell.com)?

Which Parts of ManageWise Are Involved?

If you suspect a problem with ManageWise is related to a particular 
ManageWise component, the questions below can help you isolate the so

ManageWise Console

Did you start with a clean Win 95* workstation with only Client32 2.20 load
before installing ManageWise Console?

Do you have sufficient hardware resources (you should have 100 MB 
minimum free disk space and 24 MB minimum of RAM).

What ManageWise version are you using?

What Windows* version are you using?

What Windows service pack are you using?

Client version / Multiple clients (MS/Novell®)?

Are any other programs running on the console workstation?

Are they installed locally or to network?

What is your frame type?

What happens if you IPXTM  ping the workstation to see if it is communicating

Is the problem general or isolated to certain workstations?

Is the user not running the container login script: Exit statements, contex
��� LogicSource for ManageWise
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Desktop Manager

Is the Default Security Template set?

What is your WUSER loaded/date?

Are you using the latest clients and LAN drivers?

What are the timeout issues with WAN links, check IPX/SPXTM-, or Btrieve* 
parameters?

Are you using Win95b or Win95c?

Is the inventory part working correctly?

Is the remote control part working correctly?

Have you installed screen drivers and ZENworksTM?

NetExplorer

Are NXPIP, NXPIPX, and NXPLANZ running properly?

NXPCON: Scope for IP and IPX, SNMP* community strings.

For IP:  Is NetWare LANalyzer® Agent in the segment?

SPXS.NLM version?

LANalyzer Agent

Does your LAN card support promiscuous mode?

LANZCON: are the packets shown there and is the LAN board displayed

Has the NLA service been added to the server icon?

Is the correct server monitoring the segment?

Have you started polling the segment?

Have you tested NIC?
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Has LANZ.NCF loaded and have comments been taken out of 
AUTOEXEC.NCF?

Is the SNMP load line before INITSYS.NCF or TCPIP?

Is LANZTR.NLM discovering token ring segments?

Is LANZCON discovering NIC statistics?

Is IPXCON checking for services?

NetWare Server Components

Are the relevant product modules loaded?

NetWare version (SMP/SFT3)?

OS Version patches?

ManageWise version?

ManageWise patches?

In the case of an abend:

Abend message?

ABEND.LOG / CONFIG.TXT / CONSOLE.LOG / COREDUMP?

Module causing the abend: Remove it from the AUTOEXEC.NCF?

Available space / Purgeable disk space?

NetWare Management Agent TM  (NMA)

Have there been any customizations to the SYS:ETC/TRAPTARG.NCF a
NWTRAP.NCF files?

Is SNMP loaded?

Is there any SAP filtering on the network?
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If you are using the NMA on a Windows NT* Server, did you reinstall the
latest Service Pack from Microsoft® after you installed any new component

Virus Protection InocuLAN* 4.0

Have you installed the latest pattern updates (if not, you can download th
from http://support.novell.com/Ftp/Updates/mwise/mw25/Date0.html)?

NOTE: Pattern files from http://www.Cheyenne.com are not supported.

Are you using the most recent Signature file version, Engine version, an
Pattern file version?

Are you using the most recent versions of VSCAND.EXE, 
LPROTECT.NLM, and AVENGINE.NLM?

Installation

Windows version?

Client version?

Was the schema extended?

DS health?

DSREPAIR?

NAL Patch applied?

Can You Localize the Problem to a Functional Area?

Create a diagram to visually represent the sequence of events. Use the 
bottom approach, starting with a large scope and narrowing it down.

Creating Application Objects

Executable or a .AOT (installation object)?

Windows Version?
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NetWare Administrator version?

Have DSREPAIR and DSTRACE been run yet?

Distribution of the Application Object

Do the users have rights to the object?

Do the users have rights to the location where the files reside?

Have all of the proper NWADMIN pages been filled in?

Windows version?

Client version?

Are all of the machines having the problem?

When a Machine Hangs

Does it happen every time or only sometimes?

Does it happen on different machines?

What is the brand of the computer that hangs? (If it's a Compaq, check as
for BIOS updates.)

Does the workstation hang or does the MW Console machine?

Are both machines in the same segment?

Is there any bridge or router in between?

Is a certain application launched on the target station when the machine
hangs?

Can WUSER be started after the boot process has completed and the 
workstation is logged in?

Are there any specific error messages?

Are you using the latest LAN drivers on the machines?
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WUSER.EXE

Increase IPX/SPX parameters on the ManageWise Console and on the t
workstation.

Client 32 configuration: set the IPX/SPX timeouts to a higher value. To do
open the Control Panel, Network, IPX 32-bit Protocol for Novell NetWare
Client 32, Properties, IPX: increase the IPX retry count to 40.

Under the SPX tab, increase SPX connections to 60, SPX verify time-ou
216, SPX listen time-out to 270 and SPX abort time-out to 2160.

Do you have enough resources (RAM, CPU etc.) on the MW Console 
machine?

Try different video resolution (a standard 800x600, 16 colors, for example
the MW Console and on the target workstation. Try to use the standard SV
driver from Microsoft to troubleshoot video issues.

Try swapping the video board if video problems persist.

You can also edit the configuration and WUSER files. The different secti
in the CLNTCFG.INI show how the workstation is configured.

The [Configure] section defines which users will have their workstations 
configured. The date on the ConfigureBefore line indicates that all users 
have not been configured before this date should have their workstations
reconfigured or configured for the first time. The configuration file is store
in a hidden file, named CCDRIVER.TXT, in the users' workstations. The 
date's format is YYYY/MM/DD (f.i. 1998/11/04)

The [Products] section indicates whether the Desktop Configuration Mana
will communicate with a workstation on the network. Desktop manager 
(DTM) is listed with either a Yes or a No. A Yes next to the product indica
that workstations should be configured to work with that product. If you ins
Desktop Manager, the following two lines are added to the [386Enh] sec
of the SYSTEM.INI file:

Device=VUSER.386

TimerCriticalSection=10000
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In case Windows has trouble finding the VUSER.386 file, specify the file
complete path;

like Device=C:\WINDOWS\SYSTEM\VUSER.386

You can also add the following line to the appropriate line in 
SYS:MW\LDT\CLNTCFG.INI to make the client configuration utility 
CLNTCFG.EXE add this line to SYSTEM.INI:

ADDINI3={%WINDIR}, SYSTEM.INI, 386ENH, Device, 
C:\WINDOWS\SYSTEM\VUSER.386, TRUE

The following files are added to the WINDOWS\SYSTEM directory:

COEXIST.DLL
CTL3D.DLL
IDISPLAY.DLL
VUSER.386
WINMEM32.DLL
WUSER.EXE
WOLNUI.DLL
IMP.DLL

In order to reconfigure the workstation properly, delete CCDRIVER.TXT 
the target station and run CLTNCFG again.

The CONFIG.TXT File as a Troubleshooting Tool

The CONFIG.TXT file contains information that may point to the source o
problems with ManageWise. This section provides a list of areas to chec
you read down through the CONFIG.TXT file. It also suggests corrective
actions where appropriate.

Initial Information

Look for specific information about the server, including the server name,
version, Server Up Time, and LRU Sitting Time.

If the server has been up for more than 24 hours, check the LRU sitting t
If the LRU sitting time is less than one hour, watch it closely to make sure 
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it does not decrease below 15 minutes. The server's LRU sitting should n
drop lower than 15 minutes.

If the LRU sitting time is lower than 15 minutes, Novell recommends that y
add memory to the server.

Top of Patch List

Make sure that you have applied the most up-to-date OS patches. Point
browser to support.novell.com for the current minimum patch list.

Top of Module List

Check the files and drivers listed below.

BTRIEVE.NLM

Make sure BTRIEVE.NLM is version 6.10f or greater. If you have multipl
programs that depend on the BTRIEVE.NLM being loaded, you may run 
of licenses (sessions). This could interfere with the Desktop Manager’s 
performance.

Action: If you have version 6.15 5-user version loaded, you may want to 
increase the user count to at least a 10-users version.

BSPXCOM.NLM

This NLM must be loaded for IPX communication between the server and
ManageWise console.

LAN DRIVERS

Make sure that your LAN driver is newer than 1996. Older drivers may h
problems with the newer technology in the LANalyzer Agent. Older drive
have been known to abend servers that have the NLA 1.21 installed.

HOSTMIB.NLM and NTREND.NLM

Make sure that these NLMs are specific to the OS version.
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SNMP.NLM 

Make sure this NLM is version 4.10 or greater.

SPXS.NLM 

Make sure you have rev. Q or greater.

TOP OF LAN DRIVER CONFIGURATION

Avoid using interrupts 15 and 9 in a NetWare server. These interrupts ha
been known to cause problems.

Volume Statistics for SYS

Free Disk Space and Purgeable Disk Space

All ManageWise operations occur on the SYS: volume. Check the Free D
Space and the Purgeable Disk Space. Novell recommends that you have
as much Free Disk Space as Purgeable Disk Space.

Action: If your Purgeable Disk Space is greater than your Free Disk Spa
you should consider Purging the SYS: volume to Free up disk space.

Suballocation, Compression, and Migration

Novell Engineering recommends keeping 10-20 percent of the volume sp
free to avoid suballocation problems.

Loading SNMP.NLM 

If you are loading the SNMP.NLM through the INETCFG utility, make sur
that the LOAD SNMP looks like this:

LOAD SNMP ControlCommunity= MonitorCommunity= TrapCommunity=
verbose

Loading IPXRTR.NLM

If this is a NetExplorerTM  server, make sure that you have NOT disabled th
IPX routing. If IPX routing has been disabled, the line will look like this:
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LOAD IPXRTR routing=none

This will greatly affect the discovery process.

Troubleshooting Specific Problems

The troubleshooting examples in this section illustrate some problems yo
may encounter while using ManageWise, and offer possible actions for 
solving them. They are intended to demonstrate some of the different wa
you might look at the interrelationships between the different parts of 
ManageWise and the rest of your system. The information in this section is
intended to be comprehensive.

This section is divided into the following topics:

“ManageWise Console” on page 240

“Desktop Manager” on page 270

“NetExplorer” on page 241

“NetWare LANalyzer Agent” on page 287

“ManageWise Server” on page 295

“SETUP.EXE” on page 298

“The Btrieve Environment” on page 301

“The WAN Environment” on page 305

“The Windows Environment” on page 305

ManageWise Console

Problem: ManageWise Console is sluggish

Explanation: During the initial discovery phase, the ManageWise softwar
might be sluggish if you have a very large network and NetExplorer Mana
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is populating the database and writing to the disk. After the discovery pro
is complete, console performance improves.

Action: Novell recommends that you schedule NetExplorer Manager’s ini
discovery when you do not need your workstation, such as overnight or o
a weekend.

Problem: Internetwork Map appears empty after ManageWise has run for awhile

To address this situation:

�� Use the NXPCON utility on the ManageWise Server to verify that 
NetExplorer NLM files are running on the server.

This utility informs you of the NLM status.

�� Check the Number of ManageWise Consoles field in NXPCON on yo
ManageWise Server.

This value is incremented each time a new ManageWise Console atta
to the ManageWise Server. If this value is 0, it means that no ManageW
Console is attached to the ManageWise Server.

�� If you receive the message, verify that NetExplorer Manager is runni
on your ManageWise Console.

If a red circle hash symbol appears over the NetExplorer icon, it can
connect with the ManageWise Server.

Problem: Internetwork Map is incomplete after ManageWise runs for a while

To address this situation, take the following steps:

�� In the NXPCON utility on the ManageWise Server, expand the scope
for IP discovery.

By default, only the IP network to which your server is connected (as
determined by the class of your IP address) is discovered.

�� Configure additional SNMP community names if some of your system
are using an SNMP community name other than “public.”
��� LogicSource for ManageWise

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

 to 

t 
 
dit 

m 
is 

e 
ule, 

 of 

.

�� Use NXPCON to select SNMP > View Discovered Community Names
determine which addresses NetExplorer can discover.

If addresses show up with the name UNKNOWN, NetExplorer canno
access them. Determine what the community name for the unknown
server is, and add that name to the Community List using SNMP > E
Community Name List.

�� Use NXPCON to verify NetExplorer system status.

“Initial cycle completed” should be displayed in the NetExplorer Syste
Status field. If the initial cycle is not complete, allow more time until it 
completed.

Problem: User manually renamed a segment in the internetwork map, and it was 
overwritten by NetExplorer.

Explanation: After the NetExplorer server has finished at least a complet
cycle of the discovery modules that you specified to run: the NXPIP mod
the NXPIPX module, and the NXPLANZ module, the NXPCON screen 
reports the status of each module and the cycle it is on.

Action: Rename the segment names, and they won't be overwritten by 
NetExplorer.

Problem: User login name under a workstation icon on a segment map remains the same 
regardless of who logs in subsequently from the workstation.

Action: To make ManageWise update the user login names at each cycle
IPX discovery, use the following parameter:

On your MANAGEWISE server running NETXPLOR, add the following 
lines to SYS:\NMDISK\NXP.INI:

[IPXDiscoveryOptions]

IPXUpdateUserNameForWorkStationFlag=1

Unload NETXPLOR MGR on your MANAGEWISE console, if it's running

Run UNXP.NCF on the MANAGEWISE server running NETXPLOR.

Run NETXPLOR.NCF on the MANAGEWISE server.
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Run NETXPLOR MGR on your MANAGEWISE console.

NetExplorer will now update the workstation user login names in each pa

Problem: You receive a large number of NetExplorer Traps in the NMS Alarm Manager.

Explanation: The following list of Traps cannot be suppressed from the Ala
Manager.

Box Updated
NetExplorer connection
NetExplorer disconnect
NetExplorer server initiation failure
Network adapter changed
Network adapter removed
Network modified
Network removed
New network
New network adapter
New router
New segment
New server
New workstation
New world
Router changed
Router removed
Segment modified
Server changed
Server removed
Suggest segment consolidation
Workstation changed

These traps can be viewed by choosing FAULT >ALARM DISPOSITION
from the ManageWise Console.

Action: Through alarm disposition you can disable the trap from logging to
database. You can also disable the BEEP and ticker tape, but not the log
to the ALARM Monitor.
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Problem: WIN.INI is not modified when running Windows from the network.

Explanation: When a user is made a member of the ManageWise group,
then logs in to the network, a command called CCDRIVER.EXE is execu
By default CCDRIVER looks for WIN.INI files to be modified only at the 
local drive, not at the network level.

Action: Follow these steps:

�� Map SEARCH/ROOT the location of the user’s network Windows 
directory.

�� Edit the MW_LOGIN.DAT file (located in the public directory). Chang
the CCDRIVER line to read as indicated in the example below:

Example Map statement

   Map root s16:=X:={servername}\{volumename}:{path to 
windows directory}

Example CCDRIVER command

   #COMMAND /C L:\MW\LDT\CCDRIVER /M\X:\

Problem: Customer does not see any manageable NT servers from the ManageWise 
Console.

Action: Log in to the Windows NT Server with ADMIN rights and reinstal
the ManageWise Agent for Windows NT servers.

Problem: Only a small percentage of available NetWare Server Trend statistics are 
selectable.

Action: The following is a possible work-around:

�� Back up the SYS:ETC\NTREND.INI file on the file server and remov
from it the QUEUE_JOB_WAIT_TIME parameters or others you mig
not want to gather information on.

�� LOAD NTREND RESET at the server.

�� Back up the C:\WINDOWS\NMS.INI file. Then modify the section 
beginning with "Trend Defaults - Start" so that only the desired trends
the default.
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�� Reset the database using the Database Administration Tool. This wi
delete any custom maps you may have created and all alarms receiv

�� Restart the ManageWise Console.

Problem: Alarm Disposition Table fails to launch a paging program when the server 
disables a user account (Intruder Lockout), even when set to do so.

Action: The following Intruder Lockout Trap should be used for applicatio
launch in a NW 4.1x environment:

"USER: Account Disabled Temporarily" 

Problem: A recently added application does not appear on the software list.

Action: To successfully add an application to the software list, follow thes
steps:

�� Open the Desktop Manager for an object.

�� Click on Options, Software List.

�� At the bottom of the Application Information box click on New.

�� Enter a Product Name or a description of the application.

�� Enter the version of the application if it is known. If the version is not
known then leave the default X in this field.

�� Enter the filename that the inventory will scan for on the workstation

�� Enter the file size if known. If the file size is not known, leave the defa
of 1 in this field.

�� Adjust the Scan Method as needed. However, when initially testing t
functionality it is recommended you use the default of Version Resou
Information - ProductName.

Check the Scan Extensions list to be sure the extension of the filena
(see 6 above) is listed. If the filename extension is not listed, add it b
clicking in the field and typing in the extension.
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�� Type a period (.) before an extension.

Type a space to separate extensions.

For example:

.exe .com .sys .bat

���� Locate the View box on the left side of the screen and click on the Ign
List item.

���� Review the Included in List box to see if the filename you have adde
the software list is in this list.

���� If it is, highlight it by clicking on it and then click on Remove.

This will remove the filename from the ignore list so that it will no long
be ignored during the inventory scan.

NOTE: If the filename is included in the Ignore list, then it will always 
be ignored during the inventory scan even though it has been added 
to the software list.

���� Click on Accept, then OK (to close the edit software list window).

���� Exit the Desktop Manager.

���� Have the workstation user log out and log in again, and verify that a n
software scan executes.

NOTE:  By default the software scan is scheduled to run once per day 
during login. So, if the workstation has already logged in today then 
simply logging out and in again will not execute a new software scan. 
Either wait until the next day for the workstation to have a new 
software scan executed or change the software scan frequency. To 
change the software scan frequency do the following in the Desktop 
Manager: Click on Options, Software Scanning, and change the 
Frequency. To have the added software added to the inventory 
database today, change the Frequency to Always.

���� After the workstation has logged in and a new software scan has be
performed, re-open the Desktop Manager, highlight the workstation 
click on Tools, Query, and if the added software was detected during
new software scan, it will show in the Components list.
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Problem: User wants to install only the ManageWise Console, without performing a full 
install.

Action: Follow these steps:

�� Map a drive letter to the NetExplorer server and then run the 
MANAGEWISE SETUP.EXE.

�� Select the drive letter that is mapped to the NetExplorer server and 
continue.

�� Continue through the screens.

The license screen should show the # of the license count already inst
on the NetExplorer server.

�� Click on Continue.

The next screen has the Install Options.

�� Click on Custom Install and only select the ManageWise Console op
and continue.

Problem: ManageWise inventory database has been reset or rebuilt multiple times, but 
continues to become corrupt or inaccessible.

Explanation: If the server is running a Cheyenne Arcserve* version 
(specifically 6.0 or above) this may be a problem. Arcserve 6.0 ships wit
Btrieve NLM 6.15.2 (5user) which is usually installed over the version 6.x t
comes with NetWare. When ManageWise Inventory NLM loads it mainta
its database in four .DAT files. In so doing it takes four of the five breque
sessions. If Arcserve, or any other product requiring Btrieve services, is 
loaded before or after, then one, both, or all products requiring sessions 
be affected, randomly or constantly.

Action: Follow one or more of these steps:

�� Revert to Btrieve 6.10c available in (BTR61.EXE).

This would require that Arcserve be reinstalled (if it is installed at all)
making sure that when it prompts for Btrieve to be upgraded the insta
says NO. The ManageWise Inventory database would best be rebuil
this point also.
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�� If downgrading Btrieve to 6.10c is not an option, then contact Pervas
Computing and upgrade the Btrieve 5 user to a larger user version.

�� After choosing option 1 or 2, make sure that Btrieve is loaded early i
AUTOEXEC.NCF via BSTART.NCF, and that it has been edited 
reflecting the proper loading values to accommodate ManageWise. B
sure to add the Btrieve requirements of other products onto these to

Problem: User is unable to reset the ManageWise NetExplorer database.

Action: For best results reset the database when all users are logged in 
network and let the NetExplorer process run continually. Follow these ste

�� To unload the NetExplorer process, stop the NetExplorer process on
server by typing the following at the server’s system prompt:
UNXP.NCF

�� Reset the ManageWise Console database by opening the ManageW
program group from the desktop and starting the Database 
Administration Tool.

�� On each Console that attaches to this NetExplorer server, follow the
prompts, and click on Reset Database.

�� To reload the NetExplorer process, type the following at the servers 
system prompt:
NETXPLOR.NCF 

�� Restart the ManageWise Console machine so that the NetExplorer 
Manager loads again.

�� Give the NetExplorer process some time to begin to populate the ma

This may take from 10 minutes to several hours.

Problem: A third-party MIB does not compile correctly.

Explanation: The third-party MIB may have dependencies. 

Action: Rename it so that the first letter of its name is a "z" so that it comp
last.
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Explanation: The MIB Compiler may have detected a DUPLICATE 
VARIABLE.

Action: Rem out the problem lines in the MIB by placing a "–" in front of 
them.

Explanation: There may be an incorrect syntax.

Action: Review the MIB for variable names beginning with capital letters a
rename them to lowercase. Also, look for underscores in variables, and 
rename all of the variables to something without underscores.

Explanation: Some semicolons may be missing. One semicolon should ap
in the IMPORTS section of the MIB.

Action: Check for missing semicolons.

Problem: ManageWise is unable to get SNMP information, even though the servers on the 
segment are manageable (NMA NLMs are loaded).

Explanation: ManageWise requires that SNMP.NLM be loaded prior to 
CPQSNMP.NLM. Making this change does not adversely affect the 
functionality of Compaq Insight Manager*.

Action: Load SNMP.NLM before CPQSNMP.NLM.

Problem: The NTREND.NIN file had the alarm 'VOLUME_FREE                  7        8928  1         
15      10  1  falling' but no alarm was being sent to the ManageWise Console even though 
the volume was more than 95% full.

Action: Free up disk space till Free space is greater than the rising thres
(15% default, roughly: 90%-15% of the volume) and then purge the volum

Problem: User is unable to see traps that are set to an INFORMATIONAL severity.

Action: At each server where the ManageWise Agent is loaded, follow th
steps:

�� Edit the SYS:ETC\NWTRAP.CFG file and change the following line 
from:
SEVERITY

                  WARNING
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to:
SEVERITY

                  INFORMATIONAL

�� Unload and reload the NWTRAP.NLM.

Since INFORMATIONAL is the lowest Severity level, all traps will now
be forwarded to the ManageWise Console.

Problem: Time Zone Setting syntax is incorrect for workstations.

Explanation: The TZ parameter is not set by default when installing a No
Client. ManageWise is the only Novell product that sets the TZ paramete
You can set it in the autoexec.bat file with the syntax listed below.

Action: Use the following syntax for the TZ parameter following these 
circumstances:
SET TZ = XXX9XXX

Examples:

Workstation in Mountain Standard time with Daylight Savings. "SET TZ =
MST7MDT"

Workstation in Mountain Standard time without Daylight Savings "SET TZ
MST7"

You can potentially remove the hour offset (the 7 at the end of MST) if it is
on the server. If MST7MDT is the timezone on the server, then TZ may be
to MST instead of MST7. Novell recommends setting the hour offset anyw

Table 64 Time Zone Syntax Reference

Time Zone Zone Hours from GMT Daylight Zone

Eastern Standard Time EST 5 EDT

Central Standard Time CST 6 CDT

Mountain Standard Time MST 7 MDT

Pacific Standard Time PST 8 PDT
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Problem: User is experiencing Btrieve errors and Btrieve database corruption.

Explanation: Both can be caused by insufficient Btrieve environment setti

Action: Set your Btrieve parameters to the following (as recommended by
Intel® technical document for their LanDesk* Management Suite):

Common Btrieve errors caused by insufficient parameters include the 
following:

Btrieve Error 87 (Insufficient Number of Handles)

Btrieve Error 96 (Insufficient Number of Remote Sessions)

NOTE: Be sure to change the NCF file that loads BTRIEVE.NLM so that 
BSTART.NCF is executed before loading BTRIEVE.NLM so that these 
changes will be implemented.

Each parameter’s associations are contained in the following table:

Parameter Default Minimum Recommended

# of Open Files 20 33 128

# of Handles 60 53 228

# of Locks 20 5 1

# of Transactions 15 5 45

Largest Compressed Record Size 0 N/A N/A

Largest Record Size 8192 8192 8192

Largest Page Size 4096 4096 4096

# of Remote Sessions 15 15 45

Cache Allocation 256 256 768

Parameter Value Association

# of Open Files 20 -f

# of Handles 60 -h
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Problem: After consolidating the segments on the map, one of the servers on each 
segment takes itself out of the map and creates its own ring separate from the ring that it 
is actually attached to.

Action: Set all SNMP community names back to 'public' and consolidate
segments of the detached servers.

Problem: A GPF occurs in KRNL386 when attempting to install the ManageWise console 
program via custom install.

Action: Copy the ManageWise CD to a permanent or temporary volume-
directory and then use the MAP ROOT command to create a semi-perma
drive letter map rooted to the directory where the MANAGEWISE CD wa
dumped.

Problem: The Desktop Manager component lists duplicate users in the database.

Explanation: The Report tool does not offer an option for the HW Invento
Scan date, but the Tools/Query does.

# of Locks 20 -l

# of Transactions 15 -t

Largest Compressed Record Size 0 -u

Largest Record Size 8192 -d

Largest Page Size 4096 -p

# of Remote Sessions 15 -s

Cache Allocation 256 -m

Perform Index Balancing No -c

Create Files as Transactional No -i

Logging of Selected Files No -a

Create Btrieve files in pre v6.x format No -d

Configure BSTART.NCF to Load BRouter No

Parameter Value Association
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Action: Run a query to list all of the stations that have not logged in on tod
date. Follow these steps:

�� After launching the ManageWise Console, Click File/Open/Internetwo
Map.

�� Double-click on the segment that contains the ManageWise Inventor
server you wish to query.

�� In the Segment Map dialog box, highlight the MANAGEWISE File 
Server Database icon/object for the ManageWise Inventory server y
wish to query.

�� Click Tools/Desktop Manager.

�� Click Tools/Query.

�� Under the middle "Components " option in the Query Criteria dialog b
mark only Supplemental (unmark Software and Hardware).

�� Double-click the selection for "*:Hardware Scan Date" in the left 
"Components" option, to populate the "Description Values" window.

�� Select today’s date in the "Description Values" window and then click
"NOT" in the Logical Operators section.

�� The "Query Building Box" should then display something similar to:
NOT(:Hardware Scan Date = [MMM DD HH:MM:SS YYYY])

where [MMM DD HH:MM:SS YYYY] represents the current date and
time.

This will provide a database object list of any station that did not log in a
run LDISCAN from the login script that day. You can then block and dele
these database objects. If one of the users you deleted was valid and jus
not logged in that day (on vacation, sick, etc...), then the next time they lo
and run LDISCAN from the login script, it will recreate their object in the 
MANAGEWISE Inventory database. It will re-scan their hardware invento
but not necessarily their software (this is dependent on the Tools/Softwa
Scanning option).
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Since you cannot delete a ManageWise Inventory Database entry from a q
screen you will want to print out the query results and then delete the data
objects from the Desktop Manager and/or Network Map Screen. You can
the following steps to accomplish this:

�� From Desktop Manager window after the last step above, make sure
only the Query Results are expanded; then select File/Print, and mark
Expanded Groups."

You may also want to mark the Component Set, click on components,
then select entries such as "Address" (Media Access Control Addres
and "Login Name" (to get the NDS name of the user who created the
database entry).

�� After you print this information, go to View/Columns and add the 
"Address" and "Login Name" so you can be sure you are deleting th
correct database objects.

�� Expand the [server_name] - Inventory Database selection and then u
the standard Ctrl + Left-Mouse-Click and/or Shift + Left-Mouse-Click
mark all ManageWise Inventory Database entries and then click on E
Delete.

�� Click Yes when you see the "NetWork Map DLL Delete Selected 
Element(s)? Yes/No" popup box.

�� If you wish to delete these objects from the Segment Map, mark the
option to "Remove selected items from the database as well".

The above steps will remove any duplicate objects in the ManageWise 
Inventory Database and any associated objects in the Segment Map. How
it is possible to have additional entries that have a duplicate Login Name
the Segment Map, but they will NOT have duplicate MAC addresses.To ch
for this condition you can use the following method:

�� From the Segment Map click on View/Arrange By/Object Name.

�� Scan for duplicate names. 

These could legitimately be caused by users who have more than on
machine or MAC address they use; for example, a desktop and laptop
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�� If you find an entry for a MAC address that is no longer used, you can t
any action such as deleting the object that would be helpful to you in
administrating your environment.

Problem: Users can set server parameters via SNMP, no matter what rights they have to 
the file system.

Explanation: Even if a user has no rights to SYS:SYSTEM, that user can
go into the MANAGEWISE console to "View / All / NetWare File servers"
and select the option to set server parameters. This enables them to ma
changes to both the console set parameters and AUTOEXEC.NCF.

Action: This is all done via SNMP; therefore, the server's SNMP 
ControlCommunity and MonitorCommunity strings should be changed to
something the other users don't know about. ManageWise consoles "Ge
Set" strings default to "public." The solution is to edit the server’s 
AUTOEXEC.NCF to load SNMP with different community strings. For 
example:
LOAD SNMP verbose ControlCommunity=AUTHORIZED_ONLY 

MonitorCommunity=AUTHORIZED_ONLY.

If you know what the strings are, you can change them on your console.
should then protect your consoles with a password in order to keep 
unauthorized persons from viewing the community strings for accessing 
servers.

NOTE: The MonitorCommunity can be set to public. Only the 
ControlCommunity needs to be set to a secret value. Set both to a secret 
value if you want unauthorized users to receive a message reminding them 
that they don't have privileges to view the information.

Problem: The "audible" beep that notifies you of a specific ManageWise alarm is barely 
audible.

Action: Turn up the volume. If this doesn’t work, try using the Windows 
default sound(s). This would allow for a wider and louder range of sounds 
can be triggered when an event has happened.
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Problem: The server name in the USER ID heading does not match the name of the current 
inventory server.

Explanation: The LDISCAN.CFG may have been assigned and written by
old server that is no longer being used, or one that has been renamed o
reassigned.

Action: Either manually or via a batch process, delete LDISCAN.CFG fro
the errant machines, and then log them in again to be scanned. A new file
be created with a subsequent new device ID.

NOTE: Even if the information is not correct, inventory functions and 
remote control will still work as long as no machine on the network has the 
same LDISCAN.CFG copied to it. Ghost and imaging programs can have 
adverse effects on this if the machine being ghosted had LDISCAN.CFG 
already written to it.

Problem: IPX Ping of server PRV-TMATTING fails.

Explanation: You may receive this message when you reboot a ManageW
Console on a NetWare 5 pure IP environment (no IPX\SPX).

Action: Set up the system for IPX\SPX. If this is not possible, a workarou
may be to set up the client for compatibility mode.

Problem: A server that no longer exists appears as manageable in the ManageWise 
console under VIEW > ALL > NetWare File Servers.

Explanation: The Server object still exists in the segment map and has no
been removed.

Action: From the ManageWise Console select VIEW > FIND > NODE, en
the name of the server, and delete the server object when a match is fou
the segment map.

Problem: Desktop Manager’s workstation summary reports the last scan date and time 
incorrectly.

Action: Include a set variable TZ set to the correct time zone. Follow the
steps:

�� Select Settings > Control Panel > Environment.
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�� Add the variable TZ =GMT +/- Time Zone difference.

�� Calculate the difference from GMT and change the sign of value.

For example:

1. The Time Zone for Sydney Australia is 10 hours ahead of GMT. 
(GMT+10)

2. Reverse the sign of the Time Zone difference +10 becomes -10.

3. Set the TZ variable to equal "TZ=GMT-10".

Problem: There is no icon representing an NT server you want to add to the segment map.

Explanation: In ManageWise 2.5 the icon MNTFILSV.ICO exists in 
C:\MW\NMS\ICONS. But it does not exist if you install a ManageWise 2.
console on a machine that did not have v2.5 console on it first.

Action: Copy MNTFILSV.ICO from a 2.5 console from one that was 
upgraded.

Problem: After installing ManageWise on a NetWare server, user cannot connect to this 
server through the login script.

Explanation: ManageWise installation adds several lines to the login scri
including a drive mapping to the ManageWise server and a line that exec
NTDIAG.EXE on NT workstations. If NTDIAG.EXE is not loaded, the NT
machines will not be able to respond to IPX diagnostics.

Action: Move NTDIAG.EXE to the public directory on the server where th
users are mapped.

Problem: MIBs are removed from the CURRENT directory, but the related alarms remain 
in the Alarm Disposition.

Action: Go in to the Database Administration tool and Reset Traps. This 
remove all the alarms listed in the Alarm Disposition except for the 
NetExplorer Alarms and the Connectivity Test alarm. You can then go into
Tools option and recompile the MIBs. All of the other alarms will then be 
added and the default settings will return.
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Problem: SNMP service hangs at startup, then restarts ten seconds later, adversely 
affecting other SNMP-dependent services.

Action: Try removing the Microsoft NT Monitoring Agent or NT Tools and
Monitoring Agent services from within the NT Control Panel->Services. 
Enabling (setting to automatic) the NT Monitor Agent will also work.

Problem: SNMP operation fails on some NT servers but not others, even though they are 
all exactly the same.

Explanation: The ManageWise Agent for Windows NT queries NT system
components and uses SNMP to communicate this information back to th
MANAGEWISE console. If the system is getting SNMP operation failed 
messages, then the SNMP Communication between the NT system and
MANAGEWISE console is suspect.

Action: Follow these steps:

�� Check the NT event log to see if SNMP hangs and then restarts at sy
startup.

�� If it does, check Control Panel > Network services to see if there are 
Microsoft NT monitoring agents installed and if they are in the manu
state.

�� If they are, set them to "automatic", or remove the services.

�� Check to see what is different between the system that works and th
others that do not work.

If the MANAGEWISE NT Agent works on one NT cluster and not on
other similarly configured systems, then the problem may be a 
configuration problem. If NT Agent works on one NT server cluster, th
logically, it should work on the others.

�� Check SNMP versions to make sure you are using the latest versions
compatible versions.

�� If there are any other SNMP-related applications being loaded/instal
on NT machines, try removing these applications; then add them back
at a time to isolate the problem.
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�� Check the file versions in the MANAGEWISE directory on the NT4 
servers to make sure that the MWNT01a and MWNT01b patches ha
been properly applied.

Problem: Desktop Manager crashes when connected to a 100Mbit/s switch.

Action: Follow one or more of these steps:

�� Use 10Mbit/s.

�� Upgrade to ManageWise 2.6 and use the ManageWise Console on N

�� Minimize polling by the Desktop Manager by editing C:\WINDOWS\ 
NETMAP.INI on the ManageWise console. In the [Default] section, 
change the USERCHECKER variable to OFF. If the entry does not ex
add it as follows: USERCHECKER = OFF

Problem: Duplicate objects are listed in the ManageWise Inventory Database.

Explanation: This could occur for any of the following reasons:

� An inventory scan (LDISCAN.EXE, WLDISCAN.EXE, 
LDISCNNT.EXE, LDISCAN.NLM) may not have completed for 
whatever reason, such as system lockup, LAN/WAN communication
failure, etc.

� The hidden file C:\LDISCAN.CFG may have been deleted from the 
workstation. In this case a duplicate object will be created on the nex
login if the scan utility runs.

� WLDISCAN.EXE may be running on an NT machine.

� Your Btrieve parameters may be set too low. Check the default settin
and if necessary adjust them to the needs of the environment and ot
applications using Btrieve.

� The Inventory databases may have become corrupt.

Some other situations that might cause Btrieve database corruption are p
related problems affecting the server, turning off the server without down
and exiting it first, volume space used up by files and/or purgeable files, 
installing other products while ManageWise is running.
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Action: Correct the situation that caused the duplicate object; then delete
duplicate object.

Problem: Unable to delete the “location unknown” object on the ManageWise Console.

Explanation: The "Location Unknown" object is a holding place for all the
objects that are lacking pertinent information to determine where the obj
belongs in the map. The objects stored under the "Location Unknown" m
actually be located on a number of different segments. This is the reason
you cannot delete the "Location Unknown" object.

Action: Double-click the “Location Unknown” object to view any objects 
under it. From here you can delete or move the objects. You can never d
the “Location Unknown” object itself, even if there are no objects under i

Problem: Manually added inventory data disappears after running the SyncComplete 
Integrator.

Explanation: When SyncComplete Integrator is run, it assumes that the 
information in the Inventory database is the most current and correct 
information. Therefore, all information that was manually added to the ob
is null and void. If the Inventory database doesn't have the same informa
about the object, it will overwrite the information you added manually.

Action: As a workaround, do not manually add the changed information to
object until after you have run the SyncComplete Integrator.

Problem: User receives startup errors and experiences file corruption and other problems 
after moving the database directory to a network drive.

Explanation: The nmsdb directory should be located on the local drive ON
It is not supported on a network drive because if a server goes down, it ren
the ManageWise Console useless.

Action: Move the directory back to a local drive.

Problem: On a ManageWise Console machine, the Ping Periodically list has mac 
addresses for the name of the Node or Server. 

Explanation: The Ping Periodically list that you add Nodes or Servers to u
the mac address in the internetwork map if there is no name associated 
the object in that map. That means that NetExplorer only discovered the 
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address at the time the Node or Server was found. It is possible that nob
was logged in to the workstation when it was discovered.

Action: Associate a name with the object in the internetwork map.

Desktop Manager

This section provides solutions to problems you might encounter with 
workstations managed by ManageWise via the Desktop Manager.

Problem: You get a message about loading SNMP VLM files

Explanation: When you try to get information about workstations, you mig
get a message asking you to ensure that SNMP Virtual Loadable Module
(VLM) files were loaded.

Action: If this happens, you must configure the SNMP VLM files. Refer to
NetWare Client for DOS and MS Windows User’s Guide for this information.

Problem: Login script does not execute properly

Explanation: Configuration files must be installed on a workstation for you
be able to manage it from the ManageWise Console. The Client Configura
utility (CLNTCFG.EXE file) on the ManageWise Server executes 
automatically when a member of the MANAGEWISEGROUP user group
logs in.

Action: If the login script on a workstation does not execute properly, run
CLNTCFG.EXE manually, as follows:

�� From Windows Program Manager, run CLNTCFG.EXE (located in 
SYS:\MW\LDT by default).

Make sure any files CLNTCFG.EXE needs to copy to the workstatio
are located in the same directory as CLNTCFG.EXE. The files that 
CLNTCFG.EXE requires are listed in the file CLNTCFG.INI.

�� If the workstation has been configured, a dialog box appears asking 
whether you want to reconfigure the workstation. Click Yes.

�� Click Configure.
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�� Click Exit.

Problem: You Cannot Control the Keyboard on a File Server with Desktop Management

Action: Reload USER.NLM with the /OLDKB switch.

Problem: NetWare 3.1x does not automatically adjust the time zone setting when daylight 
savings changes every six months.

Explanation: NetWare 3.1x does not automatically adjust the time zone se
when daylight savings changes every six months. The NetWare utility 
SYSTIME.EXE fixes some (but not all) time discrepancies between the 
ManageWise Server and workstations.

Action: Follow the instructions in the NetWare System Administration 
documentation under SET TIMEZONE.

Problem: When exporting hardware information, fields are positioned unaligned following 
the diskette information.

Explanation: The diskette information is stored using a quote character t
represent inches. In the resulting quote-and-comma separated records, 
quote is read as a new field indicator.

Action: Change "3.5"" to "3.5" before importing the text file into a 
spreadsheet.

Problem: Software information is lost from the output file produced by CSVETC.EXE.

Explanation: CSVETC encounters problems when "Driver" is in the softw
list.

Action: Filter out "Driver" from the original CSV file using the filter option o
the inventory print command. 

Problem: The Internet map has a non-NetWare router icon labeled NO NAME.

Action: Check that the SNMP name is configured properly on the non-
NetWare router.
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Problem: ManageWise fails to find any PCs running newly added Windows applications 
on the next software scan.

Action: Follow these steps:

�� Make a backup copy of LDAPPL.INI.

�� Manually edit SYS:\MW\LDT\LDAPPL.INI and remove the entire entr
in the IGNORE section for the application that you wish to scan for.

For example, to scan for SOL.EXE, you must delete from the IGNOR
section
<I>,SOL.EXE

�� Follow the procedure in your LANDesk Manager Tools documentation 
for adding applications to be inventoried; then either wait for the nex
software scan or initiate one manually.

Problem: After installing ManageWise on the server, user receives a Btrieve error on the 
console when LDINV.NLM attempts to load.

Explanation: This can happen when Btrieve parameters are inadequate f
the applications that use Btrieve.

Action: Increase the Btrieve parameters in BSTART.NCF or in the NCF f
being used to load Btrieve, such as ASTART.NCF. If you know the 
environment needs of your other applications, add them to the ManageW
requirements and enter those values in BSETUP.NLM. If you are unsure
double the Btrieve defaults.

Problem: On a Windows 3.x machine with a ZIP drive or JAZZ drive attached the 
CCDRIVER.EXE will not execute unless there is a disk/tape cartridge in the drive.

Explanation: This happens because of the CCDRIVER command syntax
within the MW_LOGIN.DAT file, which is "#L:\MW\LDT\CCDRIVER /A /
L". The "/L" parameter causes CCDRIVER to search local drives only for
occurrences of the WIN.INI file. ZIP and JAZZ drives are considered loca
drives and are thus searched. However, if the disk/tape cartridge is eject
from the drive it cannot be accessed and the application cannot run.
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Action: Modify the MW-LOGIN.DAT file’s CCDRIVER command line to 
exclude the ZIP/JAZZ drive. In the example below drive letter D: is 
considered to be the ZIP/JAZZ drive:
". . .CCDRIVER /A /XD".

NOTE: If a workstation has Windows 3.1x installed onto the D: drive, 
CCDRIVER will not configure Windows correctly.

Problem: Two users on the same workstation show up as different objects in the DTM 
database, but with the same MAC address.

Explanation: The Desktop Management database is supposed to replace
previous user name with the next user name so that the database remain
of redundancies and contains an accurate record of the number of users
may not happen if Btrieve is being loaded by another NLM using default 
parameters.

Action: Follow these steps:

�� Adjust your Btrieve settings / parameters (# of files, locks, handles, e
for ManageWise DTM database optimization.

�� Add BSTART.NCF to the top of AUTOEXEC.NCF, below the SET 
parameters, and before other NLMs are loaded (especially those tha
call Btrieve).

�� Reset the DTM database.
Sample: recommended BSTART.NCF ************

LOAD BTRIEVE  -p=4096 -f=128 -h=228 -l=122 -t=45 -u=0 -s=40 -
m=256

Problem: Unable to remote control a machine running VLM 1.2x over a WAN link.

Explanation: This link may be too slow.

Action: Invest in a faster WAN link. If this is not possible, the following ste
should help.

�� Change or add a PROTOCOL SPX section to the NET.CFG of the rem
stations and include:

PROTOCOL SPX
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minimum spx retries 40
spx abort timeout 50
spx connections 30
spx listen timeout 40
spx verify timeout 40

�� Reboot.

Problem: An NT station ignores the default security template and remote controls without 
permission.

Explanation: The NT user agent does not read from the default security 
template. When the machine is set up for DTM, a copy of LDCLIENT.INI
hidden at the root of the machine's C: partition.

Action: Follow these steps:

�� Find and unhide the file LDCLIENT.INI.

�� Set the line "Permission Required" to YES.

NOTE: If you want this to be the default configuration you can change the 
setting to YES in the LDCLIENT.INI file in SYS:MW\LDT. When new 
machines are added afterward, a copy of this file will be pushed down to 
them.

Problem: When entering Desktop Manager the object of the Server-Imported appears and 
aborts shortly thereafter.

Explanation: There may have been a conflict during install with another 
program that uses Btrieve.

Action: Follow these steps:

�� Remove the ManageWise console by rebooting to DOS prompt and 
removing C:-MW and all subdirectories.

�� Remove NMS.INI, and BTI.INI in the WINDOWS directory of the 
console machine.

�� On the server, unload LDINV.NLM, LDISCAN.NLM, and USER.NLM;
then remove SYS:-MW-LDT directory from that server.
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�� Run ManageWise setup and choose Custom Installation; then install 
Desktop Manager and ManageWise Console.

�� After the reinstallation reboot the console machine.

�� Run MW_AUTO.NCF on the server.

Problem: During an upgrade, the Desktop Management files are not updated on the 
ManageWise Group user workstations.

Action: The workstations will have to be re-configured again as if they ha
not ever been configured by ManageWise before.

The Desktop re-configuration can be done in one of two ways (the secon
option is the recommended):

Delete the hidden file, C:\CCDRIVER.TXT from the local drive. This will 
force the Client configuration utility to run again. You can accomplish this
manually deleting the file from the workstation, or by adding the /R parame
on the CCDRIVER.EXE line in the SYS:PUBLIC\MW_LOGIN.DAT file. 
This will delete the CCDRIVER.TXT from the local drives of the 
workstations.

If you don’t want to run the configuration utility again, you can accomplis
the same result by editing the SYS:MW\LDT\CLNTCFG.INI in the 
[Configure] section as follows:
ConfigureBefore=1995/01/01

to
ConfigureBefore=1998/2/10

or to another desired date.

NOTE: ConfigureBefore=Year/Month/Day.

With either option, you will have to reboot the workstation for changes to 
take effect.

After comparing the SYS:MW\LDT\CLNTCFG.INI included in ManageWis
to the same file in ManageWise 2.5, add the following sections and lines to
ManageWise 2.5 CLIENTCFG.INI:
Troubleshooting ���

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

ate 
.

 a 
ware 

ger 

r 

w 
[DTM: 16TONW]
ADDFILE9= {%WINSYSDIR}, WCHAT.EXE
ADDFILE10= {%WINSYSDIR}, WSLAVE.EXE 
ADDFILE11= {%WINSYSDIR}, WLS2.DLL
[DTM: 95TONW]
ADDFILE10= {%WINSYSDIR}, WCHAT.EXE
ADDFILE11= {%WINSYSDIR}, WSLAVE.EXE 
ADDFILE12= {%WINSYSDIR}, WLS2.DLL

Problem: After being configured, added to the ManageWise Group, and rebooted, a 
workstation reconfigures and reboots continuously when a user logs in.

Action: Run the Inventory scan on the NT and DOS machines. This will cre
the LDISCAN.CFG file and add the Device ID to the CFG_YES.LOG file

Problem: On a Windows 95 station running ManageWise Console, the Tools option for 
Desktop Manager is grayed out.

Explanation: This option will only become available if you are highlighting
NetWare server in a network map that has the Desktop Management soft
installed.

Action: Follow these steps:

�� Click on File/Open/Internetwork Map.

�� Double-click on the segment the Desktop Manager server exists on.

�� Highlight the Server object in the Segment Map for the Desktop Mana
server.

Problem: Upon installation of ZENworks Remote Control, ManageWise Remote Control 
no longer functions.

Explanation: ZENworks Remote Control disables ManageWise Remote 
Control. Simply reinstalling ManageWise clients will not restore the prope
Remote Control Agents in all cases.

Action: To roll back from ZENworks to ManageWise Remote Control, follo
the steps for your operating system, below.
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Windows 3.x:

Edit the WIN.INI in the Windows directory and add LOAD=WUSER.EXE
because the ManageWise install will not automatically add the 
LOAD=WUSER.EXE to the WIN.INI. This WIN.INI modification can be 
automated using NAL or ZENworks. 

Windows 95:

Edit the WIN.INI in the Windows directory and add LOAD=WUSER.EXE
because the ManageWise install will not automatically add the 
LOAD=WUSER.EXE to the WIN.INI. This WIN.INI modification can be 
automated using NAL or ZENworks. 

Windows NT:

Rerun the NTSTACFG from the SYS:MW\LDT directory on the server th
ManageWise was installed on. This will replace the ZENworks remote con
service with the ManageWise remote control service. NTSTACFG can be
from NAL or manually.

Problem: The Remote Control Agent is not loading on a reboot after installing it with the 
Novell Client for NetWare networks.

Explanation: The Remote Control Agent will NOT automatically place itse
in the Startup group for Windows 95 installations (Windows NT installatio
do automatically start the Remote Control Agent as a Service). This is 
intentional and by engineering design due to a conflict between running 
ManageWise Remote Control Software and the ZENworks Remote Cont
Software on the same station. The README.TXT that comes with the 
ZENworks install includes a list of the incompatible features. This details
what happens to ManageWise Remote Control functionality when ZENwo
Remote Control Agent is installed and vice versa.

Action: The ZENworks server install does create a Novell Application 
Launcher Object (NAL) called Remote16. This application object can be
associated to the container, groups, and/or users you wish to run the Win
95/3.x Remote Control software. After making the association, you can t
set the application to "Force Run" on the Applications tab of the Contain
Group, and/or User you made the association to. This application object p
the WUSER.EXE in the WIN.INI file using the line "load = wuser.exe."
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There is also a NAL object for RemoteNT and RemoteNTSecure that wil
Install the Remote Control Service on NT. The RemoteNT object will run 
NTSTACFG.EXE to install. The RemoteNTSecure uses an .AOT file 
information to copy just the files and registry changes down (no access i
required by the user to the NTSTACFG or other files).

Problem: When taking remote control of an NT Workstation with ZENworks, the remote 
control session is very slow.

Explanation: This problem occurs when the NT Workstation you are takin
control of has 32 MB of RAM or less.

Action: Upgrade the memory to 64 MB to speed up the remote control ses
(4 or 5 times faster).

Problem: A user listed in the database scans in from DOS or Win95 and appears for a few 
moments, then disappears from the database. This happens every time this user scans in.

Action: Delete LDISCAN.CFG from affected, or all, workstations. Then, ru
LDISCAN again. This creates a new LDISCAN.CFG and usually resolves
problem. Also delete LDISCAN.CFG from the template machine and run
GHOST.EXE again, or snapshot to prevent this problem from happening
again in stations being created from image files.

Problem: Inoculan and Desktop Management group icons created at installation remain 
open on the Windows 95 desktop, even after rebooting.

Action: The workstation user should manually close the icon group boxe

Problem: When trying to open the ManageWise Desktop Manager, the cursor simply hour 
glasses.

Action: Follow these steps:

�� On the MW Console machine, press Ctrl+Alt+Del and close the Desk
Manager program and restart the machine.

�� On the MW server, unload the following NLMs:

USER.NLM
LDISCAN.NLM
LDINV.NLM
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�� Then, on the MW server, reload the Desktop Manager by typing 
MW_AUTO.NCF

�� Back on the MW Console machine, open the MW Console, Desktop
Manager and now the process should load properly.

Problem: The NWTRAP.NLM configuration file NWTRAP.CFG is not working correctly 
when set to send only critical traps.

Action: Go into the NetWare 5 volume and check how many NWTRAP.CF
files there are. Modify in SYS:\SYSTEM\NMA. Delete all unnecessary file
Also, the following commands should result in disabling all traps except 
critical ones:
DISABLE SEVERITY <= MAJOR or

DISABLE SEVERITY < 

Problem: Running BSTOP.NCF on a NetWare server does not unload BTRIEVE.NLM.

Explanation: The link for loaded modules to unload to be able to unload 
BTRIEVE.NLM includes TCPIP.NLM. If TCPIP.NLM is loaded and/or 
bound, BTRIEVE.NLM will not unload. That would necessitate IPX being
loaded and bound for a short period or access to the volume made poss
without IPX (Netbasic) while TCPIP.NLM is unbound and unloaded to 
properly complete the inventory rebuild.

Action: Try unloading other applications that are using TCPIP. It may be 
easiest to down the server, then start it again with the -NA switch (server -N
and then use Netbasic to access the volume to delete the necessary file
Vrepair to purge the volume before restarting the server.

Problem: ManageWise hardware inventory fails to detect memory above 64MB RAM.

Explanation: ManageWise hardware inventory cannot detect Pentium II c
machines.

Action: None.

Problem: Screen is garbled when remote controlling a network node.

Action: Using VGA mode will sometimes solve this problem if the bitmap
caching feature of the adapter is also turned off. It may also be necessar
update your machine to the latest revision of the video driver.
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Problem: After adding an application to the software list in Desktop Manager, and the 
information is written to LDAPPL.INI, the application does not show up in the available 
components section in the "view / columns" option.

Explanation: The new entries in the software list will not show up in the 
available components list until at least one machine has scanned in and 
exact match of that application (usually by filename and file size) has be
made. Once a positive match has been made on one or more machines 
be written to the database and it should then show up as an available 
component.

Action: Wait until a machine scans in and matches the application.

Problem: After a tree split, remote control of Windows 95 via ManageWise doesn`t work 
anymore, and Desktop Manager can no longer create or modify the security template.

Explanation: This can happen when the “DTA SECURITY STRUCT” 
attribute is missing from the schema of the tree.

Action: Follow these steps:

�� Use NDS MANAGER to enter the attribute manually after the install.

NDS MANAGER > Object > Schema Manager > Object > Create Ne
Attribute

�� Enter Attribute name "DTA SECURITY STRUCT".

�� Select Syntax "Octet String".

�� Set Attribute Flags "Single valued" & "Public Read".

�� Highlight class Organizational unit > Double-click > Add Attribute > 
Add "DTA SECURITY STRUCT".

�� Highlight class Organization > Double-click > Add Attribute > Add 
"DTA SECURITY STRUCT".

�� Highlight class User > Double-click > Add Attribute > Add "DTA 
SECURITY STRUCT".
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Problem: When logging in to the network after installing ZENworks, some machines will 
not run WLDISCAN.EXE.

Explanation: @NALEXPLD.EXE (Nal Explorer) is in the login script and 
probably running before the ManageWise login script routine.

Action: Move @NALEXPLD.EXE down below the ManageWise login scri
routine.

Problem: Desktop Manager returns an “Insufficient Rights” error when trying to remote 
control a server, but can remote control workstations without any problem.

Action: Make sure that the file LDCLIENT.INI exists in the sys:system 
directory of the servers you are trying to remote control. It should include
following settings:
permission = no

allow takeover =yes

allow remote execute =yes

permission =yes

take over = yes

If allow takeover is set to no you will not be able to remote control the ser

An example LDCLIENT.INI file is as follows:
[Sight]

Allow Takeover=Yes

Allow Reboot=Yes

Allow File Transfer=Yes

Allow Chat=Yes

Allow Remote Execute=Yes

Visible Signal=Yes

Audible Signal=No

LanaNum=0

ForceName=No

Allow Ping Test=Yes

Allow DOS Diagnostics=Yes

Allow Windows Diagnostics=Yes

Permission Required=Yes

Default Protocol=IPX

Also ensure that USER.NLM is loaded on the NetWare server and has b
imported into the inventory database.
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Problem: Desktop Manager is grayed out in the ManageWise Console’s tool bar (View / All 
/ NetWare file servers).

Explanation: The internetwork map and segment map are empty because
had either disabled NetExplorer, or reset the map, and it hadn't repopula
yet. Therefore the only way the console can tell if this service is available
by what services are listed for the server's object, in the map.

Action: The alternative route to Desktop Manager in this scenario was to
to View / All / NetWare file servers, and then double-click the inventory ser
in the server list. When the configuration box pops up (assuming the serv
running the NetWare Management Agent) then a little blue icon labeled 
Desktop Manager should show up. If you drill down on it, then the Deskt
Manager program will launch.

NetExplorer

Problem: IP routers do not appear on the internetwork map; the NXPIP console shows 0 
routers found or 1 router found (self only) on the NetExplorer Server.

Follow these steps:

�� Type CONFIG at the server console to see if IP bound to an interface
the NetExplorer server.

�� Type MODULES at the server console to see if TCPIP.NLM loaded o
the NetExplorer Server and to see if SNMP loaded.

If Step 1 and Step 2 do not point to a problem, check for problems outsid
NMS by trying to manually change to a router that is not being discovere

Follow these steps:

�� Run TCPCON from the NetExplorer server.

�� Go to the Options menu and check the community name.

It should be "public," or set to the appropriate name for the IP Route

�� Go to the main menu, choose "Change Host," and enter the Host Nam
address for the IP Router.
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If you cannot connect to the host router, this explains why NXPIP can
find the router.

�� Next, change to each interface on the router.

If you can change to the same segment interface, but not to the rout
interface, the router is not routing properly.

If you cannot change to any interface on the router, either the router
down or the community name is incorrect.

�� Try pinging the router to determine whether it is active.

If you cannot manually change or ping, it is not an NMS problem.

If you can change to the router, refer to the NMS Installation manual for 
NXPIP configuration information.

Be certain that NXPIP is configured to use the appropriate community st

If the routers do not use RIP, use the seed router option in the NXPIP 
configuration.

Problem: When the NetExplorer Global Configuration setting is set to consolidate IP-IPX 
segments, IP and IPX appear as a single segment on the internet map. With non-Novell 
routers, some IP and IPX segments may not consolidate.

Explanation: In order for IP and IPX segments to consolidate, the followi
conditions must exist:

1. The router interface must be bound to both IP and IPX.

2. There must be a NetWare server on the segment that is connected t
non-Novell routers.

3. NXPIPX must be able to discover the interface that is bound to IPX. (U
Fault, Test Connectivity to perform an IPX ping of the interface. Be 
certain it is responding.)

4. You must not use Wellfleet® series 5 or 7 routers for Token Ring.
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Action: Make sure the conditions listed above exist on your system. If 
segments do not consolidate automatically, you can use the segment 
consolidation tool to consolidate the segments manually.

Problem: Segments appear as islands not connected to the appropriate router. Each port 
(DLCI) is represented by a NONAME ROUTER icon on the internetwork map.

Explanation: NetExplorer will fail to discover segments correctly if Frame
Relay is used as the WAN.

Frame Relay's X.25 overhead intensive protocol is designed for individua
packet-by-packet routing and link-by-link error control. This can confuse 
NetExplorer discovery cycle. Each packet is routed through the PVC 
(Permanent Virtual Circuit) with the DLCI (Data Link Connection Identifier
This header specifies the routes the packet will take and provides "seam
connectivity. These PVC paths are established by the connection provide
are available at roughly 1000 per interface.

Action: Follow these steps:

�� Find out the "Internet Free Address" from the Frame Relay provider.

The Internet Free Address is the access ID number given to the ISP 
a table of IP numbers reserved only for frame relay use. It may also 
called the SPID number. This number is required for a company to b
identified on the frame relay cloud. The number was either entered a
router number or a gateway number in the scope.

�� Enter this number into the IP Discovery Section of NXPCON.

This ensures that NetExplorer understands that the Frame Relay Cloud 
"virtual" segment on the Network. It also defines a clear path to routers a
devices on the other side. 

Problem: In an IP environment that does not use RIP as its routing protocol, IP routers 
and segments are not discovered or displayed properly on the internetwork map.

Action: Follow these steps:

�� Identify the routers that are not using RIP.

�� Set up all routers that are not using RIP as "Seed Routers."
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�� Go to the NXPCON.NLM screen on the NetExplorer server, choose 
Configuration Options, then choose IP Discovery.

An IP Discovery window will appear. This screen is designed for 
networks that do NOT run RIP at all. All devices listed on this screen 
"Seed Routers."

�� Add the main or central router to the Seed Router field, and add all 
additional routers to the Additional IP Routers.

�� Save your changes.

�� Unload and reload the NetExplorer software by using the UNXP.NCF
unload and NETXPLOR.NCF to reload.

Problem: SNMP queries of network devices do not return correct results.

Explanation: The two main issues that interfere with SNMP queries of dev
on the network are incorrect SNMP community names and incomplete Ac
or Manager Lists.

Action: Follow one of the sets of steps outlined below.

SNMP Community Names

If information is not being gathered about a specific device, verify which 
community name is not being used. Follow these steps:

�� Load TCPCON.NLM on the NetExplorer server.

�� Select SNMP Access Configuration.

�� Change the Transport Protocol to TCP/IP.

�� Change the Host Name to the device to be tested.

�� Change the Community Name, if necessary, to the appropriate value

�� Press the Escape key and answer Yes to Save TCP/IP Console Opt
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If these steps are successful, the Uptime and System fields should have
information and the other fields should be incrementing. If these steps ar
unsuccessful, "Unknown" will show up in the Uptime and System fields.

NOTE: When using TCPCON.NLM to test SNMP, please remember that 
SNMP Community Names are case sensitive.

Access or Manager Lists

Some devices accept any community name as long as it is on a list of de
that can send SNMP requests to it. If the community name in question is
on the Access or Manager List, add the community name of the NetExpl
server to the list.

Problem: NetExplorer Manager does not load on the ManageWise Console when logging 
in to a recently renamed NetWare File Server.

Action: Follow these steps:

�� From the ManageWise Console, select Configure > Global Preferenc
NetExplorer Options.

�� Change the NetWare Server Name: <server_name> to the new NetW
File Server Name.

�� Save the change.

�� Close the NetExplorer Manager and restart it, or unload Windows an
restart Windows.

Problem: When NetExplorer manager loads from WIN.INI, there is a delay followed by an 
error that IPX Ping of the NetExplorer server failed to respond. NetExplorer Manager 
loads, but it does not connect or get record updates from NetExplorer on the server.

Explanation: These problems may occur when an incompatible frame typ
being used between the ManageWise Console and the NetExplorer serv

Action: Follow these steps:

�� Go to the Control Panel and select Network to bring up the client32 
options.
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�� Select IPX 32-bit Protocol for Novell netWare Client 32, and go to 
Properties.

�� Select Advanced IPX.

�� Select Use All Detected Frame Types.

�� Add only the frame types your console machine actually uses (most 
commonly Ethernet_802.2 and Ethernet_II).

�� Select Primary Logical Board, and in the box below it fill in your prima
frame type.

This step is especially important if you use 802.3 frame types. If this
option isn't selected, communication will revert to 802.2, the default.

�� Save these settings and restart the machine.

Problem: The NetExplorer Manager is connecting and disconnecting at random, but not 
reporting any problems.

Action: Change the frame types in client32 from "Use all detected frame 
types" to "Use specified frame types." Make sure you have specified the
appropriate frame types.

NetWare LANalyzer Agent

Problem: LANalyzer is not monitoring a new network board.

Action: If you change or add a network board that you want NetWare 
LANalyzer Agent to monitor, follow these steps:

�� At the ManageWise Server console, enter
ULANZ

�� From a workstation that is logged in with SUPERVISOR rights, delete 
following file:
SYS:\LANZ\LANZ.CFG

�� At the ManageWise Server console, enter
LANZ
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Problem: NetWare LANalyzer Agent is gathering and reporting inaccurate or unreliable 
statistics

Explanation: The LAN driver that you are using might not be correct for t
network adapter you are using.

Action: Verify that you are using the latest Novell-certified LAN driver for th
network adapter you are using by pointing your browser to http://
developer.novell.com/devres/langrp/cards/cards.htm or go to the Novell L
Information System LAN Adapters and Drivers Index at http://
developer.novell.com/infosys/mastr_02.htm. Updates to Novell® drivers 
posted on the technical support site or at the NetWire® electronic bulletin
board. For more information about how to obtain current updates, refer t
“How to Obtain Updates and Patch Files” on page 306.

Problem: Missing Bar Chart in the Network Dashboard Window

Explanation: The bar chart is missing from the bottom portion of the Netw
Dashboard window.

Action: Make sure that SNMP is loaded explicitly with the following 
parameters:
LOAD SNMP VERBOSE CONTROL= TRAP=

If you have this statement in your AUTOEXEC.NCF file, make sure that 
another NLM file isn’t automatically loading SNMP without the paramete
To ensure that these parameters are being used, load CONLOG.NLM (in
NOVLIB, Lib 9, CONLOG.EXE) to review the loading of the NLM files. 
When SNMP loads, it should return the following message:
SNMP: ControlCommunity now accepts any community name.

Problem: After installing NetWare LANalyzer Agent, the server abends when you back it 
up.

Explanation: This problem is not related to the installation process. Howe
some NetWare LANalyzer Agent files were loaded and probably were op
when you backed up the server. Depending on the backup software you
backing up the LANZ.CFG file when it is open can cause the server to ab

Action: Do not back up the LANZ.CFG file when you back up the server.
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Problem: After NetWare LANalyzer Agent is installed, the SMART386.LAN driver cannot 
be loaded.

Explanation: When you install NetWare LANalyzer Agent, the 
SMART386.LAN driver is updated with a driver named MADGEODI.LAN
Because the driver name was changed, you need to update the files tha
drivers.

Action: Modify the files that load the adapter drivers to load the 
MADGEODI.LAN driver.

Problem: After NetWare LANalyzer Agent is installed, the NE3200.LAN driver cannot be 
loaded.

Explanation: When you install NetWare LANalyzer Agent, the NE3200.LA
driver is updated with a driver named NE3200P.LAN. Because the driver
name was changed, you need to update the files that load drivers.

Action: Modify the files that load the adapter drivers to load the 
NE3200P.LAN driver.

Problem: After NetWare LANalyzer Agent is installed, the NE2-32.LAN driver cannot be 
loaded.

Explanation: When you install NetWare LANalyzer Agent, the NE2-32.LA
driver is updated with a driver named NE2_32.LAN. Because the driver na
was changed, you need to update the files that load drivers.

Action: Modify the files that load the adapter drivers to call the NE2-32.LA
driver, and then load the NE2_32.LAN driver.

Problem: Unable to run LANalyzer Agent from the ManageWise server

Explanation: The LANalyzer Agent software is installed by default when 
ManageWise is installed on a NetWare server, but the load line is rem'd o
the server's AUTOEXEC.NCF file with a # sign. Only one LANalyzer serv
is needed per physical segment of the network. This installation prevents
agent from loading on multiple servers, thus saving resources.

You may re-start the ManageWise server and start the discovery process
without realizing that the LANalyzer Agent is not loaded.
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Action: The LANalyzer Agent can be loaded from the server’s prompt by
typing the following:
SEARCH ADD SYS:LANZ

LANZ.NCF

If you still can’t monitor the segment even after the LANalyzer Agent load
follow these steps:

�� Make sure that the LANalyzer Agent is loaded on every physical segm
that you wish to monitor.

�� If you are using an Ethernet switch, load the LANalyzer Agent on a ser
that is connected to each port you wish to monitor.

Ethernet switches break the physical segment even though the netw
address may be the same off of the different ports.

�� Make sure that the server that loads the LANalyzer Agent has a netw
interface card (NIC) that supports promiscuous, multicast, and (if 
Ethernet) error capturing modes.

If the NIC does not support these modes, the LANalyzer Agent will n
function. A list of certified NICs for use with LANalyzer can be obtaine
from Novell Labs by calling 800-414-5227 and requesting document
10047.

�� Edit the sys:system\AUTOEXEC.NCF and remove the #'s from the lin
    SEARCH ADD SYS:LANZ

    LANZ.NCF

�� Restart the server.

�� After the server restarts, restart the ManageWise console machine.

�� Reset the NetExplorer database and rediscover the network.

�� After the server has been discovered, click on View, All, Network 
Segments.

�� Locate the segment to which the ManageWise server is attached an
double-click to open the dashboard.
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To achieve the same results without having to cycle the server, follow the
steps:

�� From the server's console prompt enter:
SEARCH ADD SYS:LANZ

LANZ.NCF

�� Open the ManageWise console.

�� Click on View, All, NetWare Servers.

�� Locate this server in the list and highlight it by clicking on it once.

�� Click on Edit, Database Object.

�� Click on the 'Services' icon on the right of the screen.

�� Check the list of 'Services of this node:' to see if 'NetWare: Lanalyze
Agent' is listed.

�� If it isn’t listed, click on Edit, locate 'NetWare: Lanalyzer Agent' in the
'Available Services' list and click on 'Add', 'OK', then 'Save', and close
window.

�� Go back to the ManageWise Console and from the main ManageWis
screen click on View, All, Network Segments. Locate the network 
segment to which the ManageWise server is attached and double-cl

If the network segment is not listed, it may be necessary to reset the 
NetExplorer database and rediscover the network. To do so, follow these
steps:

�� From the ManageWise program group open the 'Database Administra
Tool' and 'Reset Database'.

�� After the database has been reset, restart the NetExplorer Manager.

This will cause the ManageWise server to be rediscovered with the new 
LANalyzer Agent service. The NetExplorer Manager may need to run for
minutes or more before the server is discovered. Novell recommends run
the NetExplorer Manager constantly to get a complete discovery of the 
network.
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Problem: Unable to view trends for more than 60 minutes (buttons grayed out)

Explanation: The LANalyzer Agent has not been running long enough to
compile trend information longer than 60 minutes.

Action: Try again after the LANalyzer Agent has been running for the len
of time for which you want to view trend data.

Explanation: The GTREND.NLM that comes with ManageWise doesn't 
create the directory SYS:GTREND, where the *.GT files are supposed to
written. Instead, trend information is saved in a memory buffer. When the
buffer is full the data becomes first in, first out. An error will be written to 
GT_ERR.LOG indicating that the trend information was not written to the
trend files because the file could not be found.

Action: As a work-around, follow these steps:

�� Run ULANZ.NCF on the server.

�� Make sure that GTREND.NLM is unloaded.

�� Manually create SYS:GTREND.

�� Run LANZ.NCF on the server.

When GTREND.NLM loads, it will find the manually created directory an
create in it a subdirectory with the same name. The file 1.GT will be writt
in this directory. After about an hour, the other buttons should be access
for viewing trends.

Problem: Users can see the organizations and organizational units but cannot see the leaf 
objects (users, printers, etc.)

Explanation: This problem has been seen on NT workstations running 
NWADMNNT.EXE, and on Windows 95 Workstations running 
NWADMN95.EXE and NWADMN3X.EXE.

Action: Follow these steps:

�� Make sure DSRepair.NLM is version 4.53 or greater.
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�� Run DSREPAIR, Advanced Options, Repair local database, and set
Check Local References and Rebuild Operational Schema to YES, F1
rebuild.

If the above options do not correct the problem, you may need to upgrade
DS.NLM on your servers to the current version available from Novell.

Problem: The NetWare LANalyzer Agent 1.21 on startup gives memory errors.

Action: Delete the file LANZ.CFG in the directory that contains NLM files o
NetWare LANalyzer Agent.

Problem: The FDDI Ring Stations table does not display entries other than details of 
NetWare LANalyzer Agent.

Explanation: The FDDI driver may not support MAC and SMT promiscuo
modes. It is also possible that the ManageWise Console is displaying sta
that existed on the FDDI ring before the NetWare LANalyzer Agent restar

Action: Close the FDDI Ring Stations window and open the window agai

Problem: Using LANalyzer with ManageWise 2.5, user cannot disable LAN boards with 
LANZCON.

Explanation: This can happen when the SNMP community string on the se
is not set to "public.”

Action: Change the SNMP community string on the server to "public,” us
inetcfg (it applies for "monitor state" and "control state"). Then restart the
server.

Problem: GT_ERR.LOG becomes very large, but the displayed file size remains 0 bytes.

Explanation: This can happen when the GT_ERR.LOG file is kept open. 
available disk space keeps decreasing (as shown in dir and ndir), but dir /
not show an increase.

GT_ERR.LOG is a log file for GTREND.NLM, which is supposed to write
network trend data to the SYS:GTREND directory. If this directory does n
already exist, ManageWise will not create it. In this case, GTREND.NLM w
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write information to the log file reporting that it is unable to write 1.GT to th
target path.

Action: If you run ULANZ.NCF, manually create the GTREND directory, 
then run LANZ.NCF. When gtrend loads it will create another gtrend 
directory inside of the one that was just created. From this point it will be
writing the *.GT files.

Problem: Instrumented Server is Not Receiving Token Ring Alarms.

Explanation: Your driver file may be out of date.

Action: Make sure you are using a TOKEN.LAN driver file dated 09/09/91
later.

Problem: “Island” segment icons on Internetwork Map.

Explanation: NetExplorer is unable to determine where the segments sh
be connected. NetWare LANalyzer Agent software requires at least one 
network board to be bound to the IPX protocol for the ManageWise Cons
to communicate with it. It does not require every network adapter to be bo
to IPX or to another network protocol.

Action: Bind IPX to at least one network board on the segment where the
islands occur.

Problem: Bar Charts are missing from the Network Dashboard Window.

Action: Make sure that SNMP is loaded explicitly with the following 
parameters:

LOAD SNMP VERBOSE CONTROL= TRAP=

If you have this statement in your AUTOEXEC.NCF file, make sure that 
another NLM file isn’t automatically loading SNMP without the paramete
To ensure that these parameters are being used, load CONLOG.NLM (in
NOVLIB, Lib 9, CONLOG.EXE) to review the loading of the NLM files. 
When SNMP loads, it should return the following message:

SNMP: ControlCommunity now accepts any community name
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ManageWise Server

Problem: Server halts (abends)

If the server halts, take the following steps:

�� Do not turn off your server.

�� Record the information displayed on the server console:

� Date and time the system halted.

� Description of the problem, including the process that was runnin
the time the system halted.

� Stack information at the time the system halted.

�� Restart the server; then enter the following system administration 
commands and record the information listed:

�� Call your reseller for ManageWise troubleshooting information.

Problem: Installation cannot copy .NCF files

Explanation: Occasionally during NetExplorer software installation, the er
message “Unable to copy files AUTOEXEC.NCF or NMSBASE.NCF” 
appears.

Action: If this message appears, follow these steps:

�� Exit the ManageWise installation.

�� Exit Windows.

�� Log out of all servers.

�� Start Windows again.

�� Start the ManageWise installation again.

�� Reinstall the ManageWise Server software (do not reinstall the 
ManageWise Console software).
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Table 65 Command Information to Record

Problem: Short-term memory allocation failures

Your NetWare server software reports short-term memory allocation failu
when running the discovery NLM files.

Explanation: The discovery NLM files require up to 8 MB of server RAM o
large networks.

Action: The discovery NLM files require up to 8 MB of server RAM on larg
networks.

Other solutions might be to add more RAM or reduce the size of the rece
buffers in your STARTUP.NCF file.

Problem: The ManageWise Server uses too much memory

Explanation: The default ManageWise Server configuration reserves mo
memory than might be required in your environment.

Action: You can decrease memory consumption on your server by decrea
the values of the Maximum Packet Receive Buffers and Maximum Physi
Receive Packet Size SET variables, as described in the following section

Information Explanation

MEMORY Total server memory

VERSION Version of NetWare® software

CONFIG Server configuration information

LOAD MONITOR (to view server information and performance)

DISK INFORMATION Information listed in Monitor

DEVICE Disk driver information listed in Monitor (for example, ISADISK.DSK)

MODULES Currently loaded NLM files
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Decreasing the Maximum Packet Receive Buffers

The NMSBASE.NCF file sets the maximum number of packet receive buff
to 500. Many environments do not require this large a number.

Because a large number of buffers consumes more memory, you might w
to decrease this number and verify that it does not cause problems. (The 
should be between 100 and 500.) If you decrease the number and do no
observe problems with your server that could be caused by dropped pac
keep the variable set to the smaller value. You can change the setting in
NMSBASE.NCF file; this file is located in the SYS:\SYSTEM directory.

Decreasing the Maximum Physical Receive Packet Size

NetWare uses 4,202 bytes as the default size; this value is required on t
ring, but not on Ethernet. If your server is connected only to Ethernet 
segments, you can reduce this value to 1,518 bytes. The value must be 
specified in the STARTUP.NCF file, which resides on the DOS partition o
your server. You can bring the server down, modify the value in the 
STARTUP.NCF file, and then bring the server back up.

Alternatively, you can modify the STARTUP.NCF file using the Server 
Manager utility.

To modify the value in the STARTUP.NCF file

�� At the ManageWise Server console, enter LOAD SERVMAN.

�� Select Server Parameters from the menu that appears.

�� Select Communications from the menu that appears.

�� Edit the value in the resulting screen.

You must still restart the server for the change to take effect.
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SETUP.EXE

Problem: User is unable to choose volumes other than SYS: to install on.

Solution: ManageWise must be installed on volume SYS:. However, you 
store the NetWare Management Agent trending files on a different Volum

Action: Edit the NMA2.NCF and use the following syntax on the LOAD 
NTREND line.

Example:

LOAD NTREND Dir=Vol1:\NTREND

This will save the trending date to Vol1, in the NTREND directory. The 
directory name does not need to be NTREND. It can be any name you ch
to give it.

NOTE: This rule applies only to the NetWare Management Agent trending 
files. You cannot store the NetWare LANalyzer trending files on any 
volume other than the SYS: volume.

Problem: User cannot reinstall an updated version of ManageWise on a server where a 
previous version has been installed.

Action: Remove ManageWise license files and directories and subdirecto
as follows; then run install again.

�� Make sure all ManageWise related NLMs are unloaded on the server,
run the following NCF files: UNXP, UNNMA2, and ULANZ.

�� Make sure that the virus-protection and desktop management NLMs
also unloaded.

�� To make sure that SERVINST.NLM and MWISE.NLM are both 
unloaded, manually type UNLOAD SERVINST, UNLOAD MWISE on
the server console.

�� Delete SYS:\SYSTEM\SERVINST.NLM and 
SYS:\SYSTEM\MWISE.NLM.
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�� Go into SYS:\ ETC where there are two hidden files, MWISE.MLS a
NMA2.MLS.

�� Flag them both as (N)ormal and then delete them. Example: FLAG 
MWISE.MLS N

NOTE: There may also be a file NMSID.DLL. If it exists, delete it too.

�� Using FILER, or NWADMIN, remove the following directories:

SYS:LANZ
SYS:MW
SYS:NMDISK

�� Purge the whole volume. If that is not possible, purge the directories f
which you deleted the previous files.

Problem: A newly installed third-party service does not appear, or appears grayed out, on 
the Tools menu for the server on which it is installed.

Explanation: The discovery process has not found the new service yet.

Action: To add the new service, follow these steps:

�� Highlight the server; then click Edit >Database Object, and then click 
Services Icon.

�� Click the Edit button and add the service.

�� Save the options.

Problem: The NetWare Management Agent (NMA) installation is unable to read the license 
off the diskette.

Explanation: This problem occurs when you try to install the NMA on a ser
by using PINSTALL.NLM. All portions of the ManageWise suite must be 
installed through the GUI installation routine.

Action: Instead of using PINSTALL, follow these steps:

�� Map a drive to the root of the SYS: volume to which you wish to inst
NMA.
Troubleshooting ���

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

inue.

en; 

ck 
ot, 
, 
r. If 

rder 

ou 
ed. 

ng 

ver 

 
uns 

he 
. If 
es 
�� Run the MW SETUP.EXE from the CD.

�� Select the drive letter mapped above, add the MW license, and cont

�� Continue through the screens until you get to the Install Options scre
then select Custom Install.

The next screen is Custom Install Options. The install routine will che
to see if NMA is already installed on the selected drive letter. If it is n
the option for NetWare Management Agent will be gray but selected
because NMA is the minimum requirement for a management serve
NMA is found on the server, the option will be black. 

�� Continue with the installation.

�� After the installation is complete, restart the server because the load o
of SNMP.NLM is important.

If you plan to install NMA on many servers, Novell recommends that y
re-discover the network after all servers are restarted with NMA load
To re-discover the network, follow these steps:

�� Unload the NetExplorer process from the server by typing the followi
at the server’s system prompt:

     UNXP.NCF

�� Re-load the NetExplorer process by typing: NETXPLOR.NCF

When you are finished, allow NXP to run for several hours/days to disco
the new services on the servers.

Problem: Running INETCFG on the server upsets the way ManageWise handles LOAD 
SNMP.NLM

Explanation: ManageWise REQUIRES the LOAD SNMP.NLM before the
network card drivers are loaded and bound. If the Network Administrator r
INETCFG on the server, it detects the LOAD SNMP as an explicit load 
statement and incorporates it into the INETCFG. The load sequence of t
INITSYS.NCF may load and bind the network cards before loading SNMP
the network cards are loaded and bound before SNMP is loaded, it caus
problems with ManageWise, specifically if the NetExplorer and NetWare 
LANalyzer Agent are loaded on the server.
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Action: Check the load order for ManageWise. The default load order is 
follows:

SETs
FILE SERVER NAME
IPX INTERNAL NET 
NMSBASE.NCF (a ManageWise NCF)
LOAD MEMMGR.NLM (a ManageWise NetExplorer NLM, present only i

NetExplorer was installed)
LOAD SNMP VERBOSE CONTROL= TRAP=
LOAD NE2000 ...
BIND NE2000 ...

The Btrieve Environment

Problem: LDISCAN.EXE Runs Out of Memory

Action: If LDISCAN.EXE runs from a DOS prompt but seems to run out o
memory during the login process, increase conventional memory or cons
running LDISCAN.EXE outside of the login script. If your ManageWise 
Console workstation’s Windows environment is low on memory 
(conventional or upper), you might see a MACHINES.DAT error. To free 
memory, unload some Windows applications or TSRs.

Problem: Btrieve is Conflicting with Other Applications

Explanation: Inventory Manager sometimes conflicts with other program
based on the Btrieve database.

Action: Follow one or more of these steps:

�� Check to see that Btrieve is operating with at least the default values
shown in the following table.

Parameter Default Minimum Recommended

# of Open Files 20 33 128
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�� If you know the environment needs of your other application, add the
to the ManageWise requirements and enter those values in 
BSETUP.NLM. If you are unsure, double the Btrieve defaults.

�� If another NLM file besides Inventory Manager requires Btrieve, use
BSETUP.NLM to configure a BSTART.NCF file that loads 
BTRIEVE.NLM and BSPXCOM.NLM with enough file space for both
applications.

Problem: Inventory Manager Database is acting up.

Explanation: Any unexpected termination of the file server can corrupt th
Btrieve files or cause other problems with the Inventory Manager Databa
Problems may also have been created if you recently changed Inventory
Manager’s Btrieve environment.

Action: Rebuild the MACHINES.DAT, TYPES.DAT, FILES.DAT, and 
VALUES.DAT files in the SYS:\MW\LDT directory on the ManageWise 
Server. Follow these steps:

�� At the ManageWise Server console, enter Number of handles (must b
least three times the number of sessions, below).

# of Handles 60 53 228

# of Locks 20 5 122

# of Transactions 15 5 45

Largest Compressed Record Size 0 N/A N/A

Largest Record Size 8192 8192 8192 8192 8192 8192

Largest Page Size 4096 4096 4096

# of Remote Sessions 15 15 45

Cache allocation 256 256 768

Parameter Default Minimum Recommended
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�� Enter the following:
LOAD LDINV REMOVE

�� Enter
BSTOP

This unloads BSPXCOM.NLM and BTRIEVE.NLM.

�� At a workstation, delete the MACHINES.DAT, TYPES.DAT, 
FILES.DAT, and VALUES.DAT files in the administrator’s network files
directory (default SYS:\MW\LDT).

�� Delete or rename LDINV.ERR and any MACHINES.PRE, TYPES.PR
FILES.PRE, and VALUES.PRE files.

Parameter Sessions

# of Open Files 20 -f

# of Handles 60 -h

# of Locks 20 -l

# of Transactions 15 -t

Largest Compressed Record Size 0 -u

Largest Record Size 8192 -d

Largest Page Size 4096 -p

# of Remote Sessions 15 -s

Cache Allocation 256 -m

Perform Index Balancing No -c

Create Files as Transactional No -i

Logging of Selected Files No -a

Create Btrieve files in pre v6.x format No -d

Configure BSTART.NCF to Load 
BRouter

No 
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�� In SYS:\SYSTEM, delete or rename BTRIEVE.TRN (if it exists).

�� To eradicate the deleted .DAT and .PRE files, enter
PURGE

�� At the ManageWise Server console, enter
LOAD LDINV FILE=SYS:\MW\LDT

�� At the ManageWise Server console, enter
LOAD LDISCAN INV_SERV= servername FILE=SYS:\MW\LDT

Substitute your path name as necessary.

���� At a workstation, enter
LDISCAN /V /S= servername

Alternatively, log in to the network. If you accepted the default Invento
Manager lines, LDISCAN.EXE runs in the System login script.

���� Restart the ManageWise Console workstation, and then enter
BREQUEST

BREQUEST.EXE can be loaded into high memory.

���� Load Inventory Manager from the ManageWise Control Panel in 
Windows.

Problem: Records are not listed in the Inventory Manager Database.

Explanation: The main Inventory Manager screen is empty after running
<LDIScan Executable> /s=servername (the server specified under Confi
> Inventory Server).

Action: Copy the WBTRCALL.DLL and WBTRVRES.DLL files from the 
SYS:\PUBLIC directory to your ManageWise Desktop Management tools
directory (C:\MW\LDT is the default). The inventory scanner executable 
<LDIScan executable> is LDISCAN.EXE for DOS, WLDISCAN.EXE for 
Windows 3.x, Windows 95, Windows 98, LDISCAN2.EXE for OS/2, and 
LDISCNNT.EXE for Windows NT.

Do not use the BSTART.NCF file as supplied with NetWare or manually lo
BTRIEVE.NLM and BSPXCOM.NLM with special parameters. Just load 
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LDINV.NLM at the file server and allow it to load the Btrieve NLM files 
automatically. This loads the same defaults as those set when

BTRIEVE.NLM and BSPXCOM.NLM are loaded without any special 
parameters.

Problem: LDISCAN.EXE Runs Out of Memory

Action: If LDISCAN.EXE runs from a DOS prompt but seems to run out o
memory during the login process, increase conventional memory or cons
running LDISCAN.EXE outside of the login script. If your ManageWise 
Console workstation’s Windows environment is low on memory 
(conventional or upper), you might see a MACHINES.DAT error. To free 
memory, unload some Windows applications or TSRs.

The WAN Environment

Problem: Desktop Manager tools are not functioning properly across a WAN.

Explanation: Your WAN router may be set to filter SAP packets that certa
Desktop Manager tools need.

Action: Make sure your routers are passing object type 0x0102 (OT_INTE
required for Inventory Manager, and object type 0x0004 (the Novell 
OT_FILE_SERVER), required for Desktop Manager.

The Windows Environment

Problem: Unexplained Problems with the Windows Environment

Explanation: One or more of the ManageWise files Windows needs to ope
properly may be missing or may have been altered. The ManageWise 
installation backs up any old versions of these files with an .OLD extensi
These files are copied from the directory where CLNTCFG.EXE is execu
(SYS:\LOGIN\MW\LDT by default).

Action: Make sure Windows is accessing the correct version of the follow
files:

CTL3D.DLL
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I3DCTRLS.DLL
IDISPLAY.DLL
NWIPXSPX.DLL
NWNETAPI.DLL
WLS.DLL
VUSER.386
WUSER.EXE

Technical Support and Update Information

How to Request Technical Support

To receive technical support, contact your local Novell reseller and reque
support.

For support on the NetWire electronic bulletin board, post questions in 
NOVMAN, section 2 (NetWare Mgmt. System). If you do not have a 
CompuServe* account, call CompuServe at 1-800-524-3388 or 1-614-45
0802 and ask for operator 200.

To place a call with Novell Technical Support, call 1-800-NETWARE (1-80
638-9273) in the United States and Canada. All other locations, call 801-
5588. If the issue is determined to be a software bug not previously repo
there is no charge for the support call.

How to Obtain Updates and Patch Files

Updates and patches relating to ManageWise products are available on 
Web at the Novell® Technical Support site; point your browser to http://
www.novell.com/support/ and choose ManageWise from the “Choose a 
Product” list.

Virus Protection

You can download new virus signature files from the Cheyenne Web site
(http://www.cheyenne.com).
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Novell recommends that you download the most recent virus signature f
regularly (at least once a month).
Troubleshooting ���

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99
��� LogicSource for ManageWise

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a6 13 August 99

for 

ce of 
� Optimization

This chapter explains how to customize your ManageWise® installation 
optimum performance on your network. It is divided into the following 
sections:

“ManageWise Console” on page 309

“ManageWise Server” on page 314

“Desktop Management” on page 317

“LANalyzer Agent” on page 325

“Optimizing NetExplorer” on page 333

“Optimizing NetWare Management Agent” on page 348

“SAP Filtering Tips” on page 365

NOTE: Many of these instructions involve changing parameters and 
reconfiguring program files ManageWise uses to run critical operations. 
Novell recommends that you review the ManageWise documentation and 
record your initial settings before you make any changes.

ManageWise Console

This section describes changes you can make to optimize the performan
the ManageWise Console.
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Configuring the ManageWise Console to Not Send SAP Packets

Each ManageWise Console sends a SAPTM  packet with the ID number 0x026a.
This packet tells FINDNMS.NLM which consoles to send traps to. 

This procedure can create excessive traffic on remote links. Excessive tr
is a particular problem for on-demand, dial-up connections, which can be 
tied up almost constantly by this process.

To configure the ManageWise Console to not send SAP packets, follow th
steps:

�� To define the recipients of SNMP traps, follow the instructions in 
“Editing the TRAPTARG.CFG File Manually” on page 364

�� From the ManageWise Console window, select Configure > Global 
Preferences.

The System Options Global Preferences dialog is displayed. It is 
identified by the highlighted icon on the right side of the dialog.

�� Deselect Receive NetWare® Server Alarms.

The ManageWise Console will no longer send SAP packets. However, if
ManageWise Console has already sent a SAP packet, the address of the
console is in the server’s memory and remains there until it is removed. 

The default value for removing the console’s address is 10 minutes. This v
can be altered as described in “Load Parameters for FINDNMS.NLM” on 
page 351.

Customizing the Toolbar

The Desktop Manager toolbar allows you to quickly execute the options 
use most. You specify which buttons (if any) you want to be displayed, wh
the toolbar is placed, and whether the tool tips appear with the buttons.

To configure the toolbar, follow these steps:

�� From the Desktop Manager Network View window, select View > 
Configure toolbar.
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�� In the Available Buttons list, click one or more buttons; then click the A
(>>) button.

�� Use the Separator to group the buttons on the toolbar.

�� Change the order of buttons by clicking a button and then clicking th
Move Up and Move Down buttons, or by dragging and dropping butto
inside the Toolbar Buttons list.

�� To set the toolbar back to the previous configuration, click Reset.

�� Click Close to finish customizing the toolbar.

Set IPX Discovery to Discover NetWare Servers Only

You can configure the discovery process to limit the discovery visibility in
network. This is called scoping. You can also exclude workstations from be
discovered. To eliminate workstation discovery, create the 
SYS:NMDISK\NXPIPX.INI file. The file must contain a single line:

gAutoDiscovery=3 

NOTE: This line excludes workstations only. To exclude workstations and 
routers, and to discover only file servers, change the value to 2.

Merging Inventory Databases

If you use more than one inventory database on your network, you can m
the databases in a common directory. You can merge several databases
either an existing database or a new database. To merge databases into
common database, follow these steps:

�� Select Tools > Merge Inventory Databases.

�� To move the databases you want to merge, select the icons in the 
Databases box and click the >> button. The icons are moved into th
Merged Databases box. 

�� To indicate the path for a new database or an existing database, sele
Browse button.
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�� Click Merge.

�� Click Close.

NOTE: Databases created with the merge feature do not appear in the 
Select an Inventory Database dialog because the LDINV.NLM does not 
maintain them. Click the Merge button in the "Select an Inventory 
Database" dialog to open a database created with the merge feature.

Compiling New MIBs/Recompiling Existing MIBs

By default, when you install the ManageWise Console, all MIBs in the 
C:\MW\NMS\SNMPMIBS\CURRENT directory are compiled. You can us
the ManageWise Console to compile new MIBs or to recompile existing 
MIBs. To do so, follow these steps:

�� Make sure that all the MIBs you want to compile have been copied to
C:\MW\NMS\SNMPMIBS\CURRENT directory on your ManageWise
Console.

�� Launch the ManageWise Console.

�� From the menu bar, select Tools > SNMP MIB Compiler.

As the MIBs are compiled, you can see them displayed in the MIB 
Compilation window. This window also displays any errors the Compiler h
encountered.

Using a Windows NT System as Your ManageWise Console

Follow these steps if your ManageWise Console is running on a Window
NT* system:

�� Log in to only one NDSTM  tree and make sure that your ManageWise 
server is in that tree. Logging in to multiple trees is not supported dur
installation.

�� Make sure Windows NT 4.0 with Service Pack 3 and the latest client
software are installed on your workstation (ManageWise Console).
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�� Download the most updated client software (NetWare 5® client or 
ZENworksTM  1.0 client or later) from http//:www.novell.com/download

�� Replace the NWIPXSPX.DLL file on your system ([Windows NT 
directory] \SYSTEM32\NWIPXSPX.DLL) with the file provided on 
your ManageWise CD-ROM 
([Drive]:\MISC\NTCLT\NWIPXSPX.DLL).

Next, you must stop the NTVDM process running on your system. Follow
these steps:

�� Press <Ctrl>+<Alt>+<Del>.

�� Click Task List.

The Windows NT Task Manager dialog appears.

�� Select the Processes tab and locate the NTVDM.EXE process.

�� Highlight the NTVDM.EXE entry from the list and click the End 
Processes button at the lower right side of the screen.

�� Click Yes to end the process and exit the Task Manager.

Finally, you need to replace the VLMSUP.DLL file on your system with th
file provided on the ManageWise CD-ROM.

�� Save the original VLMSUP.DLL file from your system and store a co
in a secure location.

�� Replace the file VLMSUP.DLL ([Windows NT directory] 
\SYSTEM32\VLMSUP.DLL) with the file provided on your 
ManageWise CD-ROM ([Drive]:\MISC\NTCLT\VLMSUP.DLL).

NOTE: If any Service Packs are added to the Windows OS or if any 
updates to the Novell® client are applied, these files may be overwritten. If 
you experience problems on the ManageWise Console after an update of 
any kind, go through these steps again to ensure that you have the correct 
files on the Windows NT machine.
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ManageWise Server

This section describes ways to customize the ManageWise Server.

Storing Inventory Data at Multiple Servers on a One-Tree WAN

When you log in to a WAN with only one tree, the system login script run
This script calls MW_LOGIN.DAT from the Public directory and executes
LDISCAN.EXE, which points to a specific server where inventory data w
be stored. ManageWise updates the system login script and creates the 
MW_LOGIN.DAT file only in the Public directory.

If you want to store inventory data on more than one server in a single-tr
WAN environment, you can manually set up ManageWise to run profile lo
scripts from each container.

To do so, follow these steps:

Copy the ManageWise objects from the system login script to the profile lo
script.

For each object, create an MW_LOGIN.DAT file in the Public directory of t
server the object is logging in to.

Protecting Your Data from Corruption when Bringing Down a Server

Novell recommends that you unload all virus-protection modules and 
ManageWise modules before you bring down the server.

Most modules are unloaded automatically by UNXP.NCF, UNNMA2.NCF
and UANZ.NCF. The modules listed below are not unloaded automatically
avoid possible database or file corruption, Novell recommends that you cr
an NCF file to unload them. The NLMTMs will differ depending on what is 
installed and loaded. Be sure to check for the following NLMs:

MEMMGR.NLM
MWISE.NLM
USER.NLM
LDINV.NLM
LDISCAN.NLM
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PSCAN.NLM (MW 2.1 only)
ALERT.NLM (MW 2.5 & 2.6)

These NLMs should be unloaded after all other ManageWise modules h
been unloaded.

Calculating Disk Space Needs

At times, such as when you are forecasting, planning, and budgeting you
equipment expenditures, you might want to estimate disk space needs fo
monitoring network servers. 

Most servers need about 1.5 MB per server per month. To estimate how m
disk space you would need to monitor 100 servers for one year, you can
the following equation:

1.5 MB x 100 servers x 12 months = 1.8 GB

NOTE: If your servers have items that require additional disk space, such 
as multiple CPUs, network boards, or disk volumes, you should estimate 
disk usage using 2.0 MB per server per month.

These calculations estimate the free disk space required for TrendComp
This is IN ADDITION to any other products on the workstation that have 
dynamic databases (for example, ManageWise Console 
C:\MW\NMS\NMSDB).

Unloading All ManageWise Pieces with One Command

You can create an NCF that will unload all ManageWise pieces with one
command, rather than having to run the respective unload NCF for each
component. 

The following NCF assumes that the entire product is installed and/or runn
A question mark in front of an entry indicates that you should pause for 1
seconds. This gives the server time to unload the component and reduce
risk of abending.

**************
#Begin ManageWise Unloading
# Unload NetExplorer
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?UNXP.NCF
# Unload NetWare Management Agent TM  if server is NetWare 4.x
?UNNMA2.NCF
# Unload NetWare Management Agent if server is NetWare 5
?UNNMA5.NCF
# Unload LANalyzer Agent
?ULANZ.NCF
# Unload Desktop Management Tools
UNLOAD USER.NLM
UNLOAD LDISCAN.NLM
UNLOAD LDINV.NLM
# Unload InocuLAN for NetWare
ISTOP4.NCF
# Unload ManageWise License Service
?UNLOAD MWISE.NLM
# End ManageWise Unloading

Allowing IP-Only Communications on an NT Server

The ManageWise Agent for NT Server is designed to use IPXTM  and IPTM  to 
communicate between the ManageWise Console and the NT Server. To a
IP-only communication, follow these steps:

�� Install the ManageWise Agent for NT Servers to both the NT Server a
the ManageWise Console.

�� Reboot the NT Server.

Next, from the ManageWise Console, verify that the NT Agent is function

�� Select View > All > Windows NT Servers, and then double-click the N
Server in the list.

Be sure the NT Server configuration screen comes up and that you c
open the different icons that present the NT Server information.

�� To see if NetExplorer has already discovered the NT Server, select V
> Find > Node, and specify the IP address or MAC address of the N
Server. 

If the NT Server is found in the map, highlight it and select Edit > 
Database Object. Note the IP address and MAC address (this informa
will be needed in later steps).
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�� Close the Database Editor.

�� Delete the Discovered NT Server object.

�� Select Edit > Add > Node.

�� In the list of icons, highlight Windows NT Server: Management; then
click OK.

�� In the System Name field, enter the NT Server name.

�� To the right of Network Interfaces, click Add.

�� Enter the MAC address of the NT Server.

���� Set the Protocol to TCP/IP.

���� Set the Frame Type to the appropriate frame.

���� Set the IP address to that of the NT Server.

Be sure the Prevent Detection By NetExplorer box is checked.

���� Click Add.

Be sure the information in the Binding Summary is accurate.

���� Click OK; click OK again to save the new NT Server object to the loc
database.

���� Double-click the NT Server icon in the discovery map and verify that 
NT Server can be accessed as explained in Step 4.

Desktop Management

This section describes some ways to optimize Desktop Management, 
including remote control and related features.
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Setting Remote Control Parameters

You can adjust the Viewing window for Desktop Remote and set hot keys
some of the parameters.

Setting Remote Control Options

You can configure how a host’s screen is replicated on your monitor and 
your keystrokes affect the host workstation. The remote control options a
explained in Table 66.

To set remote control options, follow these steps:

�� Select Configure > Remote Control > Options.

�� Toggle the appropriate parameter on or off, and select the font size y
want.

Table 66 Remote Control Options

Setting Remote Control Hot Keys

Table 67 describes the functions for which you can set hot keys.

Option Description

Hot Keys Enabled Enables the Desktop Remote hot key sequences set in the Hot Keys dialog.

System Key Pass 
Through 

Passes all Ctrl+ and Alt+ keystrokes from the client to the host workstation.

Audible Packet Rate 
Signal 

Sounds a clicking noise each time a packet is received. This feature indicates 
audibly the amount of traffic between the stations.

Force 16 Color 
Viewing 

Reduces the image of host workstation screens to a 16-color image on the 
client’s monitor only. This allows for better response in the Viewing window.

Suppress Background 
Bitmaps 

Ignores Windows wallpaper, providing faster screen updates.

Default Viewer Font Determines the font for full-screen DOS sessions. This font is only displayed 
when viewing a full-screen DOS window on the host workstation.
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To set remote control hot keys, follow these steps:

�� Select Configure > Remote Control > Hot Keys.

�� Select the appropriate Hot Key field.

�� Press the key combination you want to use for the selected Hot Key f

�� Press the Hot Key Enable hot key (<Ctrl>+<Alt>+<H> by default).

Table 67 Functions that Support Hot Keys

Remote Network Mana gement Across a WAN Link

You can use MPR and ManageWise together to remotely manage a netw
across a WAN link. This section outlines the steps involved in configuring
MPR 3.1 for a simple ManageWise Remote Services installation. 

The following example uses NetWare 4.1, MultiProtocol Router® (MPR) 3.1, 
and ManageWise 2.6. Similar configurations can be done with NetWare 4
NetWare 3.12, MPR 3.0 or ManageWise 2.5.

A customer site consists of a NetWare 4.1 server called CUSTOMER tha
running MPR 3.1. The same server also has ManageWise installed with 

Function Description

Full Screen Toggle Maximizes the Viewing window and removes the caption and border.

Refresh Screen Forces the host screen to refresh.

Restart Viewer Forces the client workstation to rebuild the screen image.

System Key Pass 
Through 

Toggles the System Key Pass Through feature on or off.

Hot Key Enable Disables all Desktop Remote hot keys except the Hot Key Enable hot key.

Stop Viewing Terminates the session with the host.

Win95 System Key 
Bar 

Simulates system keys on the target workstations through a floating toolbar.
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NetExplorer. The server is connected to LAN A, the customer’s local segm
customer also has an on-demand dial-up IPX link to a reseller site.

The reseller site has a NetWare 4.1 server called RESELLER that is run
MPR 3.1. RESELLER is connected to LAN B. The ManageWise Console 
workstation on LAN B.

The above configuration allows NetExplorer to run at the customer site a
gather information about LAN A. This information is available to the 
ManageWise Console at the reseller site. 

When alarms or traps are sent from the ManageWise server, the Manage
server brings up the on-demand IPX link and sends the alarms across th
to the ManageWise Console at the Reseller's site.

NOTE: NetExplorer should not be running at the reseller site; otherwise, 
RESELLER initiates a call to CUSTOMER when its exploration cycle 
starts. If you must run NetExplorer at the Reseller site for local 
management, you can minimize the frequency NetExplorer is run, or you 
can isolate the NetExplorer server so that it does not have services 
information about CUSTOMER available to it.

Configuration Steps

1. Prerequisites

� At the customer site:

Make sure MPR 3.1 is installed on the server that makes the WAN 
connection. The ManageWise server must also be installed and runni
the customer site. In this example, the ManageWise server is on the s
server as MPR 3.1. However, the ManageWise server can run on a 
different server at the customer site if desired.

� At the reseller site:

MPR 3.1 must be installed on the server that makes the WAN connec
The ManageWise Console must be installed on a workstation that is
connected to the server.

2. Configure the Communications Board
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Typical on-demand links use a standard async modem or an ISDN board
Configure the board through the INETCFG utility. Refer to "Configuring 
Drivers and Board Parameters" in the MPR 3.1 Configuration Manual if you 
are unfamiliar with this setup. The manual contains separate sections fo
modem setups and ISDN setups. On-demand links must be configured on
MPR systems.

Some points to remember:

� Asynchronous modems use the WHSMAIO driver.

� CAPI-compliant ISDN boards use the WHSMCAPI driver.

3. Configure the On-Demand PPP Interface

Set up the PPP interface and WAN Call Directory on each MPR system u
INETCFG.

Some points to remember:

� Because you will be calling another MPR system, you probably won
need to change any of the settings from their defaults.

� Do not select an interface speed faster than the speed supported by
serial interface, even if the modem itself goes faster.

Editing the LDAPPL.INI File in an Editor

The LDAPPL.INI file has five main sections: [Inventory], [Applications], 
[Excluded Applications], [Ignore], and [Excluded Ignore]. Only the 
[Inventory] section should be edited in an editor. The other four sections 
be edited in Desktop Manager.

Table 68 describes the options that can be used in the [Inventory] section

Table 68 [Inventory] Section Options

Option Description

Mode Determines how the scan programs use the software list. Three settings are 
used: Listed, Unlisted, and All.
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IMPORTANT: The software list has dependencies that can be difficult to 
edit. To minimize errors, you should not change any of the following 
sections manually. Instead, use the software editor (Options > Software 
List) to add and remove software descriptions.

The [Applications] section defines how LDISCAN recognizes an applicatio
This section uses the following syntax:

<Method>, filename, size, application, version

Table 69 [Applications] Section Options

Listed Listed mode records the files listed in LDAPPL.INI.

Unlisted Unlisted mode records the names and dates of all files that have the extensions 
listed on the ScanExtensions line but are not defined in LDAPPL.INI. This mode 
can be used to help discover unauthorized software on the network.

All All mode discovers listed and unlisted files.

Duplicate Records multiple instances of files. Set the value to OFF to record only the first 
instance or ON to record all detected instances.

Option Description

ScanExtensions Sets the file extensions (such as .EXE, .COM, and .CFG) to be recorded. File 
extensions are separated by a space in the .INI file.

Version  The scan program version. The version number helps ensure future 
compatibility.

CfgFiles1-4 Records the date, time, file size, and contents of the specified files. The database 
stores the number of revisions you specify in the Software Scanning dialog (see 
Table 81 on page 345 for a description of the available frequencies for software 
scanning).

You can leave out the drive letter if you want to search all local drives. You can 
specify more than one file on each of the four lines, but the line length is limited 
to 80 characters. Pathnames on the same line are separated by a space.

MifPath Specifies where MIF files are to be stored on a station’s local drive. By default, 
this value is set to C:\DMI\DOS\MIFS.

Option Description
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Three scanning methods are available. Table 70 on page 323 explains each 
method.

Table 70 Scanning Methods

The [Ignore] section lists specific filenames the scan program ignores, 
regardless of file type. This option can speed database processing by red
the number of files scanned.

The [Excluded] sections are used by the Edit Software List window and 
should not be edited manually.

Editing SCAN.INI

The SCAN.INI file is used by Desktop Manager to replicate files among 
servers on the network. For example, if you have two inventory servers a
you list a new application in one server’s LDAPPL.INI file, you can speci
in the SCAN.INI file that the second server’s LDAPPL.INI file also be 
updated.

LDINV.NLM searches for the files specified in the SCAN.INI file every 10
minutes and reads the contents of any updated files.

[Send] Section

The [Send] section of the SCAN.INI file lists the names, volumes, and pa
of files on the server that LDINV.NLM monitors. When the time stamp of a
of these files changes, LDINV.NLM alerts the other inventory servers on 
network.

Method Description

<F> Uses the file descriptions from .EXE file headers for Windows applications.

<P> Uses the product descriptions from .EXE file headers for Windows applications.

<I> Uses the file and product descriptions from the LDAPPL.INI file or the current software 
description .INI file. The filename and size must match exactly for Desktop Manager to 
record the file’s application name and version number. For example, to monitor the 
LDAPPL.INI file found at SYS:\, enter the following line in the [Send] section:

LDAPPL.INI, SYS:\
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[Receive] Section

The [Receive] section lists monitored files on other inventory servers. Ea
entry contains a filename, the volume and path to which the file is copied,
the name of the server that stores the file. For example, to monitor the 
inventory server “FS1” for changes to its LDAPPL.INI file, type the followin
line in the [Receive] section:

LDAPPL.INI, SYS:\LOGIN\, FS1

Assigning .BMP and .WAV Files for Individual Users

You can display a bitmap (.BMP) picture and play a waveform (.WAV) sou
file for each user recognized in the database. You can use the bitmap pic
to display a photograph of the user or the location of the user’s workstatio
a map of the building. You can use the sound file to play the proper 
pronunciation of the user’s name.

The names of the bitmap and waveform files must match the login name o
user as recorded in the database. For example, if USER1 is a login name
can define a picture USER1.BMP and a sound clip USER1.WAV for that u

You don’t need a sound card; sound files can play on your system speak
(with limited clarity on some systems) as long as you have Microsoft’s PC
Speaker Windows driver installed.

The [Settings] section in the LANSIGHT.INI file contains BMPDir=path an
WAVDir=path entries, which specify the path to your bitmap and wavefor
file directories. If no path is specified, the files are assumed to be in the s
directory as the Desktop Manager executable file (WSIGHT.EXE). The 
LANSIGHT.INI file is found in the Windows directory of the Management
Workstation.

A bitmap file can be up to 64 KB. If the picture is too large, Desktop Mana
crops the picture to fit in its picture window.

To assign a picture or sound file to a user, follow these steps:

�� Assign the user’s login name to the file and add a .BMP or .WAV 
extension.

�� Copy the file to the appropriate directory.
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To specify a path to the .BMP or .WAV file directory, follow these steps:

�� Open the LANSIGHT.INI file in the Windows directory of your local 
drive and find the [Settings] section.

�� After BMPDir=, enter the path to the directory where your bitmap file
are stored.

�� After WAVDir=, enter the path to the directory where your waveform 
files are stored.

To view a user’s picture, follow these steps:

�� Select a user from the Device list.

�� Select Device > Picture.

To play a user’s sound clip, follow these steps:

�� Select a user from the Device list.

�� Select Device > Picture.

�� Click the Speaker icon.

LANalyzer Agent

Improving NetWare LANalyzer Agent Performance

If you implement the suggestions in this section, you can improve the 
performance of your NetWare LANalyzer Agent server.

You can configure NetWare LANalyzer Agent functions by setting the 
parameters in the LANZ.NCF file.

Contents of the LANZ.NCF File

The LANZ.NCF file loads all the NetWare Loadable Module (NLM) softwa
required for NetWare LANalyzer Agent operation. The LANZ.NCF file 
resides in the SYS:SYSTEM directory.
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The following example displays the complete text of the default LANZ.NC
file.

LANZ.NCF File

#
# NetWare LANalyzer Agent
# Version 1.21
#
#------------------------------------------------------------------------
# LANZ.NCF: NetWare LANalyzer Agent Load File
#
# This NCF file is created by the NetWare LANalyzer Agent install program.
# It is used to load the NetWare Loadable Module files that make up NetWare
# LANalyzer Agent.
#
# WARNING: You should not modify this file unless you need to change
# one of the configuration parameters documented below.
# Other changes to this file are not recommended. Should you
# damage this file, you must reinstall NetWare LANalyzer Agent.
#
# NOTE: To enable or disable the monitoring of network adapters
# by NetWare LANalyzer Agent, use the LANZCON utility
# as described in the NetWare LANalyzer Agent Installation
# and Administration guide.
#
#------------------------------------------------------------------------
# Load Parameter Descriptions
#
# load LANZSU debug=1
#
# debug=1 Turns on the LANZ Control screen to see the transactional
# messages from the NetWare LANalyzer Agent.
#
# load LANZMEM bound=KB age=HHH
#
# bound=KB This is the upper limit on memory that can be allocated
# dynamically by the NetWare LANalyzer Agent.
#
# Increasing this number allows you to create larger packet
# capture buffers and maintain data for inactive stations
# for a longer period of time.
#
# Decreasing this value reduces the amount of memory that
# can be used by NetWare LANalyzer Agent. This leaves more
# memory for the other server tasks.
#
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# NetWare LANalyzer Agent automatically purges data for
# inactive stations as the memory boundary is approached.
# This allows NetWare LANalyzer Agent to adjust to
# the memory that is available to it dynamically.
#
# If the boundary is low, purging occurs frequently, saving
# only data for stations that have been recently active on
# the network. If this happens, a message appears on the
# system console indicating that not enough memory has been
# allocated to NetWare LANalyzer Agent.
#
# KB is the memory boundary in kilobytes.
#
# Initial value: Set by the installation program
# based on memory usage
#
# Minimum recommended value: 512
#
# Maximum recommended value: 75% of free server memory
# when NLM files are loaded
#
# Default value: If bound=KB is not specified,
# it defaults to 2048.
#
# age=HHH NetWare LANalyzer Agent purges data for stations that have
# not been active on the network recently. This parameter
# controls how long data for inactive stations is maintained.
#
# Memory that is used by the station table is not available
# for other uses, such as capturing packets. Reducing the
# AGE value tends to increase the amount of memory
# available for capturing packets.
#
# If you cannot allocate capture buffers that are large,
# you may need to reduce the AGE value.
#
# HHH is the inactivity period, in hours, before station data
# is purged.
#
# Minimum recommended value: 1
#
# Default value: If age=HHH is not specified,
# it defaults to 168 (1 week)
#
# load LANZDI level=1
#
# level=1 It indicates that the LANZDI will stop receiving packets
# when CPU utilization gets high.
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#
# Default is OFF. LANZDI will continue to receive packets even
# when CPU utilization gets high.
#
# load LANZSM topn=N
#
# topn=N The number of concurrent sorts of top N nodes that
# NetWare LANalyzer Agent supports for each network adapter.
#
# Recommended value: 4
# Minimum value: 2
# Maximum value: 10
#
# load LANZTR poll = 1
#
# poll=1 Polls token ring source-routed bridges.
#
# load LANZCTL trapreg=1
#
# trapreg=1 Causes SNMP traps to be sent to management consoles
# advertising themselves on the network, as well as stations
# listed in SYS:\ETC\TRAPTARG.CFG. Omitting this parameter
# or setting it to 0 causes traps to be sent only to those
# stations listed in the SYS:\ETC\TRAPTARG.CFG file.
#
#------------------------------------------------------------------------
load GTREND.MLM \D VOLNAME:\GTREND
load LANZSU.NLM
load LANZMEM.NLM bound = 2048 AGE = 168
load LANZLIB.NLM
load LANZDI.NLM
load LANZAEL.NLM
load LANZHIS.NLM
load LANZFCB.NLM
load LANZSM.NLM topn = 4
load LANZTR.NLM
load LANZFDDI.NLM
load LANZCTL.NLM trapreg = 1
#

Modifying the LANZ.NCF File

The sections below describe how to modify the parameters of the comm
in the LANZ.NCF file to configure NetWare LANalyzer Agent functions.

To make changes in the LANZ.NCF file and modify the NetWare LANalyz
Agent configuration, use the following general procedure:
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�� Open the LANZ.NCF file with a text editor.

�� Insert or modify the appropriate parameter as shown, and save the f

�� Unload and reload NetWare LANalyzer Agent as described in 
“Activating Changes in the LANZ.NCF File” on page 333.

Turning on the LANZ Control Screen

The LANZ Control screen reports significant events for NetWare LANalyz
Agent.

To turn on the LANZ Control screen, add the DEBUG parameter to the LO
LANZSU.NLM statement, as shown in the following statement:

LOAD LANZSU.NLM DEBUG=1

The default setting turns off the LANZ Control screen by omitting the 
DEBUG parameter.

Disabling Packet Capture

You might want to disable the NetWare LANalyzer Agent packet capture
function to prevent others from observing sensitive data captured in the 
packets sent on the network segment.

To disable the NetWare LANalyzer Agent packet capture function, insert
comment mark (#) as the first character in the following statement:

LOAD LANZFCB.NLM

If you only want to control packet capture during high levels of traffic rath
than disabling packet capture entirely, see “Setting Packet Flow Control” on 
page 329.

Setting Packet Flow Control

NetWare LANalyzer Agent typically operates in promiscuous mode, 
receiving all packets on the network. However, if server utilization is high a
performance becomes degraded, you can set the LEVEL parameter to 1
Optimization ���

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

vel 

e 

 be 

lt 

ble 

er 

 

t 

of the 

he 
which configures the agent to yield when server traffic is high, and then 
automatically resume operation in promiscuous mode when the traffic le
returns to normal.

The default is to not specify the LEVEL parameter at all, which allows 
continuous operation in promiscuous mode.

To set packet flow control, use the LEVEL parameter setting shown in th
following statement:

LOAD LANZDI LEVEL=1

Setting the Upper Limit of Available Memory

The BOUND parameter sets the upper limit of available memory that can
allocated dynamically to NetWare LANalyzer Agent.

The value of the BOUND parameter is measured in kilobytes. The defau
value is 2048 KB. The minimum recommended value is 512 KB. The 
maximum recommended value is 75 percent of the memory that is availa
after all NLM files are loaded.

You might receive an "Insufficient memory available for NetWare LANalyz
Agent" message in the following situations:

� The server has too little memory.

� The server has sufficient memory, but the memory is not available to
NetWare LANalyzer Agent.

� You requested a packet capture buffer that is too large, and the agen
grants you less memory than requested.

In each of these cases, Novell recommends that you increase the value 
BOUND parameter and add more RAM to your NetWare server.

To change the value of the BOUND parameter, edit the parameter with t
appropriate value in the following statement in the LANZ.NCF file:

LOAD LANZMEM BOUND=2048 AGE=68
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Purging Data from Server Memory

NetWare LANalyzer Agent holds its data in server memory. You can con
the amount of data held in memory by setting the value of the AGE param
When data reaches the “age” specified in the parameter, the data is purg
from memory.

The value of the AGE parameter is measured in hours. The default value
168, which is one week. The minimum recommended value is one hour.
Setting minimum AGE parameter prevents old conversation and node da
from consuming excessive memory. This is of concern primarily on large
bridged networks.

Novell recommends that you lower the AGE parameter by a few hours if 
receive an "Insufficient memory available for NetWare LANalyzer Agent"
message, and you have allocated sufficient memory for the agent.

Having insufficient memory is not harmful to the agent or the server. NetW
LANalyzer Agent can run indefinitely even when it is not satisfied with th
memory allocated to it.

To modify the amount of data held in server memory, change the value o
AGE parameter in the following LANZ.NCF file statement:

LOAD LANZMEM BOUND=2048 AGE=168

Sorting Concurrent Top Stations

NetWare LANalyzer Agent sorts stations whenever the top eight graphs on
Network Dashboard window, the Stations window, or both are displayed 
the ManageWise Console. The sorts are independent of each other and c
computed on the basis of different statistics.

Because each of the sort computations uses server CPU cycles, Novell 
recommends that you limit the number of concurrent computations NetW
LANalyzer Agent can support.

The TOPN parameter sets the number of concurrent sorts of topN nodes
NetWare LANalyzer Agent can support for each network adapter.
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To set the number of concurrent sort computations per network board, se
TOPN parameter in the following statement:

LOAD LANZSM TOPN= n

The default value of the TOPN parameter is 4. The minimum value is 2. 
maximum value is 10.

Sending Alarms to ManageWise Consoles Automatically

NetWare LANalyzer Agent can automatically send SNMP alarms (sometim
referred to as SNMP traps) to ManageWise Consoles or other nodes on 
network in the following configurations:

� NetWare LANalyzer Agent receives the service advertising protocol 
(SAP) packets sent by one or more ManageWise Consoles.

� The ManageWise Console or another node is listed in the server’s 
TRAPTARG.CFG file.

The TRAPTARG.CFG file is stored in the SYS:\ETC directory. The file 
provides instructions in its use. You can edit the file with any ASCII text 
editor.

To enable alarms to be sent automatically, add the TRAPREG paramete
setting as shown in this LANZ.NCF file statement (this is the default):

LOAD LANZCTL TRAPREG=1

If you omit the TRAPREG parameter or set its value to 0 (zero), the agen
sends alarms only to ManageWise Consoles listed in the TRAPTARG.CF
file.

Polling Source Route Bridges

To control source route bridge polling on token ring networks, use the PO
parameter as shown in the following statement:

LOAD LANZTR POLL=1
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For the POLL parameter, 1 = On and 0 = Off.

Setting the POLL parameter to 1 polls source-routed bridges once every
second. (You cannot change the polling rate.) The default is On.

To turn off this function, set the POLL parameter to 0:

LOAD LANZTR POLL=0

The default is to omit the POLL parameter. Also, the LOAD LANZTR 
statement is commented out on systems that do not have a token ring ad
installed.

Activating Changes in the LANZ.NCF File

To activate the changes you make in the LANZ.NCF file, save the file and 
unload and reload NetWare LANalyzer Agent by issuing the following 
commands at the server prompt:

ULANZ

The ULANZ command unloads NetWare LANalyzer Agent.

LANZ

The LANZ command reloads the agent.

Optimizing NetExplorer

The NetExplorer system includes all the network discovery components 
reside on a ManageWise Server, such as NETXPLOR.NLM, and the 
ManageWise Console, such as NetExplorer Manager software. This sec
describes how to set parameters to optimize network discovery on your 
network.

Scheduling Server Scans

LDISCAN.NLM scans for the inventory information specified on the 
command line when the NLM loads. Hardware scans occur every day as
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specified by the TIME=# parameter. The TIME parameter is set in militar
time, so 0 = midnight and 23 = 11 p.m.

During a hardware scan, LDISCAN.NLM checks the software scanning 
frequency (set in Desktop Manager > Options > Software Scanning) to 
determine if a software scan should also be run.

To change the time for server hardware scans, add the TIME= n parame
the load LDISCAN line of SYS:SYSTEM\MW_AUTO.NCF.

To change the interval for server software scans, follow these steps:

�� Select Options > Software Scanning.

�� Set the frequency.

�� Click OK.

Setting Options for DOS Inventory Scanner

The LDISCAN programs can be run from a login script for networked 
workstations or on demand from a diskette for non-networked workstatio

The scan program uses the following command-line syntax:

[/S= servername] [/D= directory] [/A= number] [/F] [/N]

[/I= inifile] [/O=[path] filename] [T=[path] filename]

[/Q[=[path] filename]] [/Z= number][/U][/M][/V][/W]

[/?]

Table 71 Scan Programs

Program Platform and Protocol

LDISCAN.EXE DOS

WLDISCAN.EXE Windows 3.x, Windows 95, Windows 98 over IP and IPX

LDISCNNT.EXE Windows NT server and workstations over IPX
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The following table summarizes DOS scan program parameters.

Table 72 DOS Scan Program Parameters

 LDISCAN2.EXE OS/2 over IPX Inventory MacScan Macintosh

Parameter Description

/S= servername Specifies the inventory server on which the inventory information should be 
stored.

/D= directory Starts the scan in the specified directory. By default, the scan starts in the root 
directory of each local hard disk.

/I= inifile Provides software descriptions to LDISCAN.EXE from a file other than 
LDAPPL.INI. The file must be located in the same directory as LDISCAN.EXE.

/O=[path] filename Writes inventory information to the specified output file. The filename CON sends 
output to the screen.

/T=[path] filename Copies the contents of the specified file to the inventory database. This option is 
used to enter inventory data from standalone workstations or from separate 
inventory files.

/Q[=[path] filename Discovers files that have extensions listed under ScanExtensions in LDAPPL.INI 
but are not defined in LDAPPL.INI. This option is similar to the Unlisted Mode 
switch in LDAPPL.INI, but the results are printed to a file instead of being saved 
to the database.

If you do not specify a filename, the program prompts you to ignore each file or 
add its description to LDAPPL.INI. If you choose to add the file description, you 
are prompted to enter a description and version number for each file.

/A= number Specifies the number of seconds before time-out.

The default is 5 seconds. If you experience inventory failure due to a slow and/
or congested network, you should increase this time-out value.

/Z= number Specifies the retry count.

/U Disables the Ctrl+C (break) keystroke on the target station for the duration of the 
scan. This option keeps users from interfering with the inventory scan.

Program Platform and Protocol
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Setting Options for Windows 3.x, Windows 95, Windows 98 Inventory 
Scanner

The WLDISCAN program can be run from a login script for networked 
workstations or from a diskette for non-networked workstations.

The scan program uses the following command-line syntax:

[/S= servername] [/D= directory] [/A= number] [/F] [/N]

[/I= inifile] [/O=[path] filename] [T=[path] filename]

[/Q[=[path] filename]] [/Z= number][/U][/M][/V][/W]

[/?]

Table 73 WLDISCAN Program Parameters

The following table summarizes Windows 3.x/Windows 95/Windows 98 
Inventory Scan Program parameters.

Parameter Description

/M Creates the LDISCAN.MIF file in the C:\DMI\DOS\MIFS directory. This file contains the 
workstation inventory information discovered in the scan.

/F Forces a software scan regardless of the software scanning setting.

/N Exempts subdirectories from the search.

/V Makes the scan visible to the user by displaying the scan’s status. If the workstation has 
not been scanned previously, this option displays a spinning wheel during the software 
scan. If the workstation has been previously scanned, a progress bar is displayed during 
the software scan.

/W Runs the DOS scan from a Windows DOS box without prompting the user to exit 
Windows.

/? Displays the command-line syntax help.
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Table 74 Windows 3.x/Windows 95/Windows 98 Inventory Scan Program Parameters

Settin g Options for Windows NT Inventor y Scanner

The LDISCNNT programs can be run from a login script for networked 
workstations and servers or from a diskette for non-networked workstatio
LDISCNNT.EXE can be run at startup. All scan programs can be run on 
demand.

The Windows NT scan program uses the following command-line syntax

[/S= servername] [/D= directory] [/I= inifile] [/H]

[/A= number] [/O=[path] filename] [T=[path] filename]

Parameter Description

/S= servername Specifies the inventory server on which the inventory information should be 
stored.

/D= directory Starts the scan in the specified directory. By default, the scan starts in the root 
directory of each local hard disk.

/I= inifile Provides software descriptions to LDISCAN.EXE from a file other than 
LDAPPL.INI. The file must be located in the same directory as LDISCAN.EXE.

/O=[path] filename Writes inventory information to the specified output file. The filename CON sends 
output to the screen.

/T=[path] filename Copies the contents of the specified file to the inventory database. This option is 
used to enter inventory data from standalone workstations or from separate 
inventory files.

/Q[=[path] filename Discovers files that have extensions listed under ScanExtensions in LDAPPL.INI 
but are not defined in LDAPPL.INI. This option is similar to the Unlisted Mode 
switch in LDAPPL.INI, but the results are printed to a file instead of being saved 
to the database.

If you do not specify a filename, the program prompts you to ignore each file or 
add its description to LDAPPL.INI. If you choose to add the file description, you 
are prompted to enter a description and version number for each file.

/A= number Specifies the number of seconds before time-out. The default is 5 seconds. If you 
experience inventory failure due to a slow and/or congested network, you should 
increase this time-out value.
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[/Q[=[path] filename]] [/Z= number] [/U][/M] [/F] [/W]

[/N][/NTI[I:N]][/NTT[T]][/V][/?]

Table 75 LDISCNNT Program Parameters

The following table summarizes Windows NT Inventory Scan program 
parameters.

Table 76 Windows NT Inventory Scan Program Parameters

Parameter Description

/p= IP/IPX Changes the network protocol from IPX to TCP/IP. The parameter values include 
IPX for the IPX network protocol and IP for the TCP/IP network protocol.

/X Disables software scanning.

/M Creates the LDISCAN.MIF file in the C:\DMI\DOS\MIFS directory. This file 
contains the workstation inventory information discovered in the scan.

/N Exempts subdirectories from the search.

/? Displays the command-line syntax help.

Parameter Description

/S= servername Specifies the inventory server on which the inventory information should be 
stored.

/D= directory Starts the scan in the specified directory. By default, the scan starts in the root 
directory of each local hard disk.

/I= inifile Provides software descriptions to LDISCNNT.EXE from a file other than 
LDAPPL.INI. The file must be located in the same directory as LDISCNNT.EXE.

/O=[path] filename Writes inventory information to the specified output file. The filename CON sends 
output to the screen.

/T=[path] filename Copies the contents of the specified file to the inventory database. This option is 
used to enter inventory data from standalone workstations or from separate 
inventory files.
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Setting Options for OS/2 Inventory Scanner

LDISCAN2.EXE can be run at startup by placing the program in the 
STARTUP.CMD or on demand from a command line.

Table 77 LDISCAN2.EXE Program Parameters

/Q[=[path] filename Discovers files that have extensions listed under ScanExtensions in LDAPPL.INI 
but are not defined in LDAPPL.INI. This option is similar to the Unlisted Mode 
switch in LDAPPL.INI, but the results are printed to a file instead of being saved 
to the database.

If you do not specify a filename, the program prompts you to ignore each file or 
add its description to LDAPPL.INI. If you choose to add the file description, you 
are prompted to enter a description and version number for each file. Do not use 
the /Q parameter with the /S or /SNMP parameters.

/A= number Specifies the number of seconds before time-out. The default is 5 seconds. If you 
experience inventory failure due to a slow and/or congested network, you should 
increase this time-out value.

/Z= number Specifies the retry count.

/H Displays the command-line syntax help.

Parameter Description

/U Disables the Ctrl+C (break) keystroke on the target station for the duration of the scan. 
This option keeps users from interfering with the inventory scan.

/M Creates the LDISCAN.MIF file in the C:\DMI\DOS\MIFS directory. This file contains the 
workstation inventory information discovered in the scan.

/F Forces a software scan regardless of the software scanning setting.

/N Exempts subdirectories from the search.

/NTI[I:N] Specifies IPX for communication with the remote inventory server. The parameter values 
specify the internal network address and node address of the remote inventory server.

/NTT[T] Specifies TCP/IP for communication with the remote inventory server. The parameter 
values specify the dotted decimal IP address of the remote inventory server.

Parameter Description
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The OS/2 scan program uses the following command-line syntax:

[/S= servername] [/D= directory] [/I= inifile] [/U] [/F]

[/O=[path] filename] [T=[path] filename] [/A= number]

[/Q[=[path] filename]] [/Z= number] [/N] [/W] [/?]

The following table summarizes Windows OS/2 Inventory Scan program
parameters:

Table 78 OS/2 Inventory Scan Program Parameters

/V Makes the scan visible to the user by displaying the scan’s status. If the workstation has 
not been scanned previously, this option displays a spinning wheel during the software 
scan. If the workstation has been previously scanned, a progress bar is displayed during 
the software scan.

/W Runs the scan from a Windows OS/2 box without prompting the user to exit Windows.

/? Displays the command-line syntax help.

Parameter Description

/S= servername Specifies the inventory server on which to store the inventory information.

/D= directory Starts the scan in the specified directory. By default, the scan starts in the root 
directory of each local hard disk.

/I= inifile Provides software descriptions to LDISCAN2.EXE from a file other than 
LDAPPL.INI. The file must be located in the same directory as LDISCAN2.EXE.

/O=[path] filename Writes inventory information to the specified output file. The filename CON sends 
output to the screen.

/T=[path] filename Copies the contents of the specified file to the inventory database. This option is 
used to enter inventory data from standalone workstations or from separate 
inventory files.

Parameter Description
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Setting Scan Options for the Inventory MacScan

The Inventory MacScan program must be installed and configured at ea
Macintosh workstation. For information on installing the MacScan Invento
Scanner, refer to Chapter 5, “ManageWise Workstation Installation Notes
the ManageWise Setup Guide.

For normal scanning, set Inventory MacScan to run an inventory scan ea
time the program launches. To change scanning options, open the Inven
MacScan program by clicking the Inventory MacScan icon in the MacSc
folder.

To configure Inventory MacScan, follow these steps:

�� Run Inventory MacScan.

�� Select File > Preferences.

�� Select Options.

The following table summarizes Inventory MacScan program 
parameters:

Table 79 Inventory MacScan Program Parameters

/Q[=[path] filename Discovers files that have extensions listed under ScanExtensions in LDAPPL.INI 
but are not defined in LDAPPL.INI. This option is similar to the Unlisted Mode 
switch in LDAPPL.INI, but the results are printed to a file instead of being saved 
to the database.

If you do not specify a filename, the program prompts you to ignore each file or 
add its description to LDAPPL.INI. If you choose to add the file description, you 
are prompted to enter a description and version number for each file. Do not use 
the /Q parameter with the /S or /SNMP parameters.

Parameter Description

/A= number Specifies the number of seconds before time-out. The default is 5 seconds. If you 
experience inventory failure due to a slow and/or congested network, you should 
increase this time-out value.

Parameter Description
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When you have finished setting parameters,

�� Click OK.

To run a scan each time Inventory MacScan loads, follow these steps:

�� Run Inventory MacScan.

�� Select File > Preferences.

�� Select Automatically Scan during startup.

�� Click OK.

Select a ManageWise Server to Send Inventory Information

Inventory MacScan requires a database to send the inventory informatio
The first time the program runs, it prompts you to select a NetWare server 
an inventory database. This database continues to be used until you sele
another inventory database.

To select an inventory database for a Macintosh station, follow these ste

�� Run Inventory MacScan.

�� Select File > Preferences.

�� Click Select Inventory Server.

�� Select an inventory server from the list.

/Z= number Specifies the retry count.

/U Disables the Ctrl+C (break) keystroke on the target station for the duration of the 
scan. This option keeps users from interfering with the inventory scan.

/F Forces a software scan regardless of the software scanning setting.

/N Exempts subdirectories from the search.

/? Displays the command-line syntax help.

Parameter Description
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�� Click OK.

You can scan for software on the Macintosh at each startup, regardless o
software scanning frequency setting.

To force software inventory scans, follow these steps:

�� Select File > Preferences.

�� Select Scan Software Regardless of the NLM.

�� Click OK.

You can set Inventory MacScan to search all local volumes, a specific lo
drive, or a specific folder on a local drive.

To limit the scope of a software scan to a single volume, follow these ste

�� Select File > Preferences.

�� Select Application Search and select the appropriate volume.

�� Click OK.

To limit the scope of a software scan to a single folder, follow these step

�� Select File > Preferences.

�� Select Application Search.

�� Find and select the appropriate folder.

�� Choose Select Current Folder.

�� Click OK.

Components to Scan for on Macintosh Workstations

Inventory MacScan provides 12 component categories for Macintosh 
inventory scans. You can choose to record information about each of the
categories or to ignore component categories.
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The following table describes the hardware and software component 
categories available in Inventory MacScan:

Table 80 MacScan Inventory Components

To select inventory component categories to include in inventory scans, 
follow these steps:

�� Select File > Select Components.

�� Double-click the components you want to include.

�� Click OK.

A check mark appears to the left of each selected component.

Component Description

ADB Devices Apple* Desktop Bus* devices such as keyboards and mice.

CPU Microprocessors, coprocessors, and other CPU-related components.

Monitors Any display attached to the workstation.

NuBus Boards Add-on boards designed for Apple’s NuBus* slots.

SCSI Devices Any SCSI hard drives and daisy-chained SCSI devices.

Volumes Any local hard disk.

Applications Find any software application on a local hard disk.

Desk Accessories Find any Desk Accessory in the Apple Menu Items folder within the System 
folder.

Drivers Find any device driver functioning on the workstation.

Fonts Find any font loaded in the System folder.

INITs Find any INIT loaded in the System folder.

System Info Discover the version and other information related to the operating system in 
use.
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Scheduling Software Scanning

Because software scanning can take more time than hardware scanning
might not want the system to scan for software each time it scans for hardw
Table 81 on page 345 describes the available frequencies for software 
scanning.

The frequency you set in the Software Scanning dialog applies both to se
and workstations.

To change the software scanning frequency, follow these steps:

�� Select Options > Software Scanning.

�� Select the frequency at which you want to collect software and 
configuration file information.

Table 81 Frequencies for Software Scanning

�� Click OK.

The software scan records the contents of the files specified on the CfgF
lines of the LDAPPL.INI file (see “Customizing Software Recognition” on 
page 346). The software scan compares the date and size of the current 
with that of the file of the previous scan. If the date and size information 
not match, the scan records the contents of the file as a new revision.

You can set the number of revisions you want to maintain in the databas

To set the number of file revisions, follow these steps:

Interval Description

Always Scans software with every hardware scan.

Daily Scans software at the first hardware scan after 24 hours have passed.

Weekly Scans software at the first hardware scan after one week has passed.

Monthly Scans software at the first hardware scan after one month has passed.

Every Scans software at the first hardware scan after the specified interval has passed.
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�� In the Software Scanning dialog, enter the number of revisions you w

�� Click OK.

Customizing Inventory Scanning

Two initialization (.INI) files control the software scanning in Desktop 
Manager: LDAPPL.INI and SCAN.INI. These files are used by the scan 
programs to hold software specifications and scan parameters. Copies o
LDAPPL.INI and SCAN.INI files are required on all servers where the sc
programs are run.

The Inventory MacScan also offers options for hardware and software 
scanning on Macintosh workstations.

Customizing Software Recognition

The LDAPPL.INI file is the default software description file. Changes to th
file affect all software scans that do not specify a different software 
description file. Most of this file can be edited from Desktop Manager.

By default, the LDAPPL.INI file contains descriptions of more than 4,000
software applications. You can choose to scan for a subset of the softwa
described in the file and you can add your own software descriptions.

The scan programs recognize software in three ways: by filename, by filen
and size, or, for Windows applications, by finding information included in
program’s executable file.

To specify applications to include in a software scan, follow these steps:

�� Select Options > Software List.

�� Select a software description from the Excluded from Scan list, and c
Add.

�� Click OK.

To add software descriptions to Desktop Manager, follow these steps:
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�� Select Options > Software List.

�� Click New.

�� Enter the appropriate information in the Application Information grou
box.

�� Click Accept.

�� Click OK.

Globally Configuring a Scheduled Scan for All InocuLAN Users

Using the NetWare Application Launcher, you can configure a scheduled 
for all InocuLAN users. Follow these steps:

�� Run AVUPDATE.EXE on the workstation.

This file installs the Cheyenne* Anti-Virus for Win 95.

�� Reboot the workstation.

�� Run SnAppShot on the machine.

�� After the pre-SnAppShot is finished and you are instructed to install 
application, exit SnAppShot.

�� Launch Cheyenne Anti-Virus for Win95.

�� Go into Scheduled Scans and click the Green arrow.

This will take you into the Scheduled scan configuration options. 

�� Configure the scanning option as you want all users to see it. 

�� Save the changes and reboot the workstation.

�� Run SnAppShot on the machine again.

You should get a message that a partial SnAppShot has taken place
see a prompt to continue.
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���� After the SnAppShot template has been created, create an applicatio
object with the template.

���� Associate the users with the object.

���� Make sure the users do not launch the Application object until they h
successfully installed the Cheyenne Anti-Virus for Win95.

Optimizing NetWare Management Agent

The NetWare Management Agent is a set of NLM files installed in a NetW
server that enables the server to be monitored and managed remotely u
SNMP. Any server with the NetWare Management Agent installed is refer
to as a managed server. This section describes how to set NMA parameters
optimize performance on your network.

Configuring NLM Load Parameters

The NetWare Management Agent installation process creates the NMA2.N
file in the SYS:\SYSTEM directory. When the NetWare server is started, 
file automatically loads all the NLM files required for a default configuratio
of NetWare Management Agent.

You can configure several LOAD parameters for each NLM file used with 
agent. You can configure your server to use these options by editing the
NMA2.NCF file on your server. 

Also, if your server is already running, you can unload any of these NLM f
and then load them at the NetWare server console using any of the 
configuration parameters. You can configure these parameters at the Net
server console or by using the NetWare remote console utility, RCONSO

The sections that follow describe each of the command-line parameters 
you can configure for NetWare Management Agent.

Load Parameters for SERVINST.NLM

SERVINST.NLM implements the NetWare Server MIB (NWSERVER.MIB
You can load SERVINST.NLM at the command line with any or all of the 
following parameters: 
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LOAD SERVINST D U= n V B= n H

Load Parameters for HOSTMIB.NLM

HOSTMIB.NLM implements both the standard Host Resources MIB (RF
1514) and the Novell extensions to the Host Resources MIB 
(NWHOSTX.MIB). You can load HOSTMIB.NLM at the command line with
any or all of the following parameters:

LOAD HOSTMIB.NLM D U= n V H

Table 82 Load Parameters for HOSTMIB.NLM

Parameter Description

D DisableSets If this parameter is present, SERVINST.NLM does not allow SNMP SET 
commands for objects in NWSERVER.MIB.

Default: SETS enabled (subject to SNMP security).

U= n UpdateInterval= n Sets the list update interval to n (n is a value in seconds). This determines 
how often certain internal lists kept by SERVINST.NLM (such as volumes 
and queues) are updated.

Set this parameter higher to minimize the number of CPU cycles used by 
SERVINST.NLM. Set it lower to guarantee immediate reporting of server 
status changes that affect the lists.

Default: 300 seconds.

V Verbose Displays informational messages.

Default: Off.

B= n BuildUserListHour= n The local time each day on a 24-hour clock (0 to 23) at which the 
SERVINST.NLM software builds a list of users that have access to the 
server.

Default: 2 (2:00 AM).

H Help Displays help on command-line parameters. If you use the H parameter, 
SERVINST.NLM displays the help messages and then exits. It does not 
remain loaded even if other parameters are entered on the command line.
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Load Parameters for NTREND.NLM

NTREND.NLM implements the Threshold and Trend MIB 
(NWTREND.MIB).

When first loaded, NTREND.NLM automatically sets up trends and 
thresholds for each monitored attribute according to the server’s configura
from values stored in the NTREND.INI file (located in the SYS:\ETC 
directory). 

You can edit this file as described in “Setting Default Trends and Thresholds”
on page 353. Thereafter, as configuration changes occur over time, 
NTREND.NLM adjusts to changes in the number and type of physical 
network interfaces, queues, volumes, and disks. 

Default thresholds are set only for important parameters. You can later u
SNMP SET commands to set thresholds for parameters like file reads an
packets in.

Table 83 Load Parameters for NTREND.NLM

Parameter Description

D DisableSets If this parameter is present, HOSTMIB does not allow SNMP SET commands 
for objects in RFC1514.MIB or NWHOSTX.MIB.

Default: SETS enabled (subject to SNMP security).

U= n UpdateInterval= n Sets the list update interval to n (n is a value in seconds). This determines how 
often certain internal lists kept by HOSTMIB.NLM are updated.

Set this parameter higher to minimize the number of CPU cycles used by 
HOSTMIB.NLM. Set it lower to guarantee immediate reporting of server 
status changes that affect the lists.

Default: 60 seconds.

V Verbose Displays informational messages.

Default: Off.

H Help Displays help for command-line parameters.

Default: Off.
��� LogicSource for ManageWise

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

ing 
m 
f 

r, 
 a 
rded 

le 
A trend file is created for each monitored attribute instance, even if trend
is disabled for that object. The file header contains all the information fro
nwtControlTableEntry, and the rest of the file stores the sample history (i
any). 

After a trend file is created, it exists until deleted explicitly by the operato
even if the monitored object (queue, for example) no longer exists. When
monitored object no longer exists, the associated nwtControlStatus is reco
as invalid.

You can load NTREND.NLM at the command line with any or all of the 
following parameters:

LOAD NTREND D=< dir> R V H

Table 84 NTREND.NLM Command Line Parameters

Load Parameters for FINDNMS.NLM

FINDNMS.NLM discovers workstations running the ManageWise Conso
by first reading the bindery of the server on which FINDNMS.NLM is 

Parameter Description

D= < dir>Directory=< dir> Enables you to specify the volume and directory where NTREND.NLM stores 
the history data files.

Example: To use VOL1: \TEST as the directory for trending files, enter the 
following command:

LOAD NTREND D=VOL1:\TEST

Default: SYS:\NTREND.

R Reset Causes NTREND.NLM to discard all the old trending history data and restart 
the sampling.

V Verbose Displays informational messages.

Default: Off.

H Help Displays help on command-line parameters.

Default: Off.
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installed. FINDNMS.NLM looks for SAP 0x026a, which is broadcast 
periodically by ManageWise. 

FINDNMS.NLM then adds the IPX address of the console to the list of 
stations that want to receive traps. Entries that cease to send SAP packe
removed from the list at an interval set by the aging-period parameter.

Third-party management stations using SNMP over IPX can share this 
mechanism by broadcasting SAP 0x026a periodically, or they can use th
TRAPTARG.CFG method described in “Defining Recipients for SNMP 
Alarms” on page 361. You can load FINDNMS.NLM at the command line 
with any or all of the following parameters:

LOAD FINDNMS U= n A= n H

Table 85 FINDNMS.NLM Command Line Parameters

Confi gurin g NMA to Send Traps to Third-Part y Management 
Consoles

NMA can send traps to SNMP-compliant consoles such as HP Openview
SunNet Manager*, and IBM Netview*.

To configure NMA to send traps to third-party consoles, follow these step

�� Compile NW2SNMP.MIB and NWTRAP.MIB in the third-party 
application.

Parameter Description

U= n UpdateInterval= n Interval, in seconds, between reads of the server’s bindery by 
FINDNMS.NLM.

Default: 300 (5 minutes).

A= n AgingPeriod= n Amount of time, in seconds, to wait before removing stations that have ceased 
to send SAP packets from the table created by FINDNMS.NLM.

Default: 600 (10 minutes).

H Help Displays help for command-line parameters.

Default: Off.
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�� Add the console’s IPX or IP address to the SYS:\ETC\TRAPTARG.CF
file located on each NMA Server from which you want to send traps.

Setting Default Trends and Thresholds

When NTREND.NLM is first loaded, it obtains the initial (default) values fo
trends and thresholds from the NTREND.INI file. This file is stored in the
NetWare server’s SYS:\ETC directory. The initial values in the NTREND.I
file are also used whenever a new trend file is created.

A new trend file is created when an instance of a monitored object (such
volume, disk, or interface object) is discovered on the server.

The following example presents a portion of a sample NTREND.INI file.

Sample NTREND.INI File

#-----------------------------------------------------------------------#
| Sample | Trend | Threshold |
# Parameter | Interval | Buckets Enbl | Rising Falling Enbl Type |
#----------------------------------------------------------------------
NUMBER_
LOGGED_IN_USERS 5 60 1 100 90 1 rising
NUMBER_LOGGED_IN_USERS 7 8928 1 90 81 1 rising
NUMBER_CONNECTIONS 5 60 1 0 0 0 rising
NUMBER_CONNECTIONS 7 8928 1 0 0 0 rising
FILE_READS 5 60 1 0 0 0 rising
FILE_READS 7 8928 1 0 0 0 rising
FILE_WRITES 5 60 1 0 0 0 rising
FILE_WRITES 7 8928 1 0 0 0 rising
FILE_READ_KBYTES 5 60 1 0 0 0 rising
FILE_READ_KBYTES 7 8928 1 0 0 0 rising
FILE_WRITE_KBYTES 5 60 1 0 0 0 rising
FILE_WRITE_KBYTES 7 8928 1 0 0 0 rising
LSL_IN_PACKETS 5 60 1 0 0 0 rising
LSL_IN_PACKETS 7 8928 1 0 0 0 rising
LSL_OUT_PACKETS 5 60 1 0 0 0 rising
LSL_OUT_PACKETS 7 8928 1 0 0 0 rising
NCP_REQUESTS 5 60 1 0 0 0 rising
NCP_REQUESTS 7 8928 1 0 0 0 rising
CPU_UTILIZATION 5 60 1 90 81 1 rising
CPU_UTILIZATION 7 8928 1 80 72 1 rising
CACHE_BUFFERS 5 60 1 45 40 1 falling
CACHE_BUFFERS 7 8928 1 0 0 1 falling
CODE_DATA_MEMORY 5 60 1 0 0 0 rising
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CODE_DATA_MEMORY 7 8928 1 0 0 0 rising

After the NTREND.NLM software is running, trend and threshold values c
be changed (using the ManageWise Console) by making use of the thres
setting features of ManageWise.

If the server is brought down, it retains the last trend and threshold settings
were set. A NetWare server with NetWare Management Agent installed o
returns to the initial values of the NTREND.INI file if one of the following 
situations occurs:

� NTREND.NLM is loaded for the first time.

� NTREND.NLM is loaded with the Reset argument (/R).

� NTREND.NLM is loaded with the Directory argument (/D) if the 
specified directory does not already contain the trend files.

� Trend files have been deleted manually.

� If you change the server configuration by adding a new volume, disk
interface, and so on, the trend value of the new device is set to the de
value.

Trends are not maintained for CD-ROM volumes. Therefore, changing tr
parameters for CD-ROM volumes has no effect. You can edit the 
NTREND.INI file to change the initial trend and threshold values of the 
NTREND.NLM software, as described in the sections that follow.

Specifying the Size of a Trending Sample

By default, NetWare Server Trends are sampled in one-minute increment
change to a larger or smaller sample, simply open the NTREND.INI file a
change the value in the TREND BUCKETS ENBL section to the number
seconds you want to sample. For example, to get a 48-hour sampling, yo
would enter a value of 172,800 (the number of seconds in 48 hours).
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Changing the Initial Trend Values

The trend values in the NTREND.INI file specify the time interval (Sampl
Interval) at which a particular trend parameter is sampled, the duration of 
for which those samples are kept (Trend Buckets), and whether this sam
parameter is enabled (Enbl). 

For each value specified by a line in the NTREND.INI file, a trend record
stored in a separate file in the SYS:\NTREND directory by default.

The following is an example of a line in the NTREND.INI file for the 
NUMBER_LOGGED_IN_USERS trend parameter with a Sample Interval
5, Trend Buckets specified at 60, and the enable parameter specified at 
(enabled).

Sample Trend Values

#-----------------------------------------------------------------------#
| Sample | Trend | Threshold |
# Parameter | Interval | Buckets Enbl | Rising Falling Enbl Type |
#----------------------------------------------------------------------
-NUMBER_
LOGGED_IN_USERS 5 60 1 100 90 1 rising

The sections that follow describe how to set or alter each of the paramet
required for a trend file.

You can specify more than one sampling interval or duration for any tren
parameter by creating another line in the NTREND.INI file.

Setting the Sample Interval

The NTREND.NLM software enables you to collect samples of a specifie
parameter at any of 12 possible time intervals (Sample Interval), from 5 
seconds to 1 day.

Each Sample Interval is specified by a code number in the NTREND.INI f
The table below specifies the code used in the NTREND.INI file for each
the Sample Intervals permitted. For example, if you want to sample a 
particular trend parameter once every hour, you would use the code 9.
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Table 86 Time Interval Code

Settin g the Trend Buckets

Once you have determined a Sample Interval for collecting samples, you m
set a duration of time for which you want to collect samples. For example
you selected a Sample Interval of one hour for a particular parameter, yo
might decide that you want to be able to review the state of that paramete
every hour over the duration of a day.

You determine the duration of time for which a parameter is collected by
number of Trend Buckets you specify. You must specify a Trend Bucket 
each sample that is collected over a specific period of time. For example
review the state every hour for 1 day, 24 Trend Buckets (1 per hour x 24 h
in a day) are required.

After the Sample Interval and the Time Duration for trend collection is se
you can compute the size of trend files. Table 87 lists the number of Trend 

Sample Interval Code

5 seconds 1

10 seconds 2

15 seconds 3

30 seconds 4

1 minute 5

5 minutes 6

15 minutes 7

30 minutes 8

1 hour 9

4 hours 10

8 hours 11

1 day 12
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Buckets possible, and the approximate size in kilobytes (in parentheses),
given Sample Interval and Time Duration.

The size of each Trend Bucket is 4 bytes plus 512 bytes for the header file
example, if the sampling interval is 5 seconds for a period of 1 hour, the 
size would be 720 Trend Buckets x 4 bytes long (rounded to the closest 4
boundary) plus 512 bytes for a total of 4.5 KB. There are always as many t
files (.NT) as there are enabled trends.

Table 87 Trend Buckets Required for Several Possible Durations

Sample Interval 1-Hour 
Duration

1-Day 
Duration

1-Week 
Duration

1-Month 
Duration

3-Month 
Duration

6-Month 
Duration

1-Year 
Duration

5 seconds

 (KB)

720

(4)

17280

(72)

120960

(488)

535680

(2144)

1607040

(6432)

3214080

(12860)

63076400

(252308)

10 seconds

(KB)

360

(4)

8640

(36)

60480

(244)

267840

(1072)

803520

(3216)

1607040

(6432)

3153600

(12616)

15 seconds

 (KB)

240

(4)

5760

(24)

40320

(164)

178560

(716)

535680

(2144)

1071360

(4284)

2102400

(8412)

30 seconds

(KB)

120

(4)

2880

(16)

20160

(84)

89280

(360)

267840

(1072)

535680

(2144)

1051200

(4208)

1 minute

(KB)

60

(4)

1440

(8)

10080

(44)

44640

(180)

133920

(540)

267840

(1072)

525600

(2104)

5 minutes

(KB)

12

(4)

288

(4)

2016

(12)

8928

(40)

26784

(108)

53568

(216)

105120

(424)

15 minutes

(KB)

4

(4)

96

(4)

672

(4)

2976

(16)

8928

(40)

17856

(72)

35040

(144)

30 minutes

(KB)

2

(4)

48

(4)

336

(4)

1488

(8)

4464

(20)

8928

(40)

17520

(72)

1 hour

(KB)

1

(4)

24

(4)

168

(4)

744

(4)

2232

(12)

4464

(20)

8760

(36)
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When a particular time duration is exceeded for a file (all the Trend Buck
have been filled), NTREND.NLM keeps adding the most recent sample b
overwriting the oldest. This means that the file contains the most recent 
duration recorded. 

For example, if you select a Sample Interval of 1 hour for a duration of 2
hours (using 24 Trend Buckets), the associated file contains the trend da
the last 24 hours.

Enabling or Disabling a Trend File

Each line in the NTREND.INI file contains a parameter that either enable
disables the NTREND.NLM software. If NTREND.NLM is enabled, it begin
creating a trend file at startup. 

The total number of trend files is equal to the number of lines in the 
NTREND.INI file. To enable the collection of data for a trend file, set the 
"Enable" column parameter to 1. To disable the collection of data for a tr
file at startup, set this parameter to 0.

Backing Up Trend Data

Trend data is not automatically backed up. If you need to back up this da
you will have to back it up manually.

4 hours

(KB)

6

(4)

42

(4)

186

(4)

558

(4)

1116

(8)

2190

(12)

8 hours

(KB)

3

(4)

21

(4)

93

(4)

279

(4)

558

(4)

1095

(8)

1 day

(KB)

1

(4)

7

(4)

31

(4)

93

(4)

186

(4)

365

(4)

Sample Interval 1-Hour 
Duration

1-Day 
Duration

1-Week 
Duration

1-Month 
Duration

3-Month 
Duration

6-Month 
Duration

1-Year 
Duration
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Changing the Initial Threshold Values

The default threshold values in the NTREND.INI file specify when a trap
generated. User-defined values are stored in the trend file (.NT) header. 
parameter rises above or falls below the set threshold value, a rising or fa
trap type is sent. 

The sections that follow describe how to set or alter each of the paramet
required for a threshold value.

Setting Rising and Falling Thresholds

Each line in the NTREND.INI file contains a parameter for the Rising 
Threshold and the Falling Threshold. For each Sample Interval, a rising 
falling trap can be generated as specified. 

After a trap is generated, another such trap is not generated until the sam
value falls below this threshold and reaches the falling threshold.

In the following example, Trap 1 is generated because it is the first time 
the parameter value rises above the Rising Threshold. The next two time
parameter value rises above the Rising Threshold, a trap is not generate
because the parameter did not fall below the Falling Threshold. Trap 2 a
Trap 3 are generated because the parameter value dropped below the F
Threshold before exceeding the Rising Threshold.

Sample Trend Values

#-----------------------------------------------------------------------#
| Sample | Trend | Threshold |
# Parameter | Interval | Buckets Enbl | Rising Falling Enbl Type |
#----------------------------------------------------------------------
NUMBER_
LOGGED_IN_USERS 5 60 1 100 90 1 rising
Trap 1
generated
Trap 3
generated
Trap not
generated
Trap not
generated
Rising threshold
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Falling threshold
Trap 2
Generated

In this example, a Rising Trap is generated the first time the 
NUMBER_LOGGED_IN_USERS parameter exceeds the Rising Thresho
value of 100. For a second Rising Trap to be generated, the parameter m
fall below the Falling-Threshold of 90, and then exceed the Rising Thresh
of 100 again.

Enabling or Disabling a Threshold Trap

Each line in the NTREND.INI file contains a parameter that enables or 
disables the NTREND.NLM software to send traps as determined by the
Rising and Falling Thresholds. This parameter is set to 1 to enable the 
software to send a trap for the values given, or to 0 to disable the software
sending a trap for this parameter.

Configuring Alarm Severity Levels

You can use the severity keyword to set a minimum alarm severity level so
traps for lesser severity alarms are not sent.

The severity levels you can set in the NWTRAP.CFG file are information
warning, recoverable, critical, and fatal. When you set a severity level of
informational, all traps are forwarded. When you set a severity level of fa
no traps are forwarded because there are no fatal traps in the NWTRAP.
file.

NetWare defines seven severity levels (adding operation aborted and 
unrecoverable). NWTRAP.NLM translates them to the SNMP severity lev
shown in Table 88 on page 360. The table also shows the corresponding 
ManageWise Console severity levels. The default is warning. Under the 
default, all alarms with a severity level of warning or greater are forwarde

Table 88 Comparison of NetWare, SNMP, and ManageWise Severity Levels

NetWare Severity Level SNMP Severity Level ManageWise Console Severity Level

0 - Informational Informational Informational
��� LogicSource for ManageWise

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

rms) 
are 
rms, 

nute) 
 and 
t 

d 
ry 

mber 
efault 
Defining Recipients for SNMP Alarms

You can configure NetWare Management Agent to send SNMP traps (ala
to your ManageWise Console or to other management nodes. The NetW
Management Agent software has two ways to determine where to send ala
which are described in the following sections.

Setting the Time Interval for Alarms

Sometimes an alarm repeats rapidly (several times per second or per mi
with identical or nearly identical parameters. When this occurs, the second
later alarms within a time interval are usually not as interesting as the firs
alarm.

To prevent the network and the management station from being inundate
with identical alarms, you can specify a time interval to be applied to eve
alarm generated by ManageWise. During this interval, alarms that are 
identical to an initial alarm are discarded.

You can define the time interval in the configuration file as follows:

Time Interval

n

The n can be any value between 0 and 232, inclusive, to indicate the nu
of seconds that must elapse before a later alarm is not discarded. The d
time interval is 10 seconds.

1 - Warning Minor Minor

2 - Recoverable Major Major

3 - Critical Critical Critical

4 - Fatal Fatal Critical

5 - Operation Aborted Fatal Critical

6 - Unrecoverable Fatal Critical

NetWare Severity Level SNMP Severity Level ManageWise Console Severity Level
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Controlling Alarm Generation

The NWTRAP.NLM configuration file is NWTRAP.CFG, which is stored in
the SYS:\ETC directory. The configuration file is read only when 
NWTRAP.NLM is loaded; therefore, any changes made to the file do not t
effect until the next time you load NWTRAP.NLM.

On a NetWare 3.1x server, EDIT.NLM does not have a large enough buffe
edit the NWTRAP.CFG file. To edit the NWTRAP.CFG file, map a drive to
the server SYS: volume and proceed from there.

You can use the NWTRAP.NLM configuration file to configure or change a
of the following:

� Types of alarms NWTRAP.NLM forwards to management stations, 
including ManageWise

� Community strings NWTRAP.NLM uses

� Time interval during which NWTRAP.NLM ignores duplicate alarms

� List of traps to be disabled, using the mask keyword

� Minimum severity of alarms NWTRAP.NLM forwards to the 
management station

� Specific alarms that you want to prevent NWTRAP.NLM from 
forwarding

The configuration file consists of keywords and their associated data (ca
ignored). Each keyword must be on a line by itself (except for mask valu
which might span several lines), and must be followed by one or more line
associated data. Keywords are community, time interval, mask, and seve

You can place comments anywhere in the file, even between a keyword 
its associated information. A comment starts with a number sign (#), and
continues to the end of the line.

The following is an example of an NWTRAP.CFG file.

Sample NWTRAP.CFG File
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#
###########################################################
# NWTRAP.CFG
#
# NWTRAP Configuration File
#
# This file specifies information to be used by NWTRAP.NLM.
# The file is read and the parameters set when NWTRAP is loaded.It must
# reside on volume SYS: in the directory SYS:\ETC and must be named
# NWTRAP.CFG to be found by NWTRAP. To change the parameters, first edit
# this file, then unload NWTRAP and load it again. Any changes to this file
# will not take effect until NWTRAP is next loaded. The parameters
# are specified by using a parameter keyword followed by the desired
# parameter value.
#
#########################################################################
Community
Public
Time Interval
10
Severity
Warning
mask
# "Memory: Short term alloc failed"
# 1
# "FileSys: Directory write err (no vol)"
# 2
# "FileSys: File write err, by server (no path)"
# 3
# "FileSys: File write err, by user (no path)"
# 4

Using Masks

You can use the mask keyword to provide a list of traps to be disabled. 
NWTRAP.NLM never forwards the masked traps to the ManageWise 
Console.

You can separate the trap numbers in your list with a comma (,), a space
return (Enter). 

The NWTRAP.CFG file lists each of the traps that can be sent from NetW
Management Agent and its trap number. The trap name is on one line an
trap number is on the following line.
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The following example shows the first three entries of the mask section in
NWTRAP.CFG file:

mask
# "Memory: Short term alloc failed"
#1
# "FileSys: Directory write err (no vol)"
#2
# "FileSys: File write err, by server (no path)"
#3

The default state of the file is for these statements to be disabled by plac
number sign (#) before the statement. In addition, the mask keyword is n
disabled initially because trap 46, Router configuration error # 1, is mask
out by default.

To enable a particular trap, locate it in the NWTRAP.CFG file and remove
number sign preceding the trap number.

If you do not want to mask any traps, be sure that the mask keyword is disa
to avoid generating an NWTRAP.CFG parse error.

The default is to not disable any specific trap. All traps are sent, except th
filtered by the configured severity level.

Editing the TRAPTARG.CFG File Manually

In addition to being discovered automatically, trap recipients can be adde
manually to a NetWare server using NetWare Management Agent. This i
useful for having traps sent to network management consoles other than
ManageWise, for working with networks where SAP filtering makes 
automatic discovery impossible, and for receiving traps on networks othe
than IPX networks.

You must add trap recipients manually by specifying their addresses in th
TRAPTARG.CFG file, which is located in the SYS:\ETC directory of each
NetWare server.

The TRAPTARG.CFG file defines the recipients of SNMP traps. You can 
this file to define recipients of SNMP traps over IPX and over UDP/IP. Th
file is fully disabled to show you how to divide the file into IPX and UDP/I
sections and how to write the IPX and IP addresses of recipients.
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The TRAPTARG.CFG file is read only when SNMP is loaded. In most cas
this means bringing the server down and restarting it because a variety o
modules must be unloaded and reloaded as well. Thus, any changes ma
the TRAPTARG.CFG file do not take effect until the next time you load 
NWTRAP.NLM.

If you are sending traps to third-party management stations, you might n
to integrate the NetWare Server trap MIB into those management stations
MIB can be found in the NWALARM.MIB file on the NetWare Managemen
Agent diskette.

The NWALARM.MIB file imports symbols from the Host Resources MIB 
(RFC1514.MIB), which is also on the NetWare Management Agent diske

Consult your management station documentation for further information 
about integrating the trap MIB.

SAP Filtering Tips

This section lists each SAP that ManageWise uses and provides tips for
filtering each type.

0x0004: NetWare File Servers

Explanation: This SAP is used by the NXPIPX.NLM on the NetExplorer 
server. NXPIPX.NLM scans the local bindery (the bindery on the server 
which it is installed) in order to identify servers. After information about ea
server is gathered, NXPIPX scans the binderies of these servers to find 
about more servers. This process is repeated.

Filtering Tips: The NetExplorer server has to be able to see at least one s
at each remote site in order to discover other servers at the remote sites

0x0007 and 0x0047: Print Servers

Explanation: This SAP is needed to identify Print Servers and Print Queu
that can be managed.
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LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

 this 
 

d 

er 

 live 

 this 
 

 

y 
 can 

.

AN 

l be 
Filtering Tips: As long as every remote site has a ManageWise Console,
SAP can be filtered without loss of functionality. Filtering this SAP would
eliminate any central administration of printing.

Central Administration: Enable outbound SAPs from all remote sites, an
disable inbound SAPs for all but your Central Administration site.

0x0233: NetWare Management Agent (ManageWise)

Explanation: This SAP is used by NXPIPX.NLM on the NetExplorer serv
to identify which servers are manageable. This SAP is also used by the 
ManageWise console to identify which servers are manageable, but as a
read from a NetWare server of what is currently running.

Filtering Tips: As long a ManageWise Console exists at every remote site,
SAP can be filtered without loss of functionality. Filtering this SAP would
eliminate any central administration of NetWare servers.

Central Administration: Enable outbound SAP from all remote sites, and
disable inbound SAP for all but your Central Administration site.

0x0237: NetExplorer Server

Explanation: This SAP is used by any NXPIPX to identify a NetExplorer 
server. This information is used by the ManageWise installation to identif
which servers the ManageWise Console, through NetExplorer Manager,
download discovered information from. 

This SAP can also affect what additional icon information is shown in a 
segment map. A server with NetWare Management Agent loaded has a 
slightly different icon than a server with the NetExplorer software loaded

Filtering Tips: As long as the NetExplorer server and the ManageWise 
Console are at the same site, this SAP should be filtered from outbound W
traffic.

Central Administration: Even if ManageWise Consoles are gathering 
information from NetExplorer servers at remote sites, this SAP should stil
filtered from outbound WAN traffic.
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� Third-Party Tools

In addition to integrated ManageWise® Agents such as the NetWare 
Management AgentTM  and NetWareTM  LANalyzer® Agent, you may want to 
use third-party applications to enhance functionality or add managing 
capabilities to ManageWise.

This section contains a brief overview of the process for integrating vario
third-party applications and integrated agents. It also includes a list of W
sites you can visit for more information about selected third-party tools.

Small-to-Medium Network Scenario

A typical small-to-medium network might include several file servers, prin
servers, and up to 200 clients. Enhancements that may be useful in this 
environment include those that enable you to do the following:

� Monitor disk, volume, and memory usage.

� Monitor print status.

� Set and monitor alarm thresholds on critical server parameters.

� Acquire detailed performance statistics and trends for traffic on a 
segment.

� Detect network overload, excessive errors, and stations with duplica
IPTM  addresses.

� Receive remote notification of network alarms via an alphanumeric pa
or electronic mailbox.
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� Monitor the status of and troubleshoot client workstations remotely.

In a small-to-medium network, you should install any snap-ins on the 
ManageWise Server (not on a NetWare server).

Medium-to-Large Network Scenario

A typical medium-to-large network might include a dozen file servers; ma
hubs, routers, and print servers; and 500 or more clients. Useful enhancem
in this environment include all the functionality listed for a small-to-mediu
network, plus the ability to do the following:

� View predictive analysis and be alerted to specific issues or impendi
problems.

� Enable automatic corrective action before failures occur.

� Plan ahead to avert network problems, instead of reacting to unplan
down time.

In a medium-to-large network, you can install third-party applications on 
NetWare servers, including server hubs (as long as the NetWare Hub 
ServicesTM  software is also installed on that server).

Third-Party Application Information Log

You may want to keep a record of information about your third-party 
applications to use in troubleshooting any problems that occur. Informati
that you should record varies according to the product. The following are
examples of information you might want to record:

� SNMPTM  addresses and masks for each third-party device (UPC syste
hubs, and so on).

� SNMP community strings (monitor, control, trap settings) defined for
management access and security for each network device.

� Names and copies of MIB files added to ManageWise.
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� Telephone number, e-mail address, and so on of the network 
administrator contact.

� Software version of products added to ManageWise and where the f
were installed. Some third-party products add an install log during 
installation that saves this type of information.

� Contacts and technical support numbers for each product.

� Whether an asynchronous terminal is required to configure the devic
(hubs and power management systems, for example).

Preparing to Install Third-Party Software

Novell recommends that you install any third-party applications and 
integrated agents after you install ManageWise. 

Following are several tasks to complete before you install any third-party
applications or integrated agents:

1. Log third-party information. See “Third-Party Application Information 
Log” on page 368.

2. Back up the NMS.INI, WINDOWS.INI, and SYSTEM.INI files.

3. Back up the ManageWise database if you are concerned about 
maintaining network topology information. This can be done using th
Database Administration Tool.

4. Review your third-party application documentation for more detailed
information before installing and integrating the application.

5. Verify that you have enough disk space to run the third-party produc

Third-Party Installation Notes

The following notes may be helpful if you are unfamiliar with a third-party
product or if you experience a problem. If you cannot solve your problem, 
the third-party technical support.
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� When installing the third-party product, ensure that you install to 
\MW\NMS. Some third-party products install to \NMS, which is not 
valid.

� Most third-party products provide initialization documentation. Some
vendors add a Windows program group and icon for user selection a
execution. Other vendors hook directly to ManageWise and add selec
items to the ManageWise drop-down menus.

� Verify that the third-party product is initialized during ManageWise 
startup and that the product can be started via icon selection or 
ManageWise launch.

� For devices that have an SNMP address, ping the device from the 
ManageWise Console to verify the network communication path. If y
do not receive a response, you might have one of the following proble

� The device is not configured correctly for IP ping.

� The device is not attached to the ManageWise local segment.

� The router might not forward the IP ping request.

� The SNMP monitor, control, or trap settings do not match the 
ManageWise settings. When the IP ping is sent, the device does
respond.

� Some products automatically install MIB information that translates 
SNMP trap messages they send. This MIB information should be ad
to the ManageWise MIB collection using the MIB Compiler.

� If you are viewing the internetwork map and cannot find an icon for a
third-party product that should be there, the product probably impleme
its own discovery process. Refer to the product documentation for m
information.

Migrating Previously Installed Third-Party Software

If you are upgrading ManageWise and have third-party applications insta
you might need to compare the backup NMS.INI file with the new NMS.I
file to see whether any entries affecting previously installed software we
changed.
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Online Information

You can read more about integrating third-party applications with 
ManageWise by visiting the following Web sites.

� A detailed list of third-party products that have been tested and appro
for use with ManageWise, including links to manufacturers’ pages:

http://developer.novell.com/devsrch/
kscgi.nlm?collection=yesno&resulttemplate=yesno.htm&query/
summary=novellproduct+%22managewise+(v2.5)%22

� Information about integrating additional alarms, sample locations for
third-party MIBs, and SNMP mail:

http://www.novell.com/products/managewise/mwalert.html

� White papers about implementing ManageWise in an enterprise 
environment:

http://consulting.novell.com/toolkit/mw_docs.html
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� Novell Integration

ManageWise® integrates seamlessly with a variety of other Novell® 
applications, letting you custom design your ideal network management 
system. This section contains information about the following:

“ManageWise and ZENworks” on page 373

“ManageWise and GroupWise” on page 376

“ManageWise and NDSTRAP.NLM” on page 380

ManageWise and ZENworks

ManageWise integrates completely with Novell ZENworksTM , letting you 
manage your entire network from a single workstation. You can impleme
ZENworks and ManageWise on a network with a Novell NetWare® 4.11 (or 
higher) server and Windows NT*, Windows 95/98*, or Windows 3.1x* 
clients.

The following table summarizes the functions of ManageWise and 
ZENworks.

Table 89 ManageWise and ZENworks Functions

ManageWise ZENworks

NetWare and Windows NT server management Customized software distribution

Desktop management Directory-enabled desktop management
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Remote Control Using ManageWise and ZENworks 1.0

The initial release of ZENworks uses a version of WUSER.EXE for remo
control that is not compatible with the ManageWise Remote Control Age
(also called WUSER.EXE). When both applications are installed on the s
console, the most recently installed version of the file will determine whic
Remote Control Agent is used. Simply reinstalling ManageWise or 
ZENworks clients will not restore the proper Remote Control Agents in a
cases.

This section provides the steps you should follow to restore the Remote 
Control Agent you want to use.

NOTE: The information in this section applies only to ZENworks 1.0. Later 
versions use ZENRC32.EXE for remote control.

Changing from ManageWise to ZENworks Remote Control

If you installed ManageWise after ZENworks and you want to go back to
using ZENworks remote control, follow the steps below for the platform y
are using.

Windows 3.x

�� Reinstall the ZENworks client to remove the LOAD=WUSER.EXE fro
the WIN.INI.

�� Enable the NAL Remote16 Application object and set it to force run 
least once) to reinstall the ZENworks remote control files.

NDS® monitoring Intelligent desktop maintenance

Early-warning alarm notification Customized desktops

Network traffic analysis NetWare 5 pure IPTM  support

Network health reporting Self-healing applications

Virus protection

Network inventorying

ManageWise ZENworks
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If you prefer not to reinstall the client, you can instead comment out 
LOAD=WUSER.EXE in the WIN.INI file in the Windows* directory. Then 
run the ZENworks WUSER.EXE from the server.

Either option will allow the ZENworks WUSER.EXE to run.

Windows 95

Choose only one of the following options:

� Reinstall the ZENworks client, select custom install, and then select 
remote control option. This will remove the LOAD=WUSER.EXE from
the WIN.INI.

�  If you prefer not to reinstall the client, you can edit the WIN.INI file an
comment out the LOAD=WUSER.EXE.

Windows NT

Rerun NTSTACFG in the SYS:PUBLIC directory of the server ZENworks
was installed on. You can run it from NAL or run it manually at each 
workstation.

Changing from ZENworks to ManageWise Remote Control

If you installed ZENworks after ManageWise and you want to go back to
using ManageWise remote control, follow the steps below for the platform
you are using.

Windows 3.x and Windows 95

Edit the WIN.INI in the Windows directory and add LOAD=WUSER.EXE
(the ManageWise installation does not do this automatically).

NOTE: This WIN.INI modification can be automated using NAL or 
ZENworks.

Windows NT

Rerun NTSTACFG from the SYS:MW\LDT directory on the server that 
ManageWise was installed on. You can run it from NAL or run it manually
each workstation.
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ManageWise and GroupWise

You can use ManageWise to manage the GroupWise® infrastructure. The 
instructions in this section assume you have already done the following:

1. Installed ManageWise on the network

2. Loaded ManageWise NetExplorerTM  Agents

3. Installed one or more ManageWise Consoles on the network, with b
IPXTM  and TCP/IP protocols installed on each console

One of these ManageWise Consoles can be dedicated to supporting the
GroupWise Support group within the organization. This console (called M
GW_Console) is then used to gather all alerts from the various GroupWi
servers.

Each GroupWise Post Office server should have a ManageWise Manage
Agent loaded. If a remote site combines File and Print and GroupWise P
Office functions on one server, that server should have the full NetWare 
Management AgentTM  loaded. 

If the remote site has a dedicated GroupWise Post Office server, that dedi
server should only have the ManageWise NetWare Management Agent a
the Virus Protection Agent loaded. 

Other servers in that location can host Inventory and LANalyzer functiona
The ManageWise installation process lets you easily determine which 
components to install on a given server.

GroupWise Server Types

Depending on the size of an office and the number of users at that site, a
GroupWise server will be either dedicated or nondedicated. A dedicated
server will have only GroupWise running on it, whereas a nondedicated se
might also be used for file and print services.

Dedicated GroupWise Post Office Servers

To set up a GroupWise server with only ManageWise Server and Virus 
Protection agents, follow these steps:
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��  Load GroupWise on a designated server.

�� Use ManageWise Install to install the ManageWise NetWare 
Management Agent on the GroupWise server.

�� Install ManageWise Virus Protection Agent on the GroupWise server

�� In SYS:ETC\TRAPTARG.CFG, define the Target IP Address of the M
GW-Console to which SNMP traps will be sent.

�� Edit SYS:\SYSTEM\AUTOEXEC.NCF on the GroupWise server to 
ensure that the ManageWise Agent and Virus Protection are loaded 
(uncomment the NMA2.NCF and LOAD LPROTECT lines).

Nondedicated GroupWise Post Office Servers

To set up a NetWare server that is also hosting a GroupWise Post Office
follow these steps:

�� Load GroupWise on the server.

�� Install the complete NetWare Management Agent on the GroupWise
server.

�� Edit SYS:ETC\TRAPTARG.CFG to define the Target IP Address of t
MW-GW-Console to which SNMP traps will be sent.

�� Edit SYS:\SYSTEM\AUTOEXEC.NCF to ensure that the ManageWis
Agent, LANalyzer Agent, Inventory Agent, and Virus Protection Agen
are loaded (uncomment the NMA2.NCF, LANZ.NCF, LOAD LDINV, 
and LOAD LPROTECT lines).

ManageWise Consoles: Compiling the GroupWise MIBs

To access and manage alerts from GroupWise servers, follow these step

�� Copy the C:\MW\NMS\SNMPMIBS\ALLMIBS\NOVELL\ 
GRPWISE\WP.MIB file to the C:\MW\NMS\SNMPMIBS\CURRENT 
directory.

�� Load the ManageWise Console. 
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From the Tools menu, run MIB Compiler.

This compiles all the MIBs that are in the 
C:\MW\NMS\SNMPMIBS\CURRENT directory.

ManageWise Forwarding Console

In a large network, you should use a ManageWise Console to consolidat
traps emanating from all servers. An IP address should be selected for t
ManageWise Console. This console will be known as the MW-FWD-Cons
The MW-FWD-Console's IP address should be defined in each server's 
SYS:\ETC\TRAPTARG.CFG file.

ManageWise GroupWise Console

In a large network, it is essential to establish a proper strategy to manag
GroupWise infrastructure. Novell recommends that you dedicate a 
ManageWise Console to recording traps from GroupWise servers. 

The MW-GW-Console could then be used only for storing traps and 
forwarding them to the GroupWise support staff's workstations. The 
GroupWise Support staff could run ManageWise on their workstations to
problems with the GroupWise infrastructure.

Follow these steps:

�� Make sure the ManageWise Console software is loaded on the MW-G
Console.

�� Make sure the AlertPage* software is loaded on the MW-GW-Conso
for forwarding alarms to the GroupWise support team's workstations

�� Copy the C:\MW\NMS\SNMPMIBS\ALLMIBS\NOVELL\ 
GRPWISE\WP.MIB file to C:\MW\NMS\SNMPMIBS\CURRENT on 
all workstations, including the MW-GW-Console workstation.

�� On all workstations, run the ManageWise Console software. Then, fr
the Tools menu, run MIB Compile. This compiles all the MIBs in the 
C:\MW\NMS\SNMPMIBS\CURRENT directory.
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�� Load and configure the AlertPage software to forward all GroupWise
SNMP traps from the MW-GW-Console to ManageWise Consoles in 
GroupWise Support Center.

�� Set the MW-FWD-Console’s AlertPage software to forward all 
GroupWise traps to the MW-GW-Console.

Network Discovery Information

You can configure the discovery process to limit the discovery visibility in
network. This is called scoping. You can also exclude workstations from be
discovered. To eliminate workstation discovery, create the 
SYS:NMDISK\NXPIPX.INI file. The file must contain a single line:

gAutoDiscovery=3 

NOTE: This line excludes workstations only. To exclude workstations and 
routers, and to discover only file servers, change the value to 2.

Setting Up ManageWise NetExplorer for a GroupWise Environment

A ManageWise NetExplorer server that is physically close to the GroupW
Support group should be set up to exclude workstations from discovery. 
should also be able to discover the entire network so it can “see” all 
GroupWise servers. (The inventory agent is used to support remote 
GroupWise users when they are having problems running GroupWise.) 

For convenience, this server is called GW-NXP-SERVER. It should have
the ManageWise Server Agent processes loaded. 

Ideally, in a large site a NetWare server should be dedicated to the Group
Support group, so that the group members can use it for storing and test
GroupWise software and support activities. 

If this server is used as the GW-NXP-SERVER, it should have the 
ManageWise NetExplorer software modules and the complete ManageW
Server Agent loaded.
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Using the NetExplorer Console, NXPCON.NLM, the NetExplorer server c
be set to target only the internal IPX addresses of the GroupWise servers 
network. 

If you only want to use TCP/IP, you might need to put in the IP addresse
routers in the network as well. Otherwise, the discovery process might b
adversely affected.

To eliminate workstation discovery at this NetExplorer server, follow thes
steps:

�� Create a SYS:NMDISK\NXPIPX.INI file containing a single line:

gAutoDiscover=3

�� Ensure that the ManageWise Inventory Agent is running on this 
NetExplorer server.

If it is not running, add the LOAD LDINV line to the SYS:SYSTEM\ 
AUTOEXEC.NCF file.

If the ManageWise agent has been loaded via the ManageWise Inst
program, the above line will already be in the AUTOEXEC.NCF file. Yo
only need to remove the comment symbol from the beginning of the 
#LOAD LDINV line.

Providing Support to Remote Workstations Running GroupWise 

Follow these steps:

�� Run ManageWise.

�� From the Tools menu, select Desktop Manager.

�� Select the desired workstation; then double-click the object to initiate
remote control of the workstation.

ManageWise and NDSTRAP.NLM

NDSTRAP.NLM implements the Novell Directory Services (NDS)Trap 
Management Information Base (MIB), a Novell proprietary MIB designed
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capture NDS events and forward them to SNMP management consoles 
SNMP traps. NDSTRAP.NLM is installed on every ManageWise Server.

The NDS Trap MIB contains at least 130 traps and new ones are being a
as they are identified. To get the most recent information, visit http://
support.novell.com/etc.
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Glossary

Acknowledge alarms
An action taken to indicate you have seen an alarm. Acknowledged alarm
appear with a check mark on the alarm report. When all alarms logged ag
a station are acknowledged, the alarm indicator on the map (the bell icon
disappears.

Adapter
Hardware, typically an interface card, installed in a computer, that conne
the computer to other hardware or devices.

Address
Identifier assigned to networks, stations, and other devices so that each d
can be separately designated to receive and reply to messages.

Advertising
Process by which services on a network inform other devices on the netw
of their existence. NetWare® uses the Service Advertising Protocol (SAP) t
do this.

Agent
A piece of software on a networked system that prepares and accumula
information and communicates on behalf of a software entity. 

ManageWise® supplies the following agents: NetWare Management AgentTM , 
NetWare LANalyzer® Agent, and NetWare Hub ServicesTM . Third-party agent 
software can also be written for ManageWise.

Alarm
A notification of a network event or condition, such as a server overload 
router that is not responding. Some alarms occur automatically for a partic
device. Others are based on configuration of thresholds. 
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See also “Alarm threshold” on page 384.

Alarm delta
The amount by which performance must fall below or rise above the alar
threshold before crossing the threshold again can trigger an alarm. Settin
alarm delta prevents repeated alarms when values fluctuate near a thres

Alarm disposition
The actions taken by ManageWise when an alarm of a certain type is rece
such as logging the alarm in the database or calling your beeper. You ca
alarm dispositions by selecting Fault > Alarm Disposition.

Alarm family
A grouping of alarm types. For example, SNMP* alarms are an alarm fam

Alarm Manager
The ManageWise component that receives alarms from the data acquisi
modules, applies the appropriate alarm disposition, and passes the alarm
the Alarm Monitor and Alarm Report for display.

Alarm Monitor
The ManageWise component that provides a real-time display of all alar
whether or not they are logged in the database.

Alarm Report
The ManageWise component that displays all alarms that have been logg
the database (as specified by the alarm disposition). New alarms are add
the display as they are written to the database. The Alarm Report also en
you to delete and acknowledge alarms, add comments to alarms, and di
only alarms for selected devices.

Alarm threshold 
A preset value that, when met or exceeded, triggers an alarm.

Alignment error
An Ethernet error indicating that a packet was received that subsequentl
could not be framed properly. Therefore, the contents of the packet could
be interpreted properly and were rejected. These malformed packets mig
the result of collisions, noise, or hardware failures. See also “Ethernet” on 
page 388 and “Frame” on page 389.
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Anchor
The object displayed in the upper-left corner of a ManageWise map. All 
network interconnection is shown as starting from that object. ManageW
lets you change the anchor using a button on the action bar.

Application Programming Interface (API)
A specification of input and results that can be used to develop software
accesses the capabilities of another application (such as ManageWise).

Autopartition
A mechanism by which a hub isolates a malfunctioning station or segmen
the network from other, properly functioning, segments of the network. A
station or segment is partitioned automatically if it is the source of a large
number of consecutive collisions or is the source of abnormally long 
collisions. The segment remains partitioned as long as the condition per

Baseline
A snapshot of your network providing an example of network state, and 
including such factors as bandwidth usage and error rates. A series of 
baselines can be taken periodically and used to track network changes.

Block
A set of continuous bits or bytes that make up a definable quantity of 
information, such as a message.

Bridge
A device that connects two or more physical networks, forwarding frame
between networks based on information in the data-link header. Becaus
operates at the data-link layer, it is transparent to the Network-layer proto

Broadcast
(noun) Packet delivery service in which all hosts on a network receive a c
of any frame that is designated for broadcast. (verb) Sending the messa
all nodes.

Btrieve
The database record manager used by ManageWise.

Buffer
Memory area or electronic register where data is stored temporarily whil
awaiting disposition. It compensates for differences in data flow rates (fo
example, between a terminal and its transmission line). 
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Also used as a data backup mechanism, holding data that might be 
retransmitted if an error is detected during transmission.

Byte
A group of eight consecutive binary digits (bits) operated on as a unit. Al
frames consist of an integer number of byes. 

See also “Frame” on page 389.

Cache
A high-speed memory section that holds blocks of data that the CPU is 
currently working on; designed to minimize the time the CPU spends 
accessing memory.

Capture filter
A mechanism that enables you to define specific types of packets to cap
rather than capturing all packets. NetWare LANalyzer Agent captures only
specified types of packets on the segment where it resides. 

Compare “Display filter” on page 388.

Checksum
Numerical computation that combines the bits of a transmitted message;
the resulting value of that computation. The value is transmitted with the
message; the receiver recalculates the checksum and compares it with t
received value to detect transmission errors. 

See also “CRC (Cyclic Redundancy Check) errors” on page 387.

Circuit
Any path that can carry an electrical current.

Client
A node or workstation on a network that requires services from a server.

Client-server model
A type of configuration that uses distributed intelligence to treat both the
server and the individual workstations as intelligent, programmable devic

Collision
An event (which is normal on any Ethernet network) that occurs when two
more nodes attempt to transmit simultaneously. Subsequent retransmiss
are generally successful due to special algorithms implemented in every
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network controller that minimize the chance of consecutive collisions 
occurring.

A large number of collisions usually indicates a high load on the network,
can also be caused by a network adapter board failure.

Connectivity test
A verification of the connection between the ManageWise Console and a
target station, using either an IPXTM  echo packet or an ICMP echo test pack

Contention
A process that occurs when processors want to use the same communic
lines. Each processor must send a request to transmit; if the channel is b
the processor must wait.

CRC (Cyclic Redundancy Check) errors
An error-checking procedure using a predefined mathematical divisor to 
check the integrity of a transmitted block.

Custom map
A custom map is a set of logically connected files that have a common ac
The term may also refer collectively to all data entities that exist for seve
related systems. A database can have several data items that can be ass
into many different record types.

Data rate mismatch
An Ethernet error that indicates a significant difference in frequency betw
the clocks in the sending and receiving stations. A port reporting a data r
mismatch is usually connected to a faulty station.

If all (or a number of) ports report a data rate mismatch, the hub network
controller contains a faulty clock source.

Database
A set of logically connected files that have a common access. All data ent
that exist for several related systems. A database can have several data
that can be assembled into many different record types.

Discovery
The process of identifying internetwork topology and devices and storing
information in the ManageWise database, which the ManageWise Conso
uses to create maps. Discovery is done by the NetExplorer system.
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Display filter
A mechanism that enables you to define a subset of the packets that have
placed in the buffer that you want ManageWise to display, rather than 
displaying all captured packets. 

See also “Capture filter” on page 386.

Distributed processing
A technique that enables multiple computers to cooperate in completing ta
typically in a networked environment.

Domain
On the Internet, a part of a naming hierarchy. Syntactically, an Internet dom
name consists of a sequence of names separated by periods. In OSI, it i
generally used as an administrative partition of a complex distributed sys

Encapsulation
A technique used by Network-layer protocols in which a layer adds head
information to the protocol data unit from the preceding layer. Also used 
enveloping one protocol inside another for transmission (for example, IP
inside IPX).

Error detection
The process of determining whether one or more bits have changed from 
to a zero, or the reverse, during transmission.

Ethernet
A type of LAN that uses a bus topology and that accesses the media usi
Carrier Sense Multiple Access with Collision Detection (CSMA/CD).

Event
A network message that indicates operational irregularities in the physic
elements of a network, or a response to the occurrence of a significant ta

FCS
See “Frame Check Sequence (FCS)” on page 389.

File server
Shared storage device for LAN users, typically in the form of a personal 
computer that has a high-volume disk and is attached to the network. 

See also “Server” on page 401.
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Filter
A mechanism that can be used to instruct NetWare LANalyzer Agent to 
capture only specific types of packets (a capture filter) or to limit ManageW
to display only a subset of the packets captured (a display filter). For exam
you can capture or display only packets coming from a certain address. 

See also “Capture filter” on page 386 and “Display filter” on page 388.

Fragment
An Ethernet packet that contains fewer than 64 bytes and has a faulty Fr
Check Sequence (FCS). A fragment is typically the result of a collision.

Frame
A packet data format for a given media. Some media support multiple pa
formats (frames) such as Ethernet 802.2, Ethernet 802.3, Ethernet II, Eth
SNAP, Token-Ring, or Token-Ring SNAP.

Frame Check Sequence (FCS)
An error that occurs when a packet is involved in a collision, when it has b
corrupted by noise, or when an error in the sending network controller oc

Frame Check Sequence (FCS) error
An error that occurs when a packet is involved in a collision, when it has b
corrupted by noise, or when an error in the sending network controller oc

Frames too long
A condition that occurs when frames are longer than 1518 bytes, the 
maximum length of a well-formed Ethernet frame.

Gauge
A graphic display of the values of selected variables. Bar graph gauges s
the current value, the high value, the maximum possible value, and the a
trigger value of the variable. You can change the alarm-trigger value.

Graph
A graphic display of trends or changes in data over time.

Graph scaling
A feature of ManageWise graphs that enables you to scale the graph valu
they are displayed in a certain range.

Hardware address
An address that is preprogrammed on a network interface card. 
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See also “Physical address” on page 398.

Header
The information at the beginning of a packet that defines control informati
including addressing and control.

Historic data
The information about the prior state of a network segment or device, oft
stored in a file.

Hot fix area
A portion of the server hard disk to which NetWare redirects faulty data 
blocks. NetWare uses this method to ensure that data is stored safely.

Hub
A collection of one or more hub cards (also known as groups) that logica
form a single multiport repeater.

Hub card
A collection of ports. In a hub, typically a PC adapter board that supports
number of 10BASE-T connections. (The terms hub card and group are 
sometimes used interchangeably, but the ManageWise product and man
use the term card.)

Hub Management Interface (HMI) specification
A definition, developed by Novell, of how hub management functions are
integrated into the Open Data-Link Interface (ODITM) model. The HMITM  
specification enables drivers to manage hubs resident in or external to a s

INETCFG
A NetWare Loadable ModuleTM  (NLMTM) that simplifies the installation of 
Novell internetworking products by enabling a network administrator to 
configure boards and enable parameters from a menu.

Internet
A collection of networks and gateways that use the TCP/IP suite of protoc
In lowercase, it is sometimes used as an abbreviation for internetwork.

Internet address
A 32-bit address assigned to hosts using TCP/IP.
��� LogicSource for ManageWise

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

n a 

 

s 

 

es 
nd so 

 is 

lel 

e on 
IP (Internet Protocol)
An industry-standard networking protocol that enables dissimilar nodes i
heterogeneous environment to communicate with one another.

IPX (Internetwork Packet eXchange)
A NetWare protocol, similar to the Xerox® Network Systems (XNS) protocol,
that provides datagram delivery of messages.

Jabber
A fault condition resulting from a network adapter that is stuck “on” and i
transmitting packets continuously.

LAN
See “Local Area Network (LAN)” on page 391.

Late event
An Ethernet collision that occurs later in the transmission than should be
possible, if the basic networking rules (protocols) are followed. Because 
stations listen for traffic before transmitting, collisions should occur only 
when two or more stations transmit nearly simultaneously, resulting in a 
collision early in the transmission.

A late collision indicates a faulty network controller or a violation of the rul
of topology: network too big, too many repeaters connected in a series, a
forth.

Link state
An indicator of the health status of a 10BASE-T twisted-pair link. If a link
disconnected, turned off, or broken, the link state indicates “link down.”

Load balancing
A scheme for distributing network traffic among parallel paths, providing 
redundancy while efficiently using the available bandwidth.

Load sharing
The ability of two or more remote bridges to share their traffic load in a 
parallel configuration; if one bridge fails, traffic is routed to the next paral
bridge.

Local Area Network (LAN)
A group of computers and other devices that are connected by a 
communications link that enables a device to interact with any other devic
the network.
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Logical network map
A graphical representation of your network resources that shows connect
but does not indicate the physical location of the devices. 

The ManageWise internetwork map is a logical network map because it sh
how network segments are interconnected but does not show where tho
segments are physically located. 

See also “Segment map” on page 401.

MAU
In IBM* token ring networks, a multistation access unit. In IEEE 802.3 
networks, a media attachment unit, which performs the physical layer 
functions of the Open Systems Interconnection (OSI) model.

Managed object
A device that is connected to a network and can be managed by network
management software or a protocol such as SNMP.

Managed server
Any server running the NetWare Management Agent software (a set of N
files), which enables it to be monitored and managed remotely from the 
ManageWise Console. The NetWare Management Agent software provid
dynamic performance data about managed servers to the ManageWise 
Console.

ManageWise
The system of Novell and third-party applications that share the platform
graphical user interface, database, and operating environment to discov
monitor, and manage devices on an Ethernet or token ring network runnin
or IPX protocols. Also the system of applications can monitor and manag
NetWare servers, hubs, routers, workstations, and segment-level operat

ManageWise Console
The component of ManageWise used by a network administrator to inter
with the network. The ManageWise Console software includes the 
ManageWise graphical user interface, database, alarm subsystem, and 
NetExplorer manager. 

The ManageWise Console communicates with agents over the LAN usin
SNMP. It collects data on the behavior of the devices on the network. You 
use the ManageWise Console to display, review, or acknowledge the da
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The term also applies to the workstation on which the ManageWise Con
software is installed.

ManageWise database
A set of Btrieve* files in which the ManageWise Console stores data abou
discovered network topology, physical location of nodes, configuration, ala
notification, and alarm disposition.

ManageWise Server
A NetWare server running, at a minimum, NetWare Management Agent 
MWISE.NLM. A ManageWise server can also run NetWare LANalyzer 
Agent, the Desktop Management Tools, Virus Protect software, NetWare 
Services software, and NetExplorer software. 

A ManageWise server running NetExplorer software is referred to as a 
NetExplorer Server. 

See also “Managed server” on page 392.

MIB (Management Information Base)
A hierarchical database that stores management information for a netwo
entity such as a router file, server, or segment.

MIB Browser
A ManageWise facility that provides SNMP access to any MIB over IP or
IPX, giving you the ability to retrieve data from any SNMP device or to se
values on any SNMP device.

MIB Compiler
The software that compiles the concise MIB files into a binary file that is u
by the MIB Browser.

MJLP (MAU jabber lockup protection)
A type of protection against jabber lockup in a transceiver or multistation
access unit (MAU). Jabber lockup is an error state caused by an excess
long transmission repeated by a connected repeater. 

This feature is provided in Ethernet transceivers to prevent a jabbering ad
from disabling use of the network. Because it might be difficult to reset a
MAU that is attached to or embedded in a repeater, repeaters disable th
transmission of a jabbering port to prevent the attached MAU from enter
jabber lockup. 

See also “Jabber” on page 391.
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MPR
See “MultiProtocol Router (MPR)” on page 394.

Multiport repeater
See “Repeater” on page 400.

MultiProtocol Router (MPR)
A router that can forward packets for multiple Network-layer protocols ov
independent networks.

Name resolution
The ability to associate a name that the network administrator has assign
with its network location.

Name server
A server on the network that maps network names to network locations.

Navigator
A ManageWise feature that helps you move through a large internetwork 
to pinpoint your specific areas of interest.

NetBIOS
Network Basic Input/Output System. Application program interface that i
typically used on LANs comprising IBM and compatible microcomputers
Separates application programs from the networking subsystem, so that
application program implementers can support multiple network designs,
a network system can support independently developed applications.

NETXPLOR.DAT
The sequential record file in which discovery data is stored temporarily on
NetExplorer Server. 

This file is usually open and should be excluded from server backups. 
Whenever NETXPLOR.NLM is unloaded, it writes over the existing file 
when it is loaded again. 

By default, ManageWise does not back up the file, but you can enable bac
by specifying the value of a parameter in the NETXPLOR.NCF file on the
NetExplorer Server.
��� LogicSource for ManageWise

LogicSource for ManageWise
Place Part Number Here

August 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 13 August 99

LM) 

the 
tion 

 the 

ents 
, 

e is 

ata 

rer 

tly 
ocol 

 
tive 
xt 
arm 
NetExplorer
A term often used to refer indiscriminately to all the network discovery 
components that reside on a ManageWise server (such as NETXPLOR.N
and the ManageWise Console (such as NetExplorer Manager software).

See also “NetExplorer Manager” on page 395 and “NetExplorer system” on 
page 395.

NetExplorer Manager
The component of the ManageWise NetExplorer system that resides on 
ManageWise Console. NetExplorer manager controls the timing and dura
of updates from NetExplorer components on the NetExplorer Server. 
NetExplorer Manager also keeps track of the records that were sent 
previously, and directs NETXPLOR.NLM to start with a specified record 
number. This enables multiple ManageWise Consoles to receive data from
NetExplorer Server as needed.

NetExplorer system
The complete ManageWise network discovery software that has compon
on a ManageWise Server (NETXPLOR.NLM, NXPIPX.NLM, NXPIP.NLM
and NXPLANZ.NLM) and on the ManageWise Console (NetExplorer 
Manager). (A ManageWise Server running the network discovery softwar
referred to as the NetExplorer Server). 

The NetExplorer Server components NXPIPX.NLM, NXPIP.NLM, and 
NXPLANZ.NLM discover segments, networks, and devices, and provide d
to NETXPLOR.NLM. At the request of NetExplorer Manager, 
NETXPLOR.NLM sends data about new or changed objects to NetExplo
Manager.

NetWare
Novell’s network operating system, which provides the ability to transparen
share services across dissimilar platforms. Uses the NetWare Core Prot
(NCP)®, Internetwork Packet Exchange (IPX)TM , and Sequenced Packet 
Exchange (SPX)TM  protocols.

NetWare Expert
The online help component of ManageWise that focuses on three areas:
tutorial, reference, and alarm help. The tutorial guides you through interac
training on the ManageWise software, the reference is an online hyperte
glossary of terms, and the alarm help explains individual alarms in the Al
Report window.
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NetWare Hub Services software
A group of NLM files that provides real-time information about NetWare 3.
or later servers with HMI-compliant hub cards. It shows the number of hu
in each server, the number of cards in each hub, the number of ports on
card, the status and traffic volume for each port, and summary information
all ports. It also lets you disconnect ports from the net.

NetWare LANalyzer Agent
The Novell SNMP-based remote monitor software that includes NLM file
installed on NetWare 3.11 or later servers. NetWare LANalyzer Agent 
discovers devices, gathers statistics, detects events and, on request, ca
packets on segments on which it is installed. 

The remote monitor and the LANternTM  network monitor provide equivalent 
functionality; both can be monitored from ManageWise.

NetWare Link Services Protocol (NLSP)
The IPX link state protocol used by IPX routers to share information abo
their routes with other devices on the network. Enables network manage
interconnect small or large networks without routing inefficiencies.

NetWare Loadable Module (NLM)
A program you can load and unload from server memory while the serve
running. The NetWare server allocates a portion of memory to the NLM w
the NLM is loaded. The NLM uses the memory to perform a task, and th
returns control of the memory to the operating system when the NLM is 
unloaded.

NetWare Management Agent
A set of NLM files installed in a NetWare server that enables the server to
monitored and managed remotely using SNMP. Servers running NetWar
Management Agent are known as managed servers. 

NetWare Management Agent provides dynamic information about the ser
such as CPU usage, NLM files loaded, and so on.

Network
In ManageWise, a component of a networking environment that correspo
to an IPX network address, an IP network address, or an IP subnet addre
applicable). 

The ManageWise Internetwork map displays segment icons and identifie
IPX network for each segment. If the network runs IP, the segment icon a
has the address of the IP network (or subnet, if applicable) on that segm
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Network adapter
The hardware installed in workstations and servers that enables them to
communicate on a network. 

See also “Adapter” on page 383.

Network address
The Network-layer address that refers to a logical network device. Also 
known as a protocol address.

Network management
The process of ensuring consistent reliability and availability of a network
well as timely transmission and routing of data. Can be performed by 
dedicated devices or programmed general-purpose devices.

Network monitoring
The network management function that constantly checks the network a
reports any problems.

Network segment
See “Segment” on page 401.

Network topology
The arrangement of nodes on a network, usually a star, ring, tree, or bus
organization.

NLM
See “NetWare Loadable Module (NLM)” on page 396.

NLSP
See “NetWare Link Services Protocol (NLSP)” on page 396.

Node
A device that is connected to a network and is capable of communicating 
other network devices. In NetWare, a node is considered to be an end sy
such as a workstation.

ODI (Open Data-Link Interface)
The Novell specification that enables multiple LAN drivers and protocols
coexist on network systems. 

The ODI specification describes the set of interface and software module
used to uncouple device drivers from protocol stacks and to enable mult
protocol stacks to share the network hardware and media transparently.
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Opaque
An application-wide object type that permits the passing of arbitrary ASN
syntax.

Packet
A unit of information transmitted as a whole from one device to another. 
packet-switching networks, a transmission unit of fixed maximum size th
consists of binary digits representing both data and a header.

Packet capture
The process of collecting packets using NetWare LANalyzer Agent for 
troubleshooting or isolating problems. You can specify a capture filter an
display filter to collect or display only the packets or portions of packets y
want. 

See also “Capture filter” on page 386 and “Display filter” on page 388.

Packet decode
The process of displaying a captured packet so that you can see each pr
layer and field. You can also see the packet data in uninterrupted hexade
and either ASCII or EBCDIC format.

Packet display
The process of viewing packets online. 

ManageWise enables you to display a window showing a summary of al
packets captured, a decoded packet, and the packet data in hexadecima
either ASCII or EBCDIC format.

See also “Packet decode” on page 398.

Packet slice
A portion of a packet, counting from the packet header, measured in byte

Because the header contains the most important data in a packet, you c
specify a packet slice when capturing packets to economize on buffer sp
and minimize the load on NetWare LANalyzer Agent.

Physical address
The Data-Link layer address of a network device.
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Pie chart
A circular graphic display of values, each occupying a wedge-shaped se
of the pie. The size of the wedge represents its proportion to the other va
(wedges) and to the whole.

Ping
A connectivity test in which an Internet control message protocol (ICMP)
echo request is sent. Connectivity is verified when a reply is received. 

See also “Connectivity test” on page 387.

Polling
Any procedure that sequentially and periodically contacts terminals in a 
network.

Port
As used in ManageWise, the connection to a repeater. (Other computer-re
definitions exist.) 

A port can be connected to a single adapter, to another repeater, or to an
network segment (which can be a coaxial cable). 

See also “Repeater” on page 400.

Profile
A group of statistics that can be selected by name to display together in 
graph, rather than displaying a single statistic. ManageWise enables you
select one profile by name and display a graph showing, for example, all e
or total utilization for a network segment. 

See also “SNMP profiles” on page 402.

Protocol
A set of rules that enables computers to connect with one another, speci
the format, timing, sequencing, and error checking for data transmission

Protocol suite
A hierarchical set of related protocols.

Query
The process of extracting data from a database and presenting it for use
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RCONSOLE (Remote Console)
A NetWare utility that enables you to manage any NetWare 3 or later ser
on the internetwork remotely from one location.

Real-time data
The dynamic, current information ManageWise provides about a network
segment, or a server. 

Compare “Historic data” on page 390 and “Trend data” on page 404.

Remote monitor
An entity that collects information about the health of a network segment 
stores the information so that it can be retrieved by management softwar
NetWare LANalyzer Agent is an example of a remote monitor.

Repeater
A device used to boost the strength of a signal; it is spaced at intervals 
throughout the length of a communications circuit. The repeater also han
collisions and other error conditions to provide correct operation of the 
network.

Router
A device that connects two networks using the same networking protoco
operates at the Network layer (Layer 3) of the OSI model for forwarding 
decisions.

See also “MultiProtocol Router (MPR)” on page 394.

Routing protocol
A type of protocol that enables routing through the implementation of a 
specific routing algorithm. Examples of routing protocols include the routi
Information Protocol (RIP), Open Shortest Path First (OSPF) protocol, an
Intermediate System-to-Intermediate System (IS-IS) protocol.

Routing table
A table stored in a router that keeps track of routes (and, in some cases, m
associated with those routes) to a particular network destination.

Routing updates
A message sent from a router to indicate network reachability and assoc
cost information. It is typically sent at regular intervals and after a chang
network topology.
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Runt
A small Ethernet packet with FCS or alignment errors. 

Runts are the result of collisions occurring on a connected segment or bet
stations connected to attached repeaters. They are essentially “inferred 
collisions.” 

Collisions between ports within the same repeater are detected explicitly
Runts are artifacts of collisions that cannot be detected explicitly because
are remote to the repeater observing the runt.

Segment
A component of a networking environment that corresponds to a physica
cable. A segment is terminated by a bridge, a router, or any connecting de
other than a repeater or hub. (ManageWise does not discover bridges, s
sometimes ManageWise displays multiple bridged segments as a single
segment.)

Segment consolidation
During the network discovery process, ManageWise might discover segm
running both IP and IPX protocols and list them in the database as two 
segments. Segment consolidation combines the dual listings, making the
database more accurate.

Segment map
A map of an Ethernet or token ring segment on a network showing the no
that are attached to the segment.

Segment overconsolidation
On routers with NetWare MultiProtocol Router software and multiport WA
interfaces connected to different networks, ManageWise discovers the 
interfaces but not the ports. Therefore all networks connected to an inter
through its ports are interpreted as one network. 

See also “Segment consolidation” on page 401.

Server
A processor that provides a specific service to the network. Examples of
servers are as follows:

Routing servers connect nodes and networks of similar architectures.

Gateway servers connect nodes and networks of different architectures by
performing protocol conversions.
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Terminal servers, printer servers, disk servers, and file servers provide an 
interface between compatible peripheral devices on a LAN.

Short event
An Ethernet error that occurs when noise causes the repeater to initiate 
normal packet repeat process. It is detected as short events by virtue of 
shorter than the shortest possible collision fragment.

Snap-in application
A software program or file that is designed to work as an accessory to 
ManageWise, rather than as an independent application.

SNMP (Simple Network Management Protocol)
A protocol used to obtain management information about a network entit
such as a router or a network segment. 

In some cases, the information is obtained from the device itself (for exam
routers and hubs frequently have some management information that ca
retrieved). In other cases, an agent collects information on behalf of the 
network entity (for example, a remote monitor collects information about
segments it is attached to).

SNMP community name
A name used by SNMP for access control. 

The community name contained in an SNMP request must match the na
expected by the device receiving the request. Different names can be use
different levels of access; for example, one name for retrieving informatio
and another for setting values.

SNMP GET operation
A transaction request to read a specific value from a MIB table on a devi

SNMP GETNEXT operation
A transaction request to read the exact value in a MIB table on a device.

SNMP POLL operation
A special request made to the SNMP Data Server to send a GET, GETNE
or SET transaction request periodically.

SNMP profiles
The files that record which SNMP variables should be retrieved by the SN
MIB Browser and the type of visual display requested (table or graph).
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SNMP SET operation
A transaction request to write a specific value to a MIB on a device.

Source address
The address of a sending network device.

Standard
A set of rules or procedures that have been agreed upon by industry 
participants.

Station
A node on a network, usually a workstation, but sometimes a server, hub
router.

Table
A display of data in rows and columns. Generally, you can resize and 
rearrange the columns in a table, and you can sort the table based on the 
in a selected column by double-clicking the column header.

TCP (Transmission Control Protocol)
The major transport protocol in the Internet suite of protocols, providing 
reliable, connection-oriented, full-duplex streams; it uses IP for delivery.

TCP/IP (Transmission Control Protocol/Internet Protocol)
The protocol suite developed by the Advanced Research Projects Agenc
(ARPA); it includes TCP as the primary transport protocol and IP as the 
Network-layer protocol.

Threshold
See “Alarm threshold” on page 384.

Throughput
The total amount of useful information that is processed or communicate
during a specific time period.

Ticker tape
A field on the ManageWise status bar that provides a horizontally scrollin
display of alarm summary information. Alarms scroll across the ticker tap
they are received by the ManageWise Console.

Token
A special type of frame that is passed between token-passing LANs; 
possession of the token gives the possessor permission to transmit.
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Token ring
A type of LAN that uses a circular (ring) topology and that accesses the m
using a token (a special type of frame that, when held by a station, gives
permission to transmit).

Topology
The physical layout of network components (cables, stations, gateways,
hubs). Three basic interconnection topologies are star, ring, and bus netw

Traffic data profile
See “Profile” on page 399.

Transaction
The computation to do a certain delimited amount of work intended to be
indivisible action.

Trap
The unsolicited messages sent by an SNMP agent to a network manage
system that indicate the occurrence of a significant event. The SNMP man
that receives a trap can poll for additional information. 

See also “Alarm” on page 383.

Trend data
The information about the performance of network objects over time; for
example, for the last hour or last 24 hours. 

Compare “Real-time data” on page 400.

Trend graph
A graph that displays trend data.

TSR (Terminate and Stay Resident)
A program that runs continuously in the background while other applicati
are running.

Unicast address
A type of address that specifies a single device.

Utilization
The percentage of a network resources being consumed by network eve

Network utilization refers to the bandwidth being consumed by traffic. 
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Server CPU utilization refers to the load on a given CPU. 

Hub port utilization refers to activity on a port.

Very long events
An Ethernet error that is presumed to be caused by continuously transmi
(jabbering) nodes. The repeater does not repeat the full length of such an 
because it would cause faulty operation of certain network elements.

Virtual circuit
In packet-switching networks, a circuit that appears to be a physical poin
point circuit. It connects two end points, conveying sequenced data pack
reliably; in fact, it shares the underlying links and relay systems with othe
users of the network.

WAN
Wide area network. A network that transmits over large geographic area
using lines provided by a common carrier for private telecommunications
facilities.

Workstation
The input/output equipment at which an operator works; the station in wh
a user can send data to, or receive data from, a computer for the purpos
performing a job.
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